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Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help

You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed Help

If you’re setting up an on-premise PeopleSoft environment, and your organization has firewall restrictions
that prevent you from using the hosted PeopleSoft Online Help, you can install the online help locally.
See Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation

Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

*  Application Fundamentals
» Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.
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In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions

PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions

The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

... (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
Options are separated by a pipe (| ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

> This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.
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ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY CD TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

¢ Asia Pacific
*  Europe
e Latin America

¢ North America

Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

e USF (U.S. Federal)

¢ E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We

are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.
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Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

» Using the PeopleSoft Online Help.
* Managing hosted Online Help.

* Managing locally installed PeopleSoft Online Help.

PeopleTools Related Links

PeopleTools 8.59 Home Page

PeopleSoft Search and Insights Home Page

“PeopleTools Product/Feature PeopleBook Index” (Getting Started with PeopleTools)

PeopleSoft Online Help

PeopleSoft Information Portal

PeopleSoft Spotlight Series

PeopleSoft Training and Certification | Oracle University

My Oracle Support

Oracle Help Center

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.

Follow Us

Icon Link

@ Watch PeopleSoft on YouTube
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Icon Link
N Follow @PeopleSoft Info on X.
A\

Read PeopleSoft Blogs

Connect with PeopleSoft on LinkedIn
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Chapter 1

Getting Started with PeopleSoft Integration
Broker

PeopleSoft Integration Broker Overview

This subject describes using PeopleSoft Integration Broker to:
* Perform asynchronous and synchronous messaging among internal systems and third-party systems.
* Expose PeopleSoft business logic as web services to PeopleSoft and third-party systems.

* Consume and invoke web services from third-party and PeopleSoft systems.

Implementing PeopleSoft Integration Broker
This section provides information to consider before you begin to use PeopleSoft Integration Broker.

Planning the Integration Architecture

The two major components of PeopleSoft Integration Broker are the integration gateway and the
integration engine. The integration gateway is a platform that manages the receipt and delivery of
messages passed among systems through PeopleSoft Integration Broker. The integration engine is an
application server process that routes messages to and from PeopleSoft applications as well as transforms
the structure of messages and translates data according to specifications that you define.

When planning the integration architecture, evaluate historical integration data, current data, as well as
expected growth and increased traffic. Consider the number of interfaces you have in production and

how much system resources they use. Also consider how many of the interfaces will be nightly batch file
loads, versus how many will be real-time service-based integrations. Devise simulated real-life integration
scenarios where you can estimate the volume and the size of the transactions to a certain degree. Then use
this information for benchmarking and stress testing—which should lead to performance tuning, hardware
sizing, and so on.

Planning Integrations

In planning the integrations to develop and execute, consider the following:

* Real-time integrations or scheduled integrations.
Determine if your business needs are best served with real-time integration or scheduled integrations.
Scheduled batch processing and file loads are discussed in other PeopleTools subjects.

See the product documentation for Process Scheduler and Application Engine.
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Inventory the integrations to develop.
Determine the systems and applications that will participate in each integration.

Consider dependencies on other systems owned by other groups having concurrent releases, and data
dependencies within the context of synchronizing data between systems. Also consider if you will
need permission from business owners to integrate with their systems.

Generic integrations.

Consider if you can develop generic integrations. Perhaps in your current environment only two
systems need to exchange information and they do so in a proprietary way. But consider that one day
perhaps additional systems in your enterprise may also need to exchange that information with the
source system. Will you need to develop transformations for systems that will be integrating later on?
Can you develop the integration in a way so that other systems will be able to consume the service or
subscribe to the information without requiring complex transformations?

Determine the integrations that will require synchronous messaging and those that will asynchronous
messaging.

In PeopleSoft Integration Broker synchronous integrations, all processing stops until a response is
received. In PeopleSoft Integration Broker asynchronous integrations, each request is placed in a
queue and is processed as soon as the system can accommodate the request.

Perhaps you may need to stop the processing of fulfilling an order until the system verifies that all
requested items are available in inventory. In such a case, a synchronous integration is needed.

However the processing of support tickets probably should not stop if a system uses integration to add
a new ticket to a queue. In such a scenario, an asynchronous integration might be appropriate.

Prioritize integration development.

Plan to develop mission-critical integrations first, standard integrations next, and nice-to-have
integrations last.

Determine if data will need transformation or translation.
Plan on using integration simulation tools.

Plan on using simulation tools such as PeopleSoft Send Master to simulate integrations with external
systems that are not under your control. Even when you do control all systems that are being
integrated, if you can’t get the integration to work using Send Master, you definitely won’t be able to
get it working from the external system. Test integrations using Send Master before spending hours
debugging a system.

See “Understanding Send Master” (Integration Broker Testing Utilities and Tools).

Determining Security

Unlike a public web service on the internet that retrieves a stock quote for a given ticker symbol, the
web services and integrations in your PeopleSoft applications can expose sensitive information such
as financial data. PeopleSoft Integration Broker facilitates transfer of information between systems;
however, a security analyst must evaluate security requirements for each individual integration.
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For example, security requirements might differ when interfacing with credit card processing vendors,
versus publishing salary information out of human resources, versus synchronizing business units
between applications, and so on.

Perhaps certain information should be available to the public, including systems outside of your company,
such as how many inventory items are available for sale. Other information might be restricted to internal
employees only, internal application systems only, or perhaps only certain users of a particular application
system.

PeopleSoft Integration Broker allows you to secure each individual integration to the level of security
required, as well as all integration data flowing over the wire.

Planning for Support
Develop a support plan for after “go-live.” In doing so, consider the following:
*  Determine who in your organization will support integration development and administration.

* Determine the type of error-notification and exception handling to implement to meet your support
requirements. Consider that while system administrators can resolve communication failure between
machines, they may not be able to resolve errors resulting from one system transmitting bad data to
another. Analyst intervention may be required to correct the data. Stronger validation at point of data
entry will result in fewer calls to a functional analyst to resolve integration issues.

Assessing Staff Skills
Assess the skills of the people who will perform development and administrative functions.

Developers working on the implementation of PeopleSoft Integration Broker should have familiarity,
training or experience in the following PeopleSoft areas:

*  PeopleTools.

*  PeopleCode.

* Application Engine.

In addition, developers should have an understanding and research capabilities in:
* Extensible Markup Language (XML).

* XML schema.

» Simple Object Access Protocol (SOAP).

* Hypertext Transfer Protocol (HTTP).

*  Web Services Description Language (WSDL).

*  Web Application Description Language (WADL).

* Universal Description, Discovery and Integration (UDDI) standard.

+ Java programming language.
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Other Sources of Information

In addition to the implementation considerations presented in this topic, take advantage of all PeopleSoft
sources of information, including the installation guides, release notes, product documentation,
curriculum, and red papers.

The Getting Started with PeopleTools documentation may also provide some useful information.
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Chapter 2

Understanding PeopleSoft Integration
Broker

Introduction to PeopleSoft Integration Broker

PeopleSoft Integration Broker is a middleware technology that:

* Performs asynchronous and synchronous messaging among internal systems and third-party systems.
»  Exposes PeopleSoft business logic as web services to PeopleSoft and third-party systems.

* Consumes and invokes web services from third-party and PeopleSoft systems.

PeopleSoft Integration Broker enables you to perform these integrations among internal systems and
third-party integration partners, while managing data structure, data format and transport disparities.
Because of its modular design, you can reuse many elements that you develop for integrations.

PeopleSoft Integration Broker consists of two subsystems: the integration gateway and the integration
engine. The integration gateway resides on a PeopleSoft web server, and the integration engine is installed
on an application server as part of the PeopleSoft application.

Important! PeopleSoft Integration Broker interacts with a wide variety of third-party products. This
documentation is not an authoritative source of information about any third-party product. Most third-
party products are delivered with their own documentation, which you should use as the primary source
for information about them. This product documentation provides guidance that enables you to determine
the configuration settings that PeopleSoft Integration Broker requires to work with third-party products.
It does not address all configuration permutations. Examples of settings and data relative to a third-party
product may not be correct for your particular situation. To properly configure PeopleSoft Integration
Broker, you must apply your own expertise and obtain the most accurate and current information about
third-party products.

Web Services

PeopleSoft Integration Broker enables you to provide web services to other PeopleSoft systems and
external integration partners by generating Web Services Description Language (WSDL) documents and
Web Application Definition Language (WADL) document from integration metadata. PeopleSoft supports
providing WSDL documents and WADL documents to the PeopleSoft WSDL repository. The system

also supports providing WSDL documents to Universal Description, Discovery, and Integration (UDDI)
repositories.

The system enables you to consume WSDL documents from other PeopleSoft and third-party systems,
and automatically creates integration metadata based on the consumed WSDL documents for processing
integrations. You can consume WSDL documents from other PeopleSoft systems, UDDI repositories,
WSDL URLSs, and Web Services Inspection Language (WSIL) URLs.
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Integration Gateway

The integration gateway is a platform that manages the receipt and delivery of messages passed among
systems through PeopleSoft Integration Broker. It supports the leading TCP/IP application protocols used
in the marketplace today and provides extensible interfaces to develop new connectors for communication
with legacy, enterprise resource planning, and internet-based systems.

Additional features include:

* Backward compatibility for Extensible Markup Language (XML) links and PeopleSoft Application
Messaging.

» Listening connectors and target connectors that transport messages between integration participants
and the integration engine.

Note: This feature also enables you to build your own connectors to complement those delivered with
PeopleSoft Integration Broker.

» Basic logging information concerning message receipt, delivery, and errors.

» Connection persistence with continuous open feeds to external systems through connectors, with full
failover capabilities.

* Transport protocol and message format management so that when messages reach the integration
engine, they have a PeopleSoft-compatible message format.

Related Links

Integration Gateway Architecture

Integration Engine

30

The integration engine runs on the PeopleSoft application server. Rather than communicating directly
with other applications, the integration engine sends and receives messages through one or more
separately installed integration gateways.

The integration engine:

» Uses a modular architecture, so it can treat gateways as black boxes and communicate with them
using standard connectors.

* Adapts elements of an existing integration to produce a new integration with only minor adjustments.

* Handles messages containing data in a variety of formats. Formats include the PeopleSoft rowset-
based message format, and nonrowset-based message structures including , XML document object
model messages, Simple Object Access Protocol (SOAP) messages, and non-XML files.

* Sends and receives messages asynchronously (like email) or synchronously (suspending activity to
wait for a response).

* Applies message transmission type and routing based on specifications that you define in a PeopleSoft
Pure Internet Architecture component.
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* By developing and applying application engine transform programs, the application engine can
transform message structure and translate data content according to specifications that you define in
PeopleSoft Pure Internet Architecture components.

You develop transform application engine programs in PeopleCode or Extensible Stylesheet Language
Transformation (XSLT) code.

These specifications can be reused for other integrations.
* Handles security features such as authentication, nonrepudiation, and cookies.

Related Links
Integration Engine Architecture

Integration Gateway Architecture

This section discusses:

*  Architecture components.
¢ Connectors.

* Gateway manager.

* Gateway services.

Architecture Elements

You use an integration gateway to receive and send messages among integration participant systems.

Listening connectors receive incoming messages and deliver the incoming requests to the gateway
manager, which is a dispatcher for messages that flow through an integration gateway. The gateway
manager determines which target connector to use to properly deliver the messages to their intended
recipients. The target connector then delivers the messages to the intended recipients using the recipients’
preferred protocols.
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This image illustrates the components that comprise the architecture of the integration gateway.
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Listening connectors and target connectors transport messages between integration participants and the
integration gateway. These connectors support asynchronous and synchronous message handling. Many
connectors are configurable at the integration gateway and system levels.

Listening Connectors

Listening connectors receive incoming data streams and perform services based on the content of the
stream. They are invoked externally by other PeopleSoft systems and third-party systems.

Target Connectors

Target connectors initiate communication with other PeopleSoft systems or third-party systems. A

target connector might not receive a response from the target system during each operation, but every
transmission requires a low-level acknowledgment.
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PeopleSoft Integration Broker Connector SDK

The integration gateway provides a fully extensible model for developing new connectors built to
the interface specification of the PeopleSoft Integration Broker software development kit (SDK) by
PeopleSoft customers, consultants, and application developers.

Related Links
“Understanding Listening Connectors and Target Connectors” (Integration Broker Administration)
“Understanding the PeopleSoft Integration Broker Connector SDK” (Integration Broker Administration)

Gateway Manager

The gateway manager processes every message that flows through an integration gateway and maintains
links to the other major integration gateway components, including target connectors, listening
connectors, and each of the gateway services.

Listening connectors invoke the gateway manager when they receive a request. The gateway manager
uses the messaging objects IBRequest and IBResponse to determine how to route each request.

The gateway manager uses a number of the gateway services during this stage to perform operations such
as message validation. The gateway manager then invokes the appropriate target connector based on the
content of the message object and waits for a reply from the target connector. When the reply is received,
the gateway manager forwards the reply to the calling listening connector.

If an error occurs, the gateway manager uses the error handling service and works with the service to
prepare an error reply for the listening connector.

Gateway Services

This section describes the gateway services that the gateway manager uses.

XML Parsing

Most IBRequest objects and IBResponse objects that are processed in the system contain a content section
that represents the actual business content sent.

Most of the time, these content sections contain XML data. Consequently, often connectors must parse
and traverse XML. The standard Java XML objects are cumbersome for manipulating XML, so the
integration gateway includes an XML parsing service consisting of objects that provide an intuitive
interface for manipulating XML objects. This service is delivered as a set of three classes: XmlDocument,
XmlINode and XmINodeList.

See the product documentation for PeopleCode API Reference.

Integration Broker Objects
Two objects comprise the messaging objects service in the integration gateway:
» IBRequest

* IBResponse
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These objects represent the request and response that enter and exit PeopleSoft Integration Broker.

See Supported Message Structures.

Connector Management

The connector management service is a composite of several services that manage connectors. The
gateway processes each IBRequest to determine the appropriate connector to call in each situation.
This is primarily a message routing function that has varying levels of complexity abstracted from
the connectors. The connector management service also processes the IBResponse returned by each
connector.

WS-Security

WS-Security is an extension to the concept of the SOAP envelope header that enables applications to
construct secure SOAP message exchanges. It also provides a means for associating security tokens with
messages.

See “Implementing Web Services Security” (Integration Broker Administration).

Error and Service Operation Logging
Most components in the system use a standard error logging interface.

Each PeopleSoft-delivered connector uses the logging API in the same fashion, ensuring that an
administrator can quickly drill down on problems or simply review the logs to see the IBRequest object,
the IBResponse object, and even the raw data exchanged with integration participants.

See Understanding Error Handling, Logging, Tracing and Debugging.

Error Handling

The integration gateway provides a standard error handling interface that is exposed to each connector.
This service provides error handling and error logging for most connectors delivered with PeopleSoft
Integration Broker.

Message Validation

Messages that pass into PeopleSoft Integration Broker must contain certain elements to be processed.
Because the integration gateway is the first component that processes messages sent to a PeopleSoft
application, it performs basic validation—such as making sure that the message identifies its requestor
and service operation name—to ensure that the integration engine and the target application can process
them.

Integration Engine Architecture

The integration engine uses a variety of PeopleTools elements to create, implement, manage, and enhance
integrations. Its modular architecture separates integration development activities from administrative
activities.
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The integration engine is a combination of PeopleSoft Application Designer definitions, PeopleSoft Pure
Internet Architecture definitions, PeopleCode, and XSLT code, along with the underlying mechanisms
that tie all these elements together. The underlying mechanisms include the request handlers that

process both inbound and outbound messages according to the specifications in the development and
administrative elements.

The integration engine resides on the PeopleSoft application server.

This diagram illustrates the integration components that reside on the integration engine and the types of
processing it performs.

Application Server
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PeopleCode Component | | Application
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Mode User Digital ’
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Service Operations

A service operation in the PeopleSoft system contains the processing logic for an integration and
determines if the integration is to be processed synchronously or asynchronously. A service operation
definition contains the following definitions:

*  Message. A message contains the payload of the integration.

* XML message schema. Message schemas provide the physical description of the data that is being
sent, including descriptions of fields, field types, field lengths, and so on.
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*  Handler. A service operation handler contains the processing logic for the service operation.

*  Routing. A routing definition specifies the direction of the integration (inbound or outbound), routing
alias names, transformations, and more.

Service Operation Types

PeopleSoft Integration Broker supports four types of service operations:
* Asynchronous one-way.

* Asynchronous request/response.

* Asynchronous to synchronous.

*  Synchronous

Note: In this section the term transaction is used to describe the exchange of data between integration
partners.

When PeopleSoft Integration Broker sends a service operation, the receiving system returns a response
back to the sender. With asynchronous transactions, the response is automatically generated by the
integration gateway, and it serves only to notify the sending system of the transmission status of the
request . It is processed automatically by the application server, which uses that status information to
update the Service Operations Monitor. With synchronous transactions, however, the response includes
the content that is requested by the sending system, and it must be generated and returned by the receiving
system.

Operation Types

36

PeopleSoft Integration Broker supports the operation types listed in the table.

For any operation type, the application must invoke PeopleCode, a component interface or data mover
script to generate and send a service operation or to receive and process a service operation.

Operation Type Routing Actions
Asynchronous — One Way. Outbound. 1. The application generates and sends
a request.

2. One or more target system receives
and processes the request.
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Operation Type Routing Actions
Asynchronous — Request/Response. Outbound. 1. The application generates and sends
a request.

2. The target system receives and
processes the request.

3. Sometime later the target system
sends a response which contains
the transaction ID from the original
request. This ID serves as the
correlation ID.

4. The application processes the
response using the correlation ID to
map it back to the original request.
The message sent back is a response
in the form of a request.

Asynchronous to Synchronous. Outbound. 1. The application generates and sends
arequest.

2. A single target system receives and
processes the request, then generates
and sends a response.

3. The application receives and
processes the response.

Synchronous. Outbound. 1. The application generates and sends
a request.

2. The application suspends activity
and waits for a response.

3. A single target system receives and
processes the request, then generates
and sends a response.

4. The application resumes its activity
and receives and processes the
response.

Asynchronous — One way. Inbound. 1. A source system generates and
sends a request.

2. The application receives and
processes the request.
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Operation Type

Routing

Actions

Asynchronous — Request/Response.

Inbound.

1. A source system generates and
sends a request.

2. The application receives and
processes the request.

3. Sometime later the application
sends a response back to the
source system. The response
includes a unique identifier from the
original request, which serves as a
correlation ID.

4. The source system processes the
response using the correlation ID to
map it back to the original request.

Asynchronous to Synchronous.

Inbound.

1. A source system generates and
sends a request.

2. The application receives and
processes the request, then generates
and sends a response.

3. The source system receives and
processes the response.

Synchronous.

Inbound.

1. A source system generates and
sends a request.

2. The source system suspends activity
and waits for a response.

3. The application receives and
processes the request, then generates
and sends a response.

4. The source system resumes its
activity and receives and processes
the response.

Related Links

Services Operation Types

Inbound and Outbound Request Flows

38

This section discusses how inbound and outbound service operation flow through the architecture

components of PeopleSoft Integration Broker.

The PeopleSoft messaging architecture is discussed in greater detail in the Understanding Messaging

topic in the product documentation.
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Related Links
Messaging Types

Asynchronous Messaging
Synchronous Messaging
Inbound Request Flow

This section describes the flow of a typical inbound request from an external system through PeopleSoft
Integration Broker.

This example illustrates the flow of an outbound request through PeopleSoft Integration Broker.

Integration Gateway

JOLT
+—Request——» — .
; : PeopleSoft Request
External Listening 'I';rgeatﬂ &q Application
System —Response Connector Connector < JOLT Server
ponse : Response

After the incoming request has been received by the integration gateway, the flow through PeopleSoft
Integration Broker is the same, regardless of the listening connector used. With this in mind, no specific
listening connector will be discussed here. The scenario is simple: a request is sent into the gateway,
which then passes it on to the application server. The application server processes the request, and returns
a response.

Step 1: External System Sends a Request to PeopleSoft Integration Broker

The first step is that an external system sends a request to PeopleSoft Integration Broker. The external
system can be another PeopleSoft system or a third-party system.

Step 2: Request is Received by the Listening Connector

When a request is received by a listening connector, the first thing that the connector does is write the
request to the gateway log file. (The gateway’s integration properties file is used to set the logging level,
which controls what is actually written to the log. If messages are not being seen in the log file, check to
ensure that the log level is set correctly.) The request is written exactly as it is received. This is very useful
in that it presents exactly what was sent on the wire, before the connector normalizes the service operation
for use by the application server.

The connector then attempts to populate an internal request class with the particulars from the received
request.

A term often used in conjunction with listening connectors is credentials. Incoming requests are

thought to have two logical parts: the credentials and the body. The credentials can be thought of as the
information required by PeopleSoft Integration Broker to process and deliver the payload of the message.
The payload is located in the body. Since the credentials are separate from the body, the integration
gateway does not need to parse or otherwise examine the request body for information on how to route it.

A request without credentials cannot be processed. If the integration gateway receives such a request an
error will occur and an error message will be returned to the requestor.
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Step 3: Request is Processed by the PeopleSoft Target Connector

In order for a request to be sent from the gateway to the application server, it must pass through the
PeopleSoft target connector. This connector has two major responsibilities: it serializes the request to a
string, and sends that string via a JOLT connection to the application server.

All communication between the gateway and the application server is done via the use of Multipurpose
Internet Mail Extensions (MIME) messages. When the request is received by the connector, it builds a
MIME message. Typically the MIME message will only have two sections. In the first, the credentials are
stored in an XML document in a specific format. The second section stores the body.

At this point the request is in a standard format understood by both the gateway and the application server.
All requests must eventually resolve to this format before they can be sent to the application server for
processing. This format effectively isolates the application server from the protocols supported by the
gateway; for the most part, there is no information present about what listening connector was initially
invoked by the external request.

One credential element that may be present is the one for cookies. Obviously if this is set, the application
server would be right in assuming that the request came through the HTTP listening connector. However,
as a general rule the application server is isolated from the details of the protocol and the general broker
code on the server does not care what listening connector was used for a given request.

Once the MIME message has been built, it is written to the gateway log.

Finally, the connector looks up the JOLT connection properties from the integration properties file and
attempts to send the MIME to the application server. If these properties are not set up correctly, the
gateway will be unable to send requests. This is a common source of error, so care should be taken when
configuring this file.

An important point to keep in mind is that even though the MIME request to the application server may
appear in the gateway log file, the actual request may not have made it to the application server, since the
log entry is written before the service operation is sent. If a communication error occurs, the entry will
still be present in the log file. However, if this situation occurs an exception will be thrown and an error
log entry will also be created.

Step 4: Request is Received by the Application Server

When the MIME request is received by the application server, the system parses it into a request object.
The MIME structure is not propagated into the server.

Assuming the request parses without error, the application server pre-processes it.
Pre-processing involves:

* Authenticating the service operation, depending on the authentication scheme configured. If the
request fails authentication, an error is returned.

* Determining the direction of the service operation, by looking at the external alias on the routing
definition that is associated with the service operation.

* Determining the runtime handler to invoke. Currently, there are three handler types supported by the
integration broker: Ping, Synchronous, and Asynchronous. The service operation type determines
the handler code to invoke. Synchronous service operations are passed to sync-specific code, and
asynchronous service operations are passed to the publish/subscribe subsystem.
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Once a request has been passed to its respective handler, further processing is dictated by the data
and PeopleCode specific to a particular system. Or in the case of hub configurations, the request may
immediately be routed to another external system.

Step 5: Response is Returned by the Application Server

Regardless of how the request is processed, a response must be returned by the application server to the
gateway in the same thread of execution. The connection between the gateway and the application server
is essentially synchronous, independent of the type of the service operation type. When the gateway sends
a request to the application server, it expects and must get a response.

In the case of synchronous processing, the generation of the response is blocked by the processing of
the request. A response cannot be generated until the service operation runs to completion. There may
be a noticeable delay in receiving the response, depending on the processing required by the OnRequest
method or if the request is being sent out of the broker to an external system for additional processing.

Asynchronous requests behave differently. Unlike synchronous requests, there is no blocking. A response
is generated for an asynchronous request as soon as the request is placed on the publication queue.
Because of this, a response generated for an asynchronous request is not a response in the strictest sense
of the term. Such responses should really be considered acknowledgments that the pub/sub system

has received the request. Receipt of such a response is not a guarantee that any applicable notification
PeopleCode has been successfully run.

Responses are converted to the MIME standard by the application server, and are returned to the gateway.

Step 6: Response is Received by the PeopleSoft Target Connector

As soon as the MIME response is received by the PeopleSoft target connector, it is written to the gateway
log file.

The MIME response is then parsed back into a gateway request object, and is then returned to the
listening connector.

Step 7: Response is Received by the Listening Connector

The response object is returned to the listening connector, upon which the response is mapped to a
response suitable for the given protocol.

It should be emphasized that, from the viewpoint of the listening connector, the processing of requests
is done synchronously. A request is received by a listening connector which then coverts it to a suitable
format, makes a blocking call to the gateway to handle the message, and ultimately gets a response back
all in the same thread of execution.

Outbound Request Flow

The following diagram shows an outgoing request through PeopleSoft Integration Broker.
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This example illustrates and outbound request through PeopleSoft Integration Broker to an external
system.

Integration Gateway

HTTP
A Request T | PeopleSoft [ Request—p
Sl Listening Target External
Server HTTP Connector Connector System
«— 4—-Fesponse—
Response

There are several scenarios that might result in a request being sent out of the broker. Requests can be sent
in PeopleCode by using the Publish or SyncRequest methods of the Integration Broker class.

Regardless of how the request is created, the mechanism for sending it out of the broker is the same, and
the flow is the same regardless of the specific outgoing target connector you invoke.

Step 1: Application Server Generates Request

Once an outgoing request has been generated, the application server must perform some basic processing
before it can be sent out.

The application server looks at the request, and extracts the information about the node that it is being
sent to.

If target connector information was not supplied via PeopleCode or as part of the routing, then the node
name is then used to look up the name of the gateway to use, the target connector to use on that gateway,
as well as any specific connector properties that need to be passed to the connector in order to handle the
request. If this information is not found, an error will occur.

The application server modifies the outgoing request with the appropriate connector information.

The request is then converted to the MIME standard format, and is sent to the gateway over an HTTP
connection.

The request must be sent to the PeopleSoft listening connector on the gateway. The application server
uses the value of the Gateway URL defined for the given gateway. If this URL is not valid or does not
point to the PeopleSoft listening connector, the application server will be unable to send the request.

Step 2: Request is Received by the PeopleSoft Listening Connector

When the MIME request is received by the PeopleSoft listening connector, it is written to the gateway log
file.

The request is converted from MIME format to a gateway request object.

The connector then examines the request to determine what target connector the request is to be sent to;
that target connector is then invoked.

Step 3: Request is Received by the Target Connector

The target connector validates the request. Each connector requires certain properties to be set, otherwise
the request cannot be sent. For example, the HTTP target connector requires that the Primary URL be set.
If any mandatory connector properties are missing or are invalid, an error will be thrown.
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The target connector then converts the request into whatever format is required by the protocol.

The modified request is then written to the gateway log, and then sent out.

Step 4: Response is Received by the Target Connector

The response received by the target connector is written to the gateway log, and the response is used to
build a gateway response object, which is then returned to the PeopleSoft listening connector.

Step 5: Response is Received by the PeopleSoft Listening Connector
The response object is then converted to the MIME standard format by the connector.
The MIME response is then written to the gateway log file, and is then returned to the application server.

Interactions with the gateway are always synchronous. If a request is sent to the gateway, a response
should be expected.

Step 2 is an HTTP POST request made of the gateway, and the response created here in Step 5 is returned
in response to that HTTP request. The HTTP connection is open for the duration of the processing for that
request.

The response object is returned to the listening connector, upon which the response is mapped to a
response suitable for the given protocol.
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Understanding Messaging

Messaging Types

PeopleSoft Integration Broker supports asynchronous and synchronous messaging.

Term Definition

Synchronous messaging In synchronous messaging, a message is sent to a target
system. The sending system must receive a response from
the target system before it continues to process additional
messages.

Asynchronous messaging In asynchronous messaging, a message is sent to a target
system. However, the sending system does not need to receive
a response from the target system before it can continue
processing messages. This type of messaging is also referred
to as fire-and-forget messaging.

The remainder of this topic discusses the PeopleSoft Integration Broker architecture for these messaging
types.

Note: For compatibility with previous PeopleTools releases, the PeopleSoft Integration Broker services-
oriented architecture introduced in PeopleTools 8.48 overlays the messaging architecture from earlier
PeopleTools 8.4x releases.

Asynchronous Messaging

This section discusses the PeopleSoft Integration Broker asynchronous messaging architecture.

Brokers, Contractors and Queues

The publication broker, publication contractor, and subscription contractor services are the primary
application server elements required for asynchronous messaging. The publication broker service routes
the workload to both contractor server processes.
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This example illustrates the publication broker service routing the workload the contractor server

processes.
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Application Server

Term

Definition

Publication broker

Acts as the routing mechanism. When an asynchronous service
operation arrives in its queue, the publication broker service
runs the defined routing rules. If the service operation needs to
be published to a remote node, it routes the service operation
to the publication contractor service. If the service operation

is subscribed to on the local node, then the publication broker
routes the service operation to the subscription contractor
service. Routing involves submitting either a subscription or
publication contract to the appropriate contractor, followed by
an asynchronous call to the contractor service notifying it that
work is waiting in the queue.

Publication contractor

References the publication contract submitted by the
publication broker service and performs an HTTP post of the
publication service operation to the integration gateway. When
the integration gateway sends a reply indicating that it received
the publication service operation, the publication contractor
service updates the publication contract with the status of
subscription processing (Done or Retry).

Subscription contractor

References the subscription contract submitted by the
publication broker service and runs the appropriate notification
PeopleCode. Then it updates the subscription contract
concerning the status of the subscription processing.

Messaging System Server Processes

The application server offers six server processes to handle asynchronous service operations. They work

in pairs to provide three primary services:

46
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Service Server Processes

Publication broker *  Broker dispatcher (PSBRKDSP)

*  Broker handler (PSBRKHND)

Publication contractor *  Publication dispatcher (PSPUBDSP)

*  Publication handler (PSPUBHND)

Subscription contractor *  Subscription dispatcher (PSSUBDSP)

*  Subscription handler (PSSUBHND)

Dispatchers and Handlers

Each of the publication broker, publication contractor, and subscription contractor is comprised of two
individual server processes that work together to handle incoming requests. One server process functions
as a dispatcher, while the other functions as a handler.

This relationship is analogous to the way that the application server handles workstation connections
and requests. To handle the incoming client requests, the application server has a listener and a handler
(or a pool of handlers). The listener receives the incoming requests and then routes them to an available
handler.

Typically, one listener serves many handlers. The relationship between the dispatcher and the handlers is
analogous to the relationship between the Jolt Server Listener (JSL) and the Jolt Server handler (JSH).
In the case of the application messaging server processes, the dispatcher functions as the listener, and the
handler as similar to the JSH.

For the services discussed in this section (publication contractor, subscription contractor, and publication
broker) there are at least two server processes: a single dispatcher and one or more handlers. The
PSxxxDSP server process is the dispatcher, and the PSxxxHND server process is the handler.

Note: The xxx represents BRK, PUB, or SUB. For example, in the case of the publication broker,
PSBRKDSP is the dispatcher and PSBRKHND is the handler.
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This example illustrates the messaging server processes grouped by their functions in the messaging
architecture:
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Application Server

Asynchronous Service Operation Publication
This section discusses:
* Asynchronous publish of a service operation instance.

* Asynchronous publish of a publication contract.

Understanding Asynchronous Service Operation Publication

This section describes the flow of an asynchronous service operation publication through PeopleSoft
Integration Broker, as well as the status of the service operations as they appear in Service Operations
Monitor.

Asynchronous Publish of Service Operation Instances

This topic describes asynchronous publishing of service operation instances in PeopleSoft Integration
Broker.

48 Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 3

This example illustrates asynchronous publish of a service operation instance in the messaging system:

Understanding Messaging

Business Event

Publish ()

cation
tract
eue

Publication Broker

Publication Contractor

L 4
Broker @) Publication
Dispatcher Dispaicher
PSERKDSP I PSPUBDSP
Broker Fublication
Handler —@—) Handler
PSBRKHMND | PSPUBHMND

The following table describes the processing steps of an asynchronous publication of a service operation
instance in PeopleSoft Integration Broker:

Step Process
1 The service operation is published and enters the message
queue.

The instance is written to the PSAPMSGPUBHDR table in the
database, but is not yet dispatched.

The broker dispatcher process picks up the service operation
instance from its queue.

During this stage, the service operation instance status in the
Service Operations Monitor is New.

2 The broker dispatcher process passes the service operation
instance to the broker handler process.

During this stage, the service operation instance status in the
Service Operations Monitor is Started.
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Step

Process

The broker handler process accepts the service operation
instance, reads the data, and runs the routing rules to determine
where the publication needs to be delivered.

The broker handler process then writes a publication contract
in the PSAPMSGPUBCON table and notifies the publication

contractor service that it has an item to process.

During this stage, the service operation instance status in the

Service Operation Monitor is Working.

After the service operation is stored in the publication contact
queue, the status of the publication contract in the Service
Operations Monitor is New, the service operation instance
status is Done, and the publication dispatcher process picks up
the publication contract from its queue.

The publication dispatcher process passes the service operation

instance to the publication handler process.

During this stage, the publication contract status in the Service
Operations Monitor is Started.

You view service operation instance status information on the Operation Instances page of the Service
Operations Monitor. To access the page select PeopleTools > Integration Broker > Service
Operations Monitor > Monitor > Monitor Asynchronous Services > Operation Instances.

See “Monitoring Asynchronous Service Operation Instances” (Integration Broker Service Operations

Monitor).

Asynchronous Publish of Publication Contracts

This topic discusses asynchronous publishing of publication contracts in PeopleSoft Integration Broker.
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This example illustrates the flow of an asynchronous publication contract through the messaging system.
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(Done, Error,
Retry, Timeout)

The following table describes the processing steps of an asynchronous publish of a publication contract in

PeopleSoft Integration Broker:

Step

Process

The publication dispatcher picks up the publication contract
from the publication contract queue.

The publication contract is written to the PSAPMSGPUBCON
table in the database, but is not yet dispatched. The publication
dispatcher process passes the publication contract to the
publication handler process.

At this stage the status of the publication contract in the
Service Operation Monitor is Started.

The publication handler process accepts the publication
contract and attempts to deliver the service operation to the

integration gateway.

At this stage, the status of the publication contract in the
Service Operations Monitor is Working.
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4 The integration gateway attempts to pass the publication
contract to the destination node.

5 The integration gateway passes the status of the publication
contract back to the publication handler.

6 The publication handler updates the Service Operations

Monitor with the status of the publication contract. The typical
statuses that displays in the Service Operations Monitor are:

*  Done. The subscribing node successfully
received the contract.

*  Timeout.
The system timed out before the
transaction processing was completed.

*  Retry.
The system encountered and error.
The retry is automatic.

When service operations have Retry status, the service
operations are not resent until an internal ping is
successful. This ping is similar to a node ping. The
publication Contract dispatcher, as part of its on idle
processing, pings a node that is in Retry status and
verifies if the connection is reestablished. When the ping
is successful the publication Contract dispatcher resends
the service operation. The service operation goes back to
the publication handler process and returns to Working

status.

You can view the status information for the publication contract using the publication Contracts page
in the Service Operations Monitor. To access the page, select PeopleTools > Integration Broker >
Service Operations Monitor > Monitor > Monitor Asynchronous Services > Publication

Contracts.

See “Monitoring Publication Contracts” (Integration Broker Service Operations Monitor).

The Service Operations Monitor may display statuses for publication contracts other than those discussed

in this section.

See “Understanding Asynchronous Service Operations Statuses” (Integration Broker Service Operations

Monitor)

Asynchronous Service Operation Subscription

52

This section discusses:
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* Asynchronous subscription of a service operation instance.

* Asynchronous subscription contracts.

Understanding Asynchronous Service Operation Subscription

This section describes the flow of an asynchronous service operation subscription through PeopleSoft
Integration Broker, as well as the service operation status at each stage of the process.

Asynchronous Subscription of Service Operation Instances

This topic describes asynchronous subscription process of service operation instances in PeopleSoft
Integration Broker.

This example illustrates the flow of an asynchronous service operation subscription through PeopleSoft
Integration Broker.

Integration
Gateway

!

Integration
Engine

!

age
Uele

O

O

l Publication Broker Subscription Contractor
L 4
Broker (5\. Subscription
Dispatcher Ny Dispatcher
PSERKDSP r PSPUBDSP .
' Broker Subscription
Handler Handler
PSBRKHMND PSPUBHMD

The following table describes the processing steps of an asynchronous subscription of a service operation
instance in PeopleSoft Integration Broker:
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Process

The service operation enters the message queue. The instance
is written to the database, but not yet dispatched

The broker dispatcher process picks up the service operation
instance from its queue.

During this stage, the status of the service operation instance in
the Service Operations Monitor is New.

The broker dispatcher process passes the service operation
instance to the broker handler process.

During this stage, the status of the service operation instance in
the Service Operations Monitor is Started.

The broker handler process accepts the service operation
instance, reads the data, and runs the subscription routing rules
to determine if the service operation needs to be processed
locally.

During this stage, the status of the service operation instance in
the Service Operations Monitor is Working.

The broker handler process then writes a subscription contract
in the PSAPMSGPUBCON table (the subscription contract
queue) and notifies the subscription contractor service that it
has an item to process.

During this stage, the status of the service operation instance in
the Service Operations Monitor is Working.

Once the service operation is stored in the subscription contact
queue, the status of the service operation instance in the
Service Operations Monitor is Done.

Processing of the subscription contract begins as the
subscription dispatcher process picks up the subscription
contract from its queue, and the status of the subscription

contract in the Service Operations Monitor is New.

In this example, at the point when the status of the
asynchronous service operation instance is Done, the

subscription contract status is New.

Asynchronous subscription contract processing is described in
the next section.
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You can view service operation instance status on the Operation Instances page of the Service Operations
Monitor. To access this page, select PeopleTools > Integration Broker > Service Operations
Monitor > Monitor > Monitor Asynchronous Services > Operation Instances.

See “Monitoring Asynchronous Service Operation Instances” (Integration Broker Service Operations
Monitor).

The Service Operations Monitor may display statuses for subscription instances other than those
discussed in this section.

See “Understanding Asynchronous Service Operations Statuses” (Integration Broker Service Operations
Monitor).

Asynchronous Subscription Contract
This topic discuses asynchronous subscription contract processing in PeopleSoft Integration Broker.

This example illustrates the flow of an asynchronous subscription contract.

cription
tract
ueue

Q

¢ Subscription Contractor

Subscription
Dispatcher
PSSUBDSP I

Subscription __@_, Status
Handler (Done or Error)
PSPUBHND

© 0

IMNotification  fef--=2z----~|
Handler @ Application
Application  |[4f----=-- »| Data Tables
Class J-

The following table describes the processing steps of an asynchronous subscription contract in PeopleSoft
Integration Broker:
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The subscription dispatchers picks up the contract from the
subscription contract queue.

The subscription dispatcher process passes the subscription
contract to the subscription handler process.

At this stage the status of the subscription contract in the
Service Operations Monitor is Started.

The subscription handler process accepts the subscription

contract and runs the notification PeopleCode.

In the example shown in the diagram, the notification
PeopleCode then uses the service operation data to update
application data tables. However, the notification PeopleCode
can use the service operation data as input to look up
information, create and publish another service operation, and
so forth.

At this stage, the status of the publication contract in the
Service Operations Monitor is Working.

The subscription handler passes the status of the subscription
contract to the Service Operations Monitor. The typical
statuses that display in the Service Operations Monitor for an
asynchronous subscription contract are:

*  Done. The notification PeopleCode ran successfully.

e Error. An error occurred.

To view status information for subscription contracts, use the Subscription Contracts page in the
Services Operation Monitor. To access the page select PeopleTools > Integration Broker > Service
Operations Monitor > Monitor > Monitor Asynchronous Services > Subscription Contracts.

See “Monitoring Subscription Contracts” (Integration Broker Service Operations Monitor).

The Service Operations Monitor may display statuses for subscription contracts other than those discussed

in this section.

See “Understanding Asynchronous Service Operations Statuses” (Integration Broker Service Operations

Monitor).

Synchronous Messaging

This section discusses synchronous messaging in PeopleSoft Integration Broker.

56
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Synchronous Service Operation Publication

This topic discusses synchronous service operation publication in PeopleSoft Integration Broker.

This example illustrates using PeopleSoft Integration Broker to consume a synchronous service operation.

PSAPPSRV

Integration :

Broker

Integration
Gateway

o BECETEEE TR

G) Logging Tables

b

Status
(Done or Error)

The following table describes the processing steps for a synchronous publication of a service operation in

PeopleSoft Integration Broker:

Step

Process

The integration engine sends the service operation to the
integration gateway.

The integration gateway attempts to deliver the service
operation to the destination node.

The integration gateway sends back the status information to
the integration engine
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4 The integration engine updates the database tables as well
as sends the status information to the Service Operations
Monitor.

The possible statuses in the Service Operations Monitor for a
synchronous publication are:

*  Done. The integration gateway was able to deliver the
service operation to the destination node.

*  Error. The integration gateway was not able to deliver the
service operation to the destination node.

You can view the status information for the invocation in the Service Operations Monitor using the
Synchronous Services page. To access the page select PeopleTools > Integration Broker > Service
Operations Monitor > Monitor > Monitor Synchronous Services.

For status information for synchronous integrations to be available in the Service Operations Monitor, you
must set the Log Detail parameter in the routing definition for the service operation.

Related Links

Defining General Routing Information
“Understanding Synchronous Service Operation Statuses” (Integration Broker Service Operations
Monitor)

“Filtering Synchronous Service Operations Data” (Integration Broker Service Operations Monitor)

“Viewing Monitor Output for Synchronous Service Operations Data” (Integration Broker Service
Operations Monitor)

Synchronous Service Operation Subscription

58

This topic discusses synchronous service operation subscription in PeopleSoft Integration Broker.
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This example illustrates providing a synchronous service operation through PeopleSoft Integration

Broker.
|
|
------ »
OnRequest Application
PeopleCode @ Data Tables
Programis) F: ............

Integration Integr{atiﬂn PSAPPSRY
Gateway ( ) . Engine

Logging Tables

Status
(Done or Error)

The following table describes the processing steps of a synchronous service operation subscription in
PeopleSoft Integration Broker:

Step Process

The integration gateway passes an inbound synchronous
service operation to the integration engine.

The integration engine runs an OnRequest PeopleCode event
program.

The OnRequest PeopleCode program attempts to update the
application data tables.
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Step Process

4 The integration engine updates the database tables as well
as sends the status information to the Service Operations
Monitor.

The possible statuses in the Service Operations Monitor for a
synchronous publication are:

*  Done. The integration gateway was able to deliver the
service operation to the destination node.

*  Error. The integration gateway was not able to deliver the
service operation to the destination node.

For status information for synchronous integrations to be available in the Service Operations Monitor, you
must set the Log Detail parameter in the routing definition for the service operation.

You can view the status information for the publication in the Service Operations Monitor by using the
Synchronous Services page. Access this page by selecting PeopleTools > Integration Broker >
Service Operations Monitor > Monitor > Monitor Synchronous Services.

Related Links

Defining General Routing Information
“Understanding Synchronous Service Operation Statuses” (Integration Broker Service Operations
Monitor)

“Filtering Synchronous Service Operations Data” (Integration Broker Service Operations Monitor)

“Viewing Monitor Output for Synchronous Service Operations Data” (Integration Broker Service
Operations Monitor)
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PeopleSoft Integration Broker Metadata

You use the following integration metadata to create and implement integrations using PeopleSoft

Integration Broker

Term

Definition

Integration PeopleCode

You use integration PeopleCode to send and receive messages,
route messages and manipulate message content.

Integration gateway definitions

This definition is an application’s internal representation of
an installed integration gateway. An application requires at
least the local gateway, through which it can send and receive
messages. Multiple nodes can share the same local gateway,
which might be the only gateway that you need for all of the
integrations.

Message definitions

Message definitions provide the physical description of the
data that is being sent, including fields, field types, and field
lengths.

Node definitions

Nodes represent any organization, application or system
that will play a part in integrations. For example, nodes can
represent customers, business units, suppliers, other trading
partners, external or third-party software systems, and so on.

Node definitions define the locations to or from which
messages can be routed.

Because an application can send messages to itself, a default
local node definition that represents the application is
delivered as part of the integration engine. Each PeopleSoft
installation must have one, and only one, default local node

Queue definitions

Queues group asynchronous services for processing. In
addition, they can dictate the order of processing of the
asynchronous service operations .
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Term Definition

Routing definitions Routing definitions determine the sender and receiver of an
integration. Routing definitions allow you to specify inbound
and outbound transformations that enable you to transform
data structures into those that the sending or receiving systems
can understand.

Service definitions Service definitions group service operations into logical
groups or categories.

Service operation definitions Service operations define the processing logic of an
integration. They specify the inbound, outbound and fault
messages associated with an integration, the integration
PeopleCode to invoke, and the routing to use.

Transformation programs A transformation or transform program is a type of
Application Engine program that you develop and specify

as part of a routing definition. PeopleSoft Integration

Broker supports the use of Extensible Stylesheet Language
Transformation (XSLT) code and PeopleCode for developing
transform programs.

Transform programs can transform, filter and translate data.

Order of Precedence for Creating Integration Metadata

Create integration metadata in the following order:
1. Integration gateway definition.
2. Node definition.

3. Message definition.

4. Integration PeopleCode.

5. Transformation programs.

6. Queue definition.

7. Service definition.

8. Service operation definition.
9. Handler definition.

10. Routing definition.

Related Links

“Defining Integration Gateways” (Integration Broker Administration)
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“Configuring Nodes” (Integration Broker Administration)

Understanding Managing Messages
Understanding Filtering, Transformation, and Translation

Understanding Service Operation Queues

Understanding Sending and Receiving Messages

Understanding Managing Services
Understanding Managing REST Services

Understanding Managing Service Operations
Understanding REST Service Operations

Understanding Routing Definitions
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Structures

Supported Message Structures

This topic discusses the message structures used by PeopleSoft Integration Broker to exchange request
and response messages between the integration gateway and the application server, between other
PeopleSoft systems, and between third-party integration partners.

Note: The code examples in this topic are for illustrative purposes only and are not intended to be used in
a production environment.

Integration Broker Message Structures

This section discusses the internal message formats for request messages and response messages, local
compression, and how to access IBInfo elements.

Internal Message Format for Request Messages

This section discusses the format used to exchange request messages between the integration gateway and
the application server. These messages are frequently referred to as IBRequest messages.

The Multipurpose Internet Mail Extension standard (MIME) is used as the basic structure for internal
messaging. MIME has several advantages in that the standard is well-known and supported, and because
it is text-based, it is human readable and can be easily serialized.

Messages using the internal format display in the integration gateway log file. Since the log file is a
valuable tool for debugging, anyone reading the file will need to understand how the messages are
structured.

Every request message contains three parts:

Term Definition

Headers The first part of a request message contains headers which
describe the attributes of the whole message.
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Term Definition

IBInfo (Integration Broker Information) The IBInfo (Integration Broker Information) section contains
the credentials of the request as well as all other information
required by the PeopleSoft Integration Broker to process

the message. The IBInfo for a request has a specific XML
structure which is used for all request messages in the system,
regardless if the message is being sent to the application server
or to the integration gateway.

Content section The final section contains the message body of the original
request. This is the payload and is what is ultimately delivered
to the final destination.

The following is an example of a request message in the PeopleSoft internal MIME format:

Message-ID: <-192.0.2.10@nowhere >

Mime-Version: 1.0

Content-Type: multipart/related; boundary="Integration Server MIME Boundary"
Content-ID: PeopleSoft-Internal-Mime-Message

PeopleSoft-ToolsRelease: 8.55

--Integration Server MIME Boundary
Content-Type: text/plain; charset=UTF-8
Content-Transfer-Encoding: 8bit
Content-ID: IBInfo
Content-Disposition: inline

<?xml version="1.0" ?>
<IBInfo>
<TransactionID>
<! [CDATA[ caa3a040-bde5-11da-914c-ecaede80d83b]]1>
</TransactionID>
<ExternalOperationName>
<! [CDATA[ QE FLIGHTPLAN TRANSFORM.VERSION 1]]>
</ExternalOperationName>
<OperationType>async</OperationType>
<From>
<RequestingNode>
<! [CDATA [ QE LOCAL]]>
</RequestingNode>
<RequestingNodeDescription>
<! [CDATA[ 11>
</RequestingNodeDescription>
<NodePassword>
<! [CDATA[ password]]>
</NodePassword>
<ExternalUserName>
<![CDATA[ 11>
</ExternalUserName>
<ExternalUserPassword>
<! [CDATA[ ]]1>
</ExternalUserPassword>
<AuthToken>
<! [CDATA[ owAAAAQDAgEBAAAAVAIAAAAAAAASAAAABABTaGRyAk4ALQg4AC4AMQ
AwWABTFZOonLEjJaPtR6v020advRU0Sq2MAAAAFAFNKYXRhV3icHYhNDKkAWGEREEQ
srFyFNOcZSaGz8xAmcwAOdzug3yZv53gMUeWaM+s1IVI1EFnZ0ysjBSv2bm01lmz1
L3Dgt4GrETHSHtQCs6cWBM2ybr 9fMBOPOLSQ==]]>
</AuthToken>
<WSA-ReplyTo>
<! [CDATA[ 11>
</WSA-ReplyTo>
<NodeDN>
<! [CDATA[ 11>
</NodeDN>
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<OrigUser>

<! [CDATA[ QEDMO]]>

</OrigUser>
<OrigNode>

<! [CDATA[ QE LOCAL]]>

</OrigNode>
<OrigProcess>

<! [CDATA[ QE FLIGHTDATA]]>

</OrigProcess>

<OrigTimeStamp>2006-03-27T15:02:39.280000-0800</0rigTimeStamp>

<DirectGatewayRequest />
<SyncServiceTimeout />

<ExternalMessagelD>

<![CDATA[ 11>

</ExternalMessageID>

<SegmentsUnOrder>N</SegmentsUnOrder>

<ConversationID>
<! [CDATA[ 11>

</ConversationID>

<WSA-MessagelD>

<! [CDATA[ 11>
</WSA-MessageID>
<InReplyToID>
<!'[CDATA[ 11>
</InReplyToID>
<DataChunk>
<![CDATA[ 11>
</DataChunk>
<DataChunkCount>
<! [CDATA[ 11>
</DataChunkCount>
</From>
<WS-Security>
<WSTokenType>
<![CDATA[ 11>
</WSTokenType>

</WS-Security>
<To>

<DestinationNode>

<! [CDATA[ QE IBTGT]]>

</DestinationNode>

<FinalDestinationNode>

<![CDATA[ 11>

</FinalDestinationNode>

<AppServerDomain>
<! [CDATA[ 11>
</AppServerDomain>

</To>
<Cookies>

<! [CDATA[ 11>
</Cookies>
<PathInfo>

<! [CDATA[ 11>
</PathInfo>
<HttpSession>

<SessionID>

<![CDATA[ 11>

</SessionID>
</HttpSession>
<QStrArgs />
<ContentSections>

<ContentSection>

<ID>ContentSection0</ID>

<NonRepudiation>N</NonRepudiation>

<Headers>
<version>

<! [CDATA[ VERSION 111>

</version>

<encoding>
<! [CDATA[

</encoding>

baseo6d (deflate)]]>
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<encodedlength>
<! [CDATA[ 948 (709)1]1>
</encodedlength>
<length>
<! [CDATA[ 2840]]>
</length>
</Headers>
</ContentSection>
</ContentSections>
<PublishNode>
<! [CDATA[ QE LOCAL]]>
</PublishNode>
<Queue>
<! [CDATA [ QE FLIGHTPLAN CHNL]]>
</Queue>
<SubQueue>
<! [CDATA[ c9de8110-bde5-11da-be79-846bde717ebf]]>
</SubQueue>
<VisitedNodes>
<! [CDATA[ QE LOCAL|]]>
</VisitedNodes>
<Connector>
<ConnectorName>
<! [CDATA[ PSFTTARGET]]>
</ConnectorName>
<ConnectorClassName>
<! [CDATA[ PeopleSoftTargetConnector]]>
</ConnectorClassName>
<RemoteFrameworkURL>
<![CDATA[ 11>
</RemoteFrameworkURL>
<ConnectorParameters>
<ConnectorParam>
<Name>
<! [CDATA[ URL]]>
</Name>
<Value>
<![CDATA[ 11>
</Value>
</ConnectorParam>
</ConnectorParameters>
<ConnectorHeaders />
</Connector>
<AttachmentSection ResponseAsAttachment="N" />
</IBInfo>

--Integration Server MIME Boundary
Content-Type: text/plain; charset=UTF-8
Content-Transfer-Encoding: 8bit
Content-ID: ContentSectionO
Content-Disposition: inline

eJydl11P2zAUhu8n7T+g/gAKFdt6UYxOHCelFHIgO1RWE1UMTUiMTRRN27+fk7SpvwItd/F57¢c
TvG+cbWvz9/£108ufhZfP46/1ycn56NrlCnz8trklTVLRcGl1kBb4wCrguhGFoUjw9P382/3w8b
tJ+Ug4GT+6£1ZnM5UZNOAMxr1hF18mrnXk76wiWTaaUzTRhOuxU7FS9hpopBxEbC51SSuY6gqTU
seK/gq6hlyJhIIFY+fp8iwuE8yCYk40VpXgZVCfeml0ileSNIIRTYw+IhltwFDBG569KUuhU/KK
gBQ8HVAR37VGeUHDzWIOFIdtbx90K1JJANNDsSWOxmcrihZbfBIxyv4FYKys2Y5YyAolHgVrDHsk
z4hMpQU+cJpYJRxb7REamlnnz8DakEpoYSHWs21iPakJCLbR7T1kIPaZnhEZvOyTSqCnXcWT2E1Z
alfLSQZO0TNQGkPiJHQLR2I3pYFU3VSyTarWX/yq7iirzTIWpCoS2b1lh9esVAQb4Mcm9831BORIJ
TWy//990JDg8A1INnc2ghbzrMO6TFalnbuBocflz2059S0yAvjz0C3J3hsHAO1PQ/XFKkLhUZVKYKJ
107n1zjGJIbMs6q6heNqquSEMTN+Y2Em69hCZ7X/bChQts8yNfveTRwrysnzfr+1 foWg5rFmj+bT
7ro9tV/H6B7C1lUN8GpbdsGmp9eXHRa09i3DVScz7£37I1Z2ue0Bfv1z0DxwgQ4 9AGXRKPxh6BMrwU
J7tegSyiRRAuR3se8TAgrehiBKmXSh6GHTQO5+POR1IYANQI1Ib48ZHOYUykXAaYCMKVg5AEOhTI4L
mhAuUH1AGiHWQHCkvDjhcVAx41JAWPfAVAKCHOX0/7PRRAw87ut fFU53bplX4K/MmvRDhS5WLgFhy
CJajVz4+gLr4SyEInFjZhLeSWzygPTx6KpgOh9k6D/9z/1gQlWw==
--Integration Server MIME Boundary--

Chapter 5
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IBRequest Header Section

The first part of a request message contains headers which describe the attributes of the whole message.

Message-ID: <-192.0.2.10@nowhere >
Mime-Version: 1.0

Content-Type: multipart/related; boundary="Integration Server MIME Boundary"
Content-ID: PeopleSoft-Internal-Mime-Message
PeopleSoft-ToolsRelease: 8.55

--Integration Server MIME Boundary
Content-Type: text/plain; charset=UTF-8
Content-Transfer-Encoding: 8bit
Content-ID: IBInfo

Content-Disposition: inline

IBRequest IBInfo Section

<?xml version="1.0" 2>
<IBInfo>

<TransactionID>
<! [CDATA[ caa3a040-bde5-11da-914c-ecaede80d83b]]>

</TransactionID>

<ExternalOperationName>

<! [CDATA[ QE FLIGHTPLAN TRANSFORM.VERSION 1]]>
</ExternalOperationName>
<OperationType>async</OperationType>

<From>

<RequestingNode>
<! [CDATA[ QE LOCAL]]>
</RequestingNode>
<RequestingNodeDescription>
<! [CDATA[ 11>
</RequestingNodeDescription>
<NodePassword>
<! [CDATA[ password]]>
</NodePassword>
<ExternalUserName>
<! [CDATA[ 11>
</ExternalUserName>
<ExternalUserPassword>
<! [CDATA[ 11>
</ExternalUserPassword>
<AuthToken>
<! [CDATA[ owAAAAQDAgEBAAAAVAIAAAAAAAASAAAABABTaGRyAk4ADLQg4AC4AMQ
AwWABTFZOonLEjJaPtR6v020advRU0Sq2MAAAAFAFNKYXRhV3icHYhNDKAWGEREEQ
srFyFNOcZSaGz8xAmcwAO0dzug3yZv53gMUeWaM+s1IVI1EFnZ0ysjBSv2bm01lmz1
L3Dgt4GrETHSHtQCS6CcWBM2ybr 9fMBbPOLSQ==]]>
</AuthToken>
<WSA-ReplyTo>
<![CDATA[ 11>
</WSA-ReplyTo>
<NodeDN>
<! [CDATA[ 11>
</NodeDN>
<OrigUser>
<! [CDATA[ QEDMO]]>
</OrigUser>
<OrigNode>
<! [CDATA[ QE LOCAL]]>
</OrigNode>
<OrigProcess>
<! [CDATA[ QE FLIGHTDATA]]>
</OrigProcess>
<OrigTimeStamp>2006-03-27T15:02:39.280000-0800</0rigTimeStamp>
<DirectGatewayRequest />
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<SyncServiceTimeout />
<ExternalMessageID>
<![CDATA[ 11>
</ExternalMessageID>
<SegmentsUnOrder>N
</SegmentsUnOrder>
<ConversationID>
<!'[CDATA[ 11>
</ConversationID>
<WSA-MessageID>

<![CDATA[ 11>
</WSA-MessagelD>
<InReplyToID>

<! [CDATA[ 11>
</InReplyToID>
<DataChunk>

<! [CDATA[ 11>
</DataChunk>
<DataChunkCount>

<!'[CDATA[ 11>
</DataChunkCount>
</From>
<WS-Security>

<WSTokenType>

<! [CDATA[ 11>

</WSTokenType>
</WS-Security>
<To>

<DestinationNode>

<! [CDATA[ QE IBTGT]]>

</DestinationNode>
<FinalDestinationNode>
<! [CDATA[ 11>
</FinalDestinationNode>
<AppServerDomain>
<!'[CDATA[ 11>
</RAppServerDomain>
</To>
<Cookies>
<!'[CDATA[ 11>
</Cookies>
<PathInfo>
<![CDATA[ 11>
</PathInfo>
<HttpSession>
<SessionID>
<![CDATA[ 11>
</SessionID>
</HttpSession>
<QStrArgs />
<ContentSections>
<ContentSection>

<ID>ContentSection0</ID>
<NonRepudiation>N</NonRepudiation>

<Headers>
<version>

<! [CDATA[ VERSION 1]]>

</version>
<encoding>

<! [CDATA[ base64d (deflate)]]>

</encoding>
<encodedlength>

<! [CDATA[ 948(709)11>

</encodedlength>
<length>

<! [CDATA[ 2840]1]1>

</length>
</Headers>
</ContentSection>
</ContentSections>
<PublishNode>

Chapter 5
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<! [CDATA[ QE LOCAL]]>
</PublishNode>
<Queue>

<! [CDATA[ QE FLIGHTPLAN CHNL]]>
</Queue>
<SubQueue>

Understanding Supported Message Structures

<! [CDATA[ c9de8110-bde5-11da-be79-846bde71l7ebf]]>

</SubQueue>
<VisitedNodes>
<! [CDATA [ QE LOCAL|]]1>
</VisitedNodes>
<Connector>
<ConnectorName>
<! [CDATA[ PSFTTARGET]]>
</ConnectorName>
<ConnectorClassName>

<! [CDATA[ PeopleSoftTargetConnector]]>

</ConnectorClassName>
<RemoteFramewor kURL>
<![CDATA[ 11>
</RemoteFrameworkURL>
<ConnectorParameters>
<ConnectorParam>
<Name>
<! [CDATA[ URL]]>
</Name>
<Value>
<![CDATA[ 11>
</Value>
</ConnectorParam>
</ConnectorParameters>
<ConnectorHeaders />
</Connector>

<AttachmentSection ResponseAsAttachment="N" />

</IBInfo>

While the basic structure is the same for all requests, not all elements are always required. An example
of this is the Connector section. The Connector XML is used to tell the integration gateway to route a

message to the named target connector. It also lists configuration parameters for the outbound request.
This XML would only be seen in requests sent from the application server to the integration gateway. For
requests going in the other direction, the section would be empty.

Note: The only element that is always required is ExternalOperationName.

The following is a list of the most important elements that may appear in the IBInfo section of a request

message:

Element

Description

IBInfo / ExternalOperationName

The name of the requested service operation.

IBInfo / Operation Type (Optional.) This is the type of service operation. The valid
values are: asynchronous, synchronous and ping.
IBInfo / TransactionID (Optional.) The transaction ID is used to uniquely identify a

request.
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Element

Description

IBInfo / From / RequestingNode

(Optional.) The requesting node is the node that sent the
request to the current system.

IBInfo / From / Password (Optional.) This is the password for the requesting node.

IBInfo / From / DN (Optional.) For incoming requests, the DN gives the
Distinguished Name extracted from the certificate
authentication process.

IBInfo / From / OrigNode (Optional.) For requests that cross multiple nodes, OrigNode is

used to identify the node that initiated the request.

IBInfo / From / OrigTimeStamp

(Optional.) This timestamp corresponds to the time that the
request was created. For requests that cross nodes, this is the
time that the first request was created.

IBInfo / To / DestinationNode

(Optional.) This is the node to which the request will be
delivered.

IBInfo / To / FinalDestinationNode

(Optional.) In cases where the message will be passed across
several nodes, this value specifies the ultimate target of the

message.

IBInfo / QStrArgs

(Optional.) Specific to incoming HTTP requests. These are the
query string parameters found when the request was received
by the HTTP listening connector.

IBInfo / Cookies

(Optional.) Specific to incoming HTTP requests. This is
cookie string found when the request was received by the
HTTP listening connector.

IBInfo / PathInfo

(Optional.) Specific to incoming HTTP requests. This is the

path information extracted from the request.

IBInfo / ContentSections / ContentSection

(Optional.) This node provides metadata about the text present
in the ContentSection.

IBInfo / ContentSections / ContentSection / ID

(Optional.) The index number of the content section.

IBInfo / ContentSections / ContentSection / NonRepudiation

(Optional.) Indicates as to whether nonrepudiation should be

performed.

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 5 Understanding Supported Message Structures

Element Description

IBInfo / ContentSections / ContentSection / Headers (Optional.) Provides additional information about the data.

IBInfo / PublishingNode (Optional.) The node that published the message.

IBInfo / Queue (Optional.) The queue to which the service operation was
published.

IBInfo / Internallnfo / AppMsg / SubQueue (Optional.) The subqueue to which the service operation was
published.

IBInfo / Internallnfo / AppMsg / VisitedNodes (Optional.) The list of nodes that have already received this

message. This is useful when a message is being propagated
across multiple nodes.

IBInfo / Internallnfo / AppMsg / PublicationID (Optional.) The publication ID for this message.

IBInfo / Connector (Optional.) Connector information instructs the gateway as to
how to process the request.

IBInfo / Connector / ConnectorName (Optional.) This is the proper name of the target connector to
invoke to send the message.

IBInfo / Connector / ConnectorClassName (Optional.) This is the class name of the target connector to
invoke.
IBInfo / Connector / ConnectorParameters (Optional.) Connector parameters are processing instructions

for the target connector to be invoked.

IBInfo / Connector / ConnectorHeaders (Optional.) Connector headers provide further metadata about
the contents of the message to be sent.

IBRequest Content Section

The content section of a request message features the message body.

-—-Integration Server MIME Boundary

Content-Type: text/plain; charset=UTF-8

Content-Transfer-Encoding: 8bit

Content-ID: ContentSection0

Content-Disposition: inline

eJydl11P2zAUhu8n7T+g/gAKFdt 6UYxOHCelFHI9gO1RWE1UMTUiMTRRN2 7+fk7SpvwItd/F5
eJydl11P2zAUhu8n7T+7¢c TvG+cbWVz9/£f108ufhZfP46/1ycn56NrlCnz8trkl1TVLRcG1kBDb
4wCrguhGFoUjw9P382/3w TvG+8btJ+Ug4GT+6f1Z2nM5UZNOAMxr1hF18mrnXk76wWTaaUzTRh
OuxU7FS9hpopBxEbC51SSuY6gqtJ+Ug4GT+TUseK/qbhlyJhIIFY+fp8iwuE8yCYk40VpXgZVC
feml0i1eSNIIRTYw+IhltwFDBG569KUuUhU/KKgBQ8HVAR37VGeUHDzWOFIdtbx90K1JJANNDSWO
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xmcrihZbfBIxyv4FYKys2Y5YyAolHgVrDHskz4hMpQU+cJpYJRxb7REamlnnz8DakEpoYSHWs21
PakJCLbR7T1kIPaZnhEZvOyTSqCnXcWT2z4hMpQU+E1ZalfLSQZ0TNQGkPiJHQLR2I3pYFU3VSy
TarWX/yq7iirzTIWpCoS2blh9esVAOb4Mcm9831BORIJTWY//9q0JDg8A1INnc2ghbZrMQ6TFalnb
uBocflZQ59S0yAviz0C3J3hsHAO1PQ/XFkLhUZVKYKJ1Q7n1z3GJIbMs6gq6heNgquSEMTN+Y2Em69
hCZ7X/bCbQts8yNfve7/Rwrysnzfr+lfbiWg5srFmjlQ7nlzjGJIbMs6q6heNgquSEMTN++bT
7ro9tV/H6B7C1lUN8GpbdsGmp9eXHRa09i3DVScz7£37IZ2ue0Bfv1z0DxwgQ4 9AGXRKPxh6BMrwU
J7tegSyiRRAuR3se8TAgrehiBKmXSh6GHTQ5+POR1yANQI1Ib48ZHOYUykXAaYCMKVg5AEoh
J7tegSyiRRAuR3se8TAgrehi BKmXSh6GHTQ5+I4LmhAuUH1AGi HwQHCkvDjhcVAx41 JAWPfAV4AKCHOX0
/TPRRAw8 7ut £FU53bplX4K/MnvRDh5WLGFhyCJajVz4+qLr4SyEJInFj ZhLeSWzyqPTx6KpgOh9ok6D
/9z/19Q1Ww==

Internal Message Format for Response Messages
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The internal format for response messages parallels that for request messages, and has the same basic
MIME structure. These messages are frequently referred to as IBResponse messages.

There are three logical components to a MIME response message: the IBResponse header section, the
IBInfo section, and the Content section.

The following code shows an example of a response message:

Message-ID: <32004392.1143500580241.JavaMail .KCOLLIN2@PLE-KCOLLIN2>
Date: Mon, 27 Mar 2006 15:03:00 -0800 (PST)

Mime-Version: 1.0

Content-Type: multipart/related;
boundary="----= Part 4 9069393.1143500580221"

Content-ID: PeopleSoft-Integration-Broker-Internal-Mime-Message
PeopleSoft-ToolsRelease: 8.55

—————— = Part 4 9069393.1143500580221
Content-Type: text/plain; charset=UTF-8
Content-Transfer-Encoding: 8bit
Content-Disposition: inline

Content-ID: IBInfo

<?xml version="1.0"?><IBInfo><Status><StatusCode>0</StatusCode>
<MsgSet>158</MsgSet>

<MsgID>10000</MsgID><DefaultTitle>Integration Broker Response
Message</DefaultTitle>

</Status><ContentSections><ContentSection><ID>ContentSection0</ID>
<NonRepudiation>N</NonRepudiation></ContentSection></ContentSections></IBInfo>
—————— = Part 4 7210339.1008355101202

IBResponse Header

The first part of a response message contains headers which describe the attributes of the whole message.

Message-ID: <32004392.1143500580241.JavaMail .KCOLLIN2@PLE-KCOLLINZ2>
Date: Mon, 27 Mar 2006 15:03:00 -0800 (PST)

Mime-Version: 1.0

Content-Type: multipart/related;
boundary="----=_Part 4 9069393.1143500580221"

Content-ID: PeopleSoft-Integration-Broker-Internal-Mime-Message
PeopleSoft-ToolsRelease: 8.55

IBResponse IBInfo Section

The format for the XML for the IBInfo for a response message is different than that for the request
message. The following is a sample (formatted for easier reading):

<?xml version="1.0"?>
<IBInfo>
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<Status>
<StatusCode>0</StatusCode>
<MsgSet>158</MsgSet>
<MsgID>10000</MsgID>
<DefaultMsg>OK</DefaultMsg>
<DefaultTitle>Integration Broker Response Message</DefaultTitle>

</Status>

<ContentSections>
<ContentSection>
<ID>ContentSection0</ID>
<NonRepudiation>N</NonRepudiation>
</ContentSection>

</ContentSections>

</IBInfo>

The following is the list of all the elements that may be present in the IBInfo for a response message:

Element Description

IBInfo / Status / StatusCode Describes the result of the request. The possible values are:
* 0 (zero). Request successfully processed.

e ]0. Temporary error occurred. Request can be resent.
»  20. Fatal error occurred. Do not resend request.

*  30.Request message is a duplicate of a message

previously received.

IBInfo / Status / MsgSet The MessageSetNumber for this message in the Message
Catalog. Message set number 158 is assigned to the PeopleSoft

Integration Broker.

IBInfo / Status / MsgID The Message Number for this message in the Message
Catalog. If no errors occurred during the processing of the
request, the MsgID will be set to the value ‘10000°.

IBInfo / Status / DefaultTitle Used if the message catalog is unavailable. This value
corresponds to the “Message Text” for a given entry in the
message catalog.

IBInfo / Status / DefaultMsg Used if the message catalog is unavailable. This value
corresponds to the “Explanation” for a given entry in the
message catalog.

IBInfo / Status / Parameters Parameters may be used to provide additional information for

€ITor reSponses.
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Element

Description

IBInfo / ContentSection

A description of the content section returned with the
response.

Note: Not all response messages will have a content section.
The structure of the content section and all child elements is
the same as was seen in the request IBInfo.

IBResponse Content Section

The content section of a response message features the message body only when working with

SyncRequests

<?xml version="1.0"?2>

<TestXml>This is a sample response message.</TestXml>

Error Codes and Message Catalog Entries

A response message may contain data relating to the processing of the request message, or it may contain
error information if there were problems in fulfilling the request.

The status code describes the nature of the response message. The following table describes possible
request message status codes and their meaning.

Value Meaning Description

0 Success The message transport and processing
were successful.

10 Retry The transport was not successful.
PeopleSoft Integration Broker will
perform its retry logic and send the
message again.

20 Error An error occurred.

30 Duplicate message The transaction ID for the message has
already been received.

40 Acknowledgement error This status is used for SOAP messages

and indicates that the contents of the
data is not proper, but the transport was
successful.
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Value Meaning Description

50 Acknowledgement hold Used for asynchronous chunking of
messages from PeopleSoft to PeopleSoft
nodes when sending multiple message

segments.

All PeopleSoft Integration Broker error messages are stored in the message catalog. A short and long
description for every error can be found there. Catalog entries are given a number, and this number is used
in the response messages.

Here is a sample error message:

Message-ID: <32004392.1143500580241.JavaMail .KCOLLIN2@PLE-KCOLLINZ2>
Date: Mon, 27 Mar 2006 15:03:00 -0800 (PST)

Mime-Version: 1.0

Content-Type: multipart/related;
boundary="----= Part 4 9069393.1143500580221"

Content-ID: PeopleSoft-Integration-Broker-Internal-Mime-Message
PeopleSoft-ToolsRelease: 8.55

—————— = Part 25 2235074.1008270392277
Content-Type: text/plain; charset=UTF-8
Content-Transfer-Encoding: 8bit
Content-Disposition: inline
Content-ID: IBInfo

<?xml version="1.0"?><IBInfo><Status><StatusCode>10</StatusCode>
<MsgSet>158</MsgSet><MsgID>10721</MsgID><Parameters count="1"><Parm>404</Parm></Par=

ameters>
<DefaultTitle>Integration Gateway Error</DefaultTitle></Status></IBInfo>
—————— = Part 25 2235074.1008270392277--

All PeopleSoft Integration Broker errors use message set /58. The actual error seen here is 10721. Going
to the message catalog, the description for message set /58, error 10721 is:

Message Text: Integration Gateway - External System Contact Error

Explanation: Integration Gateway was not able to contact the external system.
The network location specified may be incorrect, or the site is permanently
or temporarily down.

Therefore this error was created by the integration gateway when it tried to send a request message to an
external system.

Local Compression
This section provides an overview of local compression and discusses how to:
* Set local compression for asynchronous messages.
* Set local compression for synchronous messages.

* Override local compression for synchronous messages.
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Understanding Local Compression

The integration engine compresses and base64-encodes messages destined for the PeopleSoft listening
connector on its local integration gateway.

Setting Local Compression for Asynchronous Messages

Asynchronous messages are always compressed and base64 encoded when sent to the integration
gateway. There are no settings you need to make.

Setting Local Compression for Synchronous Messages

In PSAdmin you can set a threshold message size above which the system compresses synchronous
messages. The setting is shown here:

Values for config section - Integration Broker
Min Message Size For Compression=10000

Do you want to change any values (y/n)? [n]:

The value is the message size in bytes; the default value is 70000 (10 kilobytes). You can specify a setting
of 0 to compress all messages.

To turn off compression, set the value to -1.

Warning! Turning compression off can negatively impact system performance when transporting
synchronous messages greater than 1 MB. As a result, you should turn off compression only during
integration development and testing.

Note: This setting does not affect the compression of messages that the integration gateway sends using
its target connectors.

Overriding Local Compression for Synchronous Messages

You can override the PSAdmin message compression setting for synchronous messages at the transaction
level. The following method on the IBInfo object in the Message class is provided for this purpose:

&MSG.IBInfo.CompressionOverride

The valid parameters for this method are: %IntBroker Compress, %IntBroker UnCompress, and
%IntBroker Compress Reset.

See .“Understanding Message Classes” (PeopleCode API Reference)

Accessing IBInfo Elements Using PeopleCode

78

You can use the PeopleCode Message object to access IBRequest and IBResponse IBInfo data.

The following example demonstrates reading target connector information on a notification method for a
rowset-based asynchronous message.

method OnNotify
/+ & MSG as Message +/
/+ Extends/implements PS PT:Integration:INotificationHandler.OnNotify +/
/* Variable Declaration */
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integer &i;
string &strReturn;
rowset &RS;

For &1 = 1 To &MSG.IBInfo.IBConnectorInfo.GetNumberOfConnectorProperties|()
/* get Query arguments */

&strReturn = &MSG.IBInfo.IBConnectorInfo.GetQueryStringArgName (&i);
&strReturn = &MSG.IBInfo.IBConnectorInfo.GetQueryStringArgValue (&1);

End-For;
/* access the content data */
&RS = &MSG.GetRowset () ;

end-method;

The following example demonstrates reading target connector information on notification method for a
nonrowset-based asynchronous message.

method OnNotify
/+ & MSG as Message +/
/+ Extends/implements PS PT:Integration:INotificationHandler.OnNotify +/
/* Variable Declaration */
integer &i;
string &&strReturn;
xmldoc &xmldoc;

For &1 = 1 To &MSG.IBInfo.IBConnectorInfo.GetNumberOfConnectorProperties ()

&strReturn &MSG.IBInfo.IBConnectorInfo.GetQueryStringArgName (&1) ;
&strReturn = &MSG.IBInfo.IBConnectorInfo.GetQueryStringArgValue (&1);

End-For;

/* access the content data */
&xmldoc = &MSG.GetXmlDoc () ;
end-method;

If an HTTP header is passed with a dollar sign ($), PeopleSoft Integration Broker converts the dollar sign
to an underscore ().

PeopleSoft Rowset-Based Message Format
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This section discusses the PeopleSoft rowset-based message format and discusses:
» FieldTypes section of a rowset-based message.

*  MsgData section of a rowset-based message.

* PeopleSoft rowset-based message example.

¢ PeopleSoft timestamp format.

* CDATA and special characters.

79



Understanding Supported Message Structures Chapter 5

¢ Schema restrictions.

This section also provides an example of a rowset-based message.

Related Links

Message Part Structures

Understanding the PeopleSoft Rowset-Based Message Format
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To work with rowset-based messages—the PeopleSoft native format—you define a message in the
PeopleSoft Pure Internet Architecture, insert records into the message definition in a hierarchical
structure, and then populate the message and manipulate its contents by using the PeopleCode Rowset and
Message classes. Externally, the message is transmitted as XML with a prescribed PeopleSoft schema.

The PeopleSoft message schema includes a PSCAMA record, which PeopleTools adds to every level of
the message structure to convey basic information about the message and its data rows.

The Rowset and IntBroker classes are recommended for messaging between PeopleSoft applications.
If a message is populated with data from a PeopleSoft application’s database or component buffer, the
Message class is best for handling that data.

Record and Field Aliases

You can specify an alias for any record or field in a rowset-based message definition. Each node
participating in a transaction maintains its own independent definition of the message and its versions,
including record and field names and their aliases.

When you send a message with an alias defined and the message is converted to XML for sending,

only the alias appears in the XML. If you don’t specify an alias, the original name is used. If the service
operation is routed to multiple target nodes with different record or field naming schemes, you create for
each target a separate service operation version with its own aliases and send each version separately.

The only requirement for a successful transaction is that the record and field names in the XML match
either the original names or the aliases that are defined for that message and version at the node receiving
the message. This behavior applies to both request and synchronous response messages, but typically only
the source node applies aliases to accommodate the target node’s naming scheme in both directions.

In a synchronous transaction, the request and response messages can be completely different from each
other. Upon receiving a synchronous request, the target node generates and sends a response message.
Upon receiving the response, the source node uses its defined aliases to find and reapply its original
record and field names. The resulting inbound message contains the original names that were defined at
the source node, not the aliases. Therefore, both the sending and receiving PeopleCode at the source node
should expect to work with the source node’s original record and field names.

Related Links
PSCAMA
Understanding Integration PeopleCode

Understanding Filtering, Transformation, and Translation
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Rowset-Based Message Template

The following template shows the overall structure of a message in the PeopleSoft rowset-based message
format:

<?xml version="1.0"?2>
<psft message name>
<FieldTypes>

</FieldTypes>
<MsgData>
<Transaction>

</Transaction>
</MsgData>
</psft _message name>

Note: Psft message name is the name of the message definition in the PeopleSoft database. Integration
Broker inserts this message content into a standard PeopleSoft XML message wrapper for transmission.

FieldTypes Section

Each PeopleSoft message includes field type information. Field type information conveys the name of
each data record and its constituent fields, along with each field’s data type. Your receiving application
can use this information to validate data types. The field type information is contained in the FieldTypes
section of the message.

There are two FieldTypes tags:

* Each record tag consists of the name of a record, followed by a class attribute with a single valid
value: R. The record tag encloses that record’s field tags.

» Each field tag consists of the name of a field, followed by a #ype attribute with three valid values:
CHAR for a character field, DATE for a date field, and NUMBER for a numeric field.

Following is a simple FieldTypes template.

<FieldTypes>
<recordnamel class="R">
<fieldnamel type="CHAR"/>
<fieldname2 type="DATE"/>
<fieldname3 type="NUMBER"/>
</recordnamel>
<recordnameZ? class="R">
<fieldname4 type="NUMBER"/>
</recordname2>
<FieldTypes>

Note: Third-party sending applications must include a valid FieldTypes section in each message. The
PeopleSoft system expects field type information for each record and field in the message.

MsgData Section

In addition to field type information, each PeopleSoft message contains data content in the MsgData
section of the message. Between the MsgData tags are one or more Transaction sections. Each transaction
represents one row of data.
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Between the Transaction tags is a rowset hierarchy of records and fields. The record tags at each level
contain the fields for that record, followed by any records at the next lower level.

The last record within a transaction is a fully specified PeopleSoft Common Application Message
Attributes (PSCAMA) record, which provides information about the entire transaction. Immediately
following the closing tag of every record below level 0 is a PSCAMA record containing only the
AUDIT_ACTN field that specifies the action for that record.

Simple MsgData Template

Following is a simple MsgData template.

Note: The PSCAMA PUBLISH RULE ID and MSGNODENAME fields (shown emphasized) are used
internally by certain PeopleSoft utilities, but third-party systems can generally ignore them and don’t need
to include them in messages.

<MsgData>
<Transaction>
<levelOrecnamel class="R">
<fieldnamel>value</fieldnamel>
<fieldname2>value</fieldnamelZ>
<levellrecnamel class="R">
<fieldname3>value</fieldname3>
<fieldname4>value</fieldname4>
</levellrecnamel>
<PSCAMA class="R">
<AUDIT_ACTN>Value</AUDIT_ACTN>
</PSCAMA>
<levellrecname? class="R">
<fieldname5>value</fieldnameb5>
</levellrecname2>
<PSCAMA class="R">
<AUDIT_ACTN>Value</AUDIT_ACTN>
</PSCAMA>
</levelOrecnamel>
<levelOrecname2 class="R">
<fieldnameé6>value</fieldname6>
</levelOrecnamel2>
<PSCAMA class="R">
<LANGUAGE_CD>Value</LANGUAGE_CD>
<AUDIT ACTN>value</AUDIT ACTN>
<BASE7LANGUAGE7CD>Value</BASE7LANGUAGE7CD>
<MSG_SEQ FLG>value</MSG_SEQ FLG>
<PROCESS_INSTANCE>V&1ue</PROCESS_INSTANCE><PUBLISH_BULE_ID>Value</PUBLISH_3

RULE_ID><MSGNODENAME>Value</MSGNODENAME>
</PSCAMA>
<Transaction>
</MsgData>

Related Links
PSCAMA

PSCAMA

82

PeopleTools adds the PSCAMA record to every level of the message structure during processing. It isn’t
accessible in the message definition, but you can reference it as part of the Message object in the sending
and receiving PeopleCode, and you can see it in the Integration Broker Monitor. PeopleCode processes
this record the same way as any other record.
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Note: PSCAMA records are automatically included in messages only if you insert database records to
define the message structure. You can use the PeopleCode XmlDoc class to handle an inbound message
containing PSCAMA records, but the PeopleCode Message class is much better suited for this.

PSCAMA contains fields that are common to all messages. The <PSCAMA> tag repeats for each row in
each level of the transaction section of the message. The sender can set PSCAMA fields to provide basic
information about the message; for example, to indicate the message language or the type of transaction

a row represents. When receiving a message, your PeopleCode should inspect the PSCAMA records for

this information and respond accordingly.

PSCAMA Record Definition

The PSCAMA record definition includes the following fields:

Term Definition

LANGUAGE CD Indicates the language in which the message is generated,
so the receiving application can take that information into
account when processing the message. When sending a
message with component PeopleCode, the system sets this
field to the user’s default language code.

AUDIT_ACTN Identifies each row of data as an Add, Change, or Delete
action.
BASE LANGUAGE CD (Optional.) Indicates the base language of the sending

database. This is used by generic, full-table subscription
PeopleCode to help determine which tables to update.

MSG_SEQ FLG (Optional.) Supports the transmission of large transactions that
may span multiple messages. Indicates whether the message is
a header (H) or trailer (7) or contains data (blank). The header
and trailer messages don’t contain message data. The receiving
system can use this information to determine the start and end
of the set of messages and initiate processes accordingly. For
example, the header message might cause staging tables to be
cleared, while the trailer might indicate that all of the data has
been received and an update job should be initiated.

PROCESS INSTANCE (Optional.) Process instance of the batch job that created the
message. Along with the sending node and publication ID, the
receiving node can use this to identify a group of messages

from the sending node.

Copyright © 1988, 2023, Oracle and/or its affiliates. 83



Understanding Supported Message Structures Chapter 5

Term Definition

PUBLISH_RULE ID (Optional.) Indicates the publish rule that is invoked to create
the message. This is used by routing PeopleCode to locate the
appropriate chunking rule, which then determines to which
nodes the message should be sent. Third-party applications can

ignore this field.

MSGNODENAME (Optional.) The node to which the message should be sent.
This field is passed to the Publish utility by the Application
Engine program. Routing PeopleCode must look for a value in
this field and return that value to the application server. Third-
party applications can ignore this field.

Language Codes

Each message can contain only one language code (the LANGUAGE _CD field) in the first PSCAMA
record.

PeopleSoft language codes contain three characters and are mapped to corresponding International
Organization for Standardization (ISO) locale codes in an external properties file. This mapping enables
the PeopleSoft Pure Internet Architecture to derive certain defaults from the ISO locales that are stored
in a user's browser settings. Your PeopleSoft application is delivered with a set of predefined language
codes; you can define your own codes, as well.

Note: There can be only one language code for the entire message. To send messages in multiple
languages, send multiple messages.

See “Understanding International Preferences” (Global Technology).

Audit Action Codes

A PSCAMA record appears following each row of the message. At a minimum, it contains an audit action
code (the AUDIT ACTN field), denoting the action to be applied to the data row. The audit action is
required so that the receiving system knows how to process the incoming data.

The valid audit action codes match those that are used in the PeopleSoft audit trail processing: 4, C, D, K,
N, O, and blank.

The audit action values are set by the system or by the sending PeopleCode to specify that a record should
be added, changed, or deleted:
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Audit Action Code

Description

Add a noneffective or effective-dated row.
To add an effective-dated row, the value is 4.

If you populate the row data by using the
CopyRowsetDeltaOriginal method in the PeopleCode Message
class, an additional record is created with an audit action value
of O, containing the original values of the current effective-
dated row.

Change non-key values in a row.

Delete a row.

If you change at least one key value in a row (in addition to
any non-key values) and then populate the row data by using
the CopyRowsetDeltaOriginal or CopyRowsetDelta methods
in the Message class, an additional record is created with an
audit action value of K, containing the original values of the
current effective-dated row.

Change at least one key value in a row (in addition to any non-
key values).

If you change non-key values in a row and populate the row
data by using the CopyRowsetDeltaOriginal method in the
Message class, an additional record is created with an audit
action value of O, containing the original values of the current
effective-dated row.

Blank

Default value.
If a row’s content hasn’t changed, the value is blank.

This audit action code is also used to tag the parents of rows
that have changed.

Other PSCAMA Considerations

You can update values on the PSCAMA record just like any other record in the message definition before

sending the message.

The receiving process can access the fields in this record just like any other fields in the message.
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The size of the PSCAMA record varies. In particular, notice a difference between the first PSCAMA
record and the ones that follow. The first record contains all of the fields, while the other PSCAMA
records have only the AUDIT_ACTN field, which is the only field that can differ for each row of data.

Although the first PSCAMA record is always present, not all of the remaining PSCAMA records are
sent in the message. If a <PSCAMA> tag is not included for a specific row, you can assume that the row
hasn’t changed. In addition, if the <AUDIT ACTN> tag is blank or null, you can also assume the row
hasn’t changed.

If you’re receiving a message that has incremental changes, only the rows that have changed and their
parent rows are present in the message.

You can view an example of an outbound message with the PSCAMA records inserted by testing your
message definition using the Schema Tester.

See “Understanding the Schema Tester Utility” (Integration Broker Testing Utilities and Tools).

Identifying Changes to Field-Level Attributes
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When sending and receiving messages, all blank data values get stripped. As a result, you cannot
determine if a field value is blank by definition, or if its value was stripped in the messaging process.

The PeopleCode CopyRowset functions CopyRowset, CopyRowsetDelta and CopyRowsetDeltaOriginal,
feature an IsChanged attribute that automatically gets set to identify fields that have been changed. Any
field that has been changed displays the attribute IsChanged="Y".

Note: The IsChanged attribute applies only to rowset-based messages. For rowset-based message parts,
use the Message Part Default Indicator field to distinguish blanks from zeros in part messages. The
IsChanged attribute does not apply to nonrowset-based messages, including nonrowset-based container
messages and nonrowset-based part messages.

For example:

<QE_ACNUMBER IsChanged="Y">2</QE ACNUMBER>

Fields that had data and then were blanked contain the IsChanged attribute.

For example:

<DESCRLONG IsChanged="Y"/>

Fields that were always blank and thus were not changed do not feature this attribute. For example:
<QF_ NAVDESC/>

If you are writing subscription PeopleCode you reference the IsChanged value of the field in the message
rowset, as always. However, the blanks appear with the attribute IsChanged="Y".

Related Links

Distinguishing Blank from Zero in Rowset-Based Part Messages
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PeopleSoft Timestamp Format

The PeopleSoft format for all timestamps is ISO-8601. If any message fields are type timestamp, the
following format is used:

CCYY-MM-DDTHH:MM:SS.ssssss+/—-hhmm

Note: The ISO format specifies that the +/-hhmm parameter is optional, but PeopleSoft requires it. All
date and time stamps in the header and the body of the message must include the Greenwich Mean Time
(GMT) offset as +/~hhmm. This ensures that the timestamp is correctly understood by the receiving
application.

CDATA and Special Characters

Consider the following points regarding rowset-based messages:
* You cannot use CDATA in message XML if you plan to use GetRowSet to parse the message.

*  When using the ampersand character (&) in a string, it must be URL-encoded. For example: &amp.
Passing only the ampersand character results in a PeopleCode error when you get the rowset values.

»  Other special characters are best passed encoded as well, such as &gt for “<” and &Ir ">."

Schema Restrictions

For stronger schema validation control, some PeopleSoft field types have certain implicit restrictions
regarding the format of field data that is acceptable in a runtime message. These restrictions appear in
message schema.

The restrictions apply to fields having the following formats.
*  Mixed case.

* Name.

*  Phone number.

*  Social security number.

» Uppercase.

e Zip code.

Note: These restrictions apply to rowset-based messages and rowset-based message parts.

The restrictions for each are shown in the following example:

<xsd:simpleType name="BASE LANGUAGE CD TypeDef">

<xsd:annotation>

<xsd:documentation>BASE LANGUAGE CD is a character of length 3.
Allows Uppercase characters including numbers

</xsd:documentation>

</xsd:annotation>

<xsd:restriction base="xsd:string">
<xsd:maxLength value="3"/>
<xsd:whiteSpace value="preserve"/>
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<xsd:pattern value="([A-Z]|[0-9] |\p{Z}|\p{P}|\p{Lu})*"/>
</xsd:restriction>
</xsd:simpleType>

Rowset-Based Message Example

88

The message data is enclosed in a tag with the name of the message, and consists of one FieldTypes
section followed by one MsgData section. The FieldTypes section describes the records and fields that
appear in the MsgData section, which contains the actual data.

Note: The PSCAMA record requires field type information just like any other record.

<SDK_BUS EXP APPR MSG>
<FieldTypes>
<SDK_BUS_EXP PER class="R">
<SDK_EMPLID type="CHAR" />
<SDK_EXP PER DT type="DATE"/>
<SDK_SUBMIT FLG type="CHAR"/>
<SDK_INTL FLG type="CHAR" />
<SDK_APPR STATUS type="CHAR" />
<SDK_APPR_INSTANCE type="NUMBER"/>
<SDK_DESCR type="CHAR"/>
<SDK_COMMENTS type="CHAR" />
</SDK_BUS_EXP_PER>
<SDK_DERIVED class="R">
<SDK_BUS_EXP SUM type="NUMBER"/>
</SDK_DERIVED>
<SDK_BUS_EXP DTL class="R">
<SDK_CHARGE DT type="DATE"/>
<SDK_EXPENSE CD type="CHAR"/>
<SDK_EXPENSE AMT type="NUMBER" />
<SDK_CURRENCY CD type="CHAR" />
<SDK_BUS PURPOSE type="CHAR"/>
<SDK_DEPTID type="CHAR"/>
</SDK_BUS_EXP_DTL>
<PSCAMA class="R">
<LANGUAGE CD type="CHAR"/>
<AUDIT ACTN type="CHAR"/>
<BASE_LANGUAGE CD type="CHAR" />
<MSG_SEQ FLG type="CHAR" />
<PROCESS INSTANCE type="NUMBER" />
</PSCAMA>
</FieldTypes>
<MsgData>
<Transaction>
<SDK_BUS EXP PER class="R">
<SDK_EMPLID>800l</SDK_EMPLID>
<SDK_EXP PER DT>1998-08-22</SDK_EXP PER DT>
<SDK_SUBMIT FLG>N</SDK_SUBMIT FLG>
<SDK_INTL FLG>N</SDK_ INTL FLG>
<SDK_APPR_STATUS>P</SDK_APPR_STATUS>
<SDK_APPR_INSTANCE>O</SDK_APPR_INSTANCE>
<SDK_DESCR>Regional Users Group Meeting</SDK DESCR>
<SDK_ COMMENTS>Attending Northeast Regional Users Group
Meeting and presented new release functionality.
</SDK_COMMENTS>
<SDK BUS EXP DTL class="R">
<SDK_CHARGE DT>1998-08-22</SDK_CHARGE DT>
<SDK_EXPENSE_CD>10</SDK_EXPENSE_CD>
<SDK_EXPENSE AMT>45.690</SDK_EXPENSE AMT>
<SDK_CURRENCY CD>USD</SDK_CURRENCY CD>
<SDK_BUS PURPOSE>Drive to Meeting</SDK BUS PURPOSE>
<SDK_DEPTID>lOlOO</SDK_DEPTID>
</SDK_BUS_EXP_DTL>
<PSCAMA class="R">
<AUDIT7ACTN>A</AUDITiACTN>
</PSCAMA>
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<SDK_BUS_EXP DTL class="R">
<SDK CHARGE DT>1998-08- 22</SDK_CHARGE_ DT>
<SDK EXPENSE CD>09</SDK EXPENSE CD>
<SDK_EXPENSE AMT>12.440</SDK_EXPENSE AMT>
<SDK_CURRENCY CD>USD</SDK_CURRENCY CD>
<SDK BUS PURPOSE>Clty Parklng</SDK BUS_PURPOSE>
<SDK DEPTID>10100</SDK DEPTID>
</SDK__ BUS EXP DTL>
<PSCAMA class="R">
<AUDIT ACTN>A</AUDIT ACTN>
</PSCAMA>
</SDK_BUS_EXP PER>
<SDK DERIVED class="R">
<SDK BUS_EXP_ SUM>58.13</SDK_BUS EXP_ SUM>
</SDK_ DERIVED>
<PSCAMA class="R">
<LANGUAGE_CD>ENG</LANGUAGE_CD>
<AUDIT ACTN>A</AUDIT ACTN>
<BASE LANGUAGE CD>ENG</BASE LANGUAGE_CD>
<MSG SEQ FLG></MSG SEQ FLG>
<PROCESS_INSTANCE>0</PROCESS INSTANCE>
</PSCAMA>
</Transaction>
</MsgData>
</SDK_BUS_EXP APPR MSG>

Nonrowset-Based Message Structures

This section discusses nonrowset-based message structures that you can use with PeopleSoft Integration
Broker. This section discusses:

* XML messages.
*  SOAP-compliant messages.

¢ Non-XML files.

XML Messages

Copyright

The World Wide Web Consortium (W3C) has established a Document Object Model (DOM) for
accessing and manipulating structured data. The DOM specifies a standardized application programming
interface (API) that provides a consistent, familiar way to work with almost any XML data. This API—
the XML DOM—enables you to create, retrieve, navigate, and modify messages.

You define an XML message in the PeopleSoft Pure Internet Architecture by either uploading an XML
file or entering an XML schema definition. The following example shows an XML message schema:

<?xml version="1.0"?>
<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema" targetNamespace=
"http://xmlns.oracle.com/Common/schemas/COMPANY" xmlns="http://xmlns.
oracle.com/Common/schemas/COMPANY" elementFormDefault="qualified">
<xsd:element name="Company" type="CompanyType"/>
<xsd:complexType name="CompanyType">
<xsd:sequence>
<xsd:element name="Person" type="PersonType"/>
<xsd:element name="Product" type="ProductType"/>
</xsd:sequence>
</xsd:complexType>
<xsd:complexType name="PersonType">
<xsd:sequence>
<xsd:element name="Name" type="xsd:string"/>
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<xsd:element name="SSN" type="xsd:string"/>
</xsd:sequence>
</xsd:complexType>
<xsd:complexType name="ProductType">
<xsd:sequence>
<xsd:element name="Type" type="xsd:string"/>
</xsd:sequence>
</xsd:complexType>
</xsd:schema>

Then populate the message and manipulate its contents by using the PeopleCode XmlDoc class and built-
in functions, which reflect the XML DOM.

Note: You can use the XmlIDoc class to access inbound, rowset-based messages; however, the
PeopleCode Message and Rowset classes handle the PeopleSoft native format more easily.

Use the XmlDoc class if any of the following is true:

* The message structure doesn’t fit the PeopleSoft rowset model.

* The message data doesn’t come from PeopleSoft database records.

* The third-party source or target node requires non-XML message data.

Although you can use the XmlDoc class to generate or process messages that use the SOAP protocol, the
PeopleCode SoapDoc class is more efficient and is strongly recommended.

Note: Non-XML message data must be embedded in an XML wrapper, which you send and receive by
using the XmlDoc class.

Note: Due to the way in which the parser constructs content models for elements with complex content,
specifying large values for the minOccurs or maxOccurs attributes may cause the parser to throw a
StackOverflowError. Large values for minOccurs should be avoided, and unbounded should be used
instead of a large value for maxOccurs.

SOAP-Compliant Messages
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The W3C SOAP specification defines synchronous transactions in a distributed web environment. SOAP
is appropriate for Universal Description, Discovery, and Integration (UDDI) interactions, or to interact
with SOAP-compliant servers.

You define a message in PeopleSoft Application Designer without inserting any records to define its
structure, then populate the message and manipulate its contents by using the PeopleCode SoapDoc class
and built-in functions, which comply with the W3C SOAP specification. The SoapDoc class is well-
suited for messages that are populated with SOAP-compliant XML data.

SoapDoc complies with the W3C XML DOM specification. The SoapDoc class is based on the
PeopleCode XmlDoc class, with some identical methods and properties. To send and receive SoapDoc
messages, you must convert them to XmlDoc objects and use the XMLDoc built-in functions,
SyncRequestXmlDoc and GetMessageXmlDoc. SoapDoc provides a property for handling the conversion
easily.

Use the SoapDoc class if all of the following are true:

*  The third-party source or target node requires SOAP-compliant messages.
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e The third-party source or target node requires synchronous transactions.
* The message conforms to the SOAP specification.

Related Links

Generating and Sending Messages

Receiving and Processing Messages

Non-XML Files

To send non-XML files through PeopleSoft Integration Broker to their destination, you must wrap them
in the PeopleSoft non-XML message element, CDATA. However, when you send messages to third-party
systems, the recipient systems may not be able to interpret that element.

The Message class features a method, SetXMLDoc, that you can use to remove the tags upon execution
of the method. Another alternative to removing the tags is to write a transformation to do so. If you do not
use either option, the data remains in the wrapper through to the destination.

The following code example shows a non-XML file wrapped in the PeopleSoft non-XML message
element, PsNonXmL, for transport through PeopleSoft Integration Broker:

Note: The element PsNonXml is not case-sensitive.

<?xml version="1.0"?2>
<AsyncRequest>
<data PsNonXml="Yes">
<![CDATA[<?xml version="1.0"?>101 123456789
12345678902 0510145 60094101First Bank First Bank 5200 University
000001 PPDDIRECT PAY020510020510000112345678000000162200000111 222
0000001000USA0000001 USA0000001 0000001110000001627123456
789131415511 0000001000 University 0123456780000
002 82000000020012345789000000001000000000001000 123456780000001
90000010000010000000200123457890000000010000000000010009999999999
99999999999999999999999999999999999999999999999999999999999999999
99999999999999999999999999999999999999999999999999999999999999999
99999999999999999999999999999999999999999999999999999999999999999
99999999999999999999999999999999999999999999999999999999999999999
99999999999999999999999999999999999999999999999999999999999999999
99999999999999999999999999999999999999999
11>
</data>
</AsyncRequest>

The following example shows an alternative way to wrap a non-XML file in the PeopleSoft non-XML
message element for transport through PeopleSoft Integration Broker:

<?xml version="1.0"?>

<AsyncRequest PsNonXml = ’'Yes’>

<! [CDATA[<?xml version="1.0"?>101 123456789 12345678902

0510145 60094101First Bank First Bank 5200 University 000001 PPDDIRECT
PAY020510020510000112345678000000162200000111 222

0000001000USA0000001 USA0000001 0000001110000001627123456

789131415511 0000001000 University 0123456780000

002 82000000020012345789000000001000000000001000 123456780000001
900000100000100000002001234578900000000100000000000100099999999999999999
999999999999999999999999999999999999999999999999999999999999999999999999
999999999999999999999999999999999999999999999999999999999999999999999999
999999999999999999999999999999999999999999999999999999999999999999999999
999999999999999999999999999999999999999999999999999999999999999999999999
99999999999999999999999999999999999999999999999999999999999999999999999
11>
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</AsyncRequest>

The following example shows using the SetXMLDoc method to remove the PsNonXML wrapper from a
message:

// create xmldoc with PSNonXml tag and load it into the message

// create an instance of the Message object
&MSG = CreateMessage (OPERATION.QE F18 ASYNC XMLDOC) ;

// Load the Message object via the SetXmlDoc method with the xmldoc data.
// This will also remove the PSNonXml wrapper
&MSG. SetXmlDoc (&XmlDoc) ;

// perform a publish for the nonrowset-based message
$IntBroker.Publish (&MSG) ;

As stated previously in this section, if you do not use the SetXMLDoc method to remove the PsNonXml
wrapper, you must write a transformation to physically remove the tags.

Related Links
“Understanding Message Classes” (PeopleCode API Reference)
Understanding Filtering, Transformation, and Translation

“Complying With Message Formatting and Transmission Requirements” (Integration Broker
Administration)

Using Nonrowset-Based Messages in Service Operations Exposed as
WSDL

If a nonrowset-based message is used in a service operation which will be exposed as a WSDL to third
parties, the schema cannot be empty. The schema has to have at least the header elements, as shown in the
following example:

<?xml version="1.0"?>
<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"/>

Message Part Structures

This section discusses:
* Rowset-based message parts.

* Nonrowset-based message parts.

Understanding Message Part Structures
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Message parts are rowset-based messages or nonrowset-based messages that you designate as a part
message on the message definition. Message parts are used in container messages

Message parts can be re-used in multiple containers.
All parts in a container must be of the same type (Rowset-based or Nonrowset-based).

You create messages using the Message Builder page in the PeopleSoft Pure Internet Architecture.
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Related Links
PeopleSoft Rowset-Based Message Format

Nonrowset-Based Message Structures
Understanding Managing Messages

Rowset-Based Message Parts

Rowset-based message parts provide all the ease of use of using rowsets, yet the generated XML message
is industry standard and not PeopleSoft proprietary. Rowset-based message parts, like nonrowset-based
parts, can only be part of a container type message.

These are the benefits of using Rowset-based parts:

e The XML schema generated is standard XML and not the PeopleSoft message format. Rowset-based
message parts do not have a PSCAMA section, FieldTypes section, IsChanged attributes, and so forth.

» The message API for rowset-based parts is simple to use and understand.

* XML serialization and deserialization to and from part rowset is provided by Integration Broker
framework.

*  You can use a CopyRowSet type method to populate the rowset from another rowset (component
rowset).

The following example shows a sample schema from a rowset-based message part:

<?xml version="1.0"?>
<xsd:schema elementFormDefault="qualified" targetNamespace="http://xmlns.
oracle.com/Enterprise/Tools/schemas/Part 1.V1" xmlns="http://xmlns.oracle.
com/Enterprise/Tools/schemas/Part 1.V1" xmlns:xsd="http://www.w3.0rg/
2001/XMLSchema">
<xsd:element name="Part 1" type="Part 1 TypeShape"/>
<xsd:complexType name="Part 1 TypeShape">
<xsd:sequence>
<xsd:element name="First Part" type="First PartMsgDataRecord TypeShape"/>
</xsd:sequence>
</xsd:complexType>
<xsd:complexType name="First PartMsgDataRecord TypeShape">
<xsd:sequence>
<xsd:element name="QE ACNUMBER" type="QE ACNUMBER TypeDef"/>
<xsd:element name="QE WAYPOINT NBR" type="QE WAYPOINT NBR TypeDef"/>
<xsd:element minOccurs="0" name="QE BEARING" type="QE BEARING TypeDef"/>
<xsd:element minOccurs="0" name="QE RANGE" type="QE RANGE TypeDef"/>
<xsd:element minOccurs="0" name="QE ALTITUDE" type="QE ALTITUDE TypeDef"/>
<xsd:element minOccurs="0" name="QE LATITUDE" type="QE LATITUDE TypeDef"/>
<xsd:element minOccurs="0" name="QE LONGITUDE" type="QE LONGITUDE TypeDef"/>
<xsd:element name="QE HEADING" type="QE HEADING TypeDef"/>
<xsd:element name="QE VELOCITIES" type:"QE7VELOCITIESiTypeDef"/>
<xsd:element minOccurs="0" name="QE NAVDESC" type="QE NAVDESC TypeDef"/>
</xsd:sequence>
<xsd:attribute fixed="R" name="class" type="xsd:string" use="required"/>
</xsd:complexType>
<xsd:simpleType name="QE ACNUMBER TypeDef">
<xsd:annotation>
<xsd:documentation>QE ACNUMBER is a number of length 10 with a decimal
position of 0</xsd:documentation>
</xsd:annotation>
<xsd:restriction base="xsd:integer">
<xsd:totalDigits value="10"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="QE WAYPOINT NBR TypeDef">
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<xsd:annotation>
<xsd:documentation>QE WAYPOINT NBR is a number of length 3 with a decimal
position of 0</xsd:documentation>
</xsd:annotation>
<xsd:restriction base="xsd:integer">
<xsd:totalDigits value="3"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="QE BEARING TypeDef">
<xsd:annotation>
<xsd:documentation>QE BEARING is a character of length 10</xsd:documentation>=

</xsd:annotation>
<xsd:restriction base="xsd:string">
<xsd:maxLength value="10"/>
<xsd:whiteSpace value="preserve"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="QE RANGE TypeDef">
<xsd:annotation>
<xsd:documentation>QE RANGE is a character of length 10</xsd:documentation>
</xsd:annotation>
<xsd:restriction base="xsd:string">
<xsd:maxLength value="10"/>
<xsd:whiteSpace value="preserve"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="QE ALTITUDE TypeDef">
<xsd:annotation>
<xsd:documentation>QE ALTITUDE is a character of length 10</xsd:documentation=

</xsd:annotation>
<xsd:restriction base="xsd:string">
<xsd:maxLength value="10"/>
<xsd:whiteSpace value="preserve"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="QE LATITUDE TypeDef">
<xsd:annotation>
<xsd:documentation>QE LATITUDE is a character of length 15
</xsd:documentation>
</xsd:annotation>
<xsd:restriction base="xsd:string">
<xsd:maxLength value="15"/>
<xsd:whiteSpace value="preserve"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="QE LONGITUDE TypeDef">
<xsd:annotation>
<xsd:documentation>QE LONGITUDE is a character of length 15
</xsd:documentation>
</xsd:annotation>
<xsd:restriction base="xsd:string">
<xsd:maxLength value="15"/>
<xsd:whiteSpace value="preserve"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="QE HEADING TypeDef'">
<xsd:annotation>
<xsd:documentation>QE HEADING is a character of length 4
</xsd:documentation>
</xsd:annotation>
<xsd:restriction base="xsd:string">
<xsd:enumeration value="MAG"/>
<xsd:enumeration value="TRUE"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="QE VELOCITIES TypeDef">
<xsd:annotation>
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<xsd:documentation>QE VELOCITIES is a character of length 4
</xsd:documentation>
</xsd:annotation>
<xsd:restriction base="xsd:string">
<xsd:enumeration value="ADC"/>
<xsd:enumeration value="GPS"/>
<xsd:enumeration value="INS"/>
</xsd:restriction>
</xsd:simpleType>
<xsd:simpleType name="QE NAVDESC TypeDef">
<xsd:annotation>
<xsd:documentation>QE NAVDESC is a character of length 30
</xsd:documentation>
</xsd:annotation>
<xsd:restriction base="xsd:string">
<xsd:maxLength value="30"/>
<xsd:whiteSpace value="preserve"/>
</xsd:restriction>
</xsd:simpleType>
</xsd:schema>

Nonrowset-Based Message Parts

A nonrowset-based message part schema is similar to a regular nonrowset-based message, however a
nonrowset-based message part can be reused in multiple containers.

Message Container Structures

Message container structures hold rowset-based or nonrowset-based message part structures. All message
parts assigned to a container must of the same type, rowset-based or nonrowset-based.

A message container is always a nonrowset-based message.
You create container messages using the Message Builder in the PeopleSoft Pure Internet Architecture.

Related Links

Nonrowset-Based Message Structures
Understanding Managing Messages

Example 1: XML Schema of a Container Message with Rowset-Based
Message Parts

The following example shows a sample schema of a container message with three rowset-based message
parts:

<?xml version="1.0"?>
<xsd:schema elementFormDefault="unqualified" targetNamespace="http://xmlns.
oracle.com/Enterprise/Tools/schemas/Part Container.v1i"
xmlns="http://xmlns.oracle.com/Enterprise/Tools/schemas/Part Container.v1"
xmlns:Part 1.VI1="http://xmlns.oracle.com/Enterprise/Tools/schemas/Part 1.V1"
xmlns:Part 2.V1="http://xmlns.oracle.com/Enterprise/Tools/schemas/Part 2.V1"
xmlns:Part 3.V1="http://xmlns.oracle.com/Enterprise/Tools/schemas/Part 3.V1"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<xsd:import namespace="http://xmlns.oracle.com/Enterprise/Tools/schemas/
Part 1.V1" schemaLocation="http://kcollin2042803:5000/PSIGW/PeopleSoft
ServiceListeningConnector?Operation=GetSchema&amp;xsd=Part 1.V1"/>
<xsd:import namespace="http://xmlns.oracle.com/Enterprise/Tools/schemas/
Part 3.V1" schemaLocation="http://kcollin2042803:5000/PSIGW/PeopleSoft
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ServiceListeningConnector?Operation=GetSchema&amp;xsd=Part 3.V1"/>
<xsd:import namespace="http://xmlns.oracle.com/Enterprise/Tools/schemas/
Part 2.V1" schemaLocation="http://kcollin2042803:5000/PSIGW/PeopleSoft
ServiceListeningConnector?Operation=GetSchema&amp;xsd=Part 2.V1"/>
<xsd:element name="Part Container" type="Part ContainerType"/>
<xsd:complexType name="Part ContainerType">
<xsd:sequence>
<xsd:element maxOccurs="unbounded" minOccurs="0" name="Part 1" type="
Part 1.V1:Part 1 TypeShape"/>
<xsd:element maxOccurs="10" minOccurs="0" name="Part 3" type="Part 3.Vl:
Part 3 TypeShape"/>
<xsd:element maxOccurs="unbounded" minOccurs="0" name="Part 2" type="
Part 2.V1:Part 2 TypeShape"/>
</xsd:sequence>
</xsd:complexType>
</xsd:schema>

Example 2: XML Schema of a Container Message with Nonrowset-Based
Message Parts
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The following example shows a sample schema from a container message that contains three nonrowset-

based parts:

<?xml version="1.0"?>
<xsd:schema elementFormDefault="unqualified" targetNamespace="http://xmlns.
oracle.com/Enterprise/Tools/schemas/NonRowSetContainer.vl"
xmlns="http://xmlns.oracle.com/Enterprise/Tools/schemas/NonRowSetContainer.v1l"
xmlns:Part One NonRowset.vl="http://xmlns.oracle.com/Enterprise/Tools/
schemas/Part One.v1l"
xmlns:Part Three NonRowset.vl="http://xmlns.oracle.com/Enterprise/Tools/
schemas/Part Two.v1"
xmlns:Part Two NonRowset.vl="http://xmlns.oracle.com/Enterprise/Tools/
schemas/Part Three.vl"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<xsd:import schemalocation="http://kcollin2042803:5000/PSIGW/PeopleSoft
ServiceListeningConnector?Operation=GetSchema&amp; xsd=Part One NonRowset.v1l"/>
<xsd:import schemalocation="http://kcollin2042803:5000/PSIGW/PeopleSoft
ServiceListeningConnector?Operation=GetSchema&amp; xsd=Part Two NonRowset.vl1"/>
<xsd:import schemalocation="http://kcollin2042803:5000/PSIGW/PeopleSoft
ServiceListening Connector?Operation=GetSchemas&amp; xsd=Part Three Non
Rowset.v1"/>
<xsd:element name="NonRowSetContainer" type="NonRowSetContainerType"/>
<xsd:complexType name="NonRowSetContainerType">
<xsd:sequence>
<xsd:element maxOccurs="unbounded" minOccurs="0" name="Part One NonRowset"
type="Part One NonRowset.vl:Part One TypeShape"/>
<xsd:element maxOccurs="unbounded" minOccurs="0" name="Part Two NonRowset"
type="Part Two NonRowset.vl:Part Two TypeShape"/>
<xsd:element maxOccurs="unbounded" minOccurs="0" name="Part Three NonRowset"
type="Part Three NonRowset.vl:Part Three TypeShape"/>
</xsd:sequence>
</xsd:complexType>
</xsd:schema>
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Understanding Managing Messages

This section provides an overview of messages.

Message Definitions

Message definitions provide the physical description of the data that is being sent, including fields, field
types, and field lengths. You create message definitions in the PeopleSoft Internet Architecture.

Note: Messages are shapes that describe the contents of a service operation transaction. Unlike prior
PeopleTools releases, messages do not contain any processing logic. All processing logic is defined in
service operations, using service operation handlers.

Message Types

Five types of messages are available:

Term Definition

Rowset-based messages For hierarchical data that is based on PeopleSoft records, you
create a message definition by assembling records, organizing
them into a hierarchy, and selecting fields from those records
to include in the message. The result is a rowset that doesn't
need to match an existing rowset structure in the application.
Use the PeopleCode Rowset and operation classes to generate,
send, receive, and process these messages.

Nonrowset-based messages These messages can have virtually any structure and content.
You create a message definition, but you do not insert any
records. The message definition serves as a placeholder for the
actual message. Use the PeopleCode XmlIDoc and operation
classes to generate, send, receive, and process these messages.
If you're handling Simple Object Access Protocol (SOAP)
compliant data, you can also use the SoapDoc class to generate
and process these messages.

Container messages A container message is a nonrowset-based message that holds
one or more part messages.

A container message must contain all rowset-based messages
or all nonrowset-based message parts.
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Term

Definition

Message parts

Message parts are rowset-based messages or nonrowset-based
messages that you designate as a part message, to be used in a
container message.

Document messages

A document messages are messages based on the PeopleSoft
XML document technology. You create and manage these
messages in the PeopleSoft Document Builder, either by
creating the XML documents from the ground up, importing
them from schema definitions, or from PeopleSoft records.

The following table describes when to use a given message type:

Message Type

When to Use

Rowset-based message.

All PeopleSoft-to-PeopleSoft integrations.

Nonrowset-based message.

Integrations with third-party systems.

Container message with rowset-based message parts.

Exposing PeopleSoft services to third-party systems.

Container message with nonrowset-based message parts.

Exposing PeopleSoft services to third-party systems and need
to provide nested parts.

Document message.

Integrations with third-party systems.

Naming Conventions for Message Metadata

When naming the following message metadata, names cannot start with “xml,” digits or special

characters:

* Message names.
* Message aliases.
* Record aliases.

¢ Field aliases.

Message Record Structure

98

If a message handles PeopleSoft record data, that is, a rowset-based message, you must insert records in
the message definition in an appropriate hierarchical structure.

However, if the message data doesn't map to a record hierarchy, do not insert any records. You supply
or receive the data and its structure from an external source, using the PeopleCode XmlDoc or SoapDoc

classes.
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See Understanding Sending and Receiving Messages.

Underlying Record Definitions

Records that you insert in a message definition have live references to the original record definitions.
Any change that you make to an underlying record definition is automatically reflected by a change in the
corresponding record in the message definition.

Fields Defined as Uppercase

If a message definition includes character fields that are defined as uppercase, then character data in those
fields is automatically converted to uppercase when the message is received. This happens when the
receiving PeopleCode inserts the message data in a rowset, and it overrides any previous changes in the
data, including transformation and data translation.

Message Aliases and Message Versions

Message aliases are read-only once you save the message definition. As a result, once you create a
message alias for a message definition, any subsequent versions of the message that you create use the
original alias.

Restrictions for Modifying Messages

This section lists the conditions under which a message may become restricted and read-only. This list
applies to all message types, including rowset-based messages, nonrowset-based messages, container
messages, part messages, and subpart messages.

You cannot modify a message if one or more of the following conditions exists:
* The service to which a message is contained in a restricted service.

* The message is used internally by the system. For example, the delivered IB_ GENERIC message is
read-only and is used internally by the system.

* The message is referenced in the runtime tables.
To work around this, you must remove any entries in the runtime tables that reference the message.
* The message is used in a service operation where WSDL documents have been generated.

* The message is used in a service operation that has validation enabled.

Searching for Message Definitions

To search for an existing message definition in the system use the Messages - Search page
(IB_MSGSEARCH). To access the page select PeopleTools > Integration Broker > Integration
Setup > Message Definitions.
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This example illustrates the Messages — Search page.

Messages - Search

~ Search Criteria

Type: | v| Add a New Value

Message Name: |

Version: |

Search

To search for a message definition:

1. Access the Messages - Search page (PeopleTools > Integration Broker > Integration
Setup > Message Definitions).

2. Search for a message definition.
You can search for message definition in one of two ways:

* Enter search criteria in one or more of the following fields, and then click the Search button:

Field or Control Description

Type From the drop-down list, select the type of message for
which you are searching. The options are:

e Container.

e Document.

e Nonrowset.

e Part nonrowset.

e Partrowset.

*  Rowset.
Message Name Enter the name of the message.
Version Enter the version of the message.

*  Click the Search button to display all message definitions in the system.
The results appear in the Search Results grid.

3. Click the name of the message to view.
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Adding Message Definitions

This section discusses how to:
* Add rowset, nonrowset and part message definitions.

* Add document message definitions.

Understanding Adding Message Definitions
When you add a message definition to the system you first give the message a name and specify a
message version. After doing so, you can then define additional aspects of the message definition.
Adding Rowset, Nonrowset or Part Message Definitions

Use the Add a New Message page (IB. MSGSEARCH_ADD) to name a new message definition and
assign a version to it:

This example illustrates the Add a New Message page.

Add New Message

Type -
Message Name

Message Version

Return to Search

After you add a new message definition and version to the system, you can configure the message.

Use the Messages - Message Definition page (IB. MESSAGE BUILDER) to configure a message after
you create the message definition.

This example illustrates the Messages — Message Definition page.

Message Definition Schema

Schema Exists Mo
Message MOMROWSET_TEST_MSG

Part Message
Version V1
Alias
Description
Owner ID h Root Element
Comments

Message Type

Rowset-based
2 Nonrowset-based
Container

Save

The example shows the page when the message type is a Nonrowset-based message. Different options
appear on the Message—Message Definition page, depending on the type of message that you are defining.
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Note: You determine the message type when you create the definition using the Add New Message page.
The Message Type group box options on the Messages — Message Definition page are read-only.

Additional options appear on the Messages — Message Definition page when you are working with

Rowset-based or Container message types.

This example illustrates the Messages — Message Definition page. The example shows the page when the

message type is a Rowset-based message type.

Message Definition Schema

Message ROWSET_TEST_MSG
Version V1
Description

Owner D -

Comments

View Records Only
Left | Right

Yiew Included Fields Only

= ROWSET_TEST_MSG

Schema Exists Mo
Part Message

[ Exclude Description in Schema
[ single Level 0 Row

[[include Hamespace

[ Suppress Empty XML Tags

Message Type

@ Rowset.based
Nonrowset-based
Container
Add Record to Root

In the previous example, notice the additional options that display on the upper right portion of the page.

When you define a container message, it, too, has its own unique options that you define.

This example illustrates the Messages — Message Definition page. The example shows the page when the

message type is a Container message.

Message Definition Schema

Message COMTAINER_TEST_MSG

Maximum *Unbound
Occurs

Version V1
Alias
Description
Owner D -

Comments
Add Parts
Parts Personalize | Find | View All | &2 | &
Message Hame Message Version Sequence f‘éflci:r;Ln::m

0 0

Schema Exists Mo
Part Message

Message Type

Rowset-based
Nonrowset-based
@ Container

First ‘4" 10f1 '}/ Last

Maximum

M - [=]
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Note: For asynchronous integrations, define a single message. For synchronous integrations, define two
messages: one request message and one response message, unless the request and response have the same
shape.

To add a rowset, nonrowset, or part message definition:

L.

Select PeopleTools > Integration Broker > Integration Setup > Message Definitions.
The Messages — Search page appears.
Click the Add a New Valuelink.
From the Type drop-down list, select a message type to create. The options are:
*  Container. Select this value to add a container message to the system.
*  Document. Select this value to add a document message to the system.
Adding a document message type to the system is described elsewhere in this section.

See Adding Document Message Definitions.

*  Nonrowset. Select this value to add a nonrowset-based message to the system.
*  Part Nonrowset. Select this value to add a nonrowset-based message part to the system.
*  Part Rowset. Select this value to add a rowset-based message part to the system.

*  Rowset. Select this value to add a rowset-based message to the system.

In the Message Name field, enter a name for the message.

The message name cannot exceed 30 characters. Do not include any spaces in the message name.

In the Version field, enter a version for the message.

The message version cannot exceed 30 characters. Do not include any spaces in the message version.
Accepted formats for the message version include:

o Version 1.

- VI

Click the Add button.
The Messages - Message Definition page appears.

(Optional) In the Alias field, enter the name that the external system is expecting, if different from the
value in the Message Name field.

This field appears only when you are defining nonrowset-based or container messages.

(Optional) Select the Message Parts check box if the message will be used as a message part in a
container message definition.
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9.

10.

I1.

12.

13.

(Optional) In the Description field, enter a description for the definition.
(Optional) From the Owner ID drop-down list box, select an owner for the definition.

The owner ID helps to determine the application team that last made a change to the definition.
The values in the drop-down list box are translate table values that you can define in the
OBJECTOWNERID field record.

(Optional) In the Comment field, enter any pertinent comments about the definition.

In the Root Element field, enter a value to appear in the root element in generated WADL documents
when the message is used in a REST service operation.

Note: You must provide a value in this field if you are using the message in a REST-based service
operation. This field value is required for proper WADL document generation.

This field appears only when you are defining nonrowset-based messages.

The next steps to adding a message definition depend on the type of message definition that you are
creating:

*  Rowset-Based Message or Message Part. You must add a root record to the definition before you
can save it.

See Managing Rowset-Based Messages.

*  Nonrowset-Based Message or Message Part. The message definition is complete and you can
click the Save button to save the changes. You can now add an XML message schema to the
definition.

See Managing Nonrowset-Based Messages.

*  Container Message. You must add at least one message part to the definition before you can save
the changes.

See Managing Container Messages.

Adding Document Message Definitions

104

This section discusses adding document message definitions.

Understanding Adding Document Message Definitions

When you create a document message definition in the system, you create a message definition that
references a document. .

Prerequisites for Adding Document Message Definitions

Before you add a document message definition to the system, the document definition that the message
will reference must exist in the system
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When you add a document message definition, additional options appear on the page than when you add

other message types.

This example illustrates the Add New Message page. The example shows adding a Document message

type to the system.

Add New Message

Type Document -
Message Name TEST_DOC_MSG
Message Version V1

Alias

Package Demo Q,
Document | ContactGround Q
Version v1 Q.

Add Return to Search

Mote Selectan existing document object to link to the new message at save time.

After you provide a message name, version, and optional alias, you specify the document package,

document name, and version to which to link the message.

After you click the Add button, the document that you specified in the message definition appears in the

Document Builder — Document page.

This example illustrates the Document Builder — Document page. In the example the Metadata
References section shows that the message TEST DOC MSG.vI references the document.

Document | XML Relational JSON HTML

Package
Document Name

Demo

ContactGround
Version Name 1

Metadata References

Source Identifier

Integration Broker Message TEST_DOC_MSG.V1
Document Details
Left | Right

=! ContactGround
*® Contact_name
% Contact_Title
* Contact_Phone

Personalize | Find | @l i

First ‘& 10f1 &/ Last

The Metadata References section in the definition shows that there is an Integration Broker message

called TEST DOC_MSG.vI that references the document.

Note that the message definition is not saved until you click the Save button in the Document Builder.
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To add a document message definition:

L.

2.

10.

I1.

Select PeopleTools > Integration Broker > Integration Setup > Message Definitions.

Select the Add New Value tab.

From the Type drop-down list, select Document.

In the Message Name field, enter a name for the message.

The message name cannot exceed 30 characters. Do not include any spaces in the message name.

In the Version field, enter a version for the message.

The message version cannot exceed 30 characters. Do not include any spaces in the message version.
Accepted formats for the message version include:

*  Version 1.

s VI

(Optional) In the Alias field, enter the name that the external system is expecting, if different from the
value in the Message Name field.

In the Package field, enter the document package or click the Lookup button to search for one.

In the Document field, enter the document name or click the Lookup button to search for one.

In the Version field, enter the document version or click the Lookup button to search for one.

Click the Add button.

The Document Builder—-Document page appears, displaying the document definition for the document
you specified. The Metadata References grid displays the name of the message definition you added.

Click the Save button.

Managing Rowset-Based Messages
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This section provides an overview of managing rowset-based message definitions and discusses how to:

View rowset-based message structures.
Insert root records.

Insert child and peer records.

Specify record aliases.

Delete records.

Exclude fields from messages.

Specify field name aliases.

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 6 Managing Messages

* Manage XML message schemas for rowset-based messages.

* Enforce message record and field aliases in generated WSDL.

Understanding Managing Rowset-Based Messages

This section provides overview information about managing rowset-based message definitions.

Root Records

When you create a rowset-based message, you must at a minimum insert a root record (level 0) into the
definition.

Records and Record Fields

You create and modify records and record fields in PeopleSoft Application Designer.

Note: Avoid using derived/work records in messages. Work records don't behave like regular records
when used with PeopleCode rowset methods. A good alternative is to use dynamic views.

Record and Record Field Aliases
Record and field aliases are optional parameters that are used for schema and XML generation.

When record and field aliases are used, the receiver of a message sees the alias names instead of the
actual record and field names. The alias names are seen in the message definition, in message schemas,
and on generated runtime XML that is sent to the receiver.

Note that the sender still codes to the actual record and field name.

XML Schema for Rowset-Based Messages
When you create or make changes to a rowset-based message definition, the system automatically
generates message schema.

Viewing Rowset-Based Message Structures

This section discusses the three ways to view the structure of rowset-based message definitions. This
section discusses how to:

* View the entire structure of rowset-based message definitions.
* View only the records in rowset-based message definitions.

* View only included records fields in rowset-based message definitions.

Viewing the Entire Structure of Rowset-Based Message Definitions

By default, when you open a rowset-based message definition in the Messages — Message Definition
page, PeopleSoft Integration Broker displays the complete message definition structure.
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This example illustrates a partial view of the Messages — Message Definition page. The bottom
portion of the page, shown here, shows the complete message definition structure for the message

OE FLIGHTPLAN.

[= QE_FLIGHTPLAN
= & QF FLIGHTDATA

# v QE
@ QOF

ACHLUMBER

M3l SENSOR

=
@ QF
@ QF
# v OF
@ QOF
@ QF
@ QF

W
W
W
« |
@
W
W
W
W W
@

LE
LE

OFP
ACTYPE
CALLSIGHN
SQUADRON
CONM1
CONM2
ECM

& « DESCRLONG

= & gE NaVIGATION

ACMUMBER

WAYPOINT MNBE

E
GE
LE
LE
LE
e
GE
LE

BEARING
RAMNGE
ALTITUDE
LATITUDE
LONGITUDE
HEADING
VELOCITIES
NAVDESC

= & oF RADAR PRESET

= & oF ARMAMENT

Chapter 6

The system displays the definition in a tree structure. Use the Expand button (+) and the Collapse (-)
button to expand and collapse the tree to view all records, subrecords and fields (both included and
excluded) in the definition.

Record fields that are included in the message definition have a check next to them. Record fields that are
not included in the message definition have a box next to them. In the previous graphic, OE RANGE is

the only record field that is not included in the OF FLIGHTPLAN message definition.
You can view the record or field properties by clicking the record or field name.
To view the entire structure of a rowset-based message:

1. Select PeopleTools > Integration Broker > Integration Setup > Message Definitions.

2. Select a message to view.

The Messages-Message Definitions page appears and the entire structure of the message appears in a

tree view.

3. Expand and collapse the tree to view the message structure.
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You can use the Records Only page (IB. MESSAGE TR SEC) to view the records and subrecords in a

rowset-based message definition.

This example illustrates the Records Only page. The example shows records and subrecords for the

QE FLIGHTPLAN message displaying in the Records Only page.

Records Only

Message: QE_FLIGHTPLAM Version: YEREIOM_1

= OE_FLIGHTPLAN
= & QE FLIGHTDATA
= & QE_NavIGATION
= & QF_RADAR_PRESET
= & QFE_ARMAMENT
= & QF WPN_PRESETS
= & QE_STAT CONFIG

To view only the records in a rowset-based message:

1. Select PeopleTools > Integration Broker > Integration Setup > Message Definitions.

2. Select a message to view.

The Messages-Message Definitions page appears.

3. Just above the tree structure view of the message structure, click the View Records Only link.

The Records Only page appears and the records and subrecords in the message definition display in a

hierarchical view.

4. Click the Return button to return to the Messages-Message Definitions page.

Viewing Only Included Record Fields in Rowset-Based Message Definitions

You can use the Included Fields Only page (IB_ MESSAGE TR _SEC) to view the included records fields

for a rowset-based message definition.
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This example illustrates the Included Fields Only page. The example shows a sample of the records and
their included fields contained in the QF FLIGHTPLAN message definition.

Included Fields Only

Message: QE_FLIGHTPLAM Version: VERSION_1

= QE_FLIGHTPLAN
= & QE FLIGHTDATA

& « QE_ACNUMBER

& « QE_MS|_SENSOR

& « QE_OFF

& « QE_ACTYPE

& « QE_CALLSIGN

& « QE_SQUADRON

@« QE_COMMI

& o QE_COMM2

& « QE_ECM

& « DESCRLONG

= & QE_MavIGATION
& « QE_ACMUMBER
& o QE_WAYPOINT _MBR
& + QE_BEARING
& v QE_RAMNGE
& « QE_ALTITUDE
& « QE_LATITUDE
& + QE_LOMGITUDE

Included fields are denoted by a green icon in the shape of a check mark.

To view included record fields in a rowset-based message:

1. Select PeopleTools > Integration Broker > Integration Setup > Message Definitions.

2. Select a message to view.
The Messages—Message Definitions page appears.

3. Just above the tree structure view of the message structure, click the View Included Fields Only link.
The Included Fields Only page appears and included records fields contained in the message display.

4. Click the Return button to return to the Messages-Message Definitions page.

Inserting Root Records

You insert a root record into a rowset-based message definition using the Add New Record page
(IB_MESSAGE _TOP_SEC).
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This example illustrates the Add New Record page.

Add New Record

New Record Hame Q

Note: There can only be one root record defined for each rowset-based message.

To insert a root record into a definition:
1. Access the Add New Record page.

Select PeopleTools > Integration Broker > Integration Setup > Message Definitions. The
Messages-Message Definitions page appears. Click the Add Record to Root link.

2. Inthe New Record Name field, enter the name of the record to add, or click the Lookup button to
search for and select one.

3. Click the OK button.

The root record appears in the tree structure. Click the Expand button (+) to expand the tree and view
fields that are associated with the record.

You can exclude fields from the record and specify field name aliases. Steps for performing these actions
are described elsewhere in this topic.

See Excluding Fields from Messages.

See Specifying Field Name Aliases.

Inserting Child and Peer Records

You insert child and peer records into a rowset-based message definition using the Message Record
Properties page (IB_ MESSAGE REC_SEC).
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This example illustrates the Message Record Properties page.

Message Record Properties

Record: QE_FLIGHTDATA

Alias Mame: QFE_FLIGHTDATA

() Delete Record
() Add Record New Record Name: Q
Peer Record
Child Record
* Field List Customize | Find | IEI| B First B 110 or 10 B Last
[Fieldwame | incude
QE_ACNUMBER |
QE_MSI_SENSOR |
QE_OFP |
QE_ACTYPE |
QE_CALLSIGN |
QE_SQUADRON |
QE_COMMA |
QE_COMM2 |
QE_ECM |
DESCRLONG |

To insert a child or peer record into a rowset-based message definition:

L.

Access the Message Record Properties page.

(Select PeopleTools > Integration Broker > Integration Setup > Message Definitions. The
Messages-Message Definitions page appears. Click the linked record name to which to add a peer or
child record.)

In the Action group box, select Add Record.

In the New Record Name field, enter the name of the record to add, or click the Lookup button to
search for and select a name.

Select whether to add the record as a peer record or a child record.
* Select Peer Record to add the record as a peer.

¢ Select Child Record to add the record as a child.

Click the OK button.

The Messages-Message Definitions page appears.
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6. Click the Save button.

Specifying Record Aliases

You can specify aliases of the root, peer, and child records that you insert into rowset-based messages
using the Message Record Properties page.

To specify a record alias:
1. Access the Message Record Properties page.

(Select PeopleTools > Integration Broker > Integration Setup > Message Definitions. The
Messages-Message Definitions page appears. Click the linked record name to which to specify an
alias.)

2. In the Alias Name field, enter an alias name.
3. Click the OK button.

The Messages-Message Definitions page appears.
4. Click the Save button.

Related Links

Message Aliases and Message Versions

Deleting Records

This section describes how to delete records from a rowset-based message.

Note: Deleting the root record deletes all records and their associated fields that are inserted into the
definition.

To delete a record:
1. Access the Message Record Properties page.

(Select PeopleTools > Integration Broker > Integration Setup > Message Definitions. The
Messages-Message Definitions page appears. Click the name of the record to delete.)

2. Inthe Action group box, select Delete Record.
3. Click the OK button.
The Messages-Message Definitions page appears.

4. Click the Save button.

Excluding Fields from Messages

You can exclude record fields from inclusion in a rowset-based message definition using the Message
Field Properties page.
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After you exclude fields from records, the tree view of the message definition on the Message Definitions
page displays a red icon in the shape of box next to the excluded fields.

This example illustrates a partial view of the Message Field Properties page. The example shows that the
field QF ACNUMBER has been excluded from the QF FLIGHTDATA record.

[= TEST_ROWSET_MSG
= & QF FLIGHTDATA

< M QF ACNUMBER
& « QE MSI SENSOR
& « QE OFF
& « QE ACTYPE
& « QE CALLSIGN
& « QFE SQUADRON
W v QE COMMA
W o OE COMMZ
& « QE ECM

& « DESCRLONG

To exclude fields:
1. Access the Message Field Properties page.

a. Select PeopleTools > Integration Broker > Integration Setup > Message Definitions. The
Messages-Message Definitions page appears.

b. Click the Expand button (+) to expand the record tree structure, and locate the field to exclude
from the definition.

c. Click the name of the field to exclude.
The Message Field Properties page appears.
2. Click the name of the field to exclude.
3. Deselect the Include check box.
4. Click the OK button.
The Messages-Message Definitions page appears.

5. Click the Save button.

Specifying Field Name Aliases
Use the Message Field Properties page to specify field name aliases.
To specify a field name alias:
1. Access the Message Field Properties page.

a. Select PeopleTools > Integration Broker > Integration Setup > Message Definitions. The
Messages-Message Definitions page appears.
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b. Click the Expand button (+) to expand the record tree structure, and locate the field to exclude
from the definition.

c. Click the name of the field for which to specify a field name alias.
The Message Field Properties page appears.

2. Inthe Alias Name field, enter an alias name.

3. Click the OK button.
The Messages—Message Definitions page appears.

4. Click the Save button.

Including Fields in CData Sections in Generated XML

You can specify that fields be included in CData sections in generated XML. When you select the CData
Wrap check box on the Message Field Properties page, the field will be wrapped in a CData section in
generated XML.

This example illustrates the Message Field Properties page

Message Field Properties

Record: QE_SALES _ORDER
Field Name: QE_ACCOUNT_MAME
Alias Name:
Include []cpata Wrap

To include a field in a CData section in generated XML:
1. Access the Message Field Properties page.

a. Select PeopleTools > Integration Broker > Integration Setup > Message Definitions. The
Messages-Message Definitions page appears.

b. Click the Expand button (+) to expand the record tree structure, and locate the field to exclude
from the definition.

c. Click the name of the field for which to specify a field name alias.
The Message Field Properties page appears.

2. Select the CData Wrap check box.

3. Click the OK button.
The Messages—Message Definitions page appears.

4. Click the Save button.
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Managing XML Message Schemas for Rowset-Based Messages

116

This section discusses how to:

*  View XML message schemas for rowset-based messages.

* Exclude descriptions in XML message schemas.

*  Choose the number of level 0 rows to include in generated XML message schema.
* Include namespaces in generated XML message schemas.

e Suppress empty XML tags in message schema.

Viewing XML Message Schemas for Rowset-Based Messages

PeopleSoft Integration Broker automatically generates message schema for rowset-based messages when
you save the message definition.

After you save a message definition on the Messages-Message Definitions page, click the Schema tab to
view the generated XML message schema.

Excluding Descriptions in XML Message Schemas

Message data that is used to define services can have actual database record and field names in the
generated XML message schema. PeopleSoft Integration Broker provides an option where you can
exclude descriptions in generated message schemas so that sensitive information is not exposed.

The Messages—Message Definitions page features an Exclude Descriptions in Schema check box that
enables you to suppress descriptions in generated schema.

To exclude descriptions in XML message schemas:

1. Access the Messages—Message Definition page (PeopleTools > Integration Broker > Integration
Setup > Message Definitions.

2. Select the Exclude Description in Schema check box.

3. Save the changes.

See Managing XML Message Schemas for Rowset-Based Messages.

Choosing the Number of Level 0 Rows to Include in Generated XML Message
Schema

You can choose to include a single level 0 row in the generated schema or all level 0 rows in the generated
schema.

When you select the Single Level 0 Row check box, PeopleSoft Integration Broker includes a single level
0 row in the XML message schema when you Save the definition. If this box is not selected, then the
system includes all level 0 rows in the message in the generated schema.

By default the Single Level 0 Row check box is not selected.
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If you check the Single Level 0 Row check box to generate schema with one level 0 row, the level 0 row
included in the schema is the first level 0 row the system encounters in the message.

Including Namespaces in Generated XML Message Schemas

PeopleSoft Integration Broker enables you to include a namespace in XML message schemas that you
generate for rowset-based messages.

When working with a rowset-based message type, the Messages—Message Definition page displays an
Include Namespace check box. When the Include Namespace check box is selected, you can specify a
namespace to include in the generated schema on the Messages-Schema page.

This example illustrates the Messages — Schema page. The example shows the Namespace field is
populated with the namespace as defined in the Service Configuration page.

| [ scroma

Message: QE_ASYMNC_TEST

Versiomn: VERSIOM_1
Namespace: hitp:ifxkmins.oracle.comiEnterprise/Toolsischemas/QE_ASYNC_TEST VER

Schema:

By default the Namespace field is populated with the namespace defined on the Service Configuration
page, however you can change the namespace to use in the message schema as required.

To include a namespace in generated schema:

1. Access the Messages—Message Definition page (PeopleTools > Integration Broker > Integration
Setup > Message Definitions).

2. Select the Include Namespace check box.
3. Click the Schema tab.

The Messages—Schema page appears. By default the namespace as defined on the Service
Configuration page populates the Namespace field.

4. Inthe Namespace field enter the namespace to use in the generated XML message schema.
5. Click the Message Definition tab.
6. Save your changes.

The system generates the message schema and includes the namespace specified.

Suppressing Empty XML Tags in Message Schema

PeopleSoft Integration Broker enables you to suppress empty XML tags in message schema of rowset-
based messages.

The Messages-Message Definition page features a Suppress Empty XML Tags check box.
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When you select this box, message schema generated for the message will not include any XML tags that
contain empty or Null values.

Enforcing Message Record and Field Aliases in Generated WSDL
PeopleSoft Integration Broker enables you to enforce record and field aliases in generated WSDL.

The Service Configuration page features a WSDL Generation Alias Check drop-down list that enables
you to set a system check level for aliases on message definition records and fields.

You can set the following check levels:

Check Level Description

Error. If the system encounters a message definition without proper
record and field aliases, it displays an error and it will not
generate a WSDL document.

None. Default. The system creates a WSDL document regardless of
whether message records and fields are aliased or not.

Warning. As the system creates a WSDL document it displays a warning
it encounters messages definitions that do not have complete
aliasing for records and/or fields. If the system encounters
records or fields that do not have aliases defined, you can
continue to generate the WSDL document or terminate the
generation of the WSDL document.

To enforce message record and field aliases in generated WSDL:

1. Access the Service Configuration page (PeopleTools > Integration Broker > Configuration >
Service Configuration).

2. From the WSDL Generation Alias Check drop-down list, select a value. The valid options are:
e Error
*  None.

*  Warning.

Managing Nonrowset-Based Messages

This section provides an overview of managing nonrowset-based messages and discusses how to:
* Add XML message schemas to nonrowset-based messages.

» Edit nonrowset-based XML message schemas.
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Understanding Managing Nonrowset-Based Messages

After you create a nonrowset-based message definition, you do not need to complete any additional
configuration steps for the definition, except to add an XML schema. The XML schema describes the data
to be sent, and includes the field names, data types, field lengths and so on.

You may add or replace message schemas that are referenced by nonrowset-based messages in runtime
tables. However, once you change a message schema for a nonrowset-based message, you must adjust the
message for a successful integration.

Related Links
Adding Message Definitions

Adding XML Message Schemas to Nonrowset-Based Messages

To add an XML message schema to nonrowset-based messages:

Note: You cannot regenerate message schemas for messages that are defined as part of a restricted
service.

1. Select PeopleTools > Integration Broker > Integration Setup > Message Definitions.
2. Select the nonrowset-based definition to which you want to add an XML schema.
The Messages - Message Definitions page appears.
3. Click the Schema tab.
4. Click the Add Schema button.
The Schema page appears.
5. Add the XML schema to the message.
You can add the schema to the message in two ways:

*  Click the Upload Schema From File button to browse for and upload a schema that you have
already saved to a file.

* Enter the XML schema in the Schema text box that is provided.

6. Click the Save button.

If you define the message as a message part, you must supply a schema to save the message. All message
parts require a schema at save time.

Editing Nonrowset-Based XML Schemas

After an XML message schema is added to a nonrowset-based message, you can edit the schema using
the Schema page.
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Note: You cannot regenerate message schemas for messages that are defined as part of a restricted
service.

To edit nonrowset-based XML message schemas:

L.

2.

Select PeopleTools > Integration Broker > Integration Setup > Message Definitions.
Select the nonrowset-based definition that contains the schema that you want to edit.

The Messages - Message Definitions page appears.

Click the Schema tab.

The Schema page appears and displays the existing XML message schema for the definition.
Click the Edit Schema button.

In the Schema text box, make your changes and additions to the XML schema.

Click the Save button.

Deleting Nonrowset-Based XML Message Schemas

120

This section discusses how to:

Delete individual nonrowset-based XML message schemas.

Delete nonrowset-based XML message schema in bulk.

Deleting Individual Nonrowset-Based XML Message Schemas

Use the Messages-Schema page (IB. MESSAGE BUILD?2) to delete individual nonrowset-based XML
message schema.

To delete an individual nonrowset-based XML message schema:

1.

Select PeopleTools > Integration Broker > Integration Setup > Message Definitions.
The Messages-Message Definitions page appears.

Click the Schema tab.

The Messages-Schema page appears.

Click the Delete Schema button.

Deleting Nonrowset-Based XML Message Schemas in Bulk

To delete one or more nonrowset-based XML message schemas, use the Message Schemas page
(IB_HOME PAGED®9) in the Service Administration component (IB_ HOME PAGE).
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This example illustrates the Service Administration — Message Schemas page.

WSsDL Senices Senvice QOperations Messages Message Schemas

Service System Status: Development

Container, part, and rowset-based message schemas cannot be deleted.

Message Name: |
Search

Messages with e
S Customize | Find | View A1 2] B First Bl 4 op 1 B Last

Schemas

Select Message Name Version Results

Delete

To delete nonrowset-based XML message schemas in bulk:

1. Select PeopleTools > Integration Broker > Service Utilities > Integration Broker Admin.
2. Click the Message Schemas tab.

3. Choose the schema or schemas to delete.

To delete an individual schema, in the Message Name field enter the name of the message that
contains the schema to delete.

To delete more than one schema, click the Search button to display all nonrowset-based message in
the system than contain schema.

The message or messages appear in the Messages with Schema grid.

4. In the Select column, select the check box next to each message name that contain schema you want
to delete.

If deleting multiple schemas, use the forward and backward arrows and/or the Last and First links to
page through the results and select schemas to delete.

5. Click the Delete button.

Managing Message Parts

This section discusses how to create message parts.

Understanding Message Parts

Message parts are individual message definitions that get used in container messages.
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While message parts can be rowset-based or nonrowset-based, the advantage of using message parts
comes when working with rowset-based messages. By using nonrowset-based message parts, you cannot
take advantage of PeopleSoft Integration Broker's framework for creating message definitions, use of
PeopleCode, serialization, porting, and so on. The following table highlights some of the advantages of
using rowset-based message parts:

Rowset-Based Message Parts Nonrowset-Based Message Parts

You can use the PeopleSoft Pure Internet Architecture to build | You cannot use the PeopleSoft Pure Internet Architecture to
rowset-based message parts. build nonrowset-based message parts.

Message schema is automatically generated for rowset-based | You must generate message schema for nonrowset-based

messages. message parts.
The mapping from XML to rowset is managed by the You must use the XMLDoc class to manipulate nonrowset-
framework. based message content.

In addition, you must manually map the XML into XMLDoc
for the parts.

Container messages are always nonrowset-based. So, if you use a container message that contains rowset-
based part messages, the container messages sends XML that contains none of the standard PeopleSoft
message XML structures, such as PSCAMA, FieldTypes, and so on. However, you can use the rowset-
based classes and methods to populate and read the structure of each part message.

Creating Part Messages

To create a part message, create a standard rowset-based or nonrowset-based message and select the Part
Message check box on the Message Definition page.

When the service system status is set to Production, once a message is used in a container message, you
cannot alter the message while it is associated with a container message.

You must generate schemas for all part messages before you can save them.

Schemas for rowset-based messages are automatically built when the message is saved. Schemas for
nonrowset-based parts must be added in order to save the message.

Related Links
Adding Message Definitions

Managing Container Messages

Distinguishing Blank from Zero in Rowset-Based Part Messages

122

The Message Definitions page features a Message Part Default Indicator field that appears when you
select or define a rowset-based message part.

When you select the check box, XML that has a value of 0 (zero) passed in an integer field, when
serialized to a rowset, causes the IsChanged property flag on the field to set to True.
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By default an integer field has a value of 0. So if a 0 or <blank> is passed in a field, the end result is a

0 when accessing the field via the rowset. However, if you select the Message Part Default Indicator
check box the IsChanged property on such a field is set to 7rue, meaning that a 0 (zero) was passed in the
field.

Reusing Rowset-Based Message Parts

This section discusses how to:
* Reuse rowset-based message parts by reference.

* Reuse rowset-based message parts by copy.

Understanding Reusing Rowset-Based Message Parts

PeopleSoft Integration Broker enables you to reuse rowset-based message parts by referencing another
message part or by copying another message part.

Note: You cannot reuse message parts at Level 0.

Referencing Message Parts

A reference to a message part is read-only in the message part where it is referenced. To make changes
to a referenced message part, you must make the changes to the referenced message part directly. All
changes are then propagated to every message in which the message part is referenced.

Copying Message Parts

If you copy a message part, the system copies all records and fields and displays them at the record level.
The records and fields become permanent to the new message and you can edit all records and fields
directly in the message where the copied part exists. Changes you make to a copied message part are
not propagated to other copies of the message part that may exist. You must make changes to a copied
message part, you do so manually to each message part that you want to change.

Reusing Rowset-Based Message Parts by Reference
This section discusses how to:
* Reuse a message part by reference.
*  Check for recursion.
*  View referenced message part information.
* View where message parts are referenced.

*  Modify referenced message parts.

* Delete referenced message parts.

Copyright © 1988, 2023, Oracle and/or its affiliates. 123



Managing Messages Chapter 6

124

Reusing a Message Part by Reference
To reuse a message part by reference:
1. Create a rowset-based message part.

2. Add records to the message part per your requirements. At a minimum, you must add a Level 0
record.

3. In the tree view of the message part definition, click the name of the record off of which to add the
reused message part.

The Message Record Properties page appears.
4. Inthe Action box, click Add Part Reference.
5. Identify if the message part is a peer part reference or a child part reference.

If you are working off the Level 0 record, these fields are read only and Child Part Reference is
selected by default.

6. Inthe Reference Message Version field, click the Lookup button to select the message that the
system should reference.

7. Click the OK button.
The Messages-Message Definition page appears.

The reference part is identifiable in the tree view for the message part definition by the highlighted color
on the root record of the referenced part. Since this is a reference, you can only view the reference part
data structure. To make any modifications to the referenced part, you must open the message part directly
and make your changes there. The system will propagate the changes to all messages that reference the
message part.

Checking for Recursion

By default, the system checks up to 20 levels for recursion to ensure that no message part references
itself. You can modify this setting to check for recursion in as few as three levels of records and as many
as 50 levels.

This parameter is set on the System Setup Options page (IB_SYSTEMSETUP).

This example illustrates the System Setup Options page.

System Setup Options

Rowsethased messade parts maximuom recarsion level check.

Message builder depth limit: I 20

Enatle runtime Profile information for SyncfAsync processing

" IB Profile Status On
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To modify the recursion checking level:

Managing Messages

1. Access the System Setup Options page (select PeopleTools > Integration Broker >

Configuration > Integration Broker Options)

2. In the Message Builder Depth Limit field, enter a value between 3 and 50.

3. Click the Save button.

Viewing Referenced Message Part Information

A referenced message part appears highlighted in the tree structure for a message in the Messages —

Message Definition page.

This example illustrates the Messages — Message Definition page. In the example the message structure
for the FLIGHTDATA message is shown. In the tree structure the message record O ARMAMENT is

highlighted and is therefore a referenced message part in the FLIGHTDATA message.

Message Definition || Schema

Message:

Comments:

View Records Only

FLIGHTDATA

Version: W1

Alias: |

Description: |

Owner ID: |

W

PART MESSAGE

Part References

View Included Fields Only

Left | Right

Schema Exists: Yes

Part Message
] Message Part Default Indicator
[ Exclude Description in Schema

[ ] Suppress Empty XML Tags

Rowset-based
Nonrowset-based
Container

Add Record to Root

= FLIGHTDATA
= & QF FLIGHTDATA - [FlightData]

W W
Y

Y
W
W W
W o
W W
Y
W W

QE ACHMUMBER - [ACMumber]

QE M3l SEMSOR - [M31Sensor]

" « QE QFP-[OFF

QE ACTYPE - [ACType]

QFE CALLSIGM - [CallSign]

QE SQUADROM - [Squadron]

QE COMMA - [Comm1]

QE COMM2 - [Comm2]

QE ECM-[ECM
DESCRLONG - [Desc]

= & QF NAVIGATION - [Navigation]
= & QF RADAR PRESET - [RADARPreset]

= E?% QE ARMAMEMT - [Armarment]
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Note: You can make changes to a message part that is referenced in another part or subpart, as long as the
message part is not in the runtime tables, has not been exported as WSDL, or is a restricted message.

If you click a referenced message part, the Part Reference page (IB. MESSAGE PARTS?2) appears.

This example illustrates the Part Reference page.

Part Reference
Message Mame: ARMAMERT Message YVersion: Wl

Record: QE_ARMAMEMNT

Alias Mame:  |Armament iew Definition
[ Delete Part Reference

You can use the Part Reference page to view general information about the referenced message part as
well as view the complete definition for the message part.

You can also use this page to delete the reference to the message part. Deleting a part reference is
discussed elsewhere in this section.

See Reusing Rowset-Based Message Parts

To view the complete message definition for a referenced message part, on the Part References page View
Definition link shown in the previous example. When you click the link the definition for the referenced
message part appears in the Messages — Message Definition page.

This example illustrates the Messages — Message Definition page. The example shows the message
definition for he Armament message part.

Message Definition Schema

Message: ARMAMEMT

Schema Exists: Yes

Part Message
Versiom: i [IMessage Part Default Indicator
Alias:  Armament [ Exclude Description in Schema
Description; |
. W
Owner 1D: | [] Suppress Empty XML Tags
Cﬂmmems: Megsam Tym
Rowset-based
Nonrowset-based
Container
Sub-part References
View Records Only View Included Fields Only Add Record to Root
Left | Right
[= ARMAMENT

= & QFE ARMAMENT - [Armarment]
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You can use the page to view details about the record structure, view the generated message schema, and
SO on.

Modifying Referenced Message Parts

To make a modification to a referenced message part, you must make the modification in the message part
definition itself. You cannot modify a referenced message part from a message in which it is referenced.

Deleting Referenced Message Parts

You delete a referenced message part in the message where the part is referenced.
To delete a referenced message part:

1. Open the message definition that contains the referenced message part to delete.

2. In the tree structure view of the message definition, click the name of the referenced message part to
delete.

The Part Reference page appears.
3. Select the Delete Part Reference check box.

4. Click the OK button.

Managing Container Messages

This section provides an overview of managing container messages and discusses how to:
* Add message parts to container messages.
* Add and get container message attributes.

* Generate XML message schemas for container messages.

Understanding Managing Container Messages

Container messages are used for those situations where you want to produce XML that contains none of
the standard PeopleSoft messaging XML structures, such as PSCAMA, FieldType, and so on, yet you
want to use PeopleSoft rowset-based classes and methods to populate and read the message structure.

Container messages:
* Hold one or more message parts.
* Are always nonrowset-based messages.

The message parts you add to a container message must all be rowset-based message parts, or all
nonrowset-based message parts.

When working with container messages that contain rowset-based message, PeopleSoft Integration
Broker enables you to add attributes and attribute values to the container messages. Adding attributes
to container messages enables you to provide integration partners with data and information, without

Copyright © 1988, 2023, Oracle and/or its affiliates. 127



Managing Messages Chapter 6

the need to modify or provide the information in the container message definition or in any of the part
message definitions.

Understanding Including Level 0 Rows for Message Parts in Container
Messages

When you are working with a container message that holds rowset-based message parts, you can specify
the minimum and the maximum number of level 0 rows for each message part.

When you are working with a container message, the Message Definition page, the Parts grid displays the
following fields:

Term Definition

Minimum Occurs The value you enter determines the minimum number of level
0 rows in the message part to include in the container message.

Maximum Occurs The value you enter in this field determines the maximum
number of level 0 rows in the message part to include in the
container message.

By default the Maximum Occurs value is set to 1 to represent
the single row of data on the level 0 record defined on the part
(typical for component processing). However, for the case
where more then one row of data is to be passed on the level

0 record, for example there is a single record defined on the
message part and you want to send x number of rows of data,
then increase the Maximum Occurs value to the value of x (the
number of rows of data you are sending) or set the Unbounded
Maximum field to Y.

Maximum Unbounded The value you select determines if the system includes
unlimited level 0 rows from the message part in the container
message. The valid values are:

* Y. The number of level 0 rows from the part message
that the system includes in the container messages is
unlimited, or unbound. When you select this option all
rows from a part message are included in the container
message.

* N (Default) The number of level 0 rows from the part
message that the system includes in the container message
is limited. You must enter the maximum number of rows
from the part message to include in the container message
in the Maximum Occurs field.

Example: Message XML when Maximum Occurs is Set to a Non-Default Value

The section contains a example of a container message with three message parts: QF PART 1,
QF PART 2, and QE PART 3.

Each part contains only one record (level 0 record).
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As described earlier in this section, the Maximum Occurs value is / by default.

In the following example QF PART 1 is defined on the container with a Maximum Occurs value of 2 and
what is actually published in this case is two rows on the level 0 record for QF PART 1, as shown in the
example.

<?xml version="1.0"?>
<QE PARTS xmlns="http://xmlns.oracle.com/Enterprise/Tools/schemas/
QE_PARTS.VERSION 1">
<QE PART 1>
<QE NAVIGATION class="R" xmlns="http://xmlns.oracle.com/Enterprise/
Tools/schemas/QE PART 1.VERSION 1">
<QE_ACNUMBER>100</QE_ACNUMBER>
<QE_WAYPOINT NBR>10</QE WAYPOINT NBR>
<QE BEARING/>
<QE RANGE/>
<QE_ALTITUDE/>
<QE_LATITUDE/>
<QE LONGITUDE/>
<QE_HEADING/>
<QE_VELOCITIES/>
<QE_NAVDESC/>
</QE NAVIGATION>
</QE_PART_ 1>
<QE_PART 1>
<QE NAVIGATION class="R" xmlns="http://xmlns.oracle.com/Enterprise/
Tools/schemas/QE PART 1.VERSION 1">
<QE_ACNUMBER>100</QE_ACNUMBER>
<QF_WAYPOINT NBR>20</QE_WAYPOINT NBR>
<QE_BEARING/>
<QE RANGE/>
<QE_ALTITUDE/>
<QE_LATITUDE/>
<QE_LONGITUDE/>
<QE HEADING/>
<QE_VELOCITIES/>
<QE_NAVDESC/>
</QE_NAVIGATION>
</QE PART 1>
<QE_PART 2>
<QE RADAR PRESET class="R" xmlns="http://xmlns.oracle.com/Enterprise/
Tools/schemas/QE PART 2.VERSION 1">
<QE ACNUMBER>2</QE ACNUMBER>
<QE_RADAR_SELECTION>1</QE_RADAR_SELECTION>
<QE_RADARMODE>TWS</QE_RADARMODE>
<QE_RADAR OPERMODE>N</QE RADAR OPERMODE>
<QE BARSCAN>4B</QE BARSCAN>
<QE_RADARRANGE>40</QE_RADARRANGE>
<QE_TGTAGE>8</QE_TGTAGE>
<QE_CHANNELSET>B</QE_CHANNELSET>
<QE AZIMUTH>80</QE AZIMUTH>
<QE_PRF>H</QE_PRF>
</QE_RADAR PRESET>
</QE_PART 2>
<QE PART 3>
<QE ARMAMENT class="R" xmlns="http://xmlns.oracle.com/Enterprise/Tools/
schemas/QE PART 3.VERSION 1">
<QE_ACNUMBER>2</QE_ACNUMBER>
<QF_STATION NBR>1</QE STATION NBR>
<QE_AGMODE>CCIP</QE_AGMODE>
<QE BIT>SBIT</QE BIT>
<QE_WEAPONSPECS/>
</QE_ ARMAMENT>
</QE_PART_ 3>
</QE_PARTS>
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Adding Message Parts to Container Messages

This section discusses how to add message parts to container messages.

Use the Messages — Message Definitions page to add message parts to a container message. To access the
page, select PeopleTools > Integration Broker > Integration Setup > Message Definitions.

This example illustrates the Messages — Message Definitions page for the container message
CONTAINER _MSG.

Message Definition Schema

Schema Exists: Mo
Message: COMNTAINER_MSG
Part Message
Version: W1
Alias: |
Description: |
Owner ID: i
Comments:
Rowset-based
Honrowset-based
Container
Add Parts

Parts First o 1 0of1 ) Last

*Unbound

i

Maximum
(=]

[

|
Customize | Find | View Al | B |

Minimum |Maximum

kessage Name
Mess Hame Occurs Occurs

Message Version Seguence

o o |

When you click the Add Parts link to specify a message, version, and message type to add, the Add Parts
page (IB_MESSAGE_ PARTS) appears.

This example illustrates the Add Parts page.

Add Parts

Message Name: |

Message Version: |

Show Rowset-based Parts
Show Nonrowset-based Parts

For a message definition to be available for you to add to a container message, you must have selected the
Message Parts check box when you created the message definition. In addition, container messages can
contain only all rowset-based messages or all nonrowset-based messages.

After you add message parts to a container message, the Messages — Message Definitions page displays
and the message parts that you have added to the message are listed in the Parts grid.
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This example illustrates the Messages — Message Definitions page. The example shows three message

parts added to the container message.

Message Definition Schema

Message: COMTAINER_MSG

Version: W1

Alias:
Description:
Owner ID:
Comments:

Mo

Schema Exists:
Part Message

Rowset-based
Honrowset-based
Container

Add Parts

Parts Customize | Find | View Al | (2] #

Messzage Name Messzage Version Sequence

Occurs

Minimum |Maximum
Oecurs

Container Atributes

First Bl 1.3 of 3 I Last

*Unbound
Maximum

-

QE PART 1 VERSION_1 1 0 1
QE PART 2 VERSION_1 2 0 1
QE PART 3 VERSION_1 3 0 1

Click the name of any of the message parts that appear in the grid to open the individual message
definition. If the service system status is set to Production, when assigned to a container message, you
cannot modify a message definition. To modify the definition, you must delete it from the container

message first.
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This example illustrations the Messages — Message Definitions page. The example shows how the
PART I message part displays if you click the message name in the Parts grid shown in the previous
example.

 essogevetmton | SEiGHAN

Schema Exists: Yes
Message: QE_PART_1
Part Message
Version: VERSION_1 [Imessage Part Default Indicator
Alias: ] Exclude Description in Schema
Description:
Owner ID: b [] suppress Empty XML Tags
Comments: Message Type
Rowset-based
Nonrowset-based
Container
Part References
View Records Only View Included Fields Only Add Record to Eoot
Left | Right
[= QE_PART_1

= & QFE NAVIGATION

Clicking the Part References link displays all messages to which the message part is assigned.

Note: Before you add nonrowset-based message parts to a container message, you must upload XML
message schemas to each message part that you intend to include in the container message. Nonrowset-
based part messages cannot be saved without a schema.

To add a message part to a container message:
1. Select PeopleTools > Integration Broker > Integration Setup > Message Definitions.
2. Select a container message to which to add message parts.
The Messages - Message Definitions page appears.
3. Click the Add Parts link.
The Add Parts page appears.
4. Select a message to add.
You can use one of two methods to select a message to add:
a. Inthe Message Name and Message Version ficlds, enter the message name and version to add.

b. Select the Show Rowset-Based Parts option or the Show Nonrowset-Based Part option
and click the Search button to display all rowset-based or nonrowset-based messages that are
designated as part messages in the system.

132 Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 6 Managing Messages

Select one or more messages to include in the container message.

5. Click the OK button.

The Messages - Message Definitions page appears, with the Parts grid populated with the message or
messages that you selected.

6. (Optional.) In the Parts grid, enter numeric values in the Sequence column to order message part
placement in the container message.

If you do not enter any values, the system sequences the messages in the order in which you add them
to the container message.

7. (Optional.) In the Minimum Occurs field, enter the number of minimum rows in the message part to
include in the container message.

8. In the Maximum Occurs field, enter the maximum number of level 0 rows from the part message to
include in the container message.

9. In the Unbound Maximum drop-down list, select whether to include all level 0 rows from the part in
the container message.

Note: If you select ¥, note that the Maximum Occurs field no longer displays on the page, as all rows
are included in the container message.

The Minimum Occurs, Maximum Occurs and Unbound Maximum fields are described elsewhere in this
section.

See Understanding Including Level 0 Rows for Message Parts in Container Messages.

Adding and Getting Container Messages Attributes
This section discusses how to:
* Add the language code of the message sender as an attribute to a container message.
* Add attribute names to a container message.
* Populate attribute values for container message attributes.
*  QGet attribute names and values from a container message.

This section also provides a summary of PeopleCode that you can use to populate attribute values and get
attribute data from container messages.

Understanding Adding, Populating, and Getting Container Message Attributes

You can add attributes to container messages that contain rowset-based message parts to provide
integration partners with data and information, without adding the information to the message definition.

To add attributes to a container message, you first define the attribute name, length, and required flag
in the container message definition in the PeopleSoft Pure Internet Architecture. This information
appears in generated container message schema. At runtime the attributes appear at the root level of the
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generated XML. Next you use PeopleCode to populate the attribute values using the IBInfo object. At
runtime, PeopleSoft Integration Broker validates the attribute values against the lengths you defined in the
container message definition.

PeopleSoft provides a number of IBInfo object methods to get attributes from container messages.

Adding Language Codes of the Message Senders as Attributes to Container
Messages

The language code of the user who executed the publish or sync request is a common attribute to add to
a container message. As such, PeopleSoft provides an Include Language Code attribute box, that when
selected automatically includes the information as an attribute name and value in the container message.

This example illustrates the Container Attributes page. The example shows that the Include Language
Code check box is selected.

Container Attributes

Message Name: CONTAINER_MSG

Version: W1
Include Language Code

Container Attributes Customize | Find | View Al | 20 ) 88 First Kl 12 052 I Last

*Attribute Hame Length |Reguired
[=]
[=]

| [
—

Ny

To add the language code of the message sender as an attribute:

1. Access the Container Attributes page (PeopleTools > Integration Broker > Integration
Setup > Message Definitions and click the Container Attributes link).

2. Select the Include Language Code check box.
3. Click the OK button.

4. The Messages—Message Definitions page appears.

Adding Attribute Names to Container Messages

After you add one or more rowset-based message parts to a container message and save the message,
a Container Attributes link appears on the Messages-Message Definition page under the Message
Type group box. When you click the Container Attributes link, the Container Attributes page
(IB_MESSAGE_ATT SEC).
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This example illustrates the Container Attributes page. In the example two attribute names are defined,

Messagelmportance and DeveloperID.

Container Attributes

Message Name: COMTAIMER_MSG

Version: W1

[l include Language Code

*Attribute Hame

|Messagelmpnrtance

|Deve|nperID

Container Attributes Customize | Find | View Al | B2 | B

First n 1-2 of 2 u Last

To add an attribute name to a container message:

1. Access the Container Attributes page (PeopleTools > Integration Broker > Integration
Setup > Message Definitions and click the Container Attributes link).

2. In the Attribute Name field, enter a name for the attribute.

3. In the Length field, enter a numeric field length value.

4. (Optional.) Select the Required check box if you want the attribute name to be required.

5. Click the OK button.

The Messages—Message Definitions page appears.

Populating Attribute Values for Container Message Attributes

PeopleSoft provides several IBInfo object methods within the Message object to populate container

message attributes.

Here is an example of how to populate attributes. The attribute values will be validated at runtime against

the defined lengths.

&MSG = CreateMessage (Operation.MY SVC OPERATION) ;

&ret
&ret

&MSG.IBInfo.AddContainerAttribute ("MessageImportance", "Medium");
&MSG.IBInfo.AddContainerAttribute ("DeveloperID", "mdawson");

Additional IBInfo objects that you can use for working with container message attributes are described

elsewhere in this section.

Getting Attribute Names and Values from Container Messages

PeopleSoft provides several IBInfo object methods within the Message object to Get attribute information

from container messages.
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Note that if you attempt to read attributes within an Integration Broker event, such as OnNotify,
OnRequest, and so on, you must first Get a part rowset to load the attributes into the Message object from
the XML.

The following code snippet shows one example of how to read attributes from a container message:

RowSet &MSG.GetPartRowset (1) ;
&index = &MSG.Ibinfo.GetNumberOfContainerAttributes();

For &1 = 1 To &index

gattrName = &MSG.Ibinfo.GetContainerAttributeName (&1i) ;
&attrValue = &MSG.Ibinfo.GetContainerAttributeValue (&1i);

End-For;

Additional IBInfo objects that you can use for working with container message attributes are described
elsewhere in this section.

Summary of PeopleCode Use for Working With Container Message Attributes

The following table summarizes the PeopleCode methods that you can use for working with container
message attributes.

Method Description
GetNumberOfContainerAttributes Gets the number of container attributes
Syntax:

&Integer = &MSG.IBInfo.GetNumberOfContai=

nerAttributes () ;

GetContainerAttributeName Returns the name of the container attribute based on an index.
Syntax:

&String = &MSG.IBInfo.GetContainerAttrib=

uteName (Integer nIndex) ;

GetContainerAttribute Value Returns the value of the container attribute based on an index.
Syntax:

&String = &MSG.IBInfo.GetContainerAttrib=

uteValue (Integer nIndex);
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Method Description

AddContainerAttribute Add container attributes by passing in attribute name and
value.

Syntax:

&Bool = &MSG.IBRInfo.AddContainerAttribut=>

e (string name, string value);

DeleteContainerAttribute Delete a container attribute based on the attribute name.
Syntax:

&Bool = &MSG.IBInfo.DeleteContainerAttri=

bute (string name) ;

ClearContainerAttributes Deletes all container attributes in the IBInfo object.
Syntax:

&§MSG.IBInfo.ClearContainerAttributes () ;

Generating XML Message Schemas for Container Messages

XML message schemas for container messages are automatically generated when you save the definition.
You can view the generated XML message schema on the Messages - Schema page. To access the page,
select PeopleTools > Integration Broker > Integration Setup > Message Definitions and click the
Schema tab.

Copyright © 1988, 2023, Oracle and/or its affiliates. 137



Managing Messages Chapter 6

This example illustrates the Messages — Schema page. The example shows system-generated XML
message schema for a container message with rowset-based message parts.

[ Messane Definition } Schema

Message Name: TEST_01 Updated: 12M 32000 5:21:04PM
Version: Yarsion_1
Name Space: hitp:irmins.oracle.corEnterpriseools/schemasiCONTAINTER_TE Vers
Schema:

=Mmlversion="1.0"7%=
=xzd:schema elementFormDefauli="qualified"
targetMamespace="hitpJxmins.aracle.camiEnterprisefToalsfschemas/CONTAINTER _TE Version_1"
¥milns="http Mxmins oracle.com/EnterprisefToolsischemasiCONTAINTER _TE Wersion_1"
¥mins:FIRST_MSG_PART Version_1="httpifkmins.aracle comiEnterpriserToolsfschemas/FIRST_MSG_PART Wersion_1"
¥mins:SECOND_MSG_PART Version_1="httpJixmins.oracle.comiEnterprise/Toolsischemas/SECOND_MSG_PART Version_1"
¥mins THIRD_MSG_PART Yersion_1="http.fxmins.oracle.com/EnterprisefToolsischemasiTHIRD_MSG_PART Mersion_1"
s¥minsxsd="hitprenin w3, 0rgi2001 MLSchema"=
=wsdimport namespace="httpikmins oracle. comiEnterpriseMoalsischemasiFIRST_MSG_PART Yersion_1"
schemalocation="http:fpho-mdawsona peoplesof.comPSIGVPeopleSoftServicelisteningConnectar?
Operation=GetSchema&ampxsd=FIRST_MSG_PART Version_1"/=
=xsdimport namespace="httpJkmins. oracle.comiEnterprise/ToolsischemasSECOND_MSG_PART Version_1"
schemalaocation="http:fpho-mdawsona. peoplesoft.com/PSIGVWFeopleSoftServiceListeningConnectar?
Operation=GetSchema&kampxsd=SECOMD_MSG_PART Wersion_1"f=
=xedimport namespace="httpJikmins. oracle comiEnterpriseiToolsischemasMHIRD _MSG_FPART Version_1"
schemalocation="httpfpho-mdawsona peoplesoft.comfPSIGVWPeopleSoftServiceListeningConnector?
Operation=GetSchemakampxsd=THIRD_MSG_PART Wersion_1"r=
=xsdelement name="CONTAINTER_TEST_MSG" type="CONTAINTER_TEST_MSGType"l=
=wsd complexType name="CONTAINTER_TEST_MSGType"=
=xsd sequence=
=xed:element maxOccurs="unhounded" minOccurs="0" name="FIRST_MSG_PART"
type="FIRST_MSG_PART Version_1.FIRST_MESG_PART_TypeShape"/=
=x¥sd:element maxOocurs="unbounded" mindDccurs="0" name="SECOMND_MSG_PART"
type="SECOMND_MSG_PART Version_1:SECOMD_MSG_PART_TypeShape'i=
=xed:element maxQccurs="unhounded" minOccurs="0" name="THIRD_MSG_PART"
type="THIRD_MSG_FPART Wersion_1 THIRD_MSG_PART_TypeShape"/=
=Hsd.sequence=
=isd.complexType=

=fsdischemas=

The namespace that is used in the XML message schema becomes by default the value that is defined
on the Service Configuration page. To change the namespace, enter a the new namespace on the Schema
page in the Namespace ficld, the Message Definition tab, and save the change. The XML message
schema is generated again by means of the modified namespace value.

Managing Document Messages

After you add a document message to the system, you manage the document using the Document Builder
and the document utilities.

Related Links

Documents Technology

Viewing Service Operations that Reference Messages

Use the Service Operation References page (IB. MESSAGE SO SEC) to view a list of service operations
that contain a message. The Messages-Message Definitions page provides a link to this page. To access
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the page, sclect PeopleTools > Integration Broker > Integration Setup > Message Definitions and

click the Service Operation References link.

This example illustrates the Service Operation References page. The example shows a list of service
operations that contain the message /B EX NONROWSET CONTAINER.

Versiom: vl

Senvice Operations
Service Operation

Service Operation References

Message: |B_EX_MONROWSET_COMTAINER

]
Customize | Find | E1] | =t First K 1-2 of 2 o Last

| Service Operation Version |Validation

IB_EX_MP_MONROWSET_ASYNC
IB_EX_MP_MONROWSET_SYMNC

The following page elements appear on the Service Operation References page:

Field or Control

Description

Message Name of the message that is referenced in one or more service
operations.
Version Version of the message that is reference in one or more service

operations.

Service Operation

Name of the service operation that contains the message.

Service Operation Version

Version of the service operation that contains the message.

Validation

When the check box is selected message schema has been
generated for the message in the service operation.

Resolving Inconsistencies in Exported WSDL and WADL

Documents

This section discusses how to:

* View service operations with exported WSDL or WADL inconsistencies.

*  Clear exported WSDL/WADL status flags.
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Understanding Using Project Copy and Exported WSDL and WADL

When you generate WSDL or WADL for a service operation, the system sets an internal flag on the
service operation that indicates that WSDL/WADL has been generated or exported for the specific service
operation.

The system uses the same repository for WSDL and WADL documents. The WSDL metadata object is
used for project copy of WSDL and WADL. There is no WADL metadata object only WSDL.

You may later decided to use Project Copy to copy the service operation to a new database. But you may
decide not to or simply neglect to copy the exported WSDL or WADL to the new database.

Even though you have not copied the WSDL/WADL to the new database, the internal flag that says
WSDL/WADL has been generated is still set on the service operation. As a result, the system expects
WSDL/WADL to exist in the new database, when it does not. When this condition exists, the system
displays a status message on the message definition(s) of messages referenced in the service operation.

When this condition exists, the options are:
e Clear the internal WSDL/WADL exported flag on the service operation.
Information about how to perform this task is discussed in this section.
*  Use Project Copy to copy the WSDL/WADL to the new database.
See “Copying Projects” (Lifecycle Management Guide).
* Regenerate the WSDL/WADL on the new database using the Provide Web Service wizard.

See Providing Services.

Viewing Services Operations with Exported WSDL/WADL Inconsistencies

140

If the system detects a WSDL/WADL flag inconsistency, the following status message appears on the
Messages-Message Definitions page for those message definitions referenced in the service operation for
the WSDL/WADL in question:

Exported WSDL flag inconsistency detected. WSDL does not exist.
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This example illustrates the Messages — Message Definitions page. The example shows the “Exported
WSDL flag inconsistency detected” status message and the Exported WSDL Inconsistency link
appearing on the page.

Message Definition | Schema

&  Status: Exported WSDL flag inconsistency detected. WSDL does not exist.
Exported W3DL Inconsistency

Schema Exists: Yes
Part Message

Message: FLIGHTPLAM

Version: vl

Alias: Clgntrian
Description:

Owner 1D
Comments: FlightPlan Container Message

Rowset-based
Nonrowset-based
Semvice Operation References Container
Add Parts Container Aftributes

|
Parts Customize | Find | View A1 2] B Firat B g o5 g B0 ot

*Unbound

Message Name Message Version Sequence |Minimum Occurs -
= Maximum

FLIGHTDATA

In addition, an Exported WSDL Inconsistency link appears on the Messages-Message Definitions page.
Click this link to view the Exported WSDL Inconsistencies page (IB_ HOME PAGE7 SEC).

This example illustrates the Exported WSDL Inconsistencies page

Exported WSDL Inconsistencies

Message: Senvice operations flagged as having exported WSDL need for that WSDL to existin the
repaository. Ifthis is not the case, the data is inconsistent. This erroris caused by importing a
sernvice operation and not bringing along the related service or W3DL objectvia project copy.

Senvice Admin
Exported WSDL Inconsistent
Operations
Service Operation Service Operation Version
FLIGHTPLAM va

|
Customize | Find | View Al | B0 ) 88 First BN 4 or 4 B Last

The page displays service operations that exist in the database that are flagged as having WSDL/WADL
exported, yet no WSDL/WADL exists in the database for them. The Exported WSDL Inconsistencies
page features a Service Admin link. Clicking the link opens the Service Administration-WSDL page
(IB_HOME PAGEY). The Service Administration-WSDL page provides options to clear the internal
exported WSDL flag.
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Clearing Exported WSDL/WADL Status Flags
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The Clear WSDL Status page (IB_ HOME PAGE7 SEC) enables you to clear the internal exported
WSDL/WADL status flag for service operations that contain specific messages, or for all service
operations in the database.

Note: Clearing the internal exported WSDL/WADL status flag on a service operation is one way to
resolve a WSDL/WADL flag inconsistency. Other options for resolving this condition are discussed
elsewhere in this topic.

See Understanding Using Project Copy and Exported WSDL and WADL.

This example shows the Clear WSDL Export Status page

Clear WSDL export status

Operations flagged as exported but without W3DL.

|
Customize | Eind | View Al | IE“ tost Firzt K 1 of 1 o Last

senvice Operation Versiun

FLIGHTPLAM v

| Clear Export Status |

Up to this point, this section has demonstrated accessing the Clear WSDL Export Status page starting
from the Export WSDL Inconsistency link on a message definition, and then clicking on the Service
Admin link from the Exported WSDL Inconsistencies page. When you access the page using this
navigation, only the service operations that reference the message definition that you were originally
viewing on the Messages — Message Definitions page appear. Further, those service operations that appear
are those that are flagged has having WSDL/WADL exported, but for which there is none in the database.

You can also clear the WSDL/WADL export status flag for all service operations in the database that are
in the inconsistent state of having been flagged as having WSDL/WADL generated, but no WSDL/WADL
exists in the database for them. You can do so by accessing the Service Administration-WSDL page and
clicking the Clear WSDL Export Status link.
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This example illustrates the Clear WSDL Export Status page. The example shows a list of service
operation in the database that have inconsistent WSDL.

Clear WSDL export status

Qperations flagged as exported but without WSDL.

Customize | Find | view A1 | 1] 88 First Bl 1900721 I Lot
Version
GEMCOMPOMENTURL_SO il
PRCS_FINDREQUESTS Wl
PRCS_GETPARAMS Wl
PRCS_GETPROCESSMAMES Wl
FPRCS_GETPROMPT Wl
PRCS_GETREPORT Wl
PRCS_GETREQUEST Tl
PRCS_SCHEDULE Wl
PRCS_UPDATEREQUEST Tl
PT_SES_CREF_GET Wl
Clear Export Status

To clear the WSDL/WADL exported status flag:
1. Access the WSDL Export Status page using one of the following methods:

* From a message definition that displays the “Exported WSDL flag inconsistency’ status message:
Click the Exported WSDL Inconsistency link. The Exported WSDL Inconsistencies page
appears. Click the Service Admin link.

*  From the PeopleTools menu: Select PeopleTools > Integration Broker > Service Utilities >
Integration Broker Admin. The Service Administration page appears. Click the WSDL tab.
Click the Clear WSDL Export Status link.

2. Click the Clear Export Status button.

Renaming and Deleting Message Definitions

You can rename and delete messages using the Messages page (IB_ HOME PAGES) in the Services
Administration component (IB_ HOME PAGE). The Message page contains two sections: a Delete
section that enables you to delete message definitions and a Rename section that enables you to rename
message definitions.

To access the page, select PeopleTools > Integration Broker > Service Utilities > Integration
Broker Admin and click the Messages tab.
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When you first access the Messages page, all sections are collapsed. Click the section header arrow
buttons to expand and collapse each section.

This example illustrates the Services Administration — Messages page. In the example the Delete and
Rename sections are expanded.

WSDL Senices Senice Operations Messages Message Schemas Clueues Routings D]

Service System Status: Development

Message Name: |

Search

Messages Custorize | Find | View Al B0 | 88 First B 4 o ¢ B ot

Select Message Name Version Description Results
Ol

Delete

Message Name: | Q. Message Builder

New Hame: |

Rename

Results:

At the top of the page, the Service System Status field displays the current setting. The service system
status, set on the Service Configuration page, affects the ability to rename and delete messages.

See “Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration
Broker Administration).

Renaming Message Definitions

To rename a message definition:

Note: Renaming a message definition renames all versions.

1. Access the Services Administration - Messages page.

Select PeopleTools > Integration Broker > Service Utilities > Integration Broker Admin.
Click the Messages tab.

2. Click the arrow next to the Rename section header to expand the section.

3. In the Message Name field, enter the message definition to rename, or click the Lookup button to
search for and select the message to rename.

4. (Optional.) Click the Message Builder link to view details about the selected message in the
Messages - Message Definitions page.

When you are done viewing the message details, click the Return button to return to the Services
Administration - Messages page.
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5. Inthe New Name field, enter the new name for the message definition.

6. Click the Rename button.

Deleting Message Definitions
When you delete a message definition the system also deletes it's associated schema.
To delete a message definition:
1. Access the Services Administration - Messages page.

Select PeopleTools > Integration Broker > Service Utilities > Integration Broker Admin .
Click the Messages tab.

2. Click the arrow next to the Delete section header to expand the section.

3. Inthe Message Name field, enter the name of the message to delete, and click the Search button.
Search results appear in the results grid.

4. In the results grid, select the check box next to the message or messages to delete.

5. Click the Delete button.

Deleting Messages During Upgrade

To delete a message definition in an application upgrade project, you must first make sure that no live
instances of the message exist. Archive or delete any such messages in both the source and the target
database. Otherwise, you receive an error message during the copy process indicating that the object is in
use.
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Sending and Receiving Messages

Understanding Sending and Receiving Messages

To send and receive messages you use PeopleCode to:

* Send request messages from PeopleSoft Integration Broker to other systems.
* Receive response messages from other systems.

* Route messages.

* Manipulate message content.

You can also send messages directly to the integration gateway, thereby bypassing processing on the
integration engine.

Note: The code examples in this topic are for illustrative purposes only and are not intended to be used in
a production environment.

Prerequisites for Sending and Receiving Messages

Before you can define PeopleCode to generate, send, receive, and process messages, you must define the
message in PeopleSoft Internet Architecture.

Note: Once you create PeopleCode, you must also define nodes, services and service operations to
implement a complete integration.

See PeopleSoft Integration Broker Metadata.

Messaging Process Flows

The integration engine uses asynchronous request processes and synchronous request processes to
manage outbound and inbound messages. These processes examine the messaging elements that you
create to determine how to treat each message.

Outbound Message Processing Flow

This section discusses message processing flow for outbound messages. In this section, the term process
is used, and refers to either the integration engine's asynchronous request process or its synchronous
request process, depending on the type of integration you are preforming.

Outbound messages you send go through the following steps.

1. The application triggers the sending PeopleCode that you developed.
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The PeopleCode program populates and sends the message by using an asynchronous or synchronous
method.

The method that the PeopleCode uses to send the message triggers a request process in the
application’s integration engine.

The process searches the outbound routings that are associated with that service operation to
determine the valid target nodes for the message.

The asynchronous process examines only asynchronous routings, and the synchronous process
examines only synchronous routings. If for synchronous processing, a valid single outbound routing
cannot be found, the sending method returns an error.

Note: Only active routings are considered for processing.

For each outbound routing that it finds, the process submits the message to the local gateway, along
with transaction information about the node and the target connector that should be used to send the
message.

The local gateway transmits the message to the specified target node through the specified target
connector.

If this is a synchronous message, the process waits for the target node to pass a response message
back through the gateway, then returns it to the calling PeopleCode method.

Inbound Message Processing Flow

Each received message goes through the following steps:

1.

The application’s gateway receives a request message from a remote node or gateway, which specifies
the application as its target node.

The gateway submits the message to the application’s integration engine, which searches for any
inbound request routing parameter which has the same alias name as the external operation name
passed in.

If a matching routing alias name isn’t found, the integration engine returns an error message through
the gateway to the sending node.

If a routing alias name is found, the integration engine invokes either the asynchronous request
process or the synchronous request process, as appropriate, to handle the message.

Note: Any inbound routing alias that is found must have the proper permissions for that service
operation for the process to proceed.

The process accesses the service operation that matches the routing alias name and passes the message
to the service operation's handler associated with receiving PeopleCode.

* The asynchronous request process invokes the service operation's handler OnNotify event
PeopleCode.

* The synchronous request process invokes the service operation's handler OnRequest event
PeopleCode.
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5. If'this is a synchronous transaction, the process waits for the receiving PeopleCode to generate and
return a response message, then passes it back to the sending node through the gateway.

Understanding Integration PeopleCode

This section discusses the PeopleCode used for integrations and describes:
* Sending and receiving PeopleCode.

» Integration application classes.

* Integration methods.

*  Messaging methods.

* Error-handling methods.

*  Messaging PeopleCode.

*  Documents PeopleCode.

Sending and Receiving PeopleCode

This section discusses the PeopleCode you use for sending messages from PeopleSoft Integration Broker
to other systems, and the PeopleCode you use for receiving messages from other systems.

Sending PeopleCode

PeopleCode for sending messages can be located in PeopleCode events associated with records, record
fields, and components, and in application engine programs.

The PeopleCode method used to send messages is highlighted in the following table.

Transmission Type Sending PeopleCode Comments

Synchronous SyncRequest method. The SyncRequest method belongs to the
IntBroker class.

Asynchronous Publish method. The Publish method belongs to the
IntBroker class.

To work with rowset-based messages in SOAP format, transform the SOAP documents into XML
documents and then use the IntBroker class SyncRequest or Publish methods. To work with nonrowset-
based messages in SOAP format use the SOAPDoc class.

Receiving PeopleCode

The PeopleCode that you use to receive a message must be associated with the message definition. The
transmission type of the message determines the location of the PeopleCode program.
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Implement the OnRequest method for synchronous messages. Implement the OnNotify method for
asynchronous messages. Both methods are located in the PS_PT application package, in the Integration
sub-package, in the IRequestHandler and INotificationHandler classes, respectively.

Transmission Type

Message Structure

Receiving PeopleCode

Comments

method.

Synchronous Rowset-based Message is passed into the Implement the
method. OnRequest method in the
IRequestHandler application
interface.
Synchronous Nonrowset-based Message is passed into the Implement the
method. OnRequest method in the
IRequestHandler application
interface.
Asynchronous Rowset-based Message is passed into the Implement the
method. OnNotify method in the
INotificationHandler
application interface.
Asynchronous Nonrowset-based Message is passed into the Implement the

OnNotify method in the
INotificationHandler
application interface.

To get content data out of a request message, use the following guidelines.

messages.

Message Structure PeopleCode Comments
Rowset-based GetRowSet method. None.
Nonrowset-based GetXMLDoc method. You can also use Message class

functionality with nonrowset-based

See Using Message Object Functionality

With Nonrowset-Based Messages.

Application classes house the processing logic for asynchronous and synchronous messages. By
implementing the Integration Broker application classes, you can reuse code and access other benefits of

application classes.
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The following application classes exist for PeopleSoft Integration Broker. See the individual applicable
application class interfaces for more information about the methods contained in an application class.

To access these application classes, in PeopleSoft Application Designer, open the PS_PT application
package and open the Integration subpackage.

Note: All of the Integration Broker application classes are defined as interfaces. This means that there
is no native implementation of them: you must import them to your program and implement them if you

want to use them.

Application Class Methods Contained in Application | Comments
Class
INotificationHandler *  OnNotify This interface is the equivalent of the
Subscription Message event PeopleTools
*  OnError releases prior to PeopleTools 8.48.
IReceiver *  OnAckReceive This interface is the equivalent of
the OnAckReceive Message event
*  OnError in PeopleTools releases prior to
PeopleTools 8.48.
IRequestHandler *  OnRequest This interface is the equivalent
of the OnRequest Message event
*  OnError in PeopleTools releases prior to
PeopleTools 8.48.
IRouter *  OnRouteSend This interface is the equivalent of the
OnRouteSend and OnRouteReceive
*  OnRouteReceive Message events in PeopleTools releases
prior to PeopleTools 8.48.
*  OnError
ISend *  OnRequestSend This interface is the equivalent of the
OnSend Message event in PeopleTools
*  OnError releases prior to PeopleTools 8.48.

Each of the methods contained in these application classes is described in this section.

Routing Methods

Routing methods determine how a message is routed to or from PeopleSoft Integration Broker.

OnRouteSend Method

Implement the OnRouteSend method for outbound synchronous and asynchronous service operations to

specify to what node PeopleSoft Integration Broker routes a message. The implementation of this method
enables you to apply PeopleCode that filters the destination nodes to which PeopleSoft Integration Broker
routes messages.

Copyright © 1988, 2023, Oracle and/or its affiliates. 151



Sending and Receiving Messages Chapter 7

152

The OnRouteSend method is contained in the [Router application class, which is contained in the PS_PT
application package, in the Integration subpackage.

When the application PeopleCode is invoked to send a message, the routing definitions in the local
database provide a list of target nodes to which PeopleSoft Integration Broker can route the message.
The integration engine’s request handler invokes the service operation's OnRouteSend event. You can
implement the OnRouteSend method in the application package associated with the handler for this
service operation, which enables you to apply additional PeopleCode that determines the final target
nodes.

You can use OnRouteSend to validate the outbound service operation's target node list, prevent the
message from transmitting, or redirect it to a completely different set of targets.

The following table lists the PeopleCode built-in constants that you can use with the OnRouteSend
method:

Constant Description
%IntBroker ROUTE_NONE Do not send this operation to any of the possible nodes.
%IntBroker ROUTE_SOME Send this operation to a selected list of nodes. The node list

should be an array of strings in the property destinationNodes.

%IntBroker ROUTE ALL Send this operation to all nodes that have a valid routing.

OnRouteSend enables you to account for multiple synchronous targets. Only one target node at a time
can receive a request message sent with a synchronous transaction. Even though you can define the same
outbound synchronous transaction for multiple nodes, you must make sure the transaction resolves to a
single target node or the transaction fails.

The following code example shows an implementation of this class:

import PS PT:Integration:IRouter;

class RoutingHandler implements PS PT:Integration:IRouter
method RoutingHandler () ;
property array of any destinationNodes;
method OnRouteSend (& MSG As Message) Returns integer;
end-class;

/* constructor */
method RoutingHandler
end-method;

method OnRouteSend
/+ & MSG as Message +/
/+ Returns Integer +/
/+ Extends/implements PS PT:Integration:IRouter.OnRouteSend +/
/* Variable Declaration */
Local any &aNodelist;
Local any &rootNode;
Local any &xmlDoc;

/* Check the message for the instructions on how to execute
the OnRouteSend.*/

&xmlDoc = & MSG.GetXmlDoc () ;
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&rootNode = &xmlDoc.DocumentElement;
&aNodelList = &rootNode.GetElementsByTagName ("OnRouteSend") ;

If (&aNodelList.Len <> 1) Then

/* No Nodes are in the list, therefore exit. */
Exit;
Else

/* check the value of the node to determine the action to
take. */

Evaluate &aNodeList [1].NodeValue
When "True"
Return (%IntBroker_ROUTE_ALL);
Break;
When "False"
Return (%IntBroker_ROUTE_NONE);
Break;
When-Other

/* assume that this is to be routed to the node given */
Local array &nodeArray;

&nodeArray = CreateArray();

&nodeArray.Push (&aNodelList [1].NodeValue);

Local string &sIBVariableTest = GetCurrentType (&nodeArray) ;
Evaluate &sIBVariableTest
When "Array"
&destinationNodes = &nodeArray.Clone();
Return %IntBroker_ROUTE_SOME;
When "BooleanTrue"
Return %IntBroker_ROUTE_ALL;
When "BooleanFalse™
Return %IntBroker_ROUTE_NONE;
End-Evaluate;
Break;

End-Evaluate;
End-If;

end-method;

OnRouteReceive Method

Implement the OnRouteReceive method for inbound synchronous and asynchronous service operations to
apply PeopleCode that determines whether the default local node accepts inbound messages.

The OnRouteReceive method is contained in the IRouter application class, which is contained in the
PS_PT application package, in the Integration subpackage.

When the integration engine receives a message, the transaction definitions in the local database provide
a list of source nodes from which the application can accept the message. The integration engine’s request
handler invokes the service operation's OnRouteReceive event. You can implement the OnRouteReceive
method in the application package associated with the handler for this service operation, which enables
you to apply PeopleCode that determines whether the default local node accepts the inbound message.
You can employ this event regardless of the message transmission type.

The following is an example implementation of this method:

import PS PT:Integration:IRouter;
class RoutingHandler implements PS PT:Integration:IRouter

method RoutingHandler () ;
property array of any destinationNodes;
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method OnRouteReceive (& MSG As Message) Returns boolean;
end-class;

/* constructor */
method RoutingHandler
end-method;

method OnRouteReceive
/+ & MSG as Message +/
/+ Returns Boolean +/
/+ Extends/implements PS PT:Integration:IRouter.OnRouteReceive +/
/* Variable Declaration */
Local any &aNodelist;
Local any &rootNode;
Local any &xmlDoc;

/* Check the message for instructions on how to execute
the OnRouteReceive.*/

&xmlDoc = & MSG.GetXmlDoc () ;
&rootNode = &xmlDoc.DocumentElement;
&aNodelList = &rootNode.GetElementsByTagName ("OnRouteReceive") ;

If (&aNodelList.Len <> 1) Then

/* A single node must be present. */
Exit;
Else

/* check the value of the node to determine the action to
take. */

Evaluate &aNodeList [1].NodeValue
When "True"
Return ( True);
Break;
When "False"
Return ( False);
Break;
When-Other
/* don't recognize the value. */
Exit;
End-Evaluate;

End-If;

end-method;

Messaging Methods

This section describes methods used in messaging and the application classes in which they are contained.

Outbound Messaging Methods

This section describes methods used on outbound messages from PeopleSoft to other systems.
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OnRequestSend

Copyright © 1988, 2023, Oracle and/or its affiliates.

Implement for outbound synchronous and asynchronous
service operations to override connector properties before
sending a message to the integration gateway.

This method is contained in the ISend application class.

The OnRequestSend method passes in a message to your
derived application class method. The returned value needs to
be a message.

The following is an example implementation of this method.
import PS PT:Integration:ISend;
class SendHandler implements PS PT:Integ=

ration:ISend
method SendHandler () ;
method OnRequestSend (& MSG As Message=

)
Returns Message;
end-class;

/* constructor */
method SendHandler
end-method;

method OnRequestSend
/+ & MSG as Message +/
/+ Returns Message +/
/+ Extends/implements PS PT:Integrati=

on:ISend. +/
/+ OnRequest Send +/
/* Variable Declaration */
Local any &tempNode;
Local any &rootNode;
Local any &xmlDoc;
Local any é&msg;
&msg = & MSG;
&xmlDoc = &msg.GetXmlDoc () ;
/* Add a node to the doc to prove tha=

t we can
edit it in this event. */

&rootNode = &xmlDoc.DocumentElement;
&tempNode = &rootNode.AddElement ("OnS=

end") ;
&tempNode.NodeValue = "If you see thi>

s, then
the Sync OnSend PCode has altered the=

message";
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/* and write the data back into the m=>
essage */

&msg.SetXmlDoc (&xmlDoc) ;

Return (&msg);

end-method;

See Setting and Overriding Target Connector Properties at
Runtime.

When using the ISend handler with message parts, specifically
with rowset-based message parts, the rowsets of the parts must
be retrieved in the order that the content data will be sent.

The following is an example that can be used for ISend events
that use rowset-based parts (even for the cases where one is
just overriding the connectors):

method OnRequestSend
/+ &MSG as Message +/
/+ Returns Message +/
/+ Extends/implements PS PT:Integrati=

on:ISend. +/

/+ OnRequestSend +/

If (&MSG.IsPartsStructured) Then
Local number &i;
Local Rowset &rs;
For &1 = 1 To &MSG.PartCount

&rs = &MSG.GetPartRowset (&1) ;

End-For;

End-If;

Return &MSG;

end-method;
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Term Definition

OnAckReceive Implement for outbound asynchronous service operations to
access the body of a message acknowledgement to check for
SOAP faults.

This method is contained in the IReceiver application class.

The following is an example implementation of this method.
import PS PT:Integration:IReceiver;

class AckReceiveHandler implements PS PT=

Integration:IReceiver
method AckReceiveHandler () ;
method OnAckReceive(&_MSG As Message)>

Returns
integer;
end-class;

/* constructor */
method AckReceiveHandler
end-method;

method OnAckReceive

/+ & MSG as Message +/

/+ Returns Integer +/

/+ Extends/implements PS PT:Integrati=
on:+/

/+ IReceiver.OnAck Receive +/

/* Variable Declaration */

/*

/* We return a hardcoded value. In this =

case, a
message error.*/

Return (%Operation Error);

end-method;

See Handling Inbound Asynchronous Transactions.

Inbound Messaging Methods

This section describes methods used on inbound messages to PeopleSoft from other systems.
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OnRequest Implement for inbound synchronous service operations.

This method is contained in the IRequestHandler application
class.

The following is an example implementation of this method:

class RequestHandler implements PS PT:In=

tegration:
IRequestHandler
method RequestHandler () ;
method OnRequest (& MSG As Message) Re>

turns
Message;
end-class;

/* constructor */
method RequestHandler
end-method;

method OnRequest

/+ & MSG as Message +/

/+ Returns Message +/

/+ Extends/implements PS PT:Integrati=
on:+/

/+ IRequestHandler.OnRequest +/

/* Variable Declaration */

Local any &tempNode;

Local any &descNode;

Local any &rootNode;

Local any &xmlDoc;

Local any &xmldata;

Local any &msg;

&msg = CreateMessage (Operation.QE IB =
SYNC RESP, ¥IntBroker response);

&xmldata = "<?xml version='1.0'?>
<QE_IB_PeopleCode_Test=/>";

&xmlDoc = CreateXmlDoc (&xmldata) ;
&rootNode = &xmlDoc.documentelement;
&descNode = &rootNode.AddElement ("Des=>

cription");
&descNode.NodeValue = "Sync test of 0=

nRouteSend.";
&tempNode = &rootNode.addelement ("OnR=>

equest") ;
&tempNode.NodeValue = "If you see thi=

Sy
then the On Request PCode created the=

response
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message";
&msg.SetXmlDoc (&xmlDoc) ;
Return &msg;
OnNotify Implement for inbound asynchronous service operations. This

method can be used for code that does subscription processing,
and for validating and loading message data.

This method is contained in the INotificationHandler
application class.

The following is an example implementation of this method:

import PS PT:Integration:INotificationHa=
ndler;
class NotificationHandler implements PS =

PT:Integration:
INotificationHandler
method NotificationHandler () ;
method OnNotify (& MSG As Message);
end-class;

/* constructor */
method NotificationHandler
end-method;

method OnNotify
/+ & MSG as Message +/
/+ Extends/implements PS PT:Integrati=

on: +/
/+ INotificationHandler.OnNotify +/
/* Variable Declaration */
Local Rowset é&rs;

&rs = &MSG.GetRowset () ;

/* process data from rowset */
end-method;
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Term Definition
OnResponse Implement for inbound response asynchronous service
operations.

This method can be used for code that does response
subscription processing. This method is contained in the
INotificationHandler application class.

The following is an example implementation of this method
and shows how to get the request TransactionID.

import PS PT:Integration:INotificationHa=
ndler;
class RESPONSE NOTIFICATION implements P=
S PT:

Integration:INotificationHandler
method RESPONSE NOTIFICATION() ;

method OnNotify (&MSG As Message) ;
end-class;
/* constructor */
method RESPONSE NOTIFICATION

$Super = create PS PT:Integration:INo=>

tificationHandler () ;
end-method;

method OnNotify
/+ &MSG as Message +/
/+ Extends/implements PS PT:Integrati=

on:+/
/+ INotification Handler.OnNotify +/

Local Rowset &rs;

Local boolean &Ret;

Local string &TransactionID;

&rs = &MSG.GetRowset () ;

If &MSG.IsSourceNodeExternal Then

/* if the request came from an ext=

ernal non
PeopleSoft System then you can g=

et the
original TransactionID from the =

WSA MessagelD
from the request message. */

&TransactionID = &MSG.IBInfo.WSA M=
essagelD;

Else

/* if the request came from a Peop=>
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Term Definition

leSoft
System then get the original Tr=

ansactionID
from the nReplyToID */

&TransactionID = &MSG.IBInfo.InRep=>
1yToID;
End-If;

end-method;

Error-Handling Methods

Each application class contained in the Integration application subpackage contains an OnError method
that you can use for custom error handling.

Custom error handling can include sending an email notification or entering data in a log when an error
occurs.

For the IRequestHandler application class, the OnError function returns a string. This enables you to send
back custom error messages, for example SOAP faults, to non-PeopleSoft consumers. If the message
consumed was a SOAP message and the custom error message is already wrapped in SOAP, it will not
be modified and is sent as-is. However, if the OnError message is not SOAP, it is wrapped as a standard
SOAP fault and returned to the sender.

If the message consumer is another PeopleSoft system the message set/message ID framework applies.

If an error occurs the OnError method, if implemented, is automatically invoked. The type of exception
can be viewed by using the Message object to retrieve an Exception object populated with information
about the error, using the message class IBException property.

The following is an example of the OnError method implementation:

/*On Error Implementation */
method OnError
/+ &MSG as Message +/
/+ Returns String +/
/+ Extends/implements PS PT:Integration:IRequestHandler.OnError +/
Local integer &nMsgNumber, &nMsgSetNumber;
Local string &sText;

&nMsgNumber = &MSG.IBException.MessageNumber;
&nMsgSetNumber = &MSG.IBException.MessageSetNumber;

rem &sText = &exception.DefaultText;
&sText = &MSG.IBException.ToString();

/* ADD SPECIFIC ERROR INFO HERE */
Return &sText;

end-method;
See “Understanding Exception Class” (PeopleCode API Reference).

See “IBException” (PeopleCode API Reference).
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Messaging PeopleCode

Messaging PeopleCode enables you to manipulate message content. The messaging PeopleCode classes
you can use for this are:

Term Definition

Message classes Use for rowset or nonrowset-based messages.
SOAPDoc class Use for SOAP-compliant messages.
XMLDoc classes Use for XML messages.

Document class Use for Document type messages.

XML and SOAP-compliant messages are nonrowset-based messages. You can use their respective classes
to manipulate message content, or use the Message classes.

Related Links

Using Message Object Functionality With Nonrowset-Based Messages
“Understanding XmlDoc Classes” (PeopleCode API Reference)
“Understanding theSOAPDoc Class” (PeopleCode API Reference)
“Understanding Message Classes” (PeopleCode API Reference)

Document PeopleCode

PeopleSoft provides a Document API for populating and retrieving document data that includes several
built-in functions and classes.

The built-in functions are:

Term Definition
CreateDocument Use this built-in function to instantiate a Document object.
CreateDocumentKey Use this built-in function to instantiate a Document Key object

The classes are:
*  Document class.

Use the methods and properties in this class to populate and retrieve document data.
*  DocumentKey class.

Use the methods and properties in this class to create document keys.
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Document keys enable you to map the document package, document name, and document version, to
one string. As a result, when you populate or retrieve data from a document, you can specify the one
document key, instead of specifying the document package, name, and version.

populating or retrieving data from a document, you can use the one document key
e  Primitive class.

Use the methods and properties in this class to populate and retrieve document data from primitive
elements.

* Compound class.

Use the methods and properties in this class to populate and retrieve document data from compound
elements.

¢ Collection class.

Use the methods and properties in this class to populate and retrieve document data from collection
elements.

The Document API is discussed in the product documentation for PeopleCode API Reference.

Examples of populating and retrieving document data are provided elsewhere in this topic.

Generating and Sending Messages

This section provides an overview of outbound messaging and discusses how to:
* Handle outbound asynchronous message transmission.

* Handle outbound asynchronous request/response message transmission.

* Handle outbound synchronous message transmission.

» Read exceptions for outbound synchronous integrations.

» Handle cookies in messages.

Understanding Outbound Messaging

Successful outbound messaging relies on sending messages in the proper order and on testing the
messages. Messages containing non-XML data have special considerations.

Message Order

PeopleSoft Integration Broker guarantees that messages are delivered in the order in which you send them
and that they are single-threaded at the PeopleSoft receiving node. However, message order is not part of
the queue definition. You must send messages in the proper order.

Note: You can modify this behavior by using queue partitioning.
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See Applying Queue Partitioning.

Message Testing
Make sure that you adequately unit-test and system-test your messages.

Unit-test a message by triggering the PeopleCode that sends the message and then view the message
details in Service Operations Monitor. From the Service Operations Monitor, you can view the contents of
each field to verify that the message data is formatted correctly.

See the product documentation for Integration Broker Service Operations Monitor.

You can also test handler code using the Handler Tester utility. See the product documentation for
Integration Broker Testing Utilities and Tools for more information.

Message Class Outbound PeopleCode

Use the record class SelectByKey method whenever possible to get data that isn’t in the component
buffer.

If the record names are the same, use the standard record methods, such as SelectByKey, Insert, and
Update, on the message records.

There are no automatic checks for message size. You must do it programmatically. Use the following code
at level 0 to control message size when dealing with multiple transactions:

If &Msg.Size > %MaxMessageSize

Note: The OnRouteSend method enables you to apply PeopleCode that filters the destination nodes.

See “Understanding Record Class” (PeopleCode API Reference).

Non-XML Data

If you’re generating a non-XML outbound message, it’s up to you to insert the message content into a
special XML section containing a CDATA tag:

<xml psnonxml="yes">
<! [CDATA [nonXML message datal]>

Outbound Messaging and Global Variables

When you invoke a SyncRequest method the system clears any declared global variables after
OnRouteSend or OnSend PeopleCode events are fired. If a component attempts to access any of the
global variables after the SyncRequest method, a context error occurs.

OnRouteSend and OnSend events are primarily used for asynchronous messaging, however they can be
use for synchronous messages.

To avoid context errors when using OnRouteSend or OnSend events for synchronous messaging,
following these guidelines:

1. Do not use global variables.
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2. If you must use global variables, save them as temporary variables prior to executing a SyncRequest
event, then after the event is fired re-assign them back to the globals.

3. Run OnRouteSend or OnSend logic prior to the SyncRequest and after the node is obtained use
sender-specific routing. In sender-specific routing you pass the node as part of the SyncRequest call.
This will send the request to the node as long as there is an active routing. Any connector overrides
can be performed prior to the SyncRequest call and set on the message.

ling Outbound Asynchronous Message Transmission
To send a message asynchronously, use the IntBroker class Publish method in:

* A record field PeopleCode event.

* A component PeopleCode event.

When publishing from a component, publish messages only from the SavePostChange event, using
the deferred mode property.

* An Application Engine program.
* An implementation of the OnNotify method.
* An implementation of the OnRequest method .

The OnRequest service operation event is triggered only when an inbound transaction occurs.
However, when the receiving PeopleCode runs, the program can also send messages.

Message Class Outbound Asynchronous Example

The following example uses the Publish method in the PeopleCode IntBroker class:

Local Message &MSG;
Local Rowset &SALES ORDER, &RS;

/*Get a pointer to the component buffer rowset */

&SALES ORDER = GetLevelO();
/*Create an instance of the SALES ORDER_ASYNC message object */
&MSG = CreateMessage (OPERATION.SALES ORDER ASYNC) ;
/*Copy the rows from the rowset to the message object */
&MSG.CopyRowset (&SALES ORDER) ;

/*Send the message */
$IntBroker.Publish (&MSG) ;

XmlIDoc Class Outbound Asynchronous Example

The following example uses the Publish method:

Local XmlDoc &xmlRequestDoc;
Local Message &MSG;

/*Create an XmlDoc Object */
&xmlRequestDoc = CreateXmlDoc () ;

/* Parse a URL or input XML file into an XmlDoc */

&bool = &xmlRequestDoc.ParseXmlFrom URL ("C:\pt\appserv\files\
input.xml") ;
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/* Populate message with XML data */
&MSG = CreateMessage (OPERATION.XmlRequest) ;

&MSG.SetXmlDoc (&xmlRequestDoc) ;
/* Sent request */

$IntBroker.Publish (&MSG) ;

Identifying SOAP Faults

You can implement the OnAckReceive method to access IBInfo data. This enables you to read the content
of acknowledgements returned by recipient systems of asynchronous SOAP messages. The ability to
access acknowledgement content is useful when sending SOAP messages, since although there may be no
HTTP protocol errors while sending them, SOAP faults may occur.

If the message is nonrowset-based, use the message class GetXmlDoc method to get the response data.
This returns an XmlDoc object.

If the message is rowset-based, use the message class GenXMLString method to get the response data.
This returns a string object which you can load into an XmlDoc object.

If SOAP faults are found, you can set the status equal to Error so that the errors appear in the Service
Operations Monitor for the publication contract.

The following code example shows how to use GetXmlDoc and GenXMLString in an implementation
of the OnAckReceive method. Valid status overrides are %Operation_Done, %Operation_Error, and
%Operation_Retry:

import PS PT:Integration:IReceiver;

class AckReceiveHandler implements PS PT:Integration:IReceiver
method AckReceiveHandler () ;
method OnAckReceive (& MSG As Message) Returns integer;
end-class;

/* constructor */
method AckReceiveHandler
end-method;
method OnAckReceive
/+ & MSG as Message +/
/+ Returns Integer +/
/+ Extends/implements PS PT:Integration:IReceiver.OnAckReceive +/
/* Variable Declaration */
If &MSG.IsStructure Then

/* 1if message is rowset-based */
&str = &MSG.GenXMLString() ;

Else

/* if message is nonrowset-based */
&xmldoc = &MSG.GetXmlDoc () ;

End-If;

Return (%Operation Done);

end-method;

You can also implement the OnAckReceive method to read response content data returned from third-
party systems when using the HTTP target connector.
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Related Links
“Understanding XmlIDoc Classes” (PeopleCode API Reference)

Handling Outbound Asynchronous Request/Response Message
Transmission

To transmit an outbound asynchronous request/response message, send the message asynchronously using
the Publish method.

See Handling Outbound Asynchronous Message Transmission.

Handling Outbound Synchronous Transactions

Use the IntBroker class SyncRequest method for handling outbound synchronous transfers. To send a
message synchronously, you can employ SyncRequest in:

e The record field SavePreChange PeopleCode event.
* The record field SavePostChange PeopleCode event.
* The record field Workflow PeopleCode event.

e The record field FieldChange PeopleCode event.

* An implementation of the OnRequest method.

* An implementation of the OnNotify method.

Note: The OnRequest and OnNotify events are triggered only when an inbound transaction occurs,
however, when the receiving PeopleCode runs, it can also send messages.

The response message that is returned from an outbound synchronous transaction is no different from an
inbound request message. Once you have it in a Message, XmlDoc, or SoapDoc object, it has the same
properties as any other object of that type and can, therefore, be treated exactly the same way.

See Receiving and Processing Messages.

Message Class Outbound Synchronous Example 1

The following example uses the IntBroker class SyncRequest method:

Local Message &MSG, &response;
Local Rowset &SALES ORDER;

&SALES ORDER = GetLevelO();
&MSG = CreateMessage (OPERATION.SALES ORDER SYNC) ;
&MSG.CopyRowsetDelta (&§SALES ORDER) ;

/* send the synchronous request; the return value is the response
message object */
&response = $IntBroker.SyncRequest (&MSG) ;

/* check the response status; 0 means OK */
If (&response.ResponseStatus = 0) Then
/* process the response */
MY SALES ORDER SYNC.ORDER ID = &response.GetRowset () .GetRow (1)

.GetRecord (Record.SO RESPONSE) .GetField(Field.ORDER ID) .Value);
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else
/* do error handling */

End-If;

Message Class Outbound Synchronous Example 2

Chapter 7

The following example shows the use of CopyTo to get the data back from the response and into the

component buffer, and therefore the page:

Local Message &msgZipRequest, &msgZipResponse;
Local Rowset &RS, &rsMessageRowset;

&RS = GetLevelO();

&msgZipRequest = CreateMessage (OPERATION.ZIP REQUEST) ;
&msgZipRequest.CopyRowset (&RS) ;

/* send the synchronous request; the return value is the response
message object */

&msgZipResponse = $IntBroker.SyncRequest (&msgZipRequest,
Node.ZIPTOCITYANDSTATE) ;

/* check the response status; 0 means OK */
If (&msgZipResponse.ResponseStatus = 0) Then
/* process the response */
&rsMessageRowset = &msgZipResponse.GetRowset () ;
&rsMessageRowset.CopyTo (&RS) ;
else
/* do error handling */
End-If;

XmlIDoc Class Outbound Synchronous Example

The following example uses the IntBroker class SyncRequest method:

Local Message &MSG, &RESP MSG;
Local XmlDoc &flightplan xmldoc, &xmldocReturn;
Local XmlNode &ac number, &msi_ sensor, &ofp;

&flightplan xmldoc = CreateXmlDoc ("");

&ac_number = &flightplan xmldoc.CreateDocumentElement ("flightplan");

&msi sensor = &ac_number.AddElement ("msi sensor");
&msi_ sensor.NodeValue = "flir";

&ofp = &ac number.AddElement ("ofp");

&ofp.NodeValue = "8.44";

&MSG = CreateMessage (Message.SYNC REQUEST EXAMPLE) ;
&MSG.SetXmlDoc (&flightplan xmldoc) ;

&RESP MSG = &MSG.SyncRequest () ;

&xmldocReturn = &RESP MSG.GetXmlDoc () ;

&return data = &xmldocReturn.GenXmlString();

Related Links
“Understanding XmlDoc Classes” (PeopleCode API Reference)
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Reading Exceptions for Outbound Synchronous Integrations

The Routing — Routings Definition page features a User Exception check box that enables you to capture
Integration Broker exceptions for outbound synchronous integrations using PeopleCode.

Note: Do not use Try/Catch PeopleCode to attempt to read exceptions on outbound SyncRequest calls.

The following code example shows how to read captured exceptions:

&Return MSG = %IntBroker.SyncRequest (&MSG) ;
If &Return MSG.ResponseStatus = $IB Status Success Then

/* process the response message */
&RS = &MSG.GetPartRowset () ;

Else

/* evauate the error and either throw a PeopleCode exception or continue proces=

sing */
&error string = &Return MSG.IBException.ToString());
&nErrorMsgNumber = &Return MSG.IBException.MessageNumber;
&nErrorMsgSetNumber = &Return MSG.IBException.MessageSetNumber;

End-If;

Related Links
Defining General Routing Information

Overriding Synchronous Timeout Intervals at Runtime

For long-running outbound synchronous transactions, you can override the default timeout period the
transaction at runtime using the SyncServiceTimeout property. The default synchronous timeout period is
five minutes.

The HTTP header file is modified to take this parameter. The value you set is sent to the integration
gateway where it is used for the HTTP timeout.

The SyncServiceTimeout property takes a time (in seconds). The property is read-write.

The following code example shows how to use the property. To use this property, note that you must
override and setup the target connector properties for the transaction. As the example demonstrates, there
are helper methods that load properties based on node or transaction.

&MSG.SetXmlDoc (&xmlReq) ;
&MSG.IBInfo.LoadConnectorPropFromNode (Node.EATI) ;
&MSG.IBInfo.SyncServiceTimeout = 360000;
&MSG.IBInfo.ConnectorOverride = True;

&MSG Resp = SIntBroker.SyncRequest (&MSG, Node.EAT);
&xmlResponseDoc = &MSG Resp.GetXmlDoc () ;

Related Links

Setting and Overriding Target Connector Properties at Runtime

Copyright © 1988, 2023, Oracle and/or its affiliates. 169



Sending and Receiving Messages Chapter 7

Handling Cookies

PeopleSoft Integration Broker provides basic cookie handling for exchanges that are initiated by your
PeopleSoft application. You can accept a synchronous response message containing cookies, save those
cookies in a global variable, and later return them to the remote node in an outbound synchronous or
asynchronous request message. This is a typical application of cookies in a web interaction.

Cookies are implemented as an IBInfo class property, Cookies. You can access this property only in an
inbound synchronous response message or an outbound request message.

Receiving Cookies Example

The following example retains the cookies from a response message to a global variable:

Local Message &SalesRequest, &SalesResponse;
Local Rowset &SALES ORDER;
Global string &SalesCookies;

&SALES ORDER = GetLevelO();
&SalesRequest = CreateMessage(OPERATION.SALES_ORDER_SYNC);
&SalesRequest.CopyRowsetDelta (&SALES ORDER) ;

/* Send the synchronous request; the return value is the response
message object */
&SalesResponse = %$IntBroker.SyncRequest (&SalesRequest) ;

/* Retrieve cookies from the response message */
&SalesCookies = &SalesResponse.IBInfo.IBConnectorInfo.Cookies;

Returning Cookies Example

The following example retrieves the previously retained cookies from the global variable and inserts them
into a new request message:

Local Message &SalesRequest, &SalesResponse;
Local Rowset &SALES ORDER;
Global string &SalesCookies;

&SALES ORDER = GetLevelO();
&SalesRequest = CreateMessage (OPERATION.SALES ORDER SYNC) ;
&SalesRequest.CopyRowsetDelta (&SALES ORDER) ;

/* Insert the cookies in the request message */
&SalesRequest.IBInfo.IBConnectorInfo.Cookies = &SalesCookies;

/* Send the asynchronous request */
%$IntBroker.Publish (&SalesRequest) ;

Setting and Overriding Target Connector Properties at Runtime

170

PeopleSoft Integration Broker enables you to dynamically override target connector properties at runtime
that have previously been set at the node, connector and transaction levels. To set or override target
connectors at runtime, use the PeopleCode IBInfo object, the Connector Info object and implement the
OnRequestSend method.

Note: Properties set at the PeopleCode level take precedence over those set at the node, connector and
routing level.
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Field or Control Description

IBInfo object An IBInfo object is instantiated from a message object.

You can use this object in publishing or synchronous request
PeopleCode. You can also use it in your implementation of the
OnRequestSend method.

ConnectorInfo object A ConnectorInfo object is instantiated from an IBInfo object.
Use this object for reading and writing connector name/value
pair information to and from the IBRequest.

You can use this object in publishing or synchronous request
PeopleCode. You can also use it in your implementation of the
OnRequestSend method.

OnRequestSend Method The OnRequestSend method is included in the ISend
application class. Use your implementation of this method
to override target connector properties at runtime for a
subscribing node transaction.

This event associated with the service operation executes
before any transformations are processed.

You can use this event for asynchronous and synchronous
messages.

Since data is always carried with the message, you can use the IBInfo object, ConnectorInfo object and
your implementation of the OnRequestSend method to populate connector information in the publishing
PeopleCode and then override it for a specific node.

Setting and Overriding Target Connector Properties Using the OnRequestSend
Method

You can use implement the OnRequestSend method to override IBInfo and connector properties at
runtime for a subscribing node transaction.

Any content data that is changed on the message or XMLDoc is sent to the subscribing node or used
within a transformation.

To override the properties of a target connector, you must set the following statement to true:
&MSG.IBInfo.ConnectorOverride=true

If a publication contract fails as a result of using an implementation of the OnRequestSend method to
override connector properties at runtime, correct the PeopleCode in your implementation and resubmit the
message.

Example: Setting Target Connector Properties Using the OnRequestSend Method

The following example shows loading all connectors that exist for the node and adding one additional
property, FileName.

import PS PT:Integration:ISend;
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class SendHandler implements PS PT:Integration:ISend
method SendHandler();
method OnRequestSend (&Msg As Message) Returns Message;
end-class;

/* constructor */
method SendHandler
end-method;

method OnRequestSend
/+ &MSG as Message +/
/+ Returns Message +/
/+ Extends/implements PS PT:Integration:ISend.OnRequestSend +/
/* Variable Declaration */
Local Any &Bo;
Local Message &Msg;

&Bo

&MSG.IBInfo.LoadConnectorPropFromNode ("nodename") ;

&Bo = &MSG.IBInfo.IBConnectorInfo.AddConnectorProperties
("FileName", "temp", $%Property);
&MSG.IBInfo.ConnectorOverride = True;

Return (&Msg);

end-method;

Example: Overriding Connector Properties Using the OnRequestSend Method

The following example demonstrates overriding target connector properties using an implementation of
the OnRequestSend method for a rowset-based asynchronous message.

import PS PT:Integration:ISend;

class SendHandler implements PS PT:Integration:ISend
method SendHandler () ;
method OnRequestSend (&Msg As Message) Returns Message;
end-class;

/* constructor */
method SendHandler
end-method;

method OnRequestSend
/+ &MSG as Message +/
/+ Returns Message +/
/+ Extends/implements PS PT:Integration:ISend.OnRequestSend +/
/* Variable Declaration */
Local Boolean &bRet;

&bRet= &MSG.IBInfo.LoadConnectorProp ("FILEOUTPUT") ;

&MSG.IBInfo.ConnectorOverride = True;
&bRet= &MSG.IBInfo.IBConnectorInfo.AddConnectorProperties
("sendUncompressed", "Y", %Header);

&bRet= &MSG.IBInfo.IBConnectorInfo.AddConnectorProperties
("FilePath", "c:\temp", %$Property);

Return (&Msg);

End-Method;

The following example demonstrates overriding target connector properties using an implementation of
the OnRequestSend method for a nonrowset-based asynchronous message.

import PS PT:Integration:ISend;

class SendHandler implements PS PT:Integration:ISend
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method SendHandler () ;
method OnRequestSend (&Msg As Message) Returns Message;
end-class;

/* constructor */
method SendHandler
end-method;

method OnRequestSend
/+ &MSG as Message +/
/+ Returns Message +/
/+ Extends/implements PS PT:Integration:ISend.OnRequestSend +/
/* Variable Declaration */

Local XmlDoc &xmldoc;

Local Boolean &bRet;

// if you have to access the content data for content based
// decisions, do this
&xmldoc = &MSG.GetXmlDoc () ;

&bRet= &MSG.IBInfo.LoadConnectorProp ("FILEOUTPUT") ;

&MSG.IBInfo.ConnectorOverride = True;

&bRet= &MSG.IBInfo.IBConnectorInfo.AddConnectorProperties
("sendUncompressed", "Y", S%$Header);

&bRet= &MSG.IBInfo.IBConnectorInfo.AddConnectorProperties
("FilePath", "c:\temp", $%$Property);

Return (&MSG) ;

End-Method;

Related Links

“IBInfo Class” (PeopleCode API Reference)

“IBConnectorInfo Collection” (PeopleCode API Reference)
“Understanding Message Classes” (PeopleCode API Reference)

Receiving and Processing Messages

Hand

This section discusses how to:

* Handle inbound asynchronous transactions.

* Handle inbound asynchronous request/response transactions.
* Handle inbound synchronous transactions.

* Simulate receiving messages from external nodes.

Note: The OnRouteReceive method can be implemented to apply PeopleCode that determines whether
the default local node accepts the inbound message.

ling Inbound Asynchronous Transactions

Implement the OnNotify method in the PS_PT application package, in the Integration sub-package,
to handle inbound asynchronous transactions. All the examples in this section are assumed to be
implementations of the OnNotify method.
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Message Class Inbound Asynchronous Example 1

The following example implements the OnNotify method.

import PS PT:Integration:INotificationHandler;

class FLIGHTPROFILE implements PS PT:Integration:INotificationHandler
method FLIGHTPROFILE () ;
method OnNotify (& MSG As Message);

end-class;

/* constructor */
method FLIGHTPROFILE
end-method;

method OnNotify
/+ & MSG as Message +/
/+ Extends/implements PS PT:Integration:INotificationHandler.+/
/+ OnNotify +/
/* Variable Declaration */
Local any &outstring;
Local any &i;
Local any &CRLF;

Local Message &MSG;
Local Rowset &rs, &rsl;
Local Record &FLIGHTDATA, &REC;

Local string &acnumber value, &msi sensor value, &ofp value,
&actype value, &callsign value, &squadron value, &comml value,
&comm2 value, &ecm value;

Local XmlDoc é&xmldoc;
Local string &return string value;
Local boolean &return bool value;

&CRLF = Char(13) | Char(10);
&MSG = & MSG;

&rs = &MSG.GetRowset () ;
&REC = &rs(l).QE_FLIGHTDATA;

&FLIGHTDATA = CreateRecord(Record.QE FLIGHTDATA);
&REC.CopyFieldsTo (&FLIGHTDATA) ;

/* Parse out Message Data */

&acnumber value = &FLIGHTDATA.QE ACNUMBER.Value;
&msi sensor value = &FLIGHTDATA.QE MSI SENSOR.Value;
&ofp_value = &FLIGHTDATA.QE_OFP.Value;

&actypeivalue = &FLIGHTDATA.QEiACTYPE.Value;
&callsign_value = &FLIGHTDATA.QE CALLSIGN.Value;
&squadron value = &FLIGHTDATA.QE SQUADRON.Value;
&comml_value = &FLIGHTDATA.QE_COMMI.Value;

&comm2 value = &FLIGHTDATA.QE COMM2.Value;

&ecm value = &FLIGHTDATA.QE ECM.Value;

&outstring = "Send Async FLight test";

/* Construct Output String */

&outstring = &outstring | &acnumber value | &CRLF |

&msi sensor value |

&CRLF | &ofp value | &CRLF | &actype value | &CRLF |
&callsign value |

&CRLF | &squadron value | &CRLF | &comml value | &CRLF |
&comm?2 value |

&CRLF | &ecm value;

/* Log Output String into page record */
&FLIGHTDATA.GetField (Field.DESCRLONG) .Value = &outstring;
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SQLExec ("DELETE FROM PS QE FLIGHTDATA");
&FLIGHTDATA.Insert ();

end-method;

Message Class Inbound Asynchronous Example 2

The following example shows notification PeopleCode that checks the PSCAMA to determine the audit
action code and that examines the language code to determine whether related language processing is
needed:

method OnNotify
/+ &MSG as Message +/

/* Simple PeopleCode Notifcation- - Check the PSCAMA*/

Local Rowset &MSG RS;

Local Record &REC_NAME PREFIX, &REC, &REC RL;

Local integer &I;

Local string &ACTION, &LNG, &BASE LNG, &RELLNG, &KEY1, &KEY2;

&MSG RS = &MSG.GetRowset () ;
For &I = 1 To &MSG_RS.RowCount /* Loop through all transactions */
&REC = &MSG RS.GetRow (&I) .GetRecord(Record.NAME PREFIX TBL);
/* Get Audit Action for this transaction */
&ACTION = &MSG RS.GetRow (&I) .PSCAMA.AUDIT ACTN.Value;
/* Get Language code for this transaction */
&LNG = &MSG RS.GetRow (&I) .PSCAMA.LANGUAGE CD.Value;
&BASE LNG = $Language;

Evaluate &ACTION /*****************************/

/******** Add a Record *******/
/*****************************/

When "A"
/* Add the base language record */
&REC NAME PREFIX = CreateRecord(Record.NAME PREFIX TBL) ;
&REC.COpyFieldsTo(&RECiNAMEiPREFIX);
&REC NAME PREFIX.ExecuteEdits();
If &REC NAME PREFIX.IsEditError Then
/* error handling */

Else

&REC NAME PREFIX.Insert();

/* Need error handling here if insert fails */

If &LNG <> %Language Then
/* add related language record */
&RELLNG = &REC.RellLangRecName;
&REC RL = CreateRecord(Record.NAME PREFIX LNG) ;
&REC.CopyFieldsTo (&REC_RL) ;
&REC RL.LANGUAGE CD.Value = &LNG;
&REC RL.Insert();

/* Need error handling here if insert fails */
End-If;
End-If;

/*****************************/

[ x kxR x Change a Record * kK kok kK
JH KKKk Kk Kk ok Kk kkkkkkkkkk Xk kkkk [

/**** Using record objects ***/

When "C"
/* Get the Record - insert it */
&KEY1 = &REC.GetField(Field.NAME_PREFIX).Value;
&REC NAME PREFIX = CreateRecord(Record.NAME PREFIX TBL);

&REC _NAME PREFIX.NAME PREFIX.Value = &REC.GetField(Field.
NAME PREFIX) .Value;
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If &REC NAME PREFIX.SelectByKey () Then

&REC.CopyFieldsTo (§REC NAME PREFIX) ;
&REC _NAME PREFIX.ExecuteEdits();
If &REC NAME PREFIX.IsEditError Then
/* error handling */
Else
&REC _NAME PREFIX.Update() ;
End-If;

Else
&REC.CopyFieldsTo (§REC NAME PREFIX) ;
&REC _NAME PREFIX.ExecuteEdits();

If &REC NAME PREFIX.IsEditError Then
/* error handling */
Else
&REC NAME PREFIX.Insert();
End-If;
End-If;

/*****************************/

/***x*** Delete a Record ***x*x*x/
/*****************************/

/*** USing SQLEXeC ***********/

When "D"
/* Get the Record using SQLExec- error */
SKEY1 = &REC.GetField(Field.NAME_PREFIX).Value;
SQLExec ("Select NAME PREFIX from PS NAME PREFIX TBL where
NAME PREFIX = 21" &KEYI1, &KEY2) ;
If None (&KEY2) Then
/* Send to error log */

Else
SQLExec ("Delete from PS NAME PREFIX TBL where
NAME_PREFIX = :1", &KEY1);

SQLExec ("Delete from PS NAME PREFIX LNG where
NAME PREFIX = :1", &KEY1);
End-If;
End-Evaluate;
End-For;

end-method;

Message Class Inbound Asynchronous Example 3

There’s a practical limit to how large a message can be, and this can be controlled by a system-wide
variable called %oMaxMessageSize. The system administrator can change this size in the PSOPTIONS
settings. This size can be set only for all messages, not for individual definitions.

PeopleCode that populates a Message object should include code that is similar to the following example
to check the message size before inserting a new Level 0 row.

Note: Always code the %MaxMessageSize checkpoint at the Level 0 record. A batch of transactions can
be split across multiple messages, but do not split a single transaction (logical unit of work) into multiple
messages.

Local SQL &hdr sqgl, &ln sql;

Local Message &MSG;

Local Rowset &hdr rs, &ln rs;

Local Record &hdr rec, &ln rec, &hdr rec msg, &ln rec msg;

/* This PeopleCode will publish messages for a simple Header/
Line record combination. Multiple Header/Lines are copied to the
message until the $MaxMessageSize is exceeded at which point a
new message is built. This references MSR HDR INV (Header) and
DEMAND INF INV (Line) records */
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/* Create an instance of the STOCK REQUEST message */
&MSG = CreateMessage (OPERATION.STOCK REQUEST) ;

/* Create an App. Message Rowset that includes the
MSR_HDR_INV (Header) and DEMAND INF INV (Line)*/
&¢hdr rs = &MSG.GetRowset () ;
/* Create a SQL object to select the Header rows */
&¢hdr sqgl = CreateSQL("Select * from PS MSR HDR INV
WHERE BUSINESS_UNIT:'MO4Z—\1'
AND ORDER NO LIKE 'Z%' ORDER BY BUSINESS UNIT,ORDER NO");
&I = 1;

/* Create record objects for the Header and Lines */
&ln rec = CreateRecord(Record.DEMAND INF INV);
&hdr rec = CreateRecord(Record.MSR HDR INV);

/* Loop through each Header row that is fetched */
While &hdr sqgl.Fetch (&hdr rec)
/* Publish the message if its size exceeds the MaxMessageSize
/* specified in Utilities/Use/PeopleTools Options */
If &MSG.Size > %MaxMessageSize Then
$IntBroker.Publish (&MSG) ;
&I = 1;
/* Create a new instance of the message object */
&MSG = CreateMessage(OPERATION.STOCK_REQUEST);
&hdr rs = &MSG.GetRowset () ;
End-If;
If &I > 1 Then
&¢hdr rs.InsertRow (&I - 1);
End-If;
/* Instantiate the row within the Header portion of the
App Message rowset to which data will be copied */
&¢hdr rec msg = &hdr rs.GetRow (&I).GetRecord(Record.MSR HDR INV) ;
/* Copy data into the level 0 (Header portion) of
/* &MSG message structure */
&¢hdr rec.CopyFieldsTo (&hdr rec msg);

/* Publish the last message if it has been changed*/
If &hdr rec msg.IsChanged Then
$IntBroker.Publish (&MSG) ;
End-If;
End-While;

Message Class Inbound Asynchronous Example 4

The following code example shows how to get data out of the IBInfo object for a rowset-based message.

Local Rowset é&rs, &rsl;
Local Record &FLIGHTDATA, &REC;

Local string &acnumber value, &msi sensor value, &ofp value,
&actype value, é&callsign value, &squadron value, &comml value,
&comm2 value, &ecm value, &datetime;

Local XmlDoc é&xmldoc;

Local string &data;

Local boolean é&return bool value;

&CRLF = Char (13) | Char(10);
/* this is how one would access data from IBinfo and
/* IBConnectorInfo objects*/

&return bool value = &MSG.IBInfo.ConnectorOverride;

For &1 = 1 To &MSG.IBInfo.IBConnectorInfo.GetNumberOfConnector
Properties ()

&data = &MSG.IBInfo.IBConnectorInfo.GetQueryStringArgName (&1) ;
&data = &MSG.IBInfo.IBConnectorInfo.GetQueryStringArgValue (&i);
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End-For;

&MSG.IBInfo.IBConnectorInfo.ClearConnectorProperties();

&data
&data
&data
&data
&data

For &i

&data

= &MSG.IBInfo.IBConnectorInfo.ConnectorName;

= &MSG.IBInfo.IBConnectorInfo.ConnectorClassName;
= &MSG.IBInfo.IBConnectorInfo.RemoteFrameworkURL;
= &MSG.IBInfo.IBConnectorInfo.PathInfo;

= &MSG.IBInfo.IBConnectorInfo.Cookies;

= 1 To &MSG.IBInfo.IBConnectorInfo.GetNumberOfQueryStringArgs ()

&MSG.IBInfo.IBConnectorInfo.GetConnectorPropertiesName (&1i) ;

&data = &MSG.IBInfo.IBConnectorInfo.GetConnectorPropertiesValue

(

&data

&i) ;

&MSG.IBInfo.IBConnectorInfo.GetConnectorPropertiesType (&1i) ;

End-For;

&MSG.IBInfo.IBConnectorInfo.ClearQueryStringArgs () ;

&data
&data
&data
&data
&data
&data
&data
&data
&data
&data
&data
&data
&data

/* get
&rs =
&REC =

= &MSG.IBInfo.MessageType;

= &MSG.IBInfo.RequestingNodeName;
= &MSG.IBInfo.OrigUser;

= &MSG.IBInfo.OrigNode;

= &MSG.IBInfo.AppServerDomain;

= &MSG.IBInfo.OrigProcess;

= &MSG.IBInfo.OrigTimeStamp;

= &MSG.IBInfo.DestinationNode;

= &MSG.IBInfo.FinalDestinationNode;
= &MSG.IBInfo.SourceNode;

= &MSG.IBInfo.MessageName;

= &MSG.IBInfo.MessageVersion;

= &MSG.IBInfo.VisitedNodes;

the content data from the message rowset*/
&MSG.GetRowset () ;
&rs (1) .QE FLIGHTDATA;

&FLIGHTDATA = CreateRecord(Record.QE FLIGHTDATA) ;
&REC.CopyFieldsTo (&FLIGHTDATA) ;

/* Par

se out Message Data */

&acnumber value = &FLIGHTDATA.QE ACNUMBER.Value;
&¢msi_ sensor value = &FLIGHTDATA.QE MSI SENSOR.Value;

&ofp_value = &FLIGHTDATA.QE_OFP.VaIue;
&actype value = &FLIGHTDATA.QE ACTYPE.Value;

&calls

ign value = &FLIGHTDATA.QE CALLSIGN.Value;

&squadron value = &FLIGHTDATA.QE SQUADRON.Value;
&comml_value = &FLIGHTDATA.QE_COMMI.Value;

&comm2

value = &FLIGHTDATA.QE COMMZ2.Value;

secm_value = &FLIGHTDATA.QE ECM.Value;

&datetime = &FLIGHTDATA.ACTIONDTTM.Value;
&outstring = "Send Async FLight test";
/* Construct Output String */

&outstring = &outstring | &acnumber value | &CRLF | &msi sensor value

&CRLF | &ofp value | &CRLF | &actype value | &CRLF

&callsign value | &CRLF | &squadron value | &CRLF

&comml value | &CRLF | &comm2 value | &CRLF | &ecm value |
&datetime;

/* Log Output String into page record */
&FLIGHTDATA.GetField (Field.DESCRLONG) .Value = &outstring;

SQLExec ("DELETE FROM PS QE FLIGHTDATA") ;
&FLIGHTDATA. Insert () ;

Chapter 7
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The following code example shows how to get data out of the IBInfo object for a nonrowset-based

message.

Local XmlDoc é&xmldoc;

Local XmlNode &node, &root, &acct id node, &acct name node,

&address node, &phone node;
Local string &outstring, &CRLEF;
Local Record &FLIGHT DATA INFO, &REC;

Local string &data;
Local boolean é&return bool value;

/* this is how one wouild access data from IBinfo and
/* IBConnectorInfo objects*/

&return bool value = &MSG.IBInfo.ConnectorOverride;

For &1 = 1 To &MSG.IBInfo.IBConnectorInfo.GetNumberOfConnector

Properties ()

&data

&MSG.IBInfo.IBConnectorInfo.GetQueryStringArgName (&1) ;

&data = &MSG.IBInfo.IBConnectorInfo.GetQueryStringArgValue (&i);

End-For;
&MSG.IBInfo.IBConnectorInfo.ClearConnectorProperties();

&data = &MSG.IBInfo.IBConnectorInfo.ConnectorName;
&data = &MSG.IBInfo.IBConnectorInfo.ConnectorClassName;
&data = &MSG.IBInfo.IBConnectorInfo.RemoteFrameworkURL;
&data = &MSG.IBInfo.IBConnectorInfo.PathInfo;

s&data = &MSG.IBInfo.IBConnectorInfo.Cookies;

For &1 = 1 To &MSG.IBInfo.IBConnectorInfo.GetNumberOfQueryStringArgs ()

&data = &MSG.IBInfo.IBConnectorInfo.GetConnectorPropertiesName (&1);
&data = &MSG.IBInfo.IBConnectorInfo.GetConnectorPropertiesValue

(&1);

&data = &MSG.IBInfo.IBConnectorInfo.GetConnectorPropertiesType (&1);

End-For;
&MSG.IBInfo.IBConnectorInfo.ClearQueryStringArgs () ;

&data = &MSG.IBInfo.MessageType;

&data = &MSG.IBInfo.RequestingNodeName;
&data = &MSG.IBInfo.OrigUser;

&data = &MSG.IBInfo.OrigNode;

&data = &MSG.IBInfo.AppServerDomain;
&data = &MSG.IBInfo.OrigProcess;

&data = &MSG.IBInfo.OrigTimeStamp;
sdata = &MSG.IBInfo.DestinationNode;
&data = &MSG.IBInfo.FinalDestinationNode;
&data = &MSG.IBInfo.SourceNode;

&data = &MSG.IBInfo.MessageName;

&data = &MSG.IBInfo.MessageVersion;
&data = &MSG.IBInfo.VisitedNodes;

&xmldoc = &MSG.GetXmlDoc () ;

&CRLF = Char (13) | Char(10);

&root = &xmldoc.DocumentElement;
/* Get values out of XMLDoc */

&node array = &root.GetElementsByTagName ("actype");
&ac_type node = &node_array.Get(l);
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&ac_type value = &ac_type node.NodeValue;

&node array = &root.GetElementsByTagName ("msi sensor");
&msi sensor node = &node array.Get(1l);

&msi_ sensor value = &msi sensor node.NodeValue;

&node array = &root.GetElementsByTagName ("callsign");
&callsign node = &node array.Get(1l);

&callsign value = &callsign node.NodeValue;

&node array = &root.GetElementsByTagName ("ofp");
&ofp node = &node array.Get(l);
&ofp value = &ofp node.NodeValue;

&outstring = "GetDataout of xmldoc Test";

&outstring = &outstring | &CRLF | &ac_ type value | &CRLF |
&¢msi_sensor node
| &CRLF | &callsign value | &CRLF | &ofp value;

/* Write out the result string */
SQLExec ("DELETE FROM PS QE FLIGHT DATA");
&FLIGHT DATA INFO = CreateRecord(Record.QE FLIGHT DATA);

&FLIGHT DATA INFO.GetField(Field.DESCRLONG) .Value = &outstring;
&FLIGHT DATA INFO.Insert();

Message Class Inbound Asynchronous Example 6

The following example show a notification that could be an implementation of the OnNotify method,
using a component interface in the notification. This example shows error trapping and has multi
language support:

Component string &PUBNODENAME;

/* save pubnodename to prevent circular publishes */
Local Message &MSG;

Local Rowset &MSG _ROWSET, &cur rowset;

Local ApiObject &oSession;

Local ApiObject &CONTACT CI;

Local number &I;

Local string &KEY1;

Local Record &REC;

Local boolean &BC CREATE, &ADD;

Local boolean &TRANSACTION ERROR, &MSG ERROR;
/** Transaction/Message Error Flags**/

Function errorHandler ()
Local ApiObject &oPSMessageColl;
Local ApiObject &oPSMessage;
Local string &strErrMsgSetNum, &strErrMsgNum, &strErrMsgText,
&strErrType;
&oPSMessageColl = &oSession.PSMessages;
For &I = 1 To &oPSMessageColl.Count
&oPSMessage = &oPSMessageColl.Item(&I);
&strErrMsgSetNum = &oPSMessage.MessageSetNumber;
&strErrMsgNum = &oPSMessage.MessageNumber;
&strErrMsgText = &oPSMessage.Text;
&LogFile.WritelLine (&strErrType | " (" | &strErrMsgSetNum | ","
| &strErrMsgNum | ") - " | &strErrMsgText);
End-For;
rem ***** Delete the Messages from the collection *****x;
&oPSMessageColl.DeleteAll () ;
End-Function;

Function DO CI SUBSCRIBE ()
&oSession = %Session;

&CONTACT CI = &oSession.GETCOMPONENT (CompIntfc.CONTACT) ;
If (&CONTACT CI = Null) Then
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/* Replace this message with Tools message set when available */
Error MsgGet (91, 58, " Unable to get the Component Interface.");

Exit (1);
End-If;

/** Set Component Interface Properties **/

&CONTACT CI.GetHistoryItems = True;

&CONTACT CI.Interactivemode = False; /** set this to True while
debugging **/

rem Send messages to the PSMessage Collection;
&oSession.PSMessagesMode = 1;

&MSG_ERROR = False;
For &I = 1 To &MSG ROWSET.ActiveRowCount

/** Set Session Language Code Property **/

&REGIONALSETTINGS = &oSession.RegionalSettings;

&REGIONALSETTINGS.LanguageCd = &MSG ROWSET (&I) .PSCAMA.
LANGUAGE_CD.Value;

&§TRANSACTION ERROR = False;
§BC_CREATE = False;

/** Instantiate Component Interface **/
&KEY1 = &MSG_ROWSET (&I) .CONTACT TBL.PERSON ID.Value;
&CONTACT CI.PERSON ID = &KEY1;

Evaluate &MSG ROWSET (&I) .PSCAMA.AUDIT ACTN.Value
When = "A"
When = "N"

&ADD = True;

/* Check if Keys already exist. */
&CONTACT CIColl = &CONTACT CI.Find();

/*If None (&EXISTS) Then*/
If &CONTACT CIColl.Count = 0 Then
If &CONTACT CI.Create() Then
&BC_CREATE = True;
Else
/* Replace this message with Tools message set
when available */
Warning MsgGet (18022, 56, "Error creating Component
Interface for transaction %1", &I);
&TRANSACTION ERROR = True;
End-If;
Else
If Not &CONTACT CI.Get() Then
/* Replace this message with Tools message set
when available */
Warning MsgGet (18022, 59, "Could not Get Component
Interface for transaction %1", &I);
&TRANSACTION ERROR = True;
End-If;
End-If;
Break;
When = "C"
&ADD = False;
If Not &CONTACT CI.Get() Then
/* Replace this message with Tools message set when
available */
Warning MsgGet (18022, 59, "Could not Get Component

Interface for transaction %1", &I);
&TRANSACTION ERROR = True;
End-If;
Break;
When = "D"
When = "K"

When-Other
/* delete and old key action codes not allowed at this
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time */
&TRANSACTION ERROR = True;
Warning MsgGet (18022, 61, "Audit Action 'D' not allowed on
transaction %1", &TRANSACTION) ;
Break;
End-Evaluate;

&CONTACT CI.CopyRowset (&MSG ROWSET, &I);

If Not &TRANSACTION ERROR Then
If Not &CONTACT CI.save() Then
/* Replace this message with Tools message set when
available */
Warning MsgGet (18022, 57, "Error saving Component
Interface for transaction %1", &TRANSACTION) ;
&TRANSACTION ERROR = True;
End-If;
End-If;

/** close the last Component Interface in preparation for
getting the next **/
If Not &CONTACT CI.Cancel() Then
/* Replace this message with Tools message set when
available */
Warning MsgGet (18022, 58, "Error Canceling Component
Interface for transaction %1", &TRANSACTION) ;
Exit (1);
End-If;

/* Reset &TRANSACTION ERROR to "False" for &BusComp.Save ()
to execute if no

/* Transaction Error found in the next Transaction. */

&TRANSACTION ERROR = False;

End-For;

If &TRANSACTION ERROR Then

&MSG_ERROR = True;

End—If;_

End-Function;

/****

Main Process ****/

&MSG.ExecuteEdits (3Edit Required + %Edit TranslateTable);
If &MSG.IsEditError Then
&MSG_ERROR = True;

Else

&PUBNODENAME = &MSG.PubNodeName;
&MSG_ROWSET = &MSG.GetRowset () ;

/~k

Do Component Interface subscribe */

DO _CI SUBSCRIBE () ;
End-If;

If &MSG_ERROR Then
Exit (1);
End-If;

XmlIDoc Class Inbound Asynchronous Example

The following example uses the GetXmIDoc method.

Local
Local
Local
Local
Local

&CRLF

XmlDoc &Document;

XmlNode &node, &root;

string &outstring;

Rowset &LEVELO;

Record &SALES ORDER INFO, &REC;

= Char (13) | Char(10);

& Document = &MSG.GetXmlDoc () ;

Chapter 7
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&root = & Document.DocumentElement;
&child count = &root.ChildNodeCount;

/* Get values out of XmlDoc */

&node array = &root.GetElementsByTagName ("QE ACCT ID");
&acct id node = &node array.Get (2);

&account id value = &acct id node.NodeValue;

&node array = &root.GetElementsByTagName ("QE ACCOUNT NAME") ;
&acct name node = &node array.Get (2);
&account name value = &acct name node.NodeValue;

&node array = &root.GetElementsByTagName ("QE ADDRESS") ;
&address node = &node array.Get (2);
&address value = &address node.NodeValue;

&node array = &root.GetElementsByTagName ("QE PHONE") ;

&phone node = &node array.Get(2);
&phone value = &phone node.NodeValue;
&outstring = "GetMessageXmlDoc Test";
&outstring = &outstring | &CRLF | &account id value | &CRLF
| &account name value | &CRLF | &address value | &CRLF |

&phone value;

&SALES ORDER INFO = CreateRecord(Record.QE SALES ORDER) ;

&SALESioRDERilNFO.GetField(Field.QEiACCTilD).Value =
&account id value;

&SALES ORDER_INFO.GetField(Field.DESCRLONG) .Value = &outstring;

&SALES ORDER INFO.Update();

Handling Inbound Asynchronous Request/Response Transactions

Implement the OnNotify method in the PS_PT application package, located in the Integration subpackage,
to handle inbound asynchronous request/response transactions.

import PS PT:Integration:INotificationHandler;

class FLIGHTDATA RETURN implements PS PT:Integration:INotificationHandler
method FLIGHTDATA RETURN () ;
method OnNotify (&MSG As Message) ;

end-class;

/* constructor */
method FLIGHTDATA_RETURN
end-method;
method OnNotify
/+ & MSG as Message +/

/+ Extends/implements PS PT:Integration:INotificationHandler.OnNotify +/
/* Variable Declaration */

Local string &str, &value;
Local Rowset &rs;
Local integer &num;

Local Message &MSG, &MSG resp;
Local Record &FLIGHTDATA, &REC;

&rs = &MSG.GetPartRowset (1) ;
/* process request rowset */

&MSG resp = CreateMessage (Operation.FLIGHTPLAN ARR, %IntBroker Response);
&rs = &MSG resp.GetPartRowset (1);

/* populate response rowset */
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&MSG resp.IBInfo.WSA MessageID = &MSG.IBInfo.WSA MessagelD;
&MSG _resp.IBInfo.WSA ReplyTo = &MSG.IBInfo.WSA ReplyTo;
&MSG_resp.IBInfo.WS RequestAliasName = &MSG.IBInfo.WS RequestAliasName;

sIntBroker.Publish (&MSG resp) ;
end-method;

Handling Inbound Synchronous Transactions

Implement the OnRequest method in the PS_PT application package, in the Integration subpackage,
to handle inbound synchronous transactions. All the examples in this section are assumed to be
implementations of the OnRequest method.

Message Class Inbound Synchronous Example

The following example implements both the OnRequest method and the OnError method

import PS PT:Integration:IRequestHandler;

class RequestMan implements PS PT:Integration:IRequestHandler
method RequestMan () ;
method OnRequest (&MSG As Message) Returns Message;
method OnError (&MSG As Message) Returns string;

end-class;

/* constructor */
method RequestMan

%Super = create PS PT:Integration:IRequestHandler();
end-method;

method OnRequest
/+ &MSG as Message +/
/+ Returns Message +/
Local Message &response;

&response = CreateMessage (Operation.SYNC REMOTE,
%IntBroker Response);

&response.GetRowset().GetRow(l).GetRecord(Record.QE_FLIGHTDATA).
GetField (Field.DESCRLONG) .Value = &MSG.GenXMLString () ;

Return &response;
end-method;

method OnError
/+ &MSG as Message +/
/+ Returns String +/
/+ Extends/implements PS PT:Integration:IRequestHandler.OnError +/
Local integer &nMsgNumber, &nMsgSetNumber;
Local string &sText;

&nMsgNumber = &MSG.IBException.MessageNumber;
&nMsgSetNumber = &MSG.IBException.MessageSetNumber;

rem &sText = &exception.DefaultText;
&sText = &MSG.IBException.ToString();

/* ADD SPECIFIC ERROR INFO HERE */
Return &sText;

end-method;
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XmlDoc Class Inbound Synchronous Example

The following example uses the GetXmlDoc method:

Local XmlDoc &xmlRequestDoc;

Local XmlDoc é&xmlResponseDoc;

Local XmlNode &select;

Local Message &Return MSG;

Local array of XmlNode &whereClause;

Local string &recordName;

Local string &fieldName;

Local string &fieldValue;

Local Rowset &outputRowset;

Local boolean é&return bool value;

&xmlRequestDoc = &MSG.GetXmlDoc () ;
&select = &xmlRequestDoc.DocumentElement;

&recordName = &select.GetAttributeValue ("record");
&outputRowset = CreateRowset (@ ("Record." | &recordName)) ;
&whereClause = &select.GetElementsByTagName ("where") ;
If &whereClause <> Null And
&whereClause.Len <> 0 Then
&fieldName = &whereClause.Get (1) .GetAttributeValue ("field");
&fieldValue = &whereClause.Get (1) .GetAttributeValue ("value");
&outputRowset .Fill ("WHERE " | &fieldName | "= :1", &fieldValue);
Else
&outputRowset.Fill () ;
End-If;

&Return MSG = CreateMessage (OPERATION.EXAMPLE, %IntBroker_Response);
&xmlResponseDoc = &Return MSG.GetXmlDoc () ;

&b = &xmlResponseDoc.CopyRSwset(&outputRowset);
Return &Return MSG;

SoapDoc Class Inbound Synchronous Example

The following example uses the GetXmIDoc method.

Note: Because GetXmlIDoc returns an XmlDoc object, you must receive the inbound request message as
an XmlDoc object, then convert it to a SoapDoc object to process it with SOAP methods.

Local XmlDoc é&request, &response;
Local string &strXml;

Local SoapDocs &soapReq, &soapRes;
Local Message &Response Message;

&soapReg = CreateSoapDoc () ;

&request = &MSG.GetXmlDoc () ;
&soapReqg.XmlDoc = &request;

&0OK = &soapReqg.ValidateSoapDoc() ;
&parmN = &soapReq.GetParmName (1) ;
&parmV = &soapReqg.GetParmValue (1) ;

&Response Message = CreateMessage (OPERATION.SoapExample,
$IntBroker Response);

&response = &Response Message.GetXmlDoc () ;
&soapRes = CreateSoapDoc () ;
&soapRes.AddEnvelope (0) ;
&soapRes.AddBody () ;

&soapRes.AddMethod ("StockPrice", 1);
&soapRes.AddParm(&parmN, &parmV) ;
&soapRes.AddParm("Price", "29");
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&0OK = &soapRes.ValidateSoapDoc() ;

&response = &soapRes.XmlDoc;
Return &Response Message;

Simulating Receiving Messages from External Nodes

You can use PeopleCode to simulate receiving asynchronous messages from external nodes, including
running transformations.

Use can use the IntBroker class InboundPublish method to work with rowset-based and nonrowset-based
messages.

The following example shows an inbound publish as part of an OnNotify method implementation with a
rowset-based message:

Local Message &MSG REMOTE;
Local Rowset &rs;

&rs = &MSG.GetRowset () ;
/*create the message to be re-published from a simualted remote node*/

&MSG_REMOTE = CreateMessage (OPERATION.QE FLIGHTPLAN) ;

&MSG REMOTE.IBInfo.RequestingNodeName = "QE IBTGT";

&MSG REMOTE.IBInfo.ExternalOperationName = &MSG REMOTE.OperationName | "."
&MSG REMOTE.OperationVersion;

&MSG_REMOTE.CopyRowset (&rs) ;

&Ret = $IntBroker.InBoundPublish (&MSG REMOTE) ;

The following example shows an inbound publish as part of an OnNotify implementation with a
nonrowset-based message:

Local Message &MSG REMOTE;
Local XmlDoc é&xmldoc;
Local Rowset é&rs;

&xmldoc = &MSG.GetXmlDoc () ;
/*create the message to be re-published from a simualted remote node*/

&MSG_REMOTE = CreateMessage (OPERATION.QE FLIGHTPLAN) ;
/* populate the Remote Message with data to be re-published*/
&MSG_REMOTE.SetXmlDoc (&xmldoc) ;

$IntBroker.InBoundPublish (&MSG_REMOTE, Node.REMOTE NODE) ;

Processing Inbound Errors

This section discusses how to:
e Validate data.

¢ Use the Exit built-in function.
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* Correct messaging errors.

Validating Data

You validate data differently depending on the PeopleCode class that you’re using to receive the message.

XMLDoc Class Validation

You can validate incoming XML DOM-compliant messages by using the XmlDoc document type
definition (DTD) that is delivered with your PeopleSoft application.

See “Understanding XmlIDoc Classes” (PeopleCode API Reference).

SoapDoc Class Validation

You can validate SOAP-compliant messages by using the ValidateSoapDoc method in the PeopleCode
SoapDoc class.

See “Understanding theSOAPDoc Class” (PeopleCode API Reference).

Message Class Validation
Have a message receiving process validate incoming data by:
» Using the ExecuteEdits method in the code to invoke the definitional edits.

» Calling PeopleCode validation built-in functions (if they already exist, for example in a FUNCLIB
record, or if validation logic can be encapsulated within a small set of built-in functions) from within
the receiving PeopleCode.

* Calling a component interface or Application Engine program from the receiving process (for
complex validation logic).

This enables you to reuse logic that is embedded in the component.

The ExecuteEdits method uses the definitional edits to validate the message. You can specify the
following system variables alone or in combination. If you don’t specify a variable, all of the edits are
processed.

*  %Edit DateRange

*  %Edit OneZero

*  %Edit_PromptTable

*  %Edit Required

*  %Edit_TranslateTable
*  %kEdit_YesNo

The following example processes all edits for all levels of data in the message structure:

&MYMSG.ExecuteEdits () ;
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The following example processes the Required Field and Prompt Table edits:

&RECPURCHASEORDER.ExecuteEdits ($Edit Required +
$Edit PromptTable);

ExecuteEdits uses set processing to validate data. Validation by using a component interface or a
PeopleCode built-in function is usually done with row-by-row processing. If a message contains a large
number of rows per rowset, consider writing the message to a staging table and calling an Application
Engine program to do set processing if you want additional error checking.

ExecuteEdits sets several properties on several objects if there are any errors:
» IsEditError is set on the Message, Rowset, Row, and Record objects if any fields contain errors.
» EditError, MessageNumber, and MessageSetNumber are set on the Field object that contains the error.

If you don’t want to use ExecuteEdits, you can set your own errors by using the field properties. Setting
the EditError property to True automatically sets the IsEditError message property to True. You can also
specify your own message number, message set number, and so on, for the field. If you use the Exit(1)

built-in function, the message status changes to Error when you finish setting the fields that are in error.

Using the Exit Built-in Function

188

Use the Exit built-in function to invoke a messaging error process when the application finds an error.
This works only when you use the PeopleCode Message class to process inbound transactions. The same
error processing is invoked automatically if PeopleTools finds an unexpected error, such as a Structured
Query Language (SQL) error. The Exit built-in function has an optional parameter that affects how the
error is handled.

To handle error processing in application tables, use the Exit built-in function with no parameter, or just
let the notification process finish normally. This marks the message receipt as successful and commits the
data.

To handle the error tracking and correction with PeopleSoft Integration Broker, use the Exit built-in
function with 1 as a parameter to log the errors, perform a rollback, and stop processing.

Using the Exit Built-in Function Without Parameters

Inthe Exit ( ) form (that is, Exit without any parameters specified), all data is committed and the
message is marked as complete. Use this to indicate that everything processed correctly and to stop
program processing. Note, though, that the message status is set to Complete; therefore, you can’t detect
or access errors in the Service Operations Monitor. If errors did occur, the subscription code should write
them to a staging table, and then you must handle all of the error processing.

The Exit built-in function:

* Sets the message status in the application message queue for the subscription to Done.
*  Commits the transaction.

*  Stops processing.

Following is an example of using Exit without a parameter:

&MSG.ExecuteEdits () ;
If &MSG.IsEditError then
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App Specific Error Processing();
Exit () ;
Else
Specific Message Processing();
End-if;

Using the Exit Built-in Function with Parameters

When you supply a 1 as a parameter for the Exit built-in function, the function:
* Processes a rollback.

*  Sets the message status in the message queue for the subscription to Error.
*  Writes the errors to the subscription contract error table.

»  Stops processing.

You can view all errors that have occurred for this message in the Service Operations Monitor, even those
errors that are detected by ExecuteEdits.

Following is an example of using the Exit function with 1 as a parameter:

&MSG.ExecuteEdits () ;
If &MSG.IsEditError then
Exit (1)
Else
Process_ Message () ;
End-1if;

Related Links

Integration Broker Service Operations Monitor

Using Message Object Functionality With Nonrowset-Based
Messages

Prior to the PeopleTools 8.44 release, there were two distinct paths for writing and executing PeopleCode
for PeopleSoft Integration Broker which were based on whether you were working with rowset-based
XML messages or nonrowset-based XML messages.

For rowset-based XML messages, you could use a rowset and all the properties and methods associated
with the Message class. For nonrowset-based XML messages, you could not use the Message class,

but instead used built-in functions such as PublishXmlDoc and GetMessageXmlDoc. In addition, when
working with nonrowset-based messages and these built-in functions, you could only access content data.

Effective with the PeopleTools 8.44 release, when working with nonrowset-based XML messages you can
use all of the functionality of the Message object using two new methods, SetXMLDoc and GetXMLDoc.

Field or Control Description

SetXMLDoc Use this method to load and pass nonrowset-based data into
the Message object.
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Field or Control Description

GetXMLDoc Use this method to get nonrowset-based data out of the
message object.

Using the SetXMLDoc Method

The following example shows how to use SetXMLDoc to use the Message object to publish a nonrowset-
based message.

//&XmlDoc holds the nonrowset-based data as before.

// create an instance of the Message object

&MSG = CreateMessage(OPERATION.QE_F18_ASYNC_XMLDOC);
// Load the Message object with the xmldoc data.
&MSG.SetXmlDoc (&XmlDoc) ;

// perform a publish for the nonrowset-based message
$IntBroker.Publish (&MSG) ;

Using the GetXMLDoc Method

The following code example shows how to use GetXMLDoc to get nonrowset-based XML out of the
Message object.

Local XMLDOC &XmlDoc;

// get an xmldoc object loaded with the content data.
&XmlDoc = &MSG.GetXmlDoc () ;

Related Links
“Understanding Message Classes” (PeopleCode API Reference)

Generating Test Messages

Use the Handler Tester utility to generate test messages.

See “Understanding the Handler Tester Utility” (Integration Broker Testing Utilities and Tools)

Working With Message Segments

This section provides an overview of message segments and discusses how to:

* Configure nodes to handle segmented messages.

Set the maximum number of messages in a message segment.

* Create message segments.

Delete message segments.
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* Send and receive segmented messages between PeopleSoft systems.

* Send and receive segmented messages to/from third-party systems.

* Send and receive large segmented messages using parallel processing.
* Access message segments.

* View message segment data.

» Use restartable processing for publishing large messages in batch.

Related Links

“Sending and Receiving Large Segmented Messages Using Parallel Processing” (Integration Broker
Administration)
rstanding Message Segments

When you create message segments, you can divide rowset-based and nonrowset-based messages into
multiple data containers, or segments, for sending. Depending on the order in which you send a message
that contains message segments, the receiving system can process the message as a whole, or process one
segment at a time while the others are compressed in memory or held in the application database.

As a result creating message segments can enhance system performance and message exchange,
especially when you are working with large messages that exceed one gigabyte (1 GB).

To create and manage message segments, you use several methods and properties of the PeopleCode
Message class.

rstanding PeopleCode used to Work with Message Segments

This section discusses:

* Methods used with message segments.

» Properties used with message segments.

Methods Used with Message Segments

The following table lists the PeopleCode methods you can use when you work with message segments.

Method Class Description

CreateNextSegment Message Designates the end point of one segment
and the beginning of a new segment.
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Method Class Description

DeleteOrphanedSegments IntBroker Used to delete segments that might have
been orphaned if you were processing
message segments using a PeopleSoft
Application Engine program that had to
be restarted.

DeleteSegment Message Deletes a segment.

GetSegment Message Gets the segment specified by the passed
value. The passed value is the segment
number.

UpdateSegment Message Use this method to update data within

the current segment.

Note: Use the DeleteSegment and UpdateSegment methods only when storing segments data in memory.
These methods do not function when segment data is stored in the database.

Properties Used with Message Segments

The following table lists PeopleCode properties that you can use when you work with message segments.

Property

Class

Description

CurrentSegment

Message

Returns a number, indicating which

segment is the current segment.

SegmentsUnOrder

IBInfo

Determines whether to process message
segments in order or unordered. This
property pertains to asynchronous
messages only.

The values are:

*  True: Process message segments

unordered.

»  False: Process message segments in
order. (Default.)

SegmentCount

Message

Returns the total number of segments in

a message.
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Property Class Description

SegmentsByDatabase Message Enables you to override where message
segment data is stored for a message.

The values are:

*  True: Store message segments
awaiting processing in the
application database.

*  False: Store message segments
awaiting processing in memory.
(Default.)

Related Links
PeopleCode API Reference

Configuring Nodes to Handle Segmented Messages

This section describes how to configure nodes to handle segmented messages.

Understanding Configuring Nodes to Handle Segmented Messages

Before you can send segmented messages, you must configure the remote node defined on the local
system to handle segmented messages by setting the Segment Aware option on the Node Definitions
page in the PeopleSoft Pure Internet Architecture.

Warning! Do not set the Segment Aware option for remote PeopleSoft 8.45 or earlier nodes, or for third-
party systems. If you do so, the receiving system will consume only the first segment of the messages and
ignore any subsequent segments.

Configuring a Node to Handle Segmented Messages
To configure a node to handle segmented messages:
1. Select PeopleTools > Integration Broker > Integration Setup > Node Definitions.
2. Select a node with which to work and click OK.
The Node Definitions page appears.
3. Select the Segment Aware check box.

4. Click the Save button.
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Setting the Maximum Number of Message Segments in Messages

The Maximum Number of Segments parameter is a built-in global parameter that determines the
maximum number of segments that can exist in a message. When the number is met, a new message is
created and begins to be populated.

The default value is 10.

The Maximum Number of Segments parameter is set on the PeopleTools Options page (PSOPTIONS).
To access the page select PeopleTools > Utilities > Administration > PeopleTools Options.

You can also manipulate the maximum number of message segments for a message in PeopleCode using
the Y%oMAXNBRSEGMENTS built-in function.

Creating Message Segments
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This section provides an overview of creating message segments and message segment numbers and
discusses how to:

* Create message segments.

*  Count the number of segments in messages.

*  Store message segments awaiting processing.

e Override where to store message segment awaiting processing.
*  Specify the order in which to process message segments.

*  Chunk asynchronous segmented messages.

Understanding Creating Message Segments
By default every message has one segment.

To create multiple message segments use the CreateNextSegment method in the location in the message
where you want one segment to end and next segment to begin. Continue this process until you have
created the desired number of segments for the message.

Segments can contain any number of rowsets of data (rowset-based messages) or rows of data
(nonrowset-based messages).

Understanding Message Segment Numbers

When you create a message segment, PeopleSoft Integration Broker assigns a message segment number
to the segment.

The first message segment has a message segment number or 1, and message segment numbers are
increment by one sequentially thereafter. As an example, if you break a message into three segments, the
first segment number is /, the second segment number is 2, and the third segment number is 3.
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Creating Message Segments

The following example shows using the CreateNextSegment method to create three segments in the
message QE_FLIGHTPLAN, populating each segment with data from the component buffer.

&MSG = CreateMessage (OPERATION.QE FLIGHTPLAN) ;
&rs=&MSG.GetRowset () ;

//Now populate rowset

// End of first segment. Beginning of second segment.
&MSG.CreateNextSegment () ;

&rs=&MSG.GetRowset () ;

//Now populate rowset

//End of second segment. Beginning of third segment.
&MSG.CreateNextSegment () ;

&rs=&MSG.GetRowset () ;
//Now populate rowset

$IntBroker.Publish (&MSG) ;

Counting the Number of Segments in Messages

You might have the need to determine the number of segments in a message. Use the SegmentCount
property to determine this information.

Storing Message Segments Awaiting Processing

By default, message segments awaiting processing are stored in memory until all segments are processed.
Once all segments are processed, PeopleSoft Integration Broker sends all data as one message.

Use the MessageSegmentFromDB parameter in PSAdmin to specify the number of segments to keep in
memory before writing segmented messages to the database. The default value is /0.

For synchronous messages, if the number of segments sent for processing exceeds the set for the
MessageSegmentsFromDB parameter, an error occurs.

Overriding Where to Store Message Segments Awaiting Processing

You can override the number of segments to keep in memory before writing segmented messages to the
database for a single message using the SegmentsByDatabase property of the Message class.

Storage Location Description

Memory When message segments are stored in memory, PeopleSoft
Integration Broker writes all segments as one message to the
database when you send the message.

To store message segment data in memory, set the
SegmentsByDatabase property to False. (Default.)
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Storage Location Description

Application database When message segments are stored in the database, PeopleSoft
Integration Broker writes the segments to the database
individually. When you store message segments in the
database you can have an infinite number of segments in a

message.

To store message segment data in the application database, set
the SegmentsByDatabase property to True.

When you store message segments in memory, the number of segments is limited by the value set in the
MessageSegmentFromDB parameter in PSAdmin in the Setting for PUB/SUB servers section of the file.

When working with asynchronous messages, if you create more message segments then the value
set, all segments are written to the database automatically and the SegmentsByDatabase property will
automatically be set to True.

For synchronous messages, attempting to create more segments then the specified value will result in an
error message.

Specifying the Order in Which to Process Message Segments

When you work with segmented asynchronous messages you can specify that PeopleSoft Integration
Broker process the segments in order or unordered, using the SegmentsUnOrder property of the Message
class.

Message Segment Processing Description

In order When Integration Broker processes message segments in
order, it decompresses all message segments sequentially and
then processes the message as a whole. In this situation, only
one publication or subscription contract is created.

To process message segment in order, set the
SegmentsUnOrder property to False.

Unordered When Integration Broker processes message segments
unordered, it decompresses and processes all segments in
parallel. In this situation, the system creates one publication or
subscription contract for each message segment.

To process message segment unordered, set the
SegmentsUnOrder property to True.

If you attempt to send ordered segmented messages to a node that is not segment aware an error message
will be created and can be viewed on the Message Errors tab on the Message Details page in Service
Operations Monitor.
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See the product documentation for Integration Broker Service Operations Monitor.

Chunking Asynchronous Segmented Messages
Chunking asynchronous segmented messages sends message in blocks to the receiving node.

When using chunking, message instances display in Hold status in the Service Operations Monitor until
all chunks are received. Once all chunks are received, the message status switches to New.

Note: Chunking applies to ordered asynchronous messages only.

The number of segments to chunk for an asynchronous message is determined by the value you set for the
MessageSegmentByDatabase parameter in PSAdmin. The default value is /0.

As an example, if a message has 20 segments and you set MessageSegmentByDatabase to 5, PeopleSoft
Integration Broker will send four groups (array of messages) of segments to the integration gateway, and
each group will contain five segments.

Deleting Message Segments
You can delete message segments in a message only before you publish the message.
Use the DeleteSegment method of the Message class to perform the action.
You cannot delete the first segment in a message.

The following example demonstrates using the DeleteSegment method in an implementation of the
OnRequestSend method.

import PS PT:Integration:ISend;

class Send implements PS PT:Integration:ISend
method Send() ;
method OnRequestSend (&message As Message) Returns Message;
method OnError (&message As Message)

end-class;

/* constructor */
method Send

$Super = create PS PT:Integration:ISend();
end-method;

method OnRequestSend
/+ &message as Message +/
/+ Returns Message +/
/+ Extends/implements PS PT:Integration:ISend.OnRequestSend +/
Local integer &segment number, &i;
Local Rowset é&rs;

For &1 = 1 To &message.SegmentCount
&rs = Null;
&message.GetSegment (&1) ;

&rs = &message.GetRowset () ;

/* determine that segment 3 needs to be deleted. */
&segment number = &i;

End-For;

&message.DeleteSegment (&segment number) ;
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Return &message;
end-method;

method OnError
/+ &message as Message +/
/+ Extends/implements PS PT:Integration:ISend.OnError +/

end-method;

Sending and Receiving Segmented Messages between PeopleSoft Systems
This section discusses how to:
¢ Send segmented messages to PeopleSoft systems.

* Receive segmented messages from PeopleSoft systems.

Sending Segmented Messages to PeopleSoft Systems
To send a segmented message, use sending PeopleCode and events as you would with any other message.

Use the PeopleSoft target connector when the receiving node is a PeopleSoft system. The PeopleSoft
target connector automatically handles message segments, and no additional configuration is required on
the connector.

Before sending a transaction with message segments, on the sending PeopleSoft system, be sure that the
Segment Aware check box is selected for the remote node that represents the receiving system.

Receiving Segmented Messages from PeopleSoft Systems

To receive segmented message from PeopleSoft systems, use notification PeopleCode or implement the
OnRequest method.

Use the PeopleSoft listening connector to receive transactions that contain message segments from other
PeopleSoft systems. The PeopleSoft listening connector automatically handles message segments, and no
additional configuration is required on the connector.

Sending and Receiving Segmented Messages to/from Third-Party Systems
This section discusses how to:

* Send segmented messages to third-party systems.

* Receive segmented messages from third-party systems.

Understanding DataChunkCount and DataChunk Properties

PeopleSoft Integration Broker uses two properties to communicate to sending and receiving systems the
number of message segments that are contained in a transaction:
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Field or Control Description

DataChunkCount Indicates the total number of data chunks or message segments
contained in the transaction.

DataChunk Indicates the number of the data chunk or message segment
that you are sending.

For example, if there are a total of seven data chunks in the
transaction, and the current segment is the third chunk, the
DataChunk value for the current message is 3.

Note that when you are sending and receiving message segments between PeopleSoft systems these
properties are not used. The PeopleSoft target and listening connectors perform all necessary processing.

Sending Segmented Messages to Third-Party Systems

To send segmented messages from PeopleSoft systems to third-party system, use one of the following
target connectors:

AS?2 target connector

Note: AS2 will no longer be supported from PeopleTools 8.61.
PeopleSoft recommends using the Oracle SOA Suite B2B component for all EDI integrations,
including those based on the AS2 specification.

HTTP target connector
JMS target connector

SMTP target connector

No additional target connector configuration is required to send segmented messages. These connectors
read the messaging PeopleCode on the integration gateway and determine the number of segments
contained in the transaction. They then populate the DataChunkCount and DataChunk parameters and
include this information with each outbound segment sent. All of these connectors except for the HTTP
target connector send the DataChunkCount and DataChunk information in the message header of each
outbound message segment. The HTTP target connector includes the DataChunkCount and DataChunk
parameter information in the HTTP header of each outbound message segment.

Before sending a transaction with message segments, on the PeopleSoft system, be sure that the Segment
Aware check box is selected for the remote node that represents the third-party integration partner.

Receiving Segmented Messages from Third-Party Systems

At this time, only the HTTP listening connector can be used to receive message segments from third-party
systems.

To receive segmented messages with third-party integration partners, the third-party must specify the
following DataChunkCount and DataChunk parameters in the HTTP properties, query arguments, or
SOAP header:
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The receiving PeopleSoft system must use the HTTP listening connector as only this connector monitors
transactions for these parameters.

After the third party sends in the first segment, the PeopleSoft system sends an acknowledgement to the
third-party system. The acknowledgment contains a transaction ID that the third-party integration partner
must include with all subsequent segments.

The following bullet points describe sample processing for a third-party integration partner sending a
transaction to a PeopleSoft system that contains three segments:

1. First segment processing:

a.

The third-party integration partner prepares the first message/segment of the transaction. In the
HTTP properties, query string, or SOAP header, it sets the DataChunk equal to / indicating the
first chunk, and sets the DataChunkCount equal to 3 indicating total number of chunks to be sent
for the transaction.

When the request is received by the PeopleSoft system the data chunk is saved in the database as a
segment.

In the Service Operations Monitor the transaction displays a status of Hold.

The PeopleSoft system sends an acknowledgement to the third-party system, which includes a
transaction ID.

Note: The third-party integration partner must include the transaction ID as part of all subsequent
requests for the transaction. The PeopleSoft system uses the transaction ID to identify the
segments that belong to the transaction.

2. Second segment processing:

a.

The third-party integration partner prepares the second message/segment of the transaction. In the
HTTP properties, query string, or SOAP header, it sets the DataChunk equal to 2 indicating that
the message is the second chunk, and sets the DataChunkCount equal to 3 indicating total number
of chunks to be sent for the transaction. It also specifies the transaction ID sent by the PeopleSoft
system in the acknowledgement for the first segment.

When the request is received by the PeopleSoft system the data chunk is saved in the database as a
segment.

In the Service Operations Monitor the transaction displays a status of Hold.

3. Third segment processing:

a.

The third-party integration partner prepares the third message/segment of the transaction. In the
HTTP properties, query string, or SOAP header, it sets the DataChunk equal to 3 indicating that
the message is the third chunk, and sets the DataChunkCount equal to 3 indicating total number
of chunks to be sent for the transaction. It also specifies the transaction ID sent by the PeopleSoft
system in the acknowledgement for the first segment.

When the request is received by the PeopleSoft system the data chunk is saved in the database as a
segment.
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c. Since the PeopleSoft system has received all of the segments in the transaction, in the Service
Operations Monitor the transaction displays a status of New.

d. The PeopleSoft system processing the transaction like any other transaction at this point.
The PeopleCode to read the data chunks/segments is the Message Segment APIL.

Sending, Receiving, and Correlating Multiple Segmented Messages

Previous sections in this topic have discussed sending one message that contains multiple message
segments. For very large messages this can have performance impact due to the large number of
segments.

PeopleSoft provides PeopleCode that allows you to send multiple messages with multiple segments and
then correlate them into one transaction on the receiving system. So instead of sending one message with
50 message segments, you can send 10 messages with 5 message segments using parallel processing, and
then correlate the 10 messages on the receiving system.

The InitializeConversationld property on the Message object, provides the correlation between messages.
The FirstCorrelation method on the Message object ensures that the database table is truncated after
receipt of the first message only.

On the first message to be published set the InitializeConversationld property to True. After the
message is published retrieve the transaction ID from the message. For all subsequent messages, set the
CorrelationID property to the value of the transaction ID returned from the first message. As a result,
when the messages arrive at the receiving system they have different transaction IDs, but all have the
same correlation ID.

On the receiving system when the first message is received the database table is truncated. To prevent

a destructive load from occurring with the receipt and processing of each subsequent message, use the
PreNotify event. You can use the PreNotify event to truncate the database table upon receipt of the first
message. In subsequent messages use the FirstCorrelation method in the event, setting the method to True,
to determine if a prior message with the same correlation ID has already run the event.

The following example shows an example of how the sending system uses the InitializeConversationld
property:

/*First Message to Publish */

&§MSG. InitializeConversationId = true;

$IntBroker.Publish (&MSG) ;

&strCorrelationID = &MSG.TransactionId;

/* all subsequent message to correlate*/

&MSG. IBInfo.ConversationID = &strCorrelationID;
$IntBroker.Publish (&MSG) ;

The following example shows an example of how the receiving system uses the FirstCorrelation method
in the PreNotify event:

PreNotify Event:

If &MSG.FirstCorrelation() = true Then
/* process the event logic */
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End-If;
Accessing message segments is described elsewhere in this section.

See Accessing Segments in Messages.

Related Links
“FirstCorrelation” (PeopleCode API Reference)
“InitializeConversationld” (PeopleCode API Reference)

“Sending and Receiving Large Segmented Messages Using Parallel Processing” (Integration Broker
Administration)

Accessing Segments in Messages

202

After you receive a segmented message, use the GetSegment method of the Message class to access
message segment data.

After you access a message segment, use the Message class GetRowset or GetXmlDoc methods to work
with the contents of the segment.

Warning! You can access only one segment in a message at a time. When you access a message segment,
PeopleSoft Integration Broker removes the previously accessed message segment from memory.

When you access a message segment, set the existing rowset to null to eliminate storing multiple rowsets
in the data cache.

The following example shows using the GetSegment method to access a message segment in the message
QE FLIGHTDATA.

For &1 = 1 To &MSG.SegmentCount
&rs = Null; //Null the rowset to remove it from memory
&MSG.GetSegment (&1i) ;

&rs = &MSG.GetRowset () ;
&REC = &rs(l).QE_FLIGHTDATA;

&FLIGHTDATA = CreateRecord(Record.QE FLIGHTDATA);
&REC.CopyFieldsTo (&§FLIGHTDATA) ;

/* Parse out Message Data */

&acnumber value = &FLIGHTDATA.QE ACNUMBER.Value;
&msi sensor value = &FLIGHTDATA.QE MSI SENSOR.Value;
&ofp_value = &FLIGHTDATA.QE_OFP.Value;

&actype value = &FLIGHTDATA.QE ACTYPE.Value;
&callsignivalue = &FLIGHTDATA.QE CALLSIGN.Value;
&squadron value = &FLIGHTDATA.QE SQUADRON.Value;
&comml_value = &FLIGHTDATA.QE_COMMl.Value;

&comm2 value = &FLIGHTDATA.QE COMM2.Value;

&ecm value = &FLIGHTDATA.QE ECM.Value;

&outstring = "Send Async Flight test";

/* Construct Output String */

&outstring = &outstring | &acnumber value | &CRLF |

émsi sensor value | &CRLF | &ofp value | &CRLF | &actype value |
&CRLF | &callsign value | &CRLF | &squadron value | &CRLF |
&comml value | &CRLF | &comm2 value | &CRLF | &ecm value;

/* Log Output String into page record */
&FLIGHTDATA.GetField (Field.DESCRLONG) .Value = &outstring;
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SQLExec ("DELETE FROM PS QE FLIGHTDATA");
&FLIGHTDATA.Insert ();

End-For;

Viewing Message Segment Data

The Service Operations Monitor Message Details page provides information about messages that contain
segments.

Related Links

“Viewing Asynchronous Service Operation Instance Details” (Integration Broker Service Operations
Monitor)

Using Restartable Processing for Publishing Large Messages in Batch

This section provides an overview, prerequisites and setup steps for using restartable processing for
publishing large asynchronous segmented messages in batch.

Understanding Using Restartable Processing

PeopleSoft provides a PeopleSoft Application Engine library module, IB_ SEGTEST, that you can use
as a template to create a module to aid in processing large messages and messages in batch for outbound
asynchronous PeopleSoft Integration Broker segment data with restart capability.

With restart capability, if there is an abnormal program termination, you can correct any data errors and
continue processing from the point of the last commit without having to reload message segment data
from the beginning.

Understanding the IB_SEGTEST Application Engine Library Module
This section provides overview information for using the IB_ SEGTEST

The IB_SEGTEST library module consists of three sections:

*  Section 1: Sectionl. The main processing section.

» Section 2: ABORT. Use to trigger a user abort of the running application engine program

* Section 3: CLEANSEG. An independent section you can call to clean up pending segment data that
had been committed to the database but is no longer to be used.

Prerequisites

To use the information provided in this section, you should have a thorough understanding of PeopleSoft
Application Engine.

Using the IB_SEGTEST Library Module

This section provides an overview of the high-level list of tasks to perform to set up a PeopleSoft
Application Engine program to perform restartable message processing.
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Make a copy of IB_SEGTEST, including all sections and PeopleCode.

From here on, the copy of the application engine library module is referred to as IB_ SEGTEST], but
you can use any name you choose.

In the State Records tab of IB_ SEGTEST], verify that PSIBSEGRSTR_AET is the default state
record. Replace PT_EIP ERR AET with whatever state record is used in the main application engine
program that will be calling the Library module.

Note that IB_SEGTEST] is flagged as not restartable. Since database commits will be performed in
the middle of PeopleCode processing, the only way the commits can take effect is if the module is
flagged as not restartable.

The application engine program used to call IB_SEGTEST1 should be restartable.
Always issue a commit in the step prior to calling the library module IB_ SEGTEST].

In the application engine program that will be calling IB_ SEGTEST], insert a step to call
IB_SEGTEST]1, section Sectionl. Insert the step at the point in time when you want to do the message
publish. You must issue a commit prior to calling this section, otherwise there will be a ‘Unable to
Process Commit’ error issued from within IB_ SEGTEST1.

Add PSIBSEGRSTR_AET as an additional state record to the calling application engine program.

Since both programs now share state records, when IB_ SEGTESTT1 is called, all state record
values will be passed on to the called module. Presumably all application values needed to extract
application data would be stored in the application state record.

Modify the PeopleCode in IB_SEGTEST1.Sectionl. Several comments have been added to the code
to aid in the modifications. Note the following:

* Change §MSG = CreateMessage (OPERATION.QE FLIGHTPLAN) to create whatever
message will be used.

* SegmentsByDatabase should always be set to True.

* The While loop is used to simulate application code processing large volumes of data. This can be
changed to meet application needs. However, pay close attention as to when commits are issued,
when state records are updated, when new segments are created, and finally, when the message
publish is executed. The order of these events is crucial to proper workability. In the sample
program, also note how to break out of the While loop.

* Note the location where the application state record needs to be updated. A comment instructs in
the PeopleCode provides instructions on where to perform this task.

* Do not remove the Exit (1) from the end of the PeopleCode. This is necessary to bypass the
Abort action that is coded into the same Step.

* Ifin the middle of processing, the application code determines that an abort needs to be triggered,
an Exit (0) can be coded. This triggers the Abort step to be called, which will terminate
application engine processing. A restart could then be issued if processing needs to continue.

If you determine that a message no longer needs to be published, the calling application engine
program could then call the CLEANSEG step to get rid of all the pending data that has been saved
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in the database. Alternatively, the Abort step could be modified to call CLEANSEG if on any
abort, no old data is to be kept.

See the product documentation for Application Engine for more information about application engine
programs.

Populating and Retrieving Document Data

This section discusses how to:
» Instantiate Documents objects.
* Populate document data.

¢ Retrieve document data.

Understanding Populating and Retrieving Document Data

This section provides guidelines for instantiating Document objects, and populating and retrieving
document data from document message types.

Memory Management in Message Segments that Use Documents
Following these guidelines when populating or retrieving document data from message segments:

* After your code to populate a segment, set the following statement to NULL:

&DOC = null;

Including this statement in your code releases the segment data from memory. If you do not include
this statement in your code, data from all segments accumulates in memory.

» Start each new segment processing section by setting the following statement to TRUE:

&DOC = &MSG.GetDocument (true)

Including this statement in your code guarantees that only one segment is in memory at a given time.

Instantiating Document Objects
This section discusses and provides examples for how to:
» Instantiate Document objects using package, name, and version.
» Instantiate Document objects using document keys.

» Instantiate Document objects for document message types.
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Instantiating Document Objects Using Package, Name, and Version

You can instantiate a Document object using the CreateDocument built-in function. Using this approach,
you use the Create Document built-in function, and then specify the document package name, the
document name, and the document version, as shown in the following example:

&DOC = CreateDocument ("Purchasing", "PurchaseOrder", "v1");

Instantiating Document Objects Using Document Keys

The following code example shows instantiating a Document object using the a document key. This
approach uses the CreateDocumentKey and CreateDocument built-in functions.

First you instantiate a Document Key object, using the CreateDocumentKey built-in function and passing
in the document package name, document name, and document version. You then instantiate a Document
object using the CreateDocument built-in function, and pass in the document key.

&DOCKEY = CreateDocumentKey ("Purchasing", "PurchaseOrder", "v1");
&DOC = CreateDocument (&DOCKEY) ;

Instantiating Document Objects for Document Message Types

The following example shows how to instantiate a document object when the document is being used as a
message type.

&DOC = &MSG.GetDocument () ;

Populating Document Data

206

This section discusses and provides examples for how to:
* Populate documents from messages.
* Populate document using rowsets.

* Populate message segments with documents.

Populating Documents from Messages

The following example shows how to use the CreateMessage built-in function to populate a document
from a message:

&MSG
&DOC

CreateMessage (Operation. PURCHASE ORDER) ;
&MSG.GetDocument () ;

Populating Documents Using Rowsets

The following example shows using the CreateMessage built-in function and the Document class to
populate a document using a rowset:

Local Message &MSG;
Local Document &DOC;

&MSG
&DOC

CreateMessage (Operation.PURCHASE ORDER) ;
&MSG.GetDocument () ;
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/* Get Rowset */
&Rowset = &DOC.GetRowset () ;

/* populate rowset like any other rowset

/* update document with popualted rowset * /
&nRet = &DOC.UpdateFromRowset (&Rowset) ;

If (&nRet) = True Then
$IntBroker.Publish (&MSG) ;
End-If;

Populating Message Segments with Documents
The following example shows code for populating message segments with documents.

After you code to populate a segment, set the following statement to NULL to release memory:
&DOC = null;

Then, set the following statement to TRUE to manage memory and guarantee that only one segment is in
memory at a given time:

&DOC = &MSG.GetDocument (true) ;

If you do not following these coding guidelines, memory will get filled with data from all segments in the
message.

The previous statements are in emphasis in the following example:

Declare Function PopulateDocument PeopleCode QE FLIGHTDATA.QE ACNUMBER FieldFormula=

Local Document &DOC;

&MSG = CreateMessage (Operation.FLIGHTPLAN DOC) ;
/*pass in true to get ownership of the object*/
éDOC = &MSG.GetDocument (true) ;

/*popualte the docment with data */
PopulateDocument (&DOC, 1);

/*create a new segment */
&MSG.CreateNewSegment () ;

/* null out object to release memory */
&DOC = null; &DOC = &MSG.GetDocument (true) ;
PopulateDocument (&DOC, 2);
&MSG.CreateNewSegment () ; &DOC = null;

&DOC = &MSG.GetDocument (true) ;
PopulateDocument (&DOC, 3);

/* publish segmented Message (3 segments) */
$IntBroker.Publish (&MSG) ;

Retrieving Document Data
This section discusses and provides code examples for how to:

* Retrieve document data from the Message object.
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* Retrieve document data from message segments.

» Retrieve document data within a Notification event using message segments

Retrieving Document Data from the Message Object

The following code provides an example of how to retrieve a document from the Message object:

Local Message &MSG;

Local Document &DOC;

Local Primitive &PRIM;

Local Compound &COM, &COM ID, &COM BILL, &COM SHIP, &COM ITEM;
Local Collection &COL ITEM;

&MSG CreateMessage (Operation.PURCHASE ORDER) ;
&DOC &MSG.GetDocument () ;
&COM = &DOC.DocumentElement;

&COM.GetPropertyByName ("LanguageCode") .Value = "ENG";

/* Populate TransactionID Compound */

&COM_ID = &COM.GetPropertyByName ("TransactionId");
&COM2 .GetPropertyByIndex (1) .value = "KAC";

&COM2 .GetPropertyByIndex (1) .value = "12345678";

/* Populate BillTo Compound */

&COM BILL = &COM.GetPropertyByName ("BillTo") ;
&COM5.GetPropertyByName ("name") .Value = "RobbyNash";
&COM5.GetPropertyByName ("number") .Value = 713;
&COM5.GetPropertyByName ("street") .Value = "High Wind";
&COM5.GetPropertyByName ("unit") .Value = "";
&COM5.GetPropertyByName ("city") .Value = "Paia";
&COM5.GetPropertyByName ("state") .Value = "Maui HI";
&COM5 .GetPropertyByName ("zipcode") .Value = "96779";

/* Populate item collection Collection (2 rows) */
&COL_ITEM = &COM.GetPropertyByName ("item collection");

&COM ITEM = &COL ITEM.CreateItem();
&PRIM = &COM_ITEM.GetPropertyByName ("item");

&PRIM.Value = "mast";
&PRIM = &COM ITEM.GetPropertyByName ("sku") ;
&PRIM.Value = "123322";

&PRIM = &COM _ITEM.GetPropertyByName ("price");
&PRIM.Value = 300;

&PRIM = &COM _ITEM.GetPropertyByName ("quantity");
&PRIM.Value = 12;

&nRet = &COL ITEM.AppendItem(&COM ITEM) ;

&COM ITEM = &COL_ITEM.CreatelItem();
&COM5.GetPropertyByName ("item") .Value = "boom";
&COM5.GetPropertyByName ("sku") .Value = "123334";
&COM5.GetPropertyByName ("price") .Value = 270;
&COM5.GetPropertyByName ("quantity") .Value = 10;
&nRet = &COL ITEM.AppendItem(&COM ITEM) ;

$IntBroker.Publish (&MSG) ;

Retrieving Document Data from Message Segments

The following code example shows an example of retrieving document data from message segments. As
discussed elsewhere in this section, the example shows setting the following statement to NULL :

&DOC = Null;
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Setting the statement to NULL clears memory between segment loops:

import PS PT:Integration:INotificationHandler;
class DOCUMENT TESTER implements PS PT:Integration:INotificationHandler
method FLIGHTDATA() ;
method OnNotify (&MSG As Message) ;
end-class;
/* constructor */
method FLIGHTDATA
end-method;
method OnNotify
/+ &MSG as Message +/
/+ Extends/implements PS PT:Integration:INotificationHandler.OnNotify +/
/* Variable Declaration */
Local Rowset &rs;
Local Document &DOC;
Local Record &FLIGHTDATA, &REC;
Local integer &i;
/* get each segment of data via a Document and proces it */
For &1 = 1 To &MSG.SegmentCount
/* null out object to release memory */
&DOC = Null;
&MSG.GetSegment (&1) ;
/* pass true to GetDocument method to take ownership of object */&DOC = &MSG.=>
GetDocument ( True) ;

/* process Document data for each segment */

End-For;

end-method;

Retrieving Document Data within a Notification Event Using Message Segments

The following code example demonstrates how to retrieve document data within an Notification event
using message segments.

As discussed elsewhere in this section, the example shows setting the following statement to NULL :
&DOC = Null;
Setting the statement to NULL clears memory between segment loops:
For &1 = 1 To &MSG.SegmentCount
&DOC = Null;

&MSG.GetSegment (&1) ;
&DOC = &MSG.GetDocument () ;

&COM &DOC.DocumentElement;
&str = &COM.GetPropertyByName ("LanguageCode") .Value;

&COM ID = &COM.GetPropertyByName ("TransactionId");
&str = &COM ID.GetPropertyByIndex(2) .Value;

&COM BILL = &COM.GetPropertyByName ("BillTo") .Value;
&str = &COM BILL.GetPropertyByName ("name") .Value;
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&COL _ITEM = &COM.GetPropertyByName ("item collecion");
For &j = 1 To &COL_ITEM.count

&COM_ITEM = &COL ITEM.GetItem(&]j);
&str = &COM ITEM.GetPropertyByName ("item") .Value;

End-For;
End-For;

Sending and Receiving Binary Data

This section discusses how to:
* Send binary data.

* Receive binary data.

Understanding Sending and Receiving Binary Data

PeopleSoft supports the MTOM protocol for sending and receiving binary data using service operations.
While you can send and receive binary data using SOAP, doing so requires that you Base64-encode the

data, which can increase message size by 33 percent or more. The MTOM protocol enables you to send

and receive binary data in its original binary form, without any increase in size due to encoding.

Whether sending or receiving MTOM-encoded binary data, you use message segments to store the data.
The SegmentContentType property of the Message object is used to set or read the content type of each
message segment.

Sending MTOM-Encoded Binary Data
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This section discusses how to send MTOM-encoded binary data and discusses how to:
» Set target connector properties to send MTOM-encoded binary data.

* Develop messages to send MTOM-encoded binary data.

Setting Target Connector Properties to Send MTOM-Encoded Binary Data

When sending MTOM-encoded binary data, you must use the HTTP target connector. The HTTP target
connector features an MTOM property that you must set to ¥ for MTOM encoding to occur. When you
set the MTOM property to Y, the HTTP target connector attempts to convert all outgoing message to the
MTOM wire format.

See “Using the HTTP Target Connector” (Integration Broker Administration).

Developing Messages to Send MTOM-Encoded Binary Data

An outgoing MTOM message is composed of a SOAP message and one or more sets of binary data.
Segments are used to add the binary data to the outgoing request.

For each chunk of data, use a single segment as follows:
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1. Create the segment.
2. Copy the data to the segment.

3. Add the MIME type that is to appear for the MIME part containing the binary in the outgoing MTOM
wire message.

4. Set the content transfer encoding to binary.

In PeopleCode this appears as:
&theMessage.CreateNextSegment () ;

If (&theMessage.SetContentString(&dataString)) Then

&theMessage.SegmentContentType = "image/jpeg";
&theMessage.SegmentContentTransfer = %$ContentTransfer Binary;
End-If;

The SetContentString method requires character data, and is not capable of passing binary data.

For MTOM, pass in a Base64-encoded string that contains the binary data. The File object method
GetBase64StringFromBinary allows a binary file to be read in and captured as a string; use this string to
set the data for the newly created segment.

See “SetContentString” (PeopleCode API Reference), “GetBase64StringFromBinary” (PeopleCode API
Reference).

When seen on the wire, the SOAP XML in the MIME multipart message contains xop:Include references.
These references point to the MIME parts that contain the binary data. In order to be able to construct
these references, Integration Broker requires that a specific XML element, PsftXoplnclude, is present in
the outgoing message.

Each PsftXoplnclude element corresponds directly to an xop:include in the outgoing wire message, and
therefore each PsftXoplnclude element logically corresponds to an instance of binary data. Placement of
the PsftXopInclude element in the XML is application-specific; Integration Broker does not require any
particular location.

In the following example the first instance of the PsftXopInclude element corresponds to the logical point
to include an image and the second PsftXopInclude element corresponds to the logical point to include a
binary document:

<?xml version='1.0'?>
<JobApplication>
<Photo name='JohnSmith'>
<PsftXopInclude SegmentNumber='1l"'/>
</Photo>
<Resume name='JohnSmithCVv'>
<PsftXopInclude SegmentNumber='2"'/>
</Resume>
</JobApplication>

The value of the SegmentNumber attribute is used by Integration Broker to link the PsftXopInclude entry
to a specific segment used to add the data. For the purposes of MTOM, the first segment used to add
binary data is considered to be number 1, the second segment, number 2, and so on. Care should be taken
when setting these values as Integration Broker does not check to ensure that they are correct; they are
used as-is to build the xop:include references in the wire message.

In the previous example, the message data is not SOAP-wrapped. You can choose to build your own
SOAP wrapper or elect to have Integration Broker SOAP-wrap the message. If Integration Broker is to
SOAP wrap the message, you must set the HTTP target connector property SOAPUpContent to Y.
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See “Using the HTTP Target Connector” (Integration Broker Administration).

An example of XML to use this feature is as follows:

<?xml version="1.0"?>
<flt:process xmlns:flt=" http://xmlns.oracle.com/Enterprise/
Tools/schemas/flightdata.v1l">
<PsftXopInclude/>
<flt:inputl>515</flt:inputl>
<PsftXopInclude/>
<flt:input2>664</flt:input2>
</flt:process>

You would include the previous XML in the XmlDoc object and add it to the first segment of the

message.

The additional segments include the binary data associated with each declaration. For example:

&MSG = CreateMessage (Message.FLIGHTDATA) ;
&MSG.SetXmlDoc (&xmldoc) ;

&MSG.CreateNextSegment () ;

&MSG.SetContentString ("your encoded image data");
&§MSG. SegmentContentType = "image/gif";
&MSG.SegmentContentTransfer = %ContentTransfer Binary;

&MSG.CreateNextSegment () ;

&MSG.SetContentString ("your encoded video here")
&MSG.SegmentContentType = "video/mp4";
&MSG.SegmentContentTransfer = %ContentTransfer Binary;

$IntBroker.Publish (&MSG) ;

The following code example provides another XML example that demonstrates using this feature:

Local File &theFile;

Local XmlDoc &theXmlDoc;

Local Message &theMessage;

Local string &theBase64encodedString;

/* note: this example does not have any error handling, in */
/* order to keep the code relatively short and concise. */

/* create the message, and add the basic XML message data */

/* ______________________________________________________ */

&theMessage = CreateMessage(Operation.QE_FLIGHTPLAN_UNSTRUCT);

Local string &xml;

/* this example requires the SOAPUPContent HTTP Target */

/* connector property to be set to "Y", so that the */
/* outbound XML will be SOAP wrapped. */
&xml = &xml | "<?xml version='1.0'?>";

&xml = &xml | "<JobApplication>";

&xml = &xml | "<Photo name='JohnSmith'>";

&xml = &xml | "<PsftXopInclude SegmentNumber='1'/>";

&xml = &xml | "</Photo>";

&xml = &xml | "<Resume name='JohnSmithCv'>";

&xml = &xml | "<PsftXopInclude SegmentNumber='2'/>";

&xml = &xml | "</Resume>";

&xml = &xml | "</JobApplication>";

&theXmlDoc = CreateXmlDoc (&xml) ;
&theMessage.SetXmlDoc (&theXmlDoc) ;

Chapter 7

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 7 Sending and Receiving Messages

/* add an image to the outgoing message */

/* ____________________________________ */

&theFile = GetFile("D:\output\smallPicture.jpg", "R", %$FilePath Absolute);
If &theFile.IsOpen Then
&theBaseb64encodedString = &theFile.GetBase64StringFromBinary () ;
&theFile.Close();
End-If;

&theMessage.CreateNextSegment () ;
If (&theMessage.SetContentString(&theBase6d4encodedString)) Then

&theMessage.SegmentContentType = "image/jpeg";
&theMessage.SegmentContentTransfer = $ContentTransfer Binary;
End-If;

/* add a PDF file to the outgoing message */
2 T — */

&theFile = GetFile("D:\output\smallDocument.pdf", "R", %$FilePath Absolute);
If &theFile.IsOpen Then
&theBaseb64encodedString = &theFile.GetBase64StringFromBinary () ;
&theFile.Close();
End-If;

&theMessage.CreateNextSegment () ;
If (&theMessage.SetContentString(&theBase6d4encodedString)) Then

&theMessage.SegmentContentType = "application/pdf";
&theMessage.SegmentContentTransfer = $ContentTransfer Binary;
End-If;

/* send the message */

/* ________________ */

$IntBroker.Publish (&theMessage) ;

Note: PeopleSoft currently supports MTOM for asynchronous messaging only.

Related Links

Working With Message Segments
“SetContentString” (PeopleCode API Reference)

“SegmentContentType” (PeopleCode API Reference)

Receiving Binary Data
This section discusses receiving MTOM-encoded binary data requests and discusses how to:
* Enable listening connectors to receive MTOM-enoded binary data.

» Use PeopleCode to process inbound MTOM-encoded binary data.

Understanding Receiving MTOM-Encoded Binary Data

To receive MTOM-encoded binary data from integration partners, you must use the PeopleSoft services
listening connector or the HTTP listening connector.

When a message is received by an MTOM-enabled connector, the gateway first determines if the message
is using MTOM. If it is not, the message is processed normally. If MTOM is detected, the gateway
extracts the SOAP message from the MIME and then encodes the binary data in the MIME parts. This is
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effectively a pre-processing step and is done first, before normal processing can occur. Once complete, the
SOAP message is then treated no differently from any other SOAP message received. The binary data is
Base64 encoded, and is attached to the message in the form of segments.

Enabling Listening Connectors to Receive MTOM-Encoded Binary Data

The following listening connectors can receive and process MTOM-encoded messages:

* PeopleSoft services listening connector.

* HTTP listening connector.

You must enable these connectors for receiving and processing MTOM messages for any MTOM
processing to occur. You enable these properties in the integration gateway properties file. The properties
appear the MTOM Enable ListeningConnectors section as shown in the following example:

# MTOM Enable ListeningConnectors

#
#1g.MTOM.enablePeopleSoftServicelisteningConnector=true
#1g.MTOM.enableHttpListeningConnector=true

By default the properties are not enabled and are commented out.

To enable a given connector, remove the comment (#) and ensure that the property is set to frue.

Note: When these properties are enabled there is a slight performance degradation to all non-MTOM
requests sent to the connectors. The degradation is a result of system process that takes place to determine
if requests are MTOM-encoded messages.

Using PeopleCode to Process Inbound MTOM-Encoded Binary Data

MTOM messages are processed in the form of message segments. The system processes inbound MTOM
requests in two general steps:

*  Process the XML data contained in the first segment.
» For each subsequent segment, process the binary data.

The first segment contains the XML data. The xop:include references in the XML are replaced with
PsftXoplnclude elements, and each instance will point to the segment containing the associated binary
data.

The structure of this XML is application-specific, and therefore processing of this XML cannot be easily
generalized. You may be able to use the location of the PsftXopInclude elements in the XML to derive
information about the binary data segments.

Consider the following inbound MTOM request example:

<?xml version='1.0'?>
<JobApplication>
<Photo name='JohnSmith'>
<PsftXopInclude SegmentNumber='2"'/>
</Photo>
<Resume name='JohnSmithCV'>
<PsftXopInclude SegmentNumber='3'/>
</Resume>
</JobApplication>
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In this example, the XML has been structured such that the parent element contains a name value for the
associated binary content. A more complete XML might also contain information such as file type, size,
or creation date. Again, the structure of this XML is not necessarily determined by Integration Broker, but
rather by the design of the application itself.

All segments after the first contain the Base64—encoded binary data. This data is accessible as a string.
Processing of this is also application-specific. Some applications may decide to store the encoded string
for later use, while others may wish to decode it immediately.

To process the string immediately, use the PeopleCode File object method WriteBase64StringToBinary to
decode the string and to write it out as a byte array to a file. Once the method has completed and the file
closed, the file can be accessed as any other file on the file system.

See “WriteBase64StringToBinary” (PeopleCode API Reference).

The following code example shows how to use PeopleCode to process and inbound MTOM request:

import PS PT:Integration:INotificationHandler;

class MTOM CLASS implements PS PT:Integration:INotificationHandler
method MTOM CLASS () ;
method OnNotify (&MSG As Message) ;
method getFileExtensionForContentType (&contentType As string)
Returns string;

end-class;

/* constructor */
method MTOM CLASS
end-method;

method getFileExtensionForContentType
/+ &contentType as String +/
/+ Returns String +/

Evaluate &contentType

When = "image/Jjpeg"
Return "jpg"
When = "application/pdf"

Return "pdf"
When-Other

Return "unk"
End-Evaluate;

end-method;

method OnNotify
/+ &MSG as Message +/
/+ Extends/implements PS PT:Integration:INotificationHandler.OnNotify +/

/* note: this example does not have any error handling, in */
/* order to keep the code relatively short and concise. */

/* Variable Declaration */

Local integer &i, &3;

Local string &contentSectionData, &contentSectionType;
Local File &theFile;

Local XmlDoc &theXml;

/* the first section will be XML */

&MSG.GetSegment (1) ;
&contentSectionData = &MSG.GetContentString(l) ;
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&theXml = CreateXmlDoc (&contentSectionData) ;
Local array of XmlNode &nodelList;

/* get all PsftXopInclude nodes, ignore namespaces */
&nodelList = &theXml.DocumentElement.FindNodes ("//*[local-name ()=
'PsftXopInclude']"™);

/* all subsequent sections will be binary data */

J* */
For &1 = 2 To &MSG.SegmentCount

&MSG.GetSegment (&1) ;
&contentSectionData = &MSG.GetContentString(&i);

/* get the type information directly from the segment */
/* we'll use this to determine the file extension */
&contentSectionType = &MSG.SegmentContentType;

Local string &theFileName = "D:\output\";

For &j = 1 To &nodelList.Len
If (&nodelist [&]].GetAttributeValue ("SegmentNumber") =
String(&1i)) Then

rem we've found the entry that matches this content section;
rem use the 'name' attribute from the parent XML element to

rem get the file name

rem NOTE - this assumes a particular XML format that may not
rem be the same for most applications;

&theFileName = &theFileName | &nodeList [&]].ParentNode.
GetAttributeValue ("name") ;

End-If;
End-For;

rem build the complete filename, including the extension;
&theFileName = &theFileName | "." | %$This.getFileExtensionForContentType
(&contentSectionType) ;

&theFile = GetFile(&theFileName, "W", $FilePath Absolute);
If &theFile.IsOpen Then
&theFile.WriteBase64StringToBinary (&contentSectionData) ;
&theFile.Close();
End-If;

End-For;

end-method;

Note: PeopleSoft currently supports MTOM for asynchronous messaging only.

Related Links

“Using the integrationGateway.properties File” (Integration Broker Administration)

Working With Message Segments
“WriteBase64StringToBinary” (PeopleCode API Reference)
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Using PeopleCode to Manage REST Service Operations

This section discusses how to:
» Use PeopleCode to manage provider REST service operations.
* Use PeopleCode to manage consumer REST service operations.

* Generate fully-qualified URLs for REST resources.

Using PeopleCode to Manage Provider REST Service Operations

This section discusses how to:

* Read document template data and populate response messages.

Set HTTP response headers.
» Retrieve HTTP response header data.

*  Set server-side caching.

Reading Document Template Data and Populating Response Messages

To read document template data and populate provider response messages, use the OnRequest method.
You implement the OnRequest method using an application class, specifically using the IRequestHandler

application interface.

When the OnRequest event is fired the document template is populated with the values based on the
corresponding URI template. You can use the populated primitive values along with the URI Template
index to determine the proper response message data to send back to the client. The code snippet below
shows a simple example of reading the document template data and populating the response message.
Note that one can override the HTTP return code that is sent as part of the response to the client.

import PS PT:Integration:IRequestHandler;

class WeatherData implements PS PT:Integration:IRequestHandler

method WeatherData() ;

method OnRequest (&MSG As Message)
method OnError (&request As Message)

end-class;

/* constructor */
method WeatherData
end-method;

method OnRequest
/+ &MSG as Message +/
/+ Returns Message +/

Returns Message;
Returns string;

/+ Extends/implements PS PT:Integration:IRequestHandler.OnRequest +/

/* Variable Declaration */

Local Document &Doc;
Local Compound &COM;
Local Message &response;

Local XmlDoc é&weather xmldoc;
Local XmlNode &info, &country,

Local Rowset &RS;
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/* get populated Document Template */
&§Doc = &MSG.GetURIDocument () ;
&COM = &Doc.DocumentElement;

&weather xmldoc = CreateXmlDoc("");

/* populate xmldoc with data from the Document Template */
&info = &weather xmldoc.CreateDocumentElement ("WeatherInformation");
&country = &info.AddElement ("Country") ;
&country.NodeValue = &COM.GetPropertyByName ("country") .Value;
&state = &info.AddElement ("State");
&state.NodeValue = &COM.GetPropertyByName ("state") .Value;
&city = &info.AddElement ("City");
&city.NodeValue = &COM.GetPropertyByName ("city") .Value;
&day = &info.AddElement ("Day");
&day.NodeValue = &COM.GetPropertyByName ("day") .Value;

/* determine HTTP method that was invoked to determine proper response
/* message */
If &MSG.HTTPMethod = %IntBroker HTTP GET Then

&data = &info.AddElement ("Forecast");

&data.NodeValue = "55 degrees and raining";

&response = CreateMessage (Operation.WEATHERSTATION GET,
$IntBroker Response);

&response.SetXmlDoc (&weather xmldoc) ;

End-If;
If &MSG.HTTPMethod = %IntBroker HTTP DELETE Then

&data = &info.AddElement ("Forecast") ;

&data.NodeValue = "deleted";

&response = CreateMessage (Operation.WEATHERSTATION DELETE,
$IntBroker Response);

&response.SetXmlDoc (&weather xmldoc) ;

End-If;

Return &response;
end-method;

method OnError
/+ &request as Message +/
/+ Returns String +/
/+ Extends/implements PS PT:Integration:IRequestHandler.OnError +/
Local Message &Fault Msg;
Local Document &fault doc;
Local Compound &COM;

If &request.HTTPMethod = %IntBroker HTTP GET Then
&Fault Msg = CreateMessage (Operation.WEATHERSTATION GET,
%IntBroker Fault);
&fault doc = &Fault Msg.GetDocument () ;
&COM = &fault doc.DocumentElement;
&COM.GetPropertyByName ("fault data") .Value = &request.IBException.
ToString () ;

Return &fault doc.GenXmlString();
End-If;

Return "";

end-method;
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Setting HTTP Response Headers

Use the LoadRESTHeaders method of the IBInfo class to load the response headers defined on the
routing for a REST-based service operation. Once loaded, the headers can be modified without specifying
the connector override property.

The code snippet below shows how to add HTTP response headers to the any REST based service
operation response within the OnRequest event.

&response = CreateMessage (Operation.WEATHERSTATION GET, %IntBroker Response);
&bRet = &response.IBInfo.LoadRESTHeaders () ;

/* any/ modify additional Headers not defined on Routing */

&bRet = &response.IBInfo.IBConnectorInfo.AddConnectorProperties

("Content-Language ", "eng ", S$HttpHeader);

Return &response;

Retrieving Response HTTP Header Data

You can use the REST method type Head to retrieve meta-information written in response HTTP headers,
without having to transport the entire content.

The REST-based service operation created with a method of HEAD does not have a request or response
message.

You can assign the OnRequest handler used for the GET method to the service operation to check if the
method type is HEAD and, if so, simply send back the HTTP response headers.

The following code snippet shows how to use the OnRequest method to retrieve HTTP response headers

Note: HTTP response headers can be sent back to the client for all REST method types.

If &MSG.HTTPMethod = %IntBroker HTTP HEAD Then

&response = CreateMessage (Operation.WEATHERSTATION HEAD,
$IntBroker Response);

&bRet = &response.IBInfo.LoadRESTHeaders () ;
/* any additional Headers not defined on Routing */
&bRet = &response.IBInfo.IBConnectorInfo.AddConnectorProperties

("Content-Language ","eng ", SHttpHeader):;

&bRet = &response.IBInfo.IBConnectorInfo.AddConnectorProperties
("WWW-Authenticate", "Basic", $HttpHeader) ;

Return &response;
End-If;
Setting Server-Side Caching

For provider REST GET service operations you can set server-side caching by setting the SetRESTCache
method on the Message object in the OnRequest PeopleCode event. The SetRESTCache method takes a
future Date Time object.
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If you set server-side caching the system caches the entire transactional data for the specific URI resource.
Subsequent requests from a client with an identical resource will result in the data being pulled from
memory/file cache.

At any time you can delete the cache by calling the DeleteRESTCache method on the IntBroker
PeopleCode object. The DeleteRESTCache method takes the service operation and service operation
version as input variables.

Using PeopleCode to Manage Consumer REST Service Operations
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This section discusses how to:
* Invoke a consumer REST service operation.

* Add REST HTTP connector headers.

Invoking a Consumer REST Service Operations

To invoke a consumer REST service operation, the message is instantiated and then the document
template is retrieved and populated. The URI index is selected and a SyncRequest method is invoked.
The response message contains the HTTP return code. Processing of the data is the same as any other
SyncRequest method. In the case of an error, if the User Exception option is selected on the routing, you
can attempt to read the fault if defined on the service operation. If the HTTP response code is the same as
that defined on the fault message, then the fault message is created and returned. You can read the fault in
the document, if the fault message is a Document message type. The message property IsFault is read to
determine if a fault message was created.

The code example shows a simple example of populating the document template data and entering the
URI resource index to use and invoking the SyncRequest method.

The GetURIDocument method of the Message class is used to retrieve the URI for the REST based on
the specified index. The URIResourcelndex property of the Message class is used to set or return the
index for the URI as an integer. This index corresponds to the row number in the URI grid of the REST
Resource Definition section of the service operation definition.

Declare Function out BI results PeopleCode QE FLIGHTDATA.QE ACNUMBER
FieldFormula;

&§MSG = CreateMessage(Operation.MAPS_GET);

/* Get URI Document and populate with data */
&DOC = &MSG.GetURIDocument () ;

&COM = &DOC.DocumentElement;

&COM.GetPropertyByName ("MapType") .Value = "topographic";
&COM.GetPropertyByName ("Scale") .Value = "1:63";
&COM.GetPropertyByName ("Planet") .Value = "Earth";
&COM.GetPropertyByName ("Country") .Value = "USA";
&COM.GetPropertyByName ("City") .Value = "WhiteSalmon";
&COM.GetPropertyByName ("Name") .Value "MainSteet";

/* Set URI Resource Index to be used */
&MSG.URIResourcelIndex = 1;

&return message = %IntBroker.SyncRequest (&MSG) ;

/* Get return data and display */

If &return message.ResponseStatus = %IB Status Success Then
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/* if xml is returned can use XmlDoc */
&xmldocReturn = &return mesage.GetXmlDoc () ;
out BI results (&xmldocReturn.GenXmlString());

/* or if the data returned is JSON */

Local JsonParser &parser = CreatedsonParser();

Local boolean &status = &parser.Parse(&return mesage.GetContentString());
Local JsonObject &j0Obj = &parser.GetRootObject () ;

out BI results(&jObj.ToString());

/* Read Response Headers if set */
For &1 = 1 To &MSG.IBInfo.IBConnectorInfo.GetNumberOfConnectorProperties ()

If &MSG.IBInfo.IBConnectorInfo.GetConnectorPropertiesType (&i) =

$HttpHeader
Then
&name = &MSG.IBInfo.IBConnectorInfo.GetConnectorPropertiesName (&1i);
&value = &MSG.IBInfo.IBConnectorInfo.GetConnectorPropertiesValue (&i);
End-If;
End-For;
Else
If &return message.IsFault = True Then
&Fault Doc = &return message.GetDocument () ;

&COM = &Fault Doc.DocumentElement;
out BI results(&COM.GetPropertyByName ("fault data") .Value);

Else
out BI results(&return message.IBException.ToString());
End-If;

End-If;

Adding REST HTTP Connector Headers

Use the LoadRESTHeader method of the Message class to add HTTP header properties not defined on the
routing for the service operation.

The code snippet below shows how to modify HTTP headers using PeopleCode

Note: The connector override flag in PeopleCode does not need to be set in this case.

No HTTP properties are currently applicable for REST and will be removed by the Integration Broker
framework.

&request = CreateMessage (Operation.MAPS GET) ;
&bRet = &request.LoadRESTHeaders () ;
/* add any additional Headers not defined on Routing */

&bRet = &request.IBInfo.IBConnectorInfo.AddConnectorProperties
("Content-Language ", "eng ", S%HttpHeader);

Related Links
“JsonBuilder Class” (PeopleCode API Reference)
“JsonBuilder Class Methods” (PeopleCode API Reference)
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In most REST-based services, representations are hypermedia documents that contain not just data, but
links to other resources.

Use the GetUrl method contained in the %IntBroker class to generate fully-qualified URLs for REST
service operation resources. You can use the URLs with defined HTML definitions to dynamically add
REST-based web service URL links.

Note: A provider or a consumer REST based service operation representation can be used to generate the
fully-qualified link(s).

The syntax of the GetUrl method is:

string &str = %IntBroker.GetURL( string <Service Operation>, integer
<Resource Index of Service Operation>, document <Document object

defined for document Template> , <optional> bool <secure/ unsecure

REST tgt location>, <optional> bool <add encoding for unsafe characters >

The following example shows within an implementation (OnRequest event) of a REST-based provider
service, HTML is generated using links defined from other REST-based service operations.

method OnRequest

Local Document &Doc Tmpl, &DOC;

Local Compound &COM Tmpl, &COM;

Local Message &response;

Local string &STR, &STR1, &STR2, &STR3, &STR4, &strHTML;
Local boolean &bRet;

&response = CreateMessage (Operation.WEATHERSTATION GET, %IntBroker Response);
/* read URI Document to get parms out from the request*/

&Doc_Tmpl = &MSG.GetURIDocument () ;

&COM Tmpl = &Doc Tmpl.DocumentElement;

/* Instantiate a Document object based on the REST based Service */
/* Operations Document Template for which to create a link. */

&DOC CreateDocument ("Weather", "WeatherTemplate", "v1");
&COM = &DOC.DocumentElement;

/* based off the data from the request populate the Document object */
If &COM Tmpl.GetPropertyByName ("state") .Value = "Washington" Then
&COM.GetPropertyByName ("state") .Value = "Washington";
/* call new method to create fully qualified URL(s) */

&COM.GetPropertyByName ("city") .Value = "WhiteSalmon";
&STR = %$IntBroker.GetURL ("WEATHERSTATION GET", 2, &DOC);

&COM.GetPropertyByName ("city") .Value = "Troutlake";
&STR1 = %IntBroker.GetURL ("WEATHERSTATION GET", 2, &DOC);

&COM.GetPropertyByName ("city") .Value = "Yakima";
&STR2 = %IntBroker.GetURL ("WEATHERSTATION GET", 2, &DOC);

&COM.GetPropertyByName ("city") .Value = "Lyle";
&STR3 = %IntBroker.GetURL ("WEATHERSTATION GET", 2, &DOC);

/* use these URLs as bind variables for the HTML definition */
&strHTML = GetHTMLText (HTML.WEATHER CITIES, &STR, &STRI, &STR2, &STR3);
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/* set the data in the response message */
&bRet = &response.SetContentString (&strHTML) ;

End-If;

Return &response;
end-method;

Using the Entity Registration Page

Use the Entity Registration Page to add external Entities and validate them.

To access the Entity Registration Page, navigate to PeopleTools > Integration Broker > Integration

Setup > External Entity Registration.

This example illustrates the fields and controls on the Entity Registration Page. You can find definitions

for the fields and controls later on this page.

Entity Registration Page
Entity Limit
PeopleTools

PeopleTools
External Entity

PeopleSoft

PeopleSoft
External Entity

User Defined

User Defined
External Entity

(" pisable Entity Check

Personalize | Find | (2] L:,J, First (4 10of1 (» Last

[+l |[=]

Personalize | Find | (2| L:,—* First (4 10of1 (b Last

4] |[=]

Personalize | Find | (2] L:,—j First (4 10of1 (} Last

4] |[=]

Field or Control

Description

Entity Limit

Use this field to set the Entity limit.

Disable Entity Check

Select or clear this check box to disable or enable the
verification of the Entity against the Entity Registration table.

PeopleTools External Entity

Use this field to add or update PeopleTools Entities.

Note: This field is updated by the PeopleTools Team.
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Field or Control Description
PeopleSoft External Entity Use this field to add or update PeopleSoft Applications
Entities.

Note: This field is updated by the PeopleSoft Applications
Team.

User Defined External Entity Use this field to add or update User Defined Entities.
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Understanding the Message Schema Builder

The message Schema Builder enables you to build, import, modify and delete XML message schemas.

Note: The terms message schema, XML message schema, and schema are used interchangeably in this
topic.

To test message schemas during development, use the Schema Tester utility.

Use the Service Operations - General page to enable runtime validation for a service operation, or use the
Service Schema Validation page to enable validation for several service operations at a time.

Related Links
“Understanding the Schema Tester Utility” (Integration Broker Testing Utilities and Tools)
Understanding Message Schema Validation

Enabling Runtime Message Schema Validation

Message Schemas

An XML message schema describes a model for the arrangement of tags and text in a valid XML
document. A schema provides a common vocabulary for a particular application that exchanges
documents.

Building, Importing, Modifying and Deleting Message Schemas

You can use the Message Schema Builder to manage message schemas for rowset-based messages in the
application database.

Note: You can also use the pages of the Message Builder component to manage rowset-based and
nonrowset-based schemas. However, the Message Builder enables you to work with only one message
schema at a time, whereas , the Message Schema Builder enables you to perform actions, such as building
and deleting message schemas, on multiple messages at a time.

Note: You cannot use the Message Schema Builder to build schemas for message parts or container
messages. You must use the Message Builder component to build schemas for these message types.

Rowset-Based Message Schemas

Use the Message Schema Builder to generate, regenerate, view or delete rowset-based message schemas.
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You cannot regenerate or delete a rowset-based message schema that is a message part. Part and container
schemas are automatically generated at save time so there's no need to explicitly regenerate or delete
them.

Nonrowset-Based Message Schemas

Use the Message Schema Builder to import new nonrowset-based schemas into the database, modify
existing nonrowset-based message schemas, or delete them.

Schemas for nonrowset-based message parts can be deleted or modified, but message parts should never
be without a schema. After deleting a nonrowset-based message part, you should always import or enter a
new schema for the message.

Selecting and Viewing Data in the Message Schema Builder

This section discusses how to:
» Select data in the Message Schema Builder.
* View message schema data details.

e  View XML message schema code.

Selecting Data in the Message Schema Builder

226

When you access the Message Schema Builder component (IB. SCHEMABUILD) the Schema Builder
page (IB_SCHEMABUILD) displays a search engine to use to search for messages and message schema
data with which to work and view.

To access the Schema Builder page, select PeopleTools > Integration Broker > Service
Utilities > Build Message Schemas.

This example illustrates the fields and controls on the Schema Builder page. You can find definitions for
the fields and controls later on this page.

Message Schema Builder

Message Name: Q

Owner ID: b

) Schema Exists ) Rowset-based
) Mo Schema ) Nonrowset-based
{*) Both (%) Both
Search
¥ Select Al Clear All Build Selected Schemas | Delete Selected Schemas
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The Schema Builder page provides the following options for searching for data with which to work and

view in the application database.

Field or Control

Description

Message Name

(Optional.) Click the Lookup button to locate a message
definition with which to work.

If you do not select a message name, the search will be based
on all message definitions in the application database.

Owner ID

(Optional.) From the Owner ID drop-down list, select the
owner ID for the message definition.

The owner ID helps to determine the application team that last
made a change to a message definition. The values in the drop-
down list box are translate table values that you can define in
the OBJECTOWNERID field record.

Schema

Select from the following options in the Schema group box:

*  Schema Exists. Select this option to search message
versions for which schemas have been built.

*  No Schema. Select this option to search message versions
for which no schemas have been built.

*  Both. (Default.) Select this option to search all message
versions.

Structure

Select from the following options in the Structure group box:

*  Rowset-based. Select this option to search for rowset-
based message versions.

*  Nonrowset-based. Select this option to search for
nonrowset-based message versions.

*  Both. (Default.) Select this option to search for rowset-
based and nonrowset-based message versions.

Search

Click the button to search the database based on the criteria
selected.

Viewing Message Schema Details

When you search for data in the Schema Builder, message detail results appear in the Message Schemas

grid.
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This example illustrates the Message Schema Builder page. The example shows search results appearing
in the Message Schemas grid at the bottom of the page.

Message Schema Builder

Message Name:  |QE_FLIGHTPLAN

Owner ID: |

) Schema Exists
) No Schema
(& Both

O Rowset.-based
) Nonrowset based
(® Both

Messaqge Criteria

Message Schemas

customize | Find | View A1 | B0 B8 First Bl 47 or7 B Last

Message Message Version

(] QE FLIGHTPLAN VERSION_1 Yes ves  ONIONZ0
[] QE FLIGHTPLAN ASYNCCOMBO  VERSION_T No No 97952800
[] QE FLIGHTPLAN SYNC VERSION_1 Yes No 9798200
[] QE FLIGHTPLAN SYNCCOMBO  VERSION_T No No 979800
[] QE FLIGHTPLAN TRANSFORM VERSION_1 Yes No 9798200
[] QE FLIGHTPLAN UNSTRUCT VERSION_1 No No  97l98En08
[] QE FLIGHTPLAN UNSTRUCT SYNC VERSION_T1 No No  97l98Ea08
SelectAll [0 ClearAl Build Selected Schemas Delete Selected Schemas
Field or Control Description

Message

Message name returned from the search of the application
database.

Message Version

Version of the message returned from the search of the
application database.

Rowset-based

Indicates the structure of the message. The valid values are:
e Yes. Indicates that the message is a rowset-based message.

*  No. Indicates that the message is a nonrowset-based
message.

Exists

Indicates whether a schema has been built for the message.
The valid values are:

e Yes. A schema has been built for the message.

e  No. A schema has not been built for the message.
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Field or Control Description

Updated On Timestamp of the last update of the record. A new timestamp
displays when a schema is generated or deleted for a message.

Build Results Displays the results of actions performed on a schema.

Build Selected Schemas Click the button to build schemas for the selected messages.

Delete Selected Schemas Click the button to delete schemas that exist for the selected
messages.

Viewing XML Message Schema

If a message schema exists for a message, click the message name in the Message Schema grid to view
the schema details in the Schema Viewer page (IB_ SCHEMABUILD SEC).

This example illustrates the Schema Viewer page. The example shows schema details for version I of the
QFE FLIGHTPLAN message definition

Message: QE_FLIGHTPLAN . VERSION_1

Schema:

=Hml version="1.0"7= -
=x¥5d:5chema xmins:xsd="http:/fwww w3.org/2001MLSchema™
=¥sd:element name="QE_FLIGHTPLAN" type="GE_FLIGHTPLAMN_Type3hape™/=
=xsd.complexType name="QE_FLIGHTPLAMN_TypeShape™=
=¥sd.sequence=
=¥sd.element name="FieldTypes” type="FieldTypes_TypeShape™/=
=¥sd:element name="MsgData" type="MsaData_TypeShape"/=
=hsd:sequence=
=hsd.complexType=
=xsd.complexType name="FieldTypes_TypeShape™=
=xsd:all=
=¥sd.element name="0E_FLIGHTDATA"
type="FieldTypesQE_FLIGHTDATA_TypeShape = bl
£ >

Return

Note: For easier viewing, highlight the data with your cursor.

Message schemas for rowset-based messages are read-only. You can edit message schemas for nonrowset-
based messages.
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Building Message Schemas for Rowset-Based Messages

This section discusses how to build message schemas for rowset-based messages.

Building a Message Schema for a Rowset-Based Message

To build a message schema for a rowset-based message:

L.

3.

4.

Access the Schema Builder page (PeopleTools > Integration Broker > Service Utilities > Build
Message Schemas).

Search the application database for the message or messages for which to build schemas.

See Selecting Data in the Message Schema Builder.

Select the check box next to the message or messages for which to build schemas.

Click the Build Selected Schemas button.

When the schema is built successfully, a timestamp appears in the Updated On field and the Build
Results field displays Successful Schema Insert.

Importing Message Schemas for Nonrowset-Based Messages

This section discusses how to import message schemas for nonrowset-based messages.

Importing a Message Schema for a Nonrowset-Based Message

230

To import schemas for nonrowset-based messages:

L.

Access the Schema Builder page (PeopleTools > Integration Broker > Service Utilities > Build
Message Schemas).

Use the Message Schema Builder search engine to locate the message for which you want to import a
schema.

See Selecting Data in the Message Schema Builder.

In the Message Schema grid, click the message name link for the message for which you want to
import a schema.

Import the schema.
e Import a schema from a file.

You can import a schema from a file by using the Upload Schema from File button and selecting
the file to import. After you import the file, the contents displays in the Schema text box.

Note: If you receive the error, “Error retrieving the file from database,” verify that one of the
variables PS_FILEDIR or PS_SERVDIR is defined in the system variables on your machine.
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See Understanding Setting PS_FILEDIR, PS_ SERVDIR, and PS TREEBASEDIR Environment
Variables.

» Direct data entry.

You can also enter the schema directly in the Schema text box.

5. Click the Save button.
The Schema Builder page appears.

A timestamp appears in the Updated On field and the Build Results field displays Successful Schema
Insert.

Modifying Message Schemas

This section discusses how to modify message schemas.

Note: You can modify the content of message schemas built for nonrowset-based messages only.

To modify a schema, you can edit it directly in the Message Schema Builder, or you can export to make
changes.
Modifying a Message Schema
To modify a message schema:
1. Select PeopleTools > Integration Broker > Service Utilities > Build Message Schemas.
The Schema Builder search page appears.
2. Locate the message with which you want to work.

See Selecting Data in the Message Schema Builder.

3. Inthe Message Schema grid, click the message name link.

A new page displays with the message schema populated in a text box.
4. Modify the schema as needed.

*  Modify the schema directly in the text box, or

*  Modify the schema in the editor of your choice.

Use your cursor to highlight the contents of the text box and use the keyboard command CTRL
+ C to copy the contents of the text box. Paste the contents into your editor using the keyboard
command CTRL + V. Modify the content as needed. Import the content back into the Message
Schema Builder using the instructions described previously in this topic for importing message
schemas for nonrowset-based messages.
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See Importing Message Schemas for Nonrowset-Based Messages.

5. Click the Save button.

The Schema Builder page displays and the Updated On field displays the date and time of the
modification, and the Build Results field displays the results of the new schema build.

Deleting Message Schemas

This section discusses how to delete message schemas.

Understanding Deleting Message Schemas

You can delete message schemas using the Message Schema Builder page in the Message Schema Builder
component (IB_SCHEMABUILD) or using the Message Schemas page in the Service Administration
component (IB_ HOME PAGE).

Note: The Message Schema Builder page provides more comprehensive capabilities for searching for
message schema.

You cannot delete a message schema when the message on which the schema is based is:
» Referenced in a service operation.

* Referenced as a message part in a container message.

* A rowset-based message part.

* A container message.

* Referenced in a provided WSDL document.

Using the Message Schema Builder Page to Delete Message Schemas

232

When deleting a schema using the Message Schema Builder page use only the Delete Selected Schemas
button. Do not attempt to delete message schemas by deleting content in the Schema text box in the
schema details view; if you save the changes, PeopleSoft Integration Broker will attempt to validate the
blank schema at runtime and the validation will fail.

You cannot delete message schemas when the service system status is set to Production.
The service system status that is set on the Service Configuration page.

See “Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration
Broker Administration).

To delete a message schema:

1. Access the Message Schema Builder page (PeopleTools > Integration Broker > Service
Utilities > Build Message Schemas).
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The Schema Builder search page appears.
2. Locate the message with which you want to work.

See Selecting Data in the Message Schema Builder.

The Schema Builder page appears.

3. Inthe Message Schema section, select the check boxes next to the message names that contain
schemas you want to delete.

4. Click the Delete Selected Schemas button.
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Understanding Managing Services

Services are used to logically group a set of service operations.

For example, if you have a number of service operations that are related to customers, such as those
pertaining to customer information, adding customers, updating customers, deleting customers, and so on,
you can create a customer web service and then associate the related service operations with that service.

Warning! PeopleSoft delivers two services with PeopleSoft Integration Broker: IB. GENERIC and
IB_UTILITY. These services are used internally by the system. Do not delete or modify these services.

Before you can provide or consume services in a PeopleSoft system, you must configure the system
for handling services.“Configuring the Integration System to Handle Services” (Integration Broker

Administration)

Common Elements Used to Manage Services

Field or Control

Description

Comments (Optional.) Enter comments about the service or service
definition.

Description Description of the service.

Generate SOAP Template Click to open the Generate SOAP Template utility. The utility

enables you to generate SOAP documents for each service
operation in a service for testing purposes.

The link appears when working with a SOAP-based service
and only if WSDL has been generated for the service. Note
that you can use the Provide Web Service link on the Services
page to generate WSDL for the service.

Link Existing Operations

Click to add service operations already defined in the system
to a service.
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Field or Control

Description

Object Owner ID

(Optional.) Indicates the owner of the service.

The owner ID helps to determine the application team that last
made a change to a service definition. The values in the drop-
down list box are translate table values that you can define in
the OBJECTOWNERID field record.

Operation Type

Specifies how the service is transmitted.

On the Service page this field defines the operation type of the
service operation added.

Provide Web Service

Click to launch the Provide Web Services component and
export PeopleSoft services as WSDL documents.

Schema Namespace

Provides qualification for attributes and elements within an
XML schema document (XSD).

The default is http://xmlins.oracle.com/Enterprise/Tools/
schemas.

The namespace on the message definition defaults to the
schema namespace you set as the default on the Service
Configuration page.

Note: If you change the namespace, all future messages will
have the new namespace.

Service

The name of the service.

Service Alias

(Optional.) Overrides the service name and will be the name of
the service when the WSDL is provided or exported. The alias
enables you to use mixed case in the name.

Service Operation

The name of the service operation to associate with the
service.

On the Services page, use this field to add new service
operations for the current service.

Service Namespace andNamespace

The namespace field on the Service pages provides
qualification for attributes and elements within a WSDL
document.

The value defined in the Service Namespace field in the
Service Configuration page is used as the default service
namespace on the Services page. The default value is Attp./
xmlin.oracle.com/enterprise/tools/service.
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Field or Control Description

Service System Status The status that is selected restricts rename, delete, and other
administrative actions that users can perform on integration
metadata in the Services Administration component.

Values are:

*  Production.

*  Development.

See “Understanding Configuring PeopleSoft Integration

Broker for Handling Services” (Integration Broker
Administration).

Target Location Specifies the URL to be used for service requests.

You must define this location before creating services and
service schemas.

View WSDL Click to view WSDL documents in the WSDL repository that
have been generated for the service.

This link appears only when the service you are viewing is a
SOAP-based service.

Accessing and Viewing Service Definitions

This section discusses how to.

* Access service definitions.

* View WSDL documents generated for services.
*  View service operation information.

* View messages defined for services.

Accessing Service Definitions

Service definitions appear on the Services page (IB_SERVICEDEFN) in the Service component
(IB_SERVICEDEFN).

To access the Services page, select PeopleTools > Integration Broker > Integration Setup > Service
Definitions.
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This example illustrates the Services page. The example shows the service definition for the
IB_EXAMPLES service.

Services
Service: IB_EXAMPLES
*Description: B Examples.
Comments: Thiz senvice contains the following I1B examples:
1. XML examples:
a. OutSync XML to 3rd party. w
< [
Sernvice Alias: |
Object Owner ID: | PeopleTools v
*Namespace: |http:h‘xmlns.Uracle.cnmenterpriseﬂ'nnlsfsem'ce siB,
Link Existing Operations Wiew WSDL Provide Web Service

Service Operations

Service Operation: |
Operation Type: | w | Add |
Existing Operations
Operation Type

IB EX MP NONROWSET ASYNCw1 Msg pars nonrowset async. Asynch =]
1B EX MP MOMBOWSET SYMCw1 Msg pars nonrowset sync. Synch =]
B EX MP ROWSET ASYMC.wW1 Msg parts rowset async. Asynch E|
IB EX MP ROWSET SYMNCw1 Msg pars rowset sync. Synch E|
IB EX SYNC SOAP.v1 Sync SOAP. Synch =]
IB EX SYNC SOAP TP.w1 Sync SOAP to 3rd party. Synch =]
1B EX SYMC XML.W1 Sync XML. Synch [=]
IB EX SYNC XML TP.wi Sync XML to third party. Synch =l

The top of the Service page displays general information about the service, including the name of the
service, its description, its alias name, and so on.

Viewing WSDL Documents Generated for Services

Click the View WSDL link to display the WSDL Repository page (IB_SERVICEDEFN_SEC). This page
provides a summary of all the WSDL documents that are generated for the service, as well as the service
operations, request messages, response messages, and fault messages that are contained in each.

Note: Service operations must exist for a service to view WSDL documents for the service.
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This example illustrates the WSDL Repository page. The example shows the WSDL in the repository of
the IB_ EXAMPLE service. The example shows that WSDL has been exported for one service operation in

the service.

WSDL Repository
Service: IB_EXAMPLES

WSDL/WADL
WSDL: IB_EXAMPLES.A

View WSDL

Exported Service Operations

Operation

Routing External Alias

Default

Request Message

Last Update Date/Time:

Personalize | Find | View

Find

El | 2
Lk

Response Message

First B 1 or 1 B Last

04M17/2011 1:19:24PM

First B 1 o 1 B Last
Fault Message

IB_EX_SYNC_SOAP_REQUEST V1 IB_EX_SYNC_SOAP_RESFOMNSEV1

IB_EX_SYNC_S0AP1

IB_EX_SYMNC_S0AP V1

Click the View WSDL link on the WSDL Repository page to view the WSDL document in the WSDL

Viewer page (IB_SERVICEWSDL _SEC).

This example illustrates the WSDL Viewer page. The example shows the WSDL document for the

IB EXAMPLES.I.

WSDL Viewer [ 5¢]

Help

WSDL:  IB_EXAMPLES.1

=PEml version="1.0"%=
=wsdl:definitions name="1B_EXAMFLES.1"
targetfamespace="hitp:/xmins.oracle.com/Enterprise/Tools/senvices/IB_EXAMPLES. 1"
xminsIB_EX_SYMNC_S0AP_REQUEST v1="http:ffxmins.oracle.comiEnterprise/Tools!sche
mas/B_EX_SYNC_S0OAP_REQUEST W™
¥minsIB_EX_SYMC_S0AP_RESPOMSEvI="http.xmins.aracle.comiEnterprise/Toolsisch
emas/IB_EX_SYMNC_SOAP_RESPOMSENT"
¥mins:plnk="http:/’schemas.xmlsoap.orgfws/2003/05/partner-link™
¥mins:soap="http:flschemas.xmlsoap.orgiwsdlisoap’
¥minstns="http:fmins.oracle.com/Enterprise/Tools/senvices/IB_EXAMPLES. 1"
¥mins:wsdl="http:ilschemas. xmlsoap.orgfwsdl™
¥mins:wsp="http:ischemas.xmlsoap.orgfwsZ20021 2/policy™
=wsp:UsagePolicy wsdl:Required="true"/=
=plnk:partnerLinkType name="IB_EXAMPLES_PFartnerLinkType™=
=plnk:role name="1B_EXAMPLES_Provider™=
=plnk:porType name="tns:1B_EXAMPLES_PorType"/=
=/plnkrole=
=/pink:partnerLinkType=
=wsdltypes=
=x¥sd:5chema elementFormDefault="qualified”
¥minsxsd="http:fwww w3.orgl2001XMLSchema™
=¥sd.import
namespace="http:fxmins.oracle.com/Enterprise/Tools/schemas/|B_EX_SYNC_SO0AP_RE
QAUEST 1" schemalocation="IB_EX_SYMC_S0AFP_REQUEST v1.xsd™f=
=xsdimport

Return | - o | N
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To view a WSDL document generated for a service:

L.

Access the service definition. (PeopleTools > Integration Broker > Integration Setup > Service
Definitions.)

Click the View WSDL link.

The WSDL Repository page appears.

Click the View WSDL link.

The document appears in the WSDL Viewer page.

Click the Return button to return to the WSDL Repository page.

Click the Return button again to return to the Services page.

Viewing Service Operation Information

The Existing Service Operations section of the Services page contains an Operation tab that displays
service operations and service operation versions that are associated with the service. It also displays
descriptions of the service operations, the type of operation, and whether the service operation is active.

When you click the name of a service operation, the operation opens on the Service Operations page,
where you can view and modify service operations information, work with the service operation handlers,
routing definitions, and do much more.

Viewing Messages Defined for Service Operations

240

The Existing Service Operations section of the Services page contains a Messages Links tab that displays
the request and response messages defined for each service operation.

This example illustrates the Existing Service Operations section of the Services page. The example shows
the Message Links tab displaying request and response messages for the service operations that are
associated with the 1B EXAMPLES service

Existing Operations Customize | Find | View Al| ] 88 First Bl 1.5 or g I Last
Request Message\Version Response Message\ersion

B EX MOMROWSET COMTAIMER.M1 (=]
B EX NOMROWSET CONTAINER.WT IB EX MOMROWSET COMTAINER w1 [=]
B EX ROWSET CONTAINER.W1 (=]
B EX ROWSET COMTAINER.W1 IB EX ROWSET COMTAINER w1 [=]
IB EX SYNC S0AP REQUEST W IB EX S¥YMNC SOAP RESPOMSE.WT (=]
IB EX GEMERIC W1 IB EX GEMERIC.V1 (=]
B EX SYNC XML IB EX SYNC XML (=]
B EX GEMERIC w1 IB EX GEMERIC W1 (=]
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Click the request or response message name to open the message in the Message Definitions page, where
you can view and modify message definition information, message schema information, and more.

Adding Service Definitions

This section discusses how to add service definitions to the PeopleSoft system.

Understanding Naming Services and Service Aliases

Service names and service alias names can be exposed as web services. As a result, the following
restrictions apply when you name a service or a service alias. Service names and service alias names:

* Cannot begin with XML, xml, or Xml.
* Cannot begin with a digit.

* Cannot begin with a character.

Adding Service Definitions

To add a service definition to the system, use the Add a New Value link on the Services search page.
To access this page, select PeopleTools > Integration Broker > Integration Setup > Service
Definitions. Then select the Add a New Value link.

This example shows the Add New Service page.

Add New Service

Service: Q
[]REST Service

Add Return to Search

Note: Before you can add a service, you must configure PeopleSoft Integration Broker to handle services
using the Service Configuration page.

See “Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration
Broker Administration).

After you add a service definition to the system, the Services page (IB_ SERVICEDEFN) appears where
provide additional service definition information.
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This example illustrates the Services page. The example shows the definition for a non-REST service
called DEMO _SOAP_SERVICE.

Services

Service: DEMO_SOAP_SERVICE REST Service
*Description: |

Comments:

Service Alias: |

Owner ID: | b
*Namespace: |http dtemins.oracle.comi/Enterprise/Tools/senvices
Link Existing Operations View WSDL
Semvice Operations
Service Operation: |
Operation Type: | v Add

To add a service definition:

1.

Access the Services page (PeopleTools > Integration Broker > Integration Setup > Service
Definitions).

Click the Add a New Value link.

In the Service ficld, enter a name for the service.

Restrictions for naming services are discussed elsewhere in this section.
See Understanding Naming Services and Service Aliases.

Click the Add button.

The Services page appears.

In the Description field, enter a description for the service.

(Optional.) If the service is REST-based, select the Is Provider check box to define the service as a
provider service.

By default, when you add a REST-based service to the system it is a provider service.
(Optional.) In the Comments field, enter comments about the service or the service.
(Optional.) In the Service Alias field, enter an alias name for the service.

Restrictions for naming service aliases are discussed elsewhere in this section.
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See Understanding Naming Services and Service Aliases.

9. (Optional.) From the Object Owner ID drop-down list box, select the owner of the service.
10. In the Namespace field, enter a namespace URI for the service.

The default value is the namespace that is declared in the Service Namespace field on the Service
Configuration page.

11. Click the Save button.

Related Links

Adding Service Operations to Service Definitions

Adding Service Operations to Service Definitions

This section discusses how to:
* Add existing service operations to service definitions.
* Define new service operations for SOAP-based service definitions.

* Define new service operations for REST-based service definitions.

Understanding Adding Service Operations to Service Definitions
You can add a service operation that already exists in the database to a service definition, or you can add
and configure a new service operation and then add it to a service.

Adding Existing Service Operations to Service Definitions
To add an existing service operation to a service:

1. Access the Add Existing Operations page (PeopleTools > Integration Broker > Integration
Setup > Service Definitions and click the Link Existing Operations link).

The Add Existing Operations page appears.
2. Select a service operation to add to the service.

a. In the Service Operation field, enter the name of the service operation to add to the service and
click the Search button. The service operation appears in the Available Service Operations grid.

Select the check box next to the service operation name.

b. In the Service Operation field, click the Lookup button. The Look Up Service Operation page
appears.

Select a service operation from the list to add to the service.

c. Click the Search button to show a list of service operations in the database.
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Select one or more service operations to add to the service.

3. On the Add Existing Operations page, click the Save button.

The Services page appears and the service operations that you added appear in the Existing
Operations grid.

4. On the Services page, click the Save button.

Defining New Service Operations for SOAP-Based Service Definitions
This section describes how to define new service operations for SOAP-based services.
To add and configure a new service operation for a SOAP-based service:

1. Access the Services page (PeopleTools > Integration Broker > Integration Setup > Service
Definitions).

The Services page appears.

2. In the Service Operations section, locate the Service Operation field and enter a name for the new
service operation.

3. From the Operation Type drop-down list, select the type of service operation you are adding.
The valid values are:
*  Asynch Request/Response.
*  Asynch to Synch.
*  Asynch—One Way.
*  Synchronous.
Service operation types are discussed elsewhere in the product documentation.

See Services Operation Types.

4. Click the Add button.
The Service Operations-Definitions page appears. Use the page to configure the service operation.

See Configuring Service Operation Definitions.

Creating and Managing Integration Groups

This section provides and overview of integration groups and discusses how to:
* Add integration groups.

* Add integration subgroups.
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* Add services to integration groups and subgroups.
* Rename and delete integration groups.

* Copy integration groups using Project Copy.

Understanding Integration Groups

PeopleSoft provides you with the ability to great groups and subgroups of integrations that you can then
deploy using the Integration Network. Your PeopleSoft integration partners can then use the Integration
Network to introspect and activate those integrations on their systems.

You can assign services to one or more integration groups or subgroups. However, there can only be one
instance of a service within a group or subgroup assignment.

Adding Integration Groups

To add an integration group to the system, use the Integration Group search page. To access the page
select PeopleTools > Integration Broker > Integration Setup > Integration Group Definitions.

This example shows the Integration Groups — Add a New Value tab.

Integration Groups

Add a New Value

Integration Group Name;

After you name the integration group, the Integration Group Definitions page (IB_INTGROUPDEFN)
appears where you can add an optional description for the group and save the definition.
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This example illustrates the Integration Group Definitions page.

Integration Group Definitions

Integration Group Name  DEMO_INTEGRATION _GROUP

*Description

Object Owner ID | b |

EY |, =
Personalize | Find | E | E=2 First 4] 1 of 1 n Last

Q[

Add Senvices

Subgroups Find  First B0 1 0r 1 B0 Last

Integration Subgroup Hame |

[+][=]

*Description

*Senvice

. EY | -t
Subgroup Services Personalize | Find | B0 | B8 Firet B 4 op g IO st

e
Q [

Add Senvices

To add a service integration group:

1. Select PeopleTools > Integration Broker > Integration Setup > Integration Group

Definitions.
The Integration Group search page appears.
2. Click the Add a New Value tab.
3. In the Integration Group Name field, enter a name for the integration group.
4. Click the Add button.
The Integration Group Definitions page appears.
5. In the Description field, add a description for the group.
6. (Optional.) From the Object Owner ID field, select the owner of the object.

7. Click the Save button.

Chapter 9

After you have added the definition to the system you can proceed to add services to the integration

group, as well as create integration subgroups and add services to them.
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The process for adding services to integration groups and to integration subgroups is identical and is
described elsewhere in this section.

See Adding Services to Integration Groups.

Adding Services to Integration Groups

Use the Integration Group Definitions page shown in the previous section to add services to integration
groups.

Note: The information presented in this section for searching for services to add to an integration group
also applies to searching for services to add to integration subgroups.

You can search for the services to add to a group (or subgroup) by using the Add Services link on the
Integration Group Definitions page to access the Add Services page (IB_ INTGROUP_SEC).

This example illustrates the Add Services page.

Add Services

Senvice Name

Search |

El | =
Perzonalize | Find | E | = First K 1 of 1 )] Last

You can search for a service by entering a partial or complete service name in the Service Name field and
then clicking the Search button. You can also leave the Service Name field blank and click the Search
button to display a list of all services in the database.

After you locate the service or services to add to the group, select the Select check box next to each
service name to add to the group and click the OK button.

To add services to an integration group:

1. Access the Integration Group Definitions page (PeopleTools > Integration Broker > Integration
Setup > Integration Group Definitions).

2. Click the Add Services link.

The services search page appears.
3. Search for one or more services to add to the integration group, as described previously in this section.
4. Click the OK button to return to the Integration Group Definitions page.

5. Click the Save button.
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The Integration Group Definitions page features a Subgroups section where you define subgroups for an

integration group and then add services to the subgroups.

This example shows the Subgroups section of the Integration Group Definitions page. Use this section of

the page to add subgroups to an integration group.

Subgroups Find

First!I 1 of1 u La=t

Integration Subgroup Name |

[+][=]

Description

Subgroup Services

*Senvice

- . =
Personalize | Find | & |

First!I 1 of1 u La=t

Q [

Add Senvices

To add a service integration subgroup:

1. Access the Integration Group Definitions page (PeopleTools > Integration Broker > Integration

Setup > Integration Group Definitions).

2. Locate the Subgroup section of the page.

3. In the Integration Subgroup Name field, enter a name for the subgroup.

4. In the Description field, enter a description for the subgroup.

5. Click the Add Services link to add services to the subgroup.

The process for adding services to integration groups and to integration subgroups is identical and is

described elsewhere in this section.

See Adding Services to Integration Groups.

6. Click the Save button.

To add additional subgroups to the integration group, in the Subgroups section title, click the Add Row
button (+) to add another subgroups grid to the page and repeat the steps described in this section to

define the subgroup and add services to it.

Deleting Services from Integration Groups and Integration Subgroups

To delete a service from an integration group or an integration subgroup:

1. Access the Integration Group Definition page (PeopleTools > Integration Broker > Integration

Setup > Integration Group Definitions).
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2. In the Services or Subgroup Services section of the page, click the Delete Row button (-) next to the

name of the service to delete.

3. Click the Save button.

Renaming and Deleting Integration Groups
This section discusses how to:
* Rename integration groups.

* Delete integration groups.

Understanding Renaming and Deleting Integration Groups

You can rename and delete integration groups using the Integration Groups tab (IB_ INTGROUPADM) in

the Service Administration component (IB. HOME PAGE).

The Integration Group tab contains two sections: a Delete section that enables you to delete integration
groups and a Rename section that enables you to rename integration groups. When you first access the
Integration Groups tab, both sections are collapsed. Click the section header arrow buttons to expand and

collapse each section.

This example illustrates the Service Administration — Integration Groups page. The example shows the

Delete section and Rename section expanded.

@ Messages Message Schemas Queues Routings

Service System Status Development

Integration Groups

Integration Group Name |
Search

Integration Groups Personalize | Find | view Al | #

Select Integration Group Hame Results

First n 1af1 n Last

Deprecated PeopleCode DY

Delete

Integration Group Name |

New Name |

Rename

Results:

The service system status has no impact on renaming or deleting integration groups.

Renaming Integration Groups

To rename and integration group:
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4.

5.

Access the Service Administration — Integration Groups page (PeopleTools > Integration
Broker > Service Utilities > Integration Broker Admin and click the Integration Group
Definitions tab).

Click the arrow next to the Rename section header to expand the section.

In the Integration Group Name field, enter the service to rename, or click the Lookup button to
search for and select the group to rename.

In the New Name field, enter the new name for the integration group.

Click the Rename button.

After you click the Rename button, the Results field displays a message that the action was successful or
displays a warning or error message with a description of the problem.

Deleting Integration Groups

To delete and integration group:

1.

Access the Service Administration — Integration Groups page (PeopleTools > Integration
Broker > Service Utilities > Integration Broker Admin and click the Integration Group
Definitions tab).

Click the arrow next to the Delete section header to expand the section.

In the Integration Group Name field, enter the integration group to delete, and click the Search
button. Search results display in the results grid.

In the results grid, select the check box next to the integration group or groups to delete.

Click the Delete button.

Copying Integration Groups Using Project Copy

You can copy integration groups between PeopleSoft databases using Project Copy.

When using Project Copy to copy integration groups select the Integration Groups as one of the definition
types. To copy all of the service information, such as service, service operation, handler, and so on, select
all of the definitions in the Related Definitions box.

Note: At a minimum you must select Services in the Related Definitions box.

Restricting and Enabling Write Access to Service Definitions

This section provides an overview of restricting access to services and discusses how to:

Restrict write access to services.

Enable write access to services.

Note: The information in this section applies to REST and non-REST service definitions.
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Understanding Restricting Write Access to Service Definitions

When you restrict write access to a service, sensitive fields of the service definition and of associated
service operations appear in read-only mode. The following table lists the components and pages that
contain fields and data that are related to services and describes the impact that restricting access to

services has to each of them.

Restricted Component or Page

Restriction

Comments

Service

All fields are read-only.

NA

Service Operation

All fields are read-only, with the
following exceptions:

*  User Password Required.
*  Non-Repudiation.

e Runtime Schema Validation.

When a service is restricted, you cannot
regenerate routings.

Handlers All fields are read-only except: When a service is restricted, you can still
activate or inactivate handlers.
*  The Status drop-down list box.
e The Add a Row button (+) that is
used to add new handlers.
Routings All fields are read-only except: When a service is restricted, you can:

*  The Inactivate Selecting Routings
and Activate Selected Routings
buttons.

e The Add button.

*  Activate and deactivate routings
of service operations that are
associated with the service.

*  Add new routings to service
operations that are associated with
the service.

You cannot delete or rename a restricted service. In addition, you cannot change, rename or delete any
service operation that is defined as part of a restricted service.

Restricting Write Access to Service Definitions

Use the Service Configuration — Restricted Service page (IB_SVCSETUP3) in the Service Configuration
component (IB_SVCSETUP) to restrict a service.
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This example shows the Service Configuration — Restricted Services page.

Senvice Configuration UDDI Configuration Restricted Services Exclude PSFT Auth Token

Search

Restricted Service |Service Description

Service: | Q
[]Restricted Service

Services Customize | Find | View A1 | 20 88 First B 4 or 1 B st

To restrict write access to services:

1.

Select PeopleTools > Integration Broker > Configuration > Service Configuration. Click the
Restricted Services tab. The Restricted Services page appears.

In the Service field, enter a service name and click the Search button, or click the Lookup button to
search for a service.

The service name or search results display in the Services list.
Select the Restricted Service check box next to the service name to which you want to restrict access.

Click the Save button.

Enabling Write Access to Service Definitions

252

This section describes how to enable write access to services that you previous restricted.

To enable write access to services that you previously restricted:

L.

Select PeopleTools > Integration Broker > Configuration > Service Configuration. Click the
Restricted Services tab.

The Restricted Services page appears.

Select the service to write-enable using one of the following methods:

* In the Service field, enter a service name and click the Search button.
*  Click the Lookup button to search for a service.

» Select the Restricted Services check box, and click the Search button to display and select from
all currently restricted services in the system.

The service name or search results appear in the Services list.
Deselect the check box next to the service name to write access enable.

Click the Save button.
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Renaming and Deleting Service Definitions

This section discusses renaming and deleting service definitions.

Note: The information in this section applies to REST and non-REST service definitions.

You can rename and delete services using the Services tab in the Service Administration component
(IB_HOME_PAGE). The Services tab contains two sections: a Delete section that enables you to delete

services and a Rename section that enables you to rename services.

When you first access the Services tab, both sections are collapsed. Click the section header arrow buttons

to expand and collapse each section.

This example illustrates the Services Administration — Services page. The example shows the Delete and

Rename sections of the page expanded.

Senvice System Status: Development

Mote - Only services with no operations can be deleted.

Service: |

Search

WSDL Services Semnice Operations Messages Message Schemas Queues

- S
Services Customize | Find | View All | @I T First [ 4] 10f1 n Last

Select Service Description Results

Delete

Routings RN

Service: | Q

New Name: |

Rename

Results:

Renaming Service Definitions

The service system status that you set on the Service Configuration page affects the ability to rename

services.

See “Using the Service Configuration Page to Set Service Configuration Properties” (Integration Broker

Administration).

To rename a service:

1. Select PeopleTools > Integration Broker > Service Utilities. Click the Services tab.
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The Service page displays.
2. Click the arrow next to the Rename section header to expand the section.

3. Inthe Service field, enter the service to rename, or click the Lookup button to search for and select
the service to rename.

4. Inthe New Name field, enter the new name for the service.
5. Click the Rename button.

After you click the Rename button, the Results field displays a message that the action was successful or
displays a warning or error message with a description of the problem.

Deleting Service Definitions

You can delete services only when the service has no service operations associated with it. When you
search for a service to delete, only such services that have no service operations associated with them are
retrieved from the system.

To delete a service:

1. Select PeopleTools > Integration Broker > Service Utilities. Click the Services tab.
The Service tab displays.

2. Click the arrow next to the Delete section header to expand the section.

3. Inthe Service field, enter the service name to delete, and click the Search button.
Search results display in the results grid.

4. In the results grid, select the check box next to the service or services to delete.

5. Click the Delete button.

Activating and Deactivating Service Definitions in Bulk
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This section describes activating and deactivating service definitions in bulk.

Note: The information in this section applies to REST and non-REST service definitions.

The Service Administration — Service Activate/Deactivate page (IB_ HOME PAGED9) in the Service
Administration component enables you to activate and deactivate services in bulk.

This page enables you to quickly activate or deactivate services. If any problems occur during activation,
the system displays a message indicating a problem activating a certain object, for example routing,
handler, and so on. If such a message occurs, you must look at the corresponding object definition to
determine the problem. This page is not intended to be used to debug activation problems or problems
with integration metadata definitions.
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This example shows the Service Administration — Service Activate/Deactivate page.

ation Groups Deprecated PeopleCode Service ActivateDeactivate

Level

® Integration Group Integration Group Name | QL
& show ANl Subgroups
) Filter by Subgroup
CINo Subgroups
Show Services tied to Group

O Service Service

Search I

PEEﬂnﬂEEIE@QIWEﬂW%HIGﬂw i Fkattl-1ﬂ-ll’Lﬁﬂ

Description Results

Activate | Deactivate |

When you activate one or more services, all of the default service operation associated with the services
become active. In addition, the handlers, routings and queues associated with the service operations
become active as well.

When you deactivate one or more services, all selected services become deactivated. The default service
operations for the services become deactivated as well. In addition, the handlers and routing definitions
associated with the service operations become deactivated. Queues do not become deactivated, since they
can be shared with other service operations.

You can search for services to activate or deactivate by integration group name and related parameters or
by service name.

The following controls appear on this page:
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Field or Control

Description

Integration Group

(Default.) Select the control to search the database for services
to activate or deactivate by integration group.

Use one of the following integration group filters:

*  Show All Subgroups. (Default.) Select the radio button
to display all integration subgroups associated with
integration groups in the system.

»  Filter by Subgroup. Select the radio button to search for
a specific integration subgroup and enter its name in the
field.

*  No Subgroups. Select the radio button to omit integration
subgroups from your search.

*  Show Services Tied to Group.(Default.) Check the box
to include the services tied to an integration group in the
search results. By default this option is selected.

Integration Group Name

If searching by integration group, enter the integration group
name by which to search or click the Lookup button to search
for one.

Service Select the radio button and enter the name of the service by
which to search or click the Lookup button to search for one.
Search Click the button to search the database for services based on

the criteria entered.

Services (grid)

This grid displays the search results and features this controls:

*  Select. Check the box to select one or more services in the
grid to activate or deactivate.

*  Service. Indicates the name of the service.
*  Description. Description of the service.

*  Results. Displays the results of the activate or deactivate
action.

Activate Click the button to activate the services selected in the
Services grid.
Deactivate Click the button to deactivate the services selected in the

Services grid.

To activate or deactivate services in bulk:

1. Access the Service Activate/Deactivate page (PeopleTools > Integration Broker > Service
Utilities > Integration Broker Admin and click the Service Activate/Deactivate tab).
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2. Search for services to activate or deactivate:
To search by integration group:
a. Click the Integration Group control.

b. In the Integration Group Name ficld, enter or search for the integration group by which to
search.

c. If appropriate, select additional integration groups filters as described previously in this section.
To search by service in the Service field enter or search for the service name by which to search.

3. Click the Search button.

4. Select the Select check box next to each service to activate or deactivate.

5. Click the Activate button to activate the selected services; click the Deactivate button to deactivate
the selected services.

When the system has performed the selected action, the Results column displays Success for each
service you activated or deactivated.
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Understanding Managing Service Operations

This section discusses:

* Service operations.

» Service operation types.

* Naming conventions for service operation metadata.
* Service operation aliases.

» Service operation versions.

*  Monitoring service operations.

Note: Before you can provide or consume services in a PeopleSoft system, you must configure the system
for handling services.

Related Links

“Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration Broker
Administration)

Service Operations

A service operation definition consists of general information about an operation, such as its name,
description, and so on. It also specifies an operation type, which determines how the operation is to

be processed, synchronously or asynchronously. In addition, it contains routings, which determine the
direction, inbound or outbound, of the service operation. A service operation has one or more handlers,
which contain and run the programming logic for sending or receiving the message, manipulating
message content, and so on.

Note: Beginning with the PeopleTools 8.48 release, service operations house the processing logic found
in messages, transactions and relationships used in earlier versions of PeopleSoft Integration Broker.

Services Operation Types

When you create a web service operation you must specify a service operation type. Service operation
types determine the type of message processing.

There are four service operation types:
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Term

Definition

Asynchronous Request/Response

The sending system invokes a service operation
asynchronously and processes the response from the receiving
system asynchronously. Unlike a synchronous operation

type, the response is not processed on the same thread as the
response, and it is processed sometime in the future.

Asynchronous to Synchronous

The sending system's asynchronous process sends a
synchronous request to a remote system.

The sending asynchronous system expects the receiving
system to send a synchronous response back. The sending
asynchronous system transforms the response and puts it back
in the queue for asynchronous consumption.

Asynchronous — One Way

The service operation is queued and sent in near real-time.
Processing on the sending system continues without a response
from the receiving system.

Synchronous

The service operation is processed in real-time. Processing
on the sending system does not continue until it receives a
response from the receiving system.

Naming Conventions for Service Operation Metadata

Service Operation Aliases

Service Operation Versions

260

When naming the following service operation metadata, names cannot start with “xml,” digits or special

characters:

e Service operation names.

» Service operation aliases.

A service operation alias or operation alias is the service operation name that displays for the service

operation when WSDL or WADL is provided.

Service operation aliases may be mixed case.

Duplicate service operation alias names within a service are not allowed.

When you create a service operation, the operation that you create automatically becomes the default

service operation version.

If you add a new version to the operation, the newly added version automatically becomes the default.
The previous version of the service operation remains in the database as a non-default version and you

still may use that the non-default version.
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See Using Non-Default Service Operation Versions.

Monitoring Service Operations

This section describes several options for monitoring service operation performance.

Monitoring Service Operations in the Integration Broker Service Operations
Monitor

PeopleSoft provides an Integration Broker Service Operations Monitor that enables you to monitor
asynchronous and synchronous service operation information, node status, queue status, manage domains,
and more, from within the PeopleSoft Pure Internet Architecture.

See the product documentation for Integration Broker Service Operations Monitor.

Monitoring Service Operations in the Integration Network Monitor

The Integration Network provides a Network Monitor that enables you to monitor local integrations and
integrations from all remote PeopleSoft nodes defined in the Integration Network.

See “Using the Integration Network Monitor” (Integration Broker Administration).

Monitoring Service Operations in the Integration Network Transactional Tracker

The Integration Network provides a Transactional Tracker that enables you to monitor transactions
between the local system and remote PeopleSoft nodes defined in the Integration Network.

See “Using the Integration Network Transactional Tracker” (Integration Broker Administration).

Monitoring Service Operations in Performance Monitoring Tools Using Module
and Action Information

Several system monitoring tools report metrics by capturing Module and Action information. On

an Oracle database, PeopleSoft provides service operation name and PeopleCode event name as

Module name and Action name respectively. On an IBM Db2 database, PeopleSoft provides service
operationname as Module name (no Action information is provided for Db2 systems). This information
enables you to associate service operations with database transactions for monitoring and troubleshooting.

To enable capturing service operation and PeopleCode event metrics you must set the
EnableDBMonitoring option in PSADMIN.

See “Monitoring PeopleSoft MODULE and ACTION Information” (Data Management).

Accessing and Viewing Service Operation Definitions

This section discusses how to:
*  Access service operation definitions.

e View service operation definitions.
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Use the pages in the Service Operations component (IB_ SERVICE) to access and view service operation

definitions.

The example shows the Service Operations — General page. The example shows the definition for the

QFE FLIGHTPLAN SYNC service operation.

General Handlers

Routings

Service Operation
Operation Type

*QOperation Description

Operation Comments

Owner ID

QE_FLIGHTPLAN_SYNC

Synchronous

QE_FLIGHTPLAN_SYNC

[l user/Password Required

*Req Verification ~ None h

i Service Operation Security

[T used with Think Time Methods

Operation Alias ‘

[ conditional Navigation

Default Service Operation Version

Runtime Schema Validation

] Request Message

Add Fault Type | | Response Message

O Non-Repudiation

Message Information

“Version VERSION_1 Default Active
Version Comments
Any-to-Local  Does not exist

Local-to-Local Does not exist

Routing Actions Upon Save

[l Generate Any-te-Local

["] Generate Local-to-Local

Transactional

Type  Request

Message.Version QE_FLIGHTPLAN_SYNC VERSION_1 Q. View Message
Type Response

Message.Version QE_FLIGHTPLAN_SYNC.VERSION_1 Q. View Message

To access a service operation definition:

1. Select PeopleTools > Integration Broker > Integration Setup > Service Operation

Definitions.
The Service Operations— Search page appears.

2. Search for a service operation definition to view.
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You can search for an operation in one of two ways:
*  Click the Search button to display all service operation definitions in the system.

* Enter search criteria in one or more of the following fields, and then click the Search button:
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Field or Control

Description

Service

Enter the service name that contains the service operation
that you want to view, or click the Lookup button to
search for and select a service name.

Service Operation

Enter the name of the service operation to view, or click
the Lookup button to search for and select an operation.

Operation Type

This search option is for web service operations only.

From the Operation Type drop-down list box, select an
operation type. Values are:

*  Asynch Request/Response
e Asynch to Synch
e Asynchronous — One Way

e Synchronous

3. In the Service Operations results grid, click the name of the service operation to view.

The Service Operations — General tab appears with data for the service operation that you selected.

Viewing Service Operation Definitions

The Service Operations component includes three pages:

Field or Control

Description

General Tab

Features general-service and default-service operation
information.

Handlers Tab

Provides summary information about handlers that have been
added to an operation. Service operation handlers contain

the programming logic for sending and receiving service
operations and their contained messages, and for manipulating
content.

Routings Tab

Provides summary information about service operations
routings. Routing definition determine the direction—inbound,
outbound or hub—of service operations.

Viewing General Service Operation Information

When you access a service operation ( PeopleTools > Integration Broker > Integration Setup >
Service Operation Definitions, the Service Operations - General page (IB_SERVICE) appears.
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The top portion of this page contains basic information about a service operation, including its name,
description, and so on. The Service Operation Security link opens the permission list for the service.
Note that the Service Operation Security link appears only after a service operation definition is saved.

Note: The Conditional Navigation control is reserved for future use.

The Runtime Schema Validation group box shows if runtime schema validation is selected for the request
and response messages.

The Routing Status group box shows if any-to-local, local-to-local, or in the case of feeds, local-to-Atom,
routing definitions have been generated for the service operation. Click the Routings tab to view detailed
information about routing definitions that exist for a service operation.

The Routing Actions Upon Save group box shows the possible routings that the system can generate
when the service operation definition is saved.

The Message Information section displays the request message, response message information, and fault
message for the service operation. The View Message links in this section open the displayed message
on the Message Definition page, where you can view additional information about the message. For
messages defined for web services, all service operations with operation types other than Synchronous,
the queue to which a message belongs also appears. Click the View Queue link or the Add New Queue
link to open the Queue Definition page to view additional queue definition information or to add or
change a queue to which a message belongs.

Viewing Handler Information

To view service operation handler information, click the Handlers tab. Doing so displays the Service
Operations - Handlers page (IB_ SERVICEHDLR) which lists summary information about handlers that
have been added to an operation.

This example illustrates the Service Operations — Handlers page.

General Handlers Routings

Service Operation: QE_FLIGHTPLAN
Default Version: VERSION_1
Operation Type: Asynchronous - One Way

Customize | Find | View A1 20 B First B 43 0r2 B Last
Seqguence |*Implementation *Status

GEN_UPG_HANDLER_182802 OnNotify 3 Application Class Details =]
GEN_UPG_HANDLER_21703 OnNotify 1 Application Class Details =
Test_Handler On Notify 2 Application Class Details =]

This example shows the Service Operations — Handlers page for an asynchronous service operation,
QFE FLIGHTPLAN.

The summary information includes the handler name, the handler type, and the implementation method
for the handler. The status of the handler, active or inactive, also appears.

Click the Details link to open the Handler Details page (IB_SERVICEHDLR SEC) for the handler.
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This example illustrates the Handler Details page.

Managing Service Operations

Handler Details

Handler Hame:
Handler Type:

Description:

Comments:

Handler Owner:

Handler Alias:
Application Class

Class ID:

Method:

*Package Name:

*Path:

GEM_UPG_HAMDLER_18802
OnMotify

\QE_FLIGHTPLAN

GEM_UPG_HAMDLER_18802

\QE_FLIGHTPLAN
[ Q
[FLIGHTPROFILE

| OnNotify
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The Handler Details page shows additional information about the handler, including the owner and
application class or component interface details.

You can also use this page to specify the handler details.

Viewing Routing Information

Click the Routings tab to open the Service Operations - Routings page (IB_SERVICERTNGS) to view a
summary of routing definitions for an operation.

This example illustrates the Service Operations — Routings page.

General Handlers Routings

QE_FLIGHTPLAN

VERSION_1
I Add

Service Operation:
Default Version:

Routing Name:

Routing Definitions Al IE'I #il First L4 10f1 o Last

Customize | Find | Vi

Selected Hame Version Operation Type |Sender Node Receiver Node  |Direction Status Results

[F] ~GEN~UPG~24248 VERSION_1 Asynch QE_LOCAL QE_IBTGT Outbound

Inactivate Selected Routings | Activate Selected Routings |

The Routings Definition grid on the page lists summary information for routings that are defined for a
service operation. Summary information that is displayed includes the routing definition name, service
operation version, routing type, sending node, receiving node, direction of the routing and the routing
status.

Click a routing definition name to open the routing in the Routing Definitions component, where you can
view additional information about the routing.
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See Viewing Routing Definitions in Graphical Format.

You can also use this page to add routing definitions to a service operation and to activate or deactivate
routings for an operation.

See Adding Routing Definitions, Activating and Inactivating Routing Definitions.

Adding Service Operation Definitions

This section describes how to add web service operation definitions to the PeopleSoft system.
To add a service operation definition:

1. Select PeopleTools > Integration Broker > Integration Setup > Service Operation
Definitions.

The Service Operations — Search page appears.
2. Click the Add a New Value link.

3. In the Service field, enter the service name to which the new operation will belong or click the
Lookup button to search for a service name.

4. In the Service Operation field, enter a name for the service operation.

5. From the Operation Type drop-down list box, select an operation type. Values are:
*  Asynchronous — One Way
*  Synchronous
*  Asynch Request/Response

*  Asynch to Synch

6. Click the Add button.

The new definition appears on the General tab of the Service Operation component, and you can now
define the service operation.

Configuring Service Operation Definitions

After you add a service operation definition to the system, you can define the service operation.
This section discusses how to:

*  Specify general service operation information.

* Define service operation version information.

* Add handlers to service operations.
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* Add routing definitions.

* Activate and inactivate routings.

Specifying General Service Operation Information
To specify general service operation information:

1. Access the Service Operations-General page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions).

2. In the Operation Description field, enter a description for the operation.

3. (Optional.) Select the User ID/ Password Required check box to require a user ID and password for
inbound service operations.

See “Managing User Authentication” (Integration Broker Administration).

4. From the Security Verification drop-down list, select the level of security with which inbound
integrations must be sent.

See “Validating Security on Inbound Integrations” (Integration Broker Administration).
5. (Optional.) In the Operation Comments ficld, enter comments about the service operation.
6. (Optional.) From the Object Owner ID field, select the owner of the definition.

The owner ID helps to determine the application team that last made a change to a service
definition. The values in the drop-down list box are translate table values that you can define in the
OBJECTOWNERID field record.

7. (Optional.) In the Operation Alias field, enter an alias name for the service operation.

When working with a web service operation, the general information section of this page includes a
Service Operation Security link. Granting permissions to service operations is discussed elsewhere in
this topic.

Before you can save the service operation definition, you specify messages for the service operation, as
described in the next section.

See Setting Permissions to Service Operations.

Defining Service Operation Version Information

When you first create a service operation definition, the definition that you initially define is the default
version.

When the newly created service operation definition opens, the Default check box is enabled and is read-
only.

You can subsequently define additional service operation versions and assign them as the default.

See Managing Service Operation Versions.

Copyright © 1988, 2023, Oracle and/or its affiliates. 267



Managing Service Operations Chapter 10

268

Defining General Version Information
To define the service operation default version:

1. Access the Service Operations - General page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions).

2. In the Version field, enter a version identifier.
The default is v/.
3. (Optional.) In the Version Description field, enter a description for the operation version.

If you enter no information, the description by default is the name of the service operation when you
save the definition.

4. (Optional.) In the Version Comments box, enter comments about the version.
5. (Optional.) Select the Non-Repudiation check box to apply nonrepudiation to the message.

6. (Optional.) Select the Runtime Schema Validation check box to enable service schema validation at
runtime. You can set validation for the request message, response message, or both.

Continue to the next section to specify messages for service operations. You cannot save the service
operation definition until you define messages for it.

Specifying Messages for Service Operations

You specify messages for service operations in the Message Information section of the Service Operations
— General page.

The messages that you specify define the structure of the data that is contained in the service operation.

The service operation type determines the number of messages and message types (request or response)
that you specify.

To specify messages for a service operation:
1. Locate the Message Information section on the Service Operations — General page.
2. Locate the Type field, and take note of the message type to define.

3. In the Message.Version field, enter the message name followed by a dot and version, or click the
Lookup button to search for one.

After you select the message, you can click the View Message link to view the message.

4. Specify the queue for the message.

Note: If you are defining a message for a synchronous operation type, you do not need to define a
queue.

Your options are:
* In the Queue Name field, enter the queue name.

*  Click the Lookup button to search for a queue.
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*  Click the Add Queue link to open the Queue Definitions page and define a new queue for the
message.

See Adding Queue Definitions.

*  Click the Multi-Queues link to open the Queue List page and assign multiple queues to process
the message.

The Multi-Queue link appears only when you have enabled the multi-queue feature and when
you are working with asynchronous service operations.

See Assigning Multiple Queues to Process Service Operations.

5. Repeat steps 1 through 4 for each message type that appears in the Message Information section.

6. Click the Save button.

Specifying Fault Messages for Service Operations

You can specify fault messages for service operations for error handling.
Note the following about fault messages:

*  You cannot add fault messages to asynchronous service operations.

* Fault messages must be nonrowset-based messages, container messages, or document messages. Fault
messages cannot be rowset-based messages.

To specify a fault message:
1. Locate the Default Service Operation Version section on the Service Operations — General tab.
2. Click the Add Fault Type button.

A new row appears in which to specify a message. Note that the Type field in the new row displays
Fault.

3. Inthe Message.Versionfield, enter the message name, or click the Lookup button to search for one.
After you select the message, you can click the View Message link to view the message.
4. Click the Save button.

To delete a fault message, in the Default Service Operation Version section, click the Delete Fault Type
button. Then click the Save button.

Generating Local-to-Local and Any-to-Local Routing Definitions

Use the Service Operations-General page to initiate generating local-to-local and any-to-local routing
definitions.

See Initiating System-Generated Routing Definitions.
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Adding Handlers to Service Operations

Adding handlers to service operations is discussed elsewhere in the product documentation

See Understanding Service Operation Handlers.

Adding Routing Definitions

This section describes how to create point-to-point service operation routing definitions from the Service
Operations — Routing page.

To add a routing to a service operation:

1.

Access the Service Operations - Routings page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions and click the Routings tab).

In the Routing Name field, enter a name for the routing.
Click the Add button.
The Routing Definition page appears.

Creating and defining a routing is discussed elsewhere in the product documentation.

The next section describes how to activate routings.

Related Links

Understanding Routing Definitions

Adding Routing Definitions

Activating and Inactivating Routing Definitions

270

To activate or inactivate a routing:

L.

On the Service Operations component, click the Routings tab.
The Routings page appears.

Select the check box in the Select column next to the routing definition names that you want to
activate or inactivate.

Activate or inactivate the routing definition.
* To activate the routings, click the Activate Selected Routings button.

* To inactivate the routings, click the Inactivate Selected Routings button.

Click the Save button.
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Setting Permissions to Service Operations

This section describes how to use the Service Operations component to set permissions to access service
operations. You can also set these permission in the Security component.

Understanding Setting Permission to Service Operations
Security operations are secured using permission lists.

When you select the User/Password Required check box on the Service Operations-General page, on
inbound integrations, your integration partners must supply a valid user ID that is associated with the
permission list you specify to invoke service operations.

Setting Permission Access to Service Operations

To grant permissions to service operations:

1. Select PeopleTools > Integration Broker > Integration Setup > Service Operation
Definitions and select a service operation with which to work.

The Service Operations - General page appears.
2. Click the Service Operation Security link.
The Web Service Access page appears.

3. In the Permission List field, enter a permission list for the service operation, or click the Lookup
button to search for and select one.

4. From the Access drop-down list, select an access level for the service operation. Values are:
*  Full Access. (Default.)

¢ No Access.
5. Click the Save button.

Related Links

“Defining Permissions” (Security Administration)

Managing Service Operation Versions

This section discusses how to:
* Create service operation versions.

* Use non-default service operation versions.
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Creating Service Operation Versions

The information in this section pertains to REST and non-REST service operations.

When you create a new service operation version, the new version automatically becomes the active
default version.

If you have generated WSDL or WADL for the current service operation, after you create the new version
you are prompted to generate WSDL or WADL for the new version.

To create a new service operation version:

1. Select PeopleTools > Integration Broker > Integration Setup > Service Operation
Definitions.

Select the service operation with which to work. The Service Operations—General page appears.
2. At the bottom of the page, click the Add Version link.
The Service Operation Versions page appears.
3. Inthe Service Operations Version field, enter the new version and click the OK button.
The Service Operations Version page appears.
4. Complete the fields as appropriate for the new service operation version.
See Defining Service Operation Version Information.
5. Click the Save button.
The new service operation version appears in the Service Operations—General page.

A Non-Default Versions grid appears at the bottom of the page that lists and provides access to the
previous service operation version. Note that all versions that display in this grid have a status of Inactive.

Using Non-Default Service Operation Versions

272

PeopleCode processing for service operation handlers takes place on the default service operation version.

To continue using non-default service operation version you must write and apply transformations to
transform message shapes contained in the non-default service operation version to the message shapes
contained in the default version so that handler processing of the service operation can occur.

You need to write and apply transformations only for the changed message shapes. For example, if

a service operation contains request and response messages, but only the request message shape has
changed between versions, you need only write and apply a transform program to transform the request
message on the request message that is contained in the non-default service operation version to the shape
of the request message in the default version.

The non-default versions are inactive until the transformations are entered and the status is changed to
Active. Then the grid shows the version with Active.
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Attaching Files to Service Operations

This section provides an overview of attaching files to service operations and discusses how to:
* Use the FTP Attachment utility.
* Send attachment information with service operations.

*  Process attachment information that is included in service operations.

Understanding Attaching Files to Service Operations

PeopleSoft Integration Broker provides an FTP Attachment Upload utility that enables you to upload

attachments from any directory to your FTP server and then provide the location of the attachments in
service operation PeopleCode. The attachments can be in any file format, such as text files, EDI files,
word processing files, and so on.

As the operation is consumed, you can access these attachments using the attachment API. The recipient
can get the necessary information about the attachment and can retrieve it using a URL or file location
that you provide.

Note: The FTP Attachment Upload utility does not support uploading attachments from the database. To
upload attachments from the database, manually retrieve and copy them to the FTP server.

Using the FTP Attachment Utility

Use the FTP Attachment Upload page in the Files Utilities component (IB_ FILEUPLOAD) to upload
files to your FTP server for attaching to service operations.

To access the FTP Attachment Upload page, select PeopleTools > Integration Broker > File
Utilities > FTP Attachment Upload.

This example illustrates the fields and controls on the FTP Attachment Upload page. You can find
definitions for the fields and controls later on this page.

FTP Attachment Upload

User: I

Password: |

FTP Host; |

Remote Directony: |

File Hame Prepend: |

Add Attachment
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You work with the following page elements:
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Field or Control

Description

User Indicates the user ID of the FTP server.
Password Indicates the password to the FTP server.
FTP Host Indicates the machine name of the FTP server.

Remote Directory

Indicates the directory path to the file to upload.

File Name Prepend Enter text to prepend the file name to build the final file name
to copy to the target directory.
Add Attachment Click to upload the indicated file.

Sending Attachment Information with Service Operations

The following example shows sample PeopleCode for sending attachment information:

Local Message &MSG;
Local Rowset &Flight Profile;
Local String &Attachment id;

QE FLIGHTDATA.QE ACNUMBER.Value = QE FLIGHTDATA.QE ACNUMBER + 1;

&FLIGHT PROFILE = GetLevelO();

&MSG = CreateMessage (Operation.ASYNC_RR);

&Attachment id = &MSG.IBInfo.AddAttachment

(c:\\temp\\myfile.txt);

&attachReturn = &MSG.IBInfo.SetAttachmentProperty (&Attachment id,

$Attachment Encoding, "UTF-8");

&attachReturn = &MSG.IBInfo.SetAttachmentProperty (&Attachment id,

$Attachment Base, "Standard");

&attachReturn = &MSG.IBInfo.SetAttachmentProperty (&Attachment id,

$Attachment Disposition, "Pending");

&attachReturn = &MSG.IBInfo.SetAttachmentProperty (&Attachment id,

$Attachment Language, "English");

&attachReturn = &MSG.IBInfo.SetAttachmentProperty (&Attachment id,

$Attachment Description, "Parts data");

&MSG.CopyRowset (&FLIGHT PROFILE);

%$IntBroker.Publish (&MSG) ;

274
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Processing Attachment Information Included in Service Operations

The following example shows sample PeopleCode for processing an attachment from a notification:
import PS PT:Integration:INotificationHandler;

class FLIGHTPROFILE implements PS PT:Integration:INotificationHandler;
method FLIGHTPROFILE () ;
method OnNotify (&MSG As Message) ;

end-class;

/* Constructor */
method FLIGHTPROFILE

$Super = create PS PT:Integration:INotificationHandler();
end method;

method OnNotify
/+ $MSG as Message +/
/+ Extends/implements PS PT:Integration:INotificationHandler.OnNotify +/

Local Rowset &rs;
Local integer &count;
Local string &Attachment ID &Results;

&rs = &MSG.GetRowset () ;

&count = &MSG.IBInfo.NumberOfAttachments;
If &count > 0 Then

&Attachment ID = &§MSG.IBInfo.GetAttachmentContentID (1) ;

&Results = &MSG.IBInfo.GetAttachmentProperty (&Attachment ID,
$Attachment Encoding);

&Results = &MSG.IBInfo.GetAttachmentProperty (&Attachment ID,
%Attachment Type);

&Results = &MSG.IBInfo.GetAttachmentProperty (&Attachment ID,
$Attachment URL) ;

&Results = &MSG.IBInfo.GetAttachmentProperty (&Attachment ID,
%Attachment Base);

&Results = &MSG.IBInfo.GetAttachmentProperty (&Attachment ID,
$Attachment Location);

&Results = &MSG.IBInfo.GetAttachmentProperty (&Attachment ID,
%Attachment Disposition);

&Results = &MSG.IBInfo.GetAttachmentProperty (&Attachment ID,
$Attachment Description);

End-If;
/* Process data from message */

end-method;

Assigning Multiple Queues to Process Service Operations

This section discusses how to:
* Enable multi-queue service operation processing.

*  Specify multiple queues to process service operations.

Understanding Assigning Multiple Queues to Process Service Operations

You can assign a service operation to multiple queues for unordered processing.
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Assigning multiple queues to process service operations is a good approach to distribute message
processing for inbound integrations with third-party integration partners. To distribute message processing
for integrations with PeopleSoft Integration partners use the primary-secondary dispatcher functionality
delivered with Integration Broker.

The Service Operations page features a Multi-Queues link that enables you to specify multiple queues
to handle inbound or outbound service operations. When you use the multi-queue option, the requests are
split across multiple queues.

The Multi-Queues link is enabled only when a message is assigned to an unordered queue.
Before you can use this feature you must enable it in the Service Configuration page.

Related Links

“Implementing Primary-Secondary Dispatchers” (Integration Broker Administration)

Enabling Multi-Queue Service Operation Processing

Before you can assign multiple queues to process a service operation, you must enable the multi-queue
processing feature on the Service Configuration page.

To enable multi-queue service operation processing:

1. Access the Service Configuration page (PeopleTools > Integration Broker > Configuration >
Service Configuration).

2. Select the Enable Multi-Queue check box.

3. Click the Save button.

Specifying Multiple Queues to Process Service Operations

276

When a service operation contains a message assigned to an unordered queue, the Service Operations—
General page displays a Multi-Queues link. The Multi-Queues link displays in the Message Information
section of the page.

Use the link to specify multiple queues to process the service operation.

This example illustrates the Message Information section on the Service Operations — General tab. A
Multi-Queues link appears to the right of the Queue Name field.

Message Information

Type: Request

Message.Version: IB_EX_ROWSET_CONTAINERV Q. view Message
*Queue Hame: ||[B_EXAMPLES Q, View Queue  Add Mew Queue  Multi-gueues

When you click the Multi-Queues link, the Queues List page (IB_ SERVICEQUEUES) appears.
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This example illustrates the Queues List page. The example shows that one queue, /B EXAMPLES, has
been assigned to process the service operation.

Queue List

Senvice Operation Version Queues

*Queue Name
IB_EXAMPLES Q, (=]

The Queues List page shows the queues assigned to process a service operation. Use the Add Row button
(+) to add new rows and use the Lookup button to search for and specify additional queues to process the
service operation. Note that when you use the Lookup button to search for a queue, only those queues
that are active and unordered are available to select.

To assign multiple queues to process an inbound service operation:

1. Access the Service Operations—General page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions).

2. In the Message Information section, click the Multi-Queues link. The Queue List page appears.
3. Click the Add Row button (+) to add a new row. A new row appears.

4. Click the Lookup button to search for an select an unordered queue.

5. Repeat steps 3 and 4 to assign additional queues to process the service operation.

6. Click the OK button. The Service Operations—General page appears.

7. Click the Save button.

To remove a queue, click the Delete Row button (-) next to the queue name to remove. Click the OK
button to return to the Service Operations—General page. Then, click the Save button.

Invoking Multiple Service Operations

You can invoke multiple service operations on the receiving system using a single inbound service
operation. This process is sometimes referred to as service operation fan out.

Invoking multiple service operations using a single inbound service operation applies to asynchronous
service operations only.

To invoke multiple service operations on the receiving system using one inbound service operation,
you must specify the name of the inbound service operation in the External Alias field on the routing
definition of each service operation on the receiving system that you want to invoke.

The service operations on the receiving system do not need to be assigned to the same queue; PeopleSoft
Integration Broker will invoke service operations assigned to different queues.
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If the sending system sends in a partition key (using the SubQueue HTTP listening connector or
PeopleSoft services listening connector parameter), the receiving PeopleSoft system will honor it. If there
is a transformation defined for the service operation, partitioning occurs after the transformation. If the
sending system does not send in a partition key, the receiving PeopleSoft system applies partitioning
according to the queue definition defined for the service operation.

Renaming and Deleting Service Operations

278

The information in this section pertains to REST and non-REST service operations.

You can rename and delete service operations using the Services Operations page in the Service
Administration component. The Services Operations page contains three sections: a Delete section that
enables you to delete service operations, a Rename section that enables you to rename service operations,
and a Service Change section that enables you to change the service with which a service operation is
associated.

To access the page, select PeopleTools > Integration Broker > Service Utilities > Integration
Broker Admin and click the Service Operations tab.

When you first access the Services Operations page, all sections are collapsed. Click the section header
arrow buttons to expand and collapse each section.

This example shows the Service Administration — Service Operations page. The example shows the page
with the Delete and Rename sections expanded.

WsSDL | Senices Service Operations Messages | Message Schemas | Queues | Routings [

Service System Status: Development
Service Operation: |

Search

Service Operation Versions Customize | Find | View Al 2] 88 First B 4 o5 4 B ast

Select Service Operation Version Service Default Resulis

Delete

Service Operation: | Q

New Name: |

Fename

Results:

At the top of the page, the Service System Status displays the current setting. The service system status,
set in the Service Configuration page, impacts the ability to rename and delete messages.

See “Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration
Broker Administration), “Using the Service Configuration Page to Set Service Configuration Properties”
(Integration Broker Administration).
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Renaming Service Operations

Renaming a service operation is allowed only if the operation is not referenced in any runtime table. If a
service operation is referenced in a runtime table, you must archive the data before you can rename the
operation.

You cannot rename service operations associated with the restricted services /B_UTILITY and
IB_GENERIC .

To rename a service operation:
1. Access the Integration Broker Admin — Service Operations page.
2. Expand the Rename section.

3. In the Service Operation field, enter the service to rename, or click the Lookup button to search for
and select the service operation to rename.

4. Inthe New Name field, enter the new name for the service.

5. Click the Rename button.

Deleting Service Operations

You can delete service operations individually, with the exception of the default service operation version.
If you mark the default service operation for deletion, the system marks all versions for deletion and the
entire service operation is deleted.

When you delete a service operation, you are actually deleting a version of a service operation. A service
operation cannot exist without at least one default version.

Note: If you delete the default version of a service operation, the system deletes all versions of the service
operation.

Deleting a service operation is allowed only if the operation is not referenced in any runtime table. If
a service operation is referenced in a runtime table, you must first archive the data before deleting the
service operation. Use the Service Operations Monitor to archive data.

See “Archiving Service Operations” (Integration Broker Service Operations Monitor).

You cannot delete service operations associated with the restricted services /B_UTILITY and
IB_GENERIC .

To delete a service operation:
1. Access the Integration Broker Admin — Service Operations page.
2. Expand the Delete section.

3. Inthe Service Operations field, enter the service operation name to delete and click the Search
button.

Search results appear in the results grid.

4. In the results grid, select the check box next to the service operation or service operations to delete.
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5. Click the Delete button.
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Managing REST Services

Understanding Managing REST Services

As non-REST services are used to logically group a set of non-REST service operations, REST services
are used to logically group a set of REST service operations.

For example, if you have a number of REST service operations that are related to customers, such as
those pertaining to customer information, adding customers, updating customers, deleting customers, and
so on, you can create a customer REST service and then associate the related REST service operations

with that REST service.

Before you can provide or consume REST services in a PeopleSoft system, you must configure the
system for handling services.“Configuring the Integration System to Handle Services” (Integration Broker

Administration)

Common Elements Used to Manage REST Services

Field or Control

Description

Comments (Optional.) Enter comments about the service or service
definition.
Description Description of the service.

Is Provider

This option appears when the service is defined as a REST-
based service.

Select the check box to define the service as a provider
service.

Link Existing Operations

Click to add service operations already defined in the system
to a service.

Object Owner ID

(Optional.) Indicates the owner of the service.

The owner ID helps to determine the application team that last
made a change to a service definition. The values in the drop-
down list box are translate table values that you can define in
the OBJECTOWNERID field record.
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Field or Control

Description

Operation Type

Specifies how the service is transmitted.

On the Service page this field defines the operation type of the
service operation added.

Provide Web Service

Click to launch the Provide Web Services component and
export a PeopleSoft REST service as a WADL document.

This link appears only when the service is a provider REST
service.

REST Method

Indicates the HTTP method for manipulating REST resources.

REST Service

The service is defined as a REST-based service when this box
is selected.

Schema Namespace

Provides qualification for attributes and elements within an
XML schema document (XSD).

The default is Attp://xmins.oracle.com/Enterprise/Tools/
schemas.

The namespace on the message definition defaults to the
schema namespace you set as the default on the Service
Configuration page.

Note: If you change the namespace, all future messages will
have the new namespace.

Service

The name of the service.

Service Alias

(Optional.) Overrides the service name and will be the name of
the service when the WSDL is provided or exported. The alias
enables you to use mixed case in the name.

Service Operation

The name of the service operation to associate with the
service.

On the Services page, use this field to add new service
operations for the current service.

Namespace

The namespace field on the Service pages provides
qualification for attributes and elements within a WADL
document.

The value defined in the Service Namespace field in the
Service Configuration page is used as the default service
namespace on the Services page. The default value is http://
xmlin.oracle.com/enterprise/tools/service.
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Field or Control Description

Service System Status The status that is selected restricts rename, delete, and other
administrative actions that users can perform on integration
metadata in the Services Administration component.

Values are:

*  Production.

*  Development.

See “Understanding Configuring PeopleSoft Integration

Broker for Handling Services” (Integration Broker
Administration).

View WADL Click the link to view WADL documents in the WSDL
repository that have been generated for the service

This link appears only when the service you are viewing is a
REST-based provider service.

Accessing and Viewing REST Service Definitions

This section discusses how to:

* Access REST service definitions.

*  View WADL documents for REST services.
e View REST service operation information.

*  View messages defined for REST service operations.

Accessing REST Service Definitions

REST Service definitions appear on the Services page (IB_ SERVICEDEFN) in the Service component
(IB_SERVICEDEFN).

Use the Services — Search page to search for and access REST definitions in the database.

This example illustrates the Services — Search page.

SeL]}vices - Search

Search Criteria

Service Q Add a Mew Value

[CIREST Service
Search
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Note that the Services — Search page features a REST Service check box. To access a REST service in
the database you must select the REST Service check box. If you do not select the check box, the system

searches the database for non-REST services only.

After a successful search for a REST service, the system displays the definition in the Services page.

This example illustrates the Services page. The example shows the service definition for a REST service,

OF WEATHERSTATION.

ﬁﬁewices

Service QE_WEATHERSTATION

*Description |\Weather Station Senvice

Comments

Service Alias \WeatherStation
Owner D PeopleTools -

*Namespace http:xmins.oracle.com/EnterpriseMools/senvices

Link Existing Operations Wiew WADL Provide Web Service
Service Operations

Service Operation WeatherStation z

REST Method: -

Existing Operations  Personalize | Find | View All | @I E First ‘4

Operation Message Links | [k
Operation.Default Version Alias Active

QE_WEATHERSTATION_DELETE w1 WeatherStation
QOE_WEATHERSTATION_GETW1 WeatherStation
QE_WEATHERSTATION_HEAD W WeatherStation
QE_WEATHERSTATION_POSTv1  WeatherStation
QE_WEATHERSTATION_PUTWV WeatherStation

WEATHERSTATION_PATCH.V WeatherStation

REST Service Type

Is Provider

Add

160f6 ‘»' Last

Operation
Type

Synch
Synch
Synch
Synch
Synch

o [ O D] O] [l

Synch

The top portion of the page features a read-only REST Service check box that, when selected, indicates
that the service is a REST-based service. The page also features a read-only Provider check box that,
when selected, indicates the service is a provider service; if the Provider check box is not selected, the

service 1s a consumer REST service.

To access a REST service definition:
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1. Select PeopleTools > Integration Broker > Integration Setup > Service Definitions.
The Services-Search page appears.

2. Select the REST Service check box.

3. Use one of the following methods to search for a definition:

» To search for a specific service, in the Service field enter the name of the service and click the
Search button.

* To view and select from all REST services in the database, click Search button, and in the results
grid select the service to access.

The definition for the selected service appears in the Services page.

Viewing WADL Documents for REST Services

Click the View WADL link to display the WSDL Repository page (IB_ SERVICEDEFN_SEC) and access
any generated WADL documents for the service.

This example illustrates the WSDL Repository page. The example shows a link to view the WADL
document for the QF WEATHERSTATION service.

WSDL Repository
Help
Service: QE_WEATHERSTATION
WSDLAVADL Find First ‘4" 10of1 '*/ Last
VWADL: QE WEATHERSTATION.1 Default Last Update Date/Time: 07102018 2:38:02PM
Wiew WADL

When you click the View WADL link on the WSDL Repository page, the WADL Viewer page
(IB_SERVICEWSDL _SEC) appears and you can view the WADL document for the service.
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This example illustrates the WADL Viewer page. The example shows the generated WADL document for
the QE WEATHERSTATION service appearing on the page.

WADL Viewer Ll
Help

VWADL: QE_WEATHERSTATIOMN. 1
=ml version="1.0"7=
=application xmins="http:/fiwadl.devjava.net/2009/02"
xmins QE_FLIGHTPLAM_SYMC VERSION_1="http:i*mins.oracle.com/EnterpriseMools
Ischemas/QE_FLIGHTPLAMN_SYNC VERSION_17
xmins:QE_WEATHERDATAVI="hitp:ifxmIns.oracle.comiEnterprise/Tools/schemas
IOE_WEATHERDATANT" xmins:QE_WEATHER_FAULTv1="hitp:ixmlins.oracle.com
[Enterprise/Mools/schemas/iQE_Weather QE_Weather_Faultv1”
xminsxsi="http e w3 orgf2001XMLSchema-instance™s
=grammars=
=include href="0E_WEATHERDATA V1 xsd™/=
=include href="0QE_WEATHER _FAULT v xsd"/=
=include href="0E_FLIGHTPLAN_SYMC VERSION_1xsd"f=
=lgrammars=
=resources base="http:islc10pro.us.oracle.com:8000/FPSIGWRESTLIsteningConnector
MeTD0Czr=
=resource uri="WeatherStation.v1™=
=method href="#GETWeatherStation.v17/=
=method href="#HEADWeatherStation v17/=
=method href="#P05TWeatherStation v17=
=method href="#PUTWeatherStation.v17/=
=method href="#PATCHWeatherStation.v17=
=method href="#0DELETEWeatherStation.v17/=
=fresource=
<fresources=
=method id="DELETEWeatherStation v1" name="DELETE"=

sraniiacts

[t | »

To view a WADL document for a REST service:

1. Access the service definition (PeopleTools > Integration Broker > Integration Setup > Service
Definitions).

2. Click the View WADL link.

The WSDL Repository page appears.

(98]

Click the View WADL link.
The document appears in the WADL Viewer page.

4. Click the Return button to return to the WSDL Repository page.

v

Click the Return button again to return to the Services page.
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Viewing REST Service Operation Information

The Existing Service Operations section of the Services page contains an Operation tab that displays
service operations and service operation versions that are associated with the service.

It also displays the service operation Alias, the type of operation, and whether the service operation is
active. When you click the name of a service operation, the operation opens on the Service Operations
page, where you can view and modify service operations information, work with the service operation
handlers, routing definitions, and do much more.

View Messages Defined for REST Service Operations

The Existing Service Operations section of the Services page contains a Messages Links tab that displays
the request and response messages defined for each REST service operation in the service.

This example illustrates the Existing Service Operations section of the Services page. The example shows
the Message Links tab displaying request and response messages for the service operations that are
associated with the OF WEATHERSTATION service

Cperation Message Links | [F=x

Request Messageersion Rezponze MessageMNersion
QOE_WEATHERDATAW =]
IB_REST_STUB.IB_REST_STUB QE_WEATHERDATA W1 =]
N =
QE_FLIGHTPLAM_SYMC VERSION_1 QOE_WEATHERDATAW =]
QOE_FLIGHTPLAM_SYMC VERSION_1 QOE_WEATHERDATAW =]
QOE_FLIGHTPLAMN_SYMC VERSION_1 QOE_WEATHERDATAW =]

Click the request or response message name to open the message in the Message Definitions page, where
you can view and modify message definition information, message schema information, and more.

Adding REST Service Definitions

This section discusses how to add REST service definitions to the PeopleSoft system.

Understanding Naming Services and Service Aliases for REST Service
Definitions

REST service names and REST service alias names can be exposed as REST services. As a result, the
following restrictions apply when you name a REST service or a REST service alias. REST service names
and REST service alias names:

» Cannot begin with XML, xml, or Xml.

* Cannot begin with a digit.
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* Cannot begin with a character.

Adding REST Service Definitions

To add a REST service definition to the system, use the Add New Service page (IB_SERVICE_ADD).
To access this page, select PeopleTools > Integration Broker > Integration Setup > Service
Definitions, then select the Add a New Value link.

This example illustrates the Add New Service page.

Add New Service

Service: €8
[C1REST Service

Add Return to Search

Note: Before you can add a service, you must configure PeopleSoft Integration Broker to handle services
using the Service Configuration page.

See “Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration
Broker Administration).

Important! To create a REST service you must select the REST Service option when you add the service.

After you add a service definition to the system, the Services page (IB_ SERVICEDEFN) appears that you
use to configure the service definition.
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This example illustrates the Services page. The example shows that a REST-based service definition
called DEMO REST SERVICE has been added to the system. Note that the REST Service check box at
the top of the page is checked, signifying that the service is REST-based.

Services

Service: DEMO_REST_SERVICE REST Service
*Description: | Is Provider

Comments:

Semvice Alias: |

OwneriD: | =
*Namespace: |http:frxmln5.nracle.cn miEnterprise/Tools/senvices

Link Existing Operations View WADL

Senvice Operations

Service Operation:

REST Method: | v Add

To add and configure a REST service definition:

1. Access the Services page (PeopleTools > Integration Broker > Integration Setup > Service
Definitions).

2. Click the Add a New Value link.
3. In the Service field, enter a name for the service.
Restrictions for naming services are discussed elsewhere in this section.
See Understanding Naming Services and Service Aliases for REST Service Definitions.
4. Select the Rest Service check box.
5. Click the Add button.
The Services page appears.
6. In the Description field, enter a description for the service.
7. (Optional.) Select the Is Provider check box to define the service as a provider service.
By default, when you add a REST-based service to the system it is a provider service.
8. (Optional.) In the Comments field, enter comments about the service or the service.

9. (Optional.) In the Service Alias field, enter an alias name for the service.
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Restrictions for naming service aliases are discussed elsewhere in this section.

See Understanding Naming Services and Service Aliases for REST Service Definitions.
10. (Optional.) From the Object Owner ID drop-down list box, select the owner of the service.
11. In the Namespace ficld, enter a namespace URI for the service.

The default value is the namespace that is declared in the Service Namespace field on the Service
Configuration page.

12. Click the Save button.

Adding Service Operations to REST Service Definitions

This section discusses how to:
* Add existing service operations to REST service definitions.

* Define new service operations for REST service definitions.

Understanding Adding Service Operations to REST Service Definitions

You can add a REST service operation that already exists in the database to a REST service definition, or
you can add a new REST service operation to the database.

Adding Existing Service Operations to REST Service Definitions

The process for adding existing REST service operations to REST services is identical to the process for
adding non-REST services to non-REST service operations.

Important! You can add only those service operations defined as REST service operations to REST
service definitions; you cannot add non-REST service operations to REST services and you cannot add
REST service operations to non-REST services.

See Adding Existing Service Operations to Service Definitions.

Adding New Service Operation Definitions for REST Services

290

The only way to add a new REST service operation to the database is from a REST service, using the
Add button in the Service Operations section of the Services page (IB_SERVICEDEFN).

The type of service, provider or consumer, determines the type of service operation that the system adds.
If you are working with a provider service and add a service operation, a provider service operation is
added to the service; if you are working with a consumer service and add a service operation, the system
adds a consumer service operation.
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This example illustrates the Services page. The example shows the service definition for the
WEATHERSTATION service. The service is a provider service, as indicated by the selection of the Is
Provider check box.

Services

Service: WEATHERSTATIOMN REST Service
*Description: |Weather Station Service Is Provider

Comments:

Service Alias: |
Owner 1D | &
*Namespace: |http:frxrnln5.nracle.cn miEnterprise/Tools/senices

Link Existing Operations Wiew WADL

Senvice Operations

Service Operation:

REST Method: | v Add

Use the Service Operations section on the Services page to add REST service operation definitions to
the system. The system automatically appends the service operation name with the name of the selected
REST method. This functionality allows you to reuse the service operation name using other method
types. The system allows you to enter a service operation name in mixed-cased. The service operation
name you enter becomes the default service operation alias.

So for example, if you enter a service operation name of WeatherStation and select the GET method from
the REST Method drop-down list, the system names the operation WEATHERSTATION GET and the
service operation alias is WeatherStation.

If a service is defined as a provider service, all service operations you create from the service definition
are provider services operations. If a service is defined as a consumer service, all service operations you
create from the service definition are consumer service operation.

After you provide a service operation name and a REST method and click the Add button, the new
service operation appears in the Service Operations component and you can proceed to configure the
operation.
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This example illustrates the Service Operations — General tab. The example shows a new REST service
operation called WEATHERSTATION GET.

General Handlers Routings

Service Operation: WEATHERSTATION_GET
REST Method: GET

*Operation Description: |

Operation Comments: [l user/iPassword Required
*Req Verification: Mane w
Owner ID: | .’ |
Operation Alias:  WeatherStation [] used with Think Time Methods
REST Resource Definition
REST Base URL: nttp Aibuffy.us.oracle:8920/PSIGW/PSIGWI/RESTLIsteningConnecto

URI Template Format Example: weather/{state}{city} *forecast={day}

URI Perzonalize | Find | ILEI-I i First Bl 4 of 1 I | ast

Index |Template Validate
| = | validate (=]

Document Template: | 2, View Message

Default Service Operation Version

*Version: vt Default Active
Version Description: | Routing Status
Version Comments: Any-to-Local: Does not exist
Local-to-Local: Does not exist

Routing Actions Upon Save

Generate Any-to-Local
[] Runtime Schema Validation []Generate Local-to-Local

Add Fault Type |

Type: Response Status Code: 200 w
Message.Version: | QA view Message
Content-Type: | teadthemnl v |

To add a new service operation for a REST-based service:

1. Access the Services page (PeopleTools > Integration Broker > Integration Setup > Service
Definitions).

The Services page appears.

2. In the Service Operations section, locate the Service Operation field and enter a name for the new
service operation.
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3. From the REST Method drop-down list, select the HTTP method for manipulating the resources
defined in the service operation. The valid values are:

*  Delete.
*  Get.

*  Head.
*  Patch.
*  Post.

*  Put

For more information on REST methods see REST Methods.

4. Click the Add button.

The Service Operations-Definitions page appears. Use the page to configure the service operation. See
Defining General REST Service Operation Information

Restricting and Enabling Write Access to REST Service
Definitions

You can restrict write access to a REST service so that sensitive fields of the service definition

and of associated service operations appear in read-only mode. Use the Restricted Service page
(IB_SVCSETUP3) in the Service Configuration component (IB_SVCSETUP) to restrict a service. Use
the process for restricting and enabling write access to non-REST service definition for restricting and
enabling write access to REST service definitions.

See Restricting and Enabling Write Access to Service Definitions.

Renaming and Deleting REST Service Definitions

You can rename and delete services using the Services tab in the Integration Broker Admin component
(IB_HOME_ PAGE). Use the process for renaming and deleting non-REST service definitions for
renaming and deleting REST service definitions.

See Renaming and Deleting Service Definitions.

Activating and Deactivating REST Service Definitions in Bulk

You can activate and deactivate services in bulk using the Service Activate/Deactivate page
(IB_HOME PAGEDY) in the Service Administration component. Use the process for activating and
deactivating non-REST services in bulk for activating and deactivating REST services in bulk.

See Activating and Deactivating Service Definitions in Bulk.
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Understanding REST Service Operations

A REST service operation definition consists of general information about an operation, such as its name,
description, request and response messages, and so on.

REST services operations are synchronous service operations.

Like a non-REST service operations, a REST service operation contain a routing, which determines the
direction, inbound or outbound, of the service operation.

For a provider REST service operation the system creates an any-to-local routing definition when

you save the service operation. You have the option to generate a local-to-local routing definition. For
consumer REST service operations the system creates an outbound local-to-WADL routing definition
when you save the service operation. You cannot add routing definitions to provider or consumer REST

service operations.

A REST service operation definition also contains a handler, which contains and runs the programming
logic for providing or consuming the service operation, manipulating message content, and so on.

REST Service Operations Types

All REST service operations are synchronous service operations.

A synchronous service operations is processed in real time. Processing on the sending system does not
continue until it receives a response from the receiving system.

REST Methods

REST methods determine the HTTP method for manipulating the resources defined in the service
operation. The valid values are listed and described in the following table and can all be used for provider

and consumer service operations:

Term Definition

DELETE Delete an existing resource.

GET Retrieve a representation of a resource.

HEAD Identical to a GET except that no message body is returned in
the response.
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Term Definition

PATCH Update a partial resource.

POST Create a new resource to an existing URL.

PUT Create a new resource to a new URL, or modify an existing
resource to an existing URL.

REST Resource Definitions

REST service operation definitions contain a REST Resource Definition section where you define the
REST base URL, resource URI templates, URI indexes, and document template.

See Understanding REST Resource Definition Concepts

REST Messages

This section provides information about request and response messages used in REST service operations.

Request and Response Message Combinations

The REST method you select for a REST service operation determines the request and response message
combination that you can use for the operation. The following table lists the allowable request and
response message combinations for each REST method:

REST Method Request Message Response Message
Delete No Yes
Get No Yes
Head No No
Patch Yes Yes
Post Yes Yes
Put Yes Yes
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MIME Content-Types

When you specify a message for a REST service operation, you must also specify the MIME content-type
of the message. PeopleSoft supports the following content types for request and response messages used
for REST service operations:

* application/json
* application/xml
o text/xml

e text/plain

e text/html

HTTP Status Codes

When you define a message for a REST service operation, along with the MIME content-type, specify the
HTTP response code to return to the integration partner. Note that the content-type defines the acceptable
HTTP media type.

PeopleSoft supports the following HTTP status codes:
e 200 - Default. OK: Request successfully executed and the response has content.
e 201 - This value is valid only when the REST method is Post.

Created: Resource successfully created. The response contains the created resource and possibly a
location header that points to the new resource.

* 202 - Accepted: Request has been accepted for processing but processing has not been completed.
This is required for resource that supports asynchronous process.

* 203 - This value is valid only when the REST method is Get.
* 204 - No Content: Request successfully executed and the response doesn't have content.
e 205 - Reset Content: Tells the user agent to reset the document which sent this request.

* 206 - Partial Content: This response code is used when the Range header is sent from the client to
request only part of a resource.

* 207 - Multi-Status: Conveys information about multiple resources, for situations where multiple status
codes might be appropriate.

Optional MIME Content-Types and HTTP Status Codes

Using the Set Content Types window, you can assign optional content-types and status codes to message
instances on REST service operations. You can type in any content type or select from the existing
content types.

Generated WADL documents will reflect the optional content-type values, allowing consumers to request
the content type they prefer.

You can define optional content types on request, response, and fault message instances.
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You can define optional status codes on response message instances.

Naming Conventions for REST Service Operation Metadata

The same naming convention restrictions that apply to non-REST service operations apply to REST
service operations.

See Naming Conventions for Service Operation Metadata.

REST Service Operation Aliases

A service operation alias or operation alias is the service operation name that displays for the service
operation when WADL is provided.

REST service operation aliases may be mixed case.

Service operation alias names for REST service operations can be the same across types. For example,
you can have the same alias, for example myalias, for Delete, Get, Patch, Put, Post and Head REST
service operations.

REST Service Operation Versions

The same information about non-REST service operation versions applies to REST service operation
versions.

See Service Operation Versions.

WADL Node

PeopleTools delivers a WADL node that is the default node for consumer REST services.

Monitoring REST Service Operations

298

You can use the same tools to monitor REST service operations as those you use to monitor non-REST
service operations. These tools include:

» The Service Operations Monitor.

* The Integration Network Monitor.

*  The Integration Network Transactional Tracker.
* Performance monitoring tools.

The Managing Service Operations topic in the product documentation provides a brief summary of each
of these tools.

See Monitoring Service Operations.

Related Links

Integration Broker Service Operations Monitor
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“Using the Integration Network Monitor” (Integration Broker Administration)
“Using the Integration Network Transactional Tracker” (Integration Broker Administration)
“Monitoring PeopleSoft MODULE and ACTION Information” (Data Management)

Accessing and Viewing REST Service Operation Definitions

This section discusses how to:
* Access REST service operation definitions.

* View REST service operation definitions.

Accessing REST Service Operation Definitions

You access a REST service operation definition from the service definition that contains the operation you
want to access.

Use the Services page (IB_SERVICE) to list and access REST service operations; use the Service
Operations page (IB_ SERVICE REST) to view and work with REST service operations.
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This example illustrates the Service Operation — General page for a REST service operation definition.

General Handlers Routings

Service Operation QE_WEATHERSTATION_GET
REST Method GET

*Operation Description | "VeatherSation Zebra

) [Tl useriPassword Required
Operation Comments

*Req Verification ~ MNone
Senvice Operation Security

ownerip PeopleTools -

Operation Alias | WVeatherStation [Tl used with Think Time Methods

REST Resource Definition

REST Base URL hitpdimyserverexample.com:8920/PSIGW/RESTListeningConnector/QE_LOCALMWeatherStation v/

LRI Template Format Example: weatheri{stateWcity} ?forecast={day}

URI Personalize | Find | @| i First Bl 1 ora B Last
Index (Template Validate |Build
1 weatheristate}{city}?forecast={day} Validate Build [=]
2 weather/{statel{city} Validate Build [*#] [=]
3 weather/state} Validate Build [=]
4 weatherf{countryi{state}dcity} *forecast={day} Validate Build E|
Document Template |QE_WEATHERTEMPLATE V1 Q. view Message
Default Service Operation Version
*Version V1 Default [¥] Active
Version Description |Weather3ati0n Zebra Routing Status
Version Comments Any-to-Local  Exists

Local-to-Local Exjsts

Runtime Schema Validation Routing Actions Upon Save

[C Response Message [“| Regenerate Any-to-Local
Delete Fault Type | [| regenerate Local-to-Local

Message Instance

Type Response
MessageVersion |QE_WEATHERDATAV1 Q. View Message
Content-Type  textixml = Qptional Content-Types
Status Code 200 - Optional Status Codes
Type Fault
MessageVersion |QE_WEATHER_FAULTV1 Q. View Message
Content-Type  textixml ¥ Optional Content-Types
Status Code 400 ¢ Optional Status Codes

To access a REST service operation:
1. Select PeopleTools > Integration Broker > Integration Setup > Service Definitions.
The Services — Search page appears.

2. Select the REST Service check box.
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Important! You must select the REST Service box to retrieve a REST service operation from the
database. If you do not select this option, the system retrieves non-REST services when you perform
the search.

In the Service field, perform one of the following actions:
* Enter all or part of the service name.
*  Click the Lookup button to search for and select a service name.

* Leave the field blank to retrieve a list of all REST services in the database.

Click the Search button.

The Services grid displays a list of results.

Click the name of the service that contains the service operation that you want to access.
The service definition appears.

In the Existing Service Operations grid, click the service operation name.

The Service Operations — General tab appears with data for the service operation that you selected.

Viewing REST Service Operation Definitions

The Service Operations component includes three pages:

Field or Control Description
General Tab Features general-service and default-service operation
information.

This page also features REST resource definition information
if the service operation you are viewing is a REST service
operation.

Handlers Tab Provides summary information about handlers that have been

added to an operation. Service operation handlers contain

the programming logic for sending and receiving service
operations and their contained messages, and for manipulating
content.

Note that handlers are not used for REST consumer-based
service operations and the Handler tab does not appear when
you view or work with a consumer REST service operation.

Routings Tab Provides summary information about service operations

routings. Routing definition determine the direction —
inbound, outbound — of service operations.
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Viewing General Service Operation Information

The top portion of this page contains basic information about a service operation, including its name,
description, and so on. The Service Operation Security link opens the permission list for the service.
Note that the Service Operation Security link appears only after a service operation definition is saved.

The page features a REST Resource Definition section that displays the REST base URL, resources
defined for the service operation, and the name of the document template associated with the service
operation. This section of the page also provides access to the URI Template Builder and to build URI
templates as well as to a page to validate URIs.

The Default Service Operation Version section displays service-operation version information and
whether runtime schema validation is enabled.

The Runtime Schema Validation group box shows if runtime schema validation is selected for the request
and response messages.

The Routing Status group box shows if any-to-local or local-to-local routing definitions have been
generated for the service operation. Click the Routings tab to view detailed information about routing
definitions that exist for a service operation.

The Routing Actions Upon Save group box shows the possible routings that the system can generate
when the service operation definition is saved.

The Message Information section displays the request message, response message information, and fault
message for the service operation. The View Message links in this section open the displayed message on
the Message Definition page, where you can view additional information about the message.

Viewing Handler Information

To view service operation handler information, click the Handlers tab. Doing so displays the Service
Operations - Handlers page (IB_SERVICEHDLR) which lists summary information about handlers that
have been added to an operation.

This example illustrates the Service Operations — Handlers page

General Handlers Routings

Service Operation: QE_WEATHERSTATIOMN_GET
Default Version: vi1

Operation Type: Synchronous

Personalize | Find | View Al B | B8 First B 4 o B Last
|REQUESTHDLR OnRequest v || |App Class v| Active v| Details =]

Each REST-based provider service operation has a single handler; REST-based consumer service
operations do not have handlers.

Note: There are no handlers for REST-based consumer service operations and the Handler tab does not
appear when you view and work with consumer REST service operations.

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 12 Managing REST Service Operations

The only handler Type available for provider REST services is the OnRequest handler. When working
with REST provider service operations you can implement the OnRequest handler as an application class
only. The application class is implemented as any other OnRequest integration broker event.

The summary information includes the handler name, the handler type, and the implementation method
for the handler. The status of the handler, active or inactive, also appears.

Click the Details link to open the Handler Details page (IB_SERVICEHDLR_SEC) for the handler.

This example illustrates the Handler Details page.

Handler Details

Handler Hame: REQUESTHDLR
Handler Type: On Request

Description: |We atherStation Zebra

Comments:
Handler Owner: |
Application Class
*Package Name; |QE_F LIGHTPLAMN_SYNC Q
*Path: |3 Q
Class ID: |We atherData Q,
Method: |OnRequest v|

The Handler Details page shows additional information about the handler, including the owner and
application class details.

You can also use this page to specify the handler details.

Viewing Routing Information

Click the Routings tab to open the Service Operations - Routings page (IB_SERVICERTNGS) to view a
summary of routing definitions for an operation.

This example illustrates the Service Operations — Routings page.

General | Handlers | Routings

Service Operation QE_WEATHERSTATION_GET
Default Version v1
User Exception

Note This user exception status is applicable only if an outbound routing cannot be determined. If a valid outbound routing can be determined then the user exception
status on the actual routing will be used.

Routing Definitions Personaize | Find [ View Al BV il First B 12 or2 I Last

Selected Hame Version Operation Type | Sender Node Receiver Node  |Direction Status Results

[l ~GENERATED~16936857 1 Synch QF_LOGAL QF_LOCAL Local Active =

O ~GENERATED~48593706 w1 Synch ~~ANY~~ QE_LOCAL Inbound Active =
Inactivate Selected Routings Activate Selected Routings
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The Routings Definition grid on the page lists summary information for routings that are defined for a
service operation. Summary information that is displayed includes the routing definition name, service
operation version, routing type, sending node, receiving node, direction of the routing and the routing
status.

Click a routing definition name to open the routing in the Routing Definitions component, where you can
view additional information about the routing.

When you create a provider REST service operation the system automatically creates an any-to-local
routing. You can also generate local-to-local routings for a provider REST service operation.

When you create a consumer REST service operation the system automatically creates a local-to-WADL
routing definition. Local-to-WADL is the only routing type you can use with consumer REST service
operations.

See Viewing Routing Definitions in Graphical Format.

You can also use this page to activate or inactivate routings for an operation.

See Adding Routing Definitions, Activating and Inactivating Routing Definitions.

Defining General REST Service Operation Information

304

The top portion of the Service Operations - General page is used to define general information about the
service operation.

1. When you click Add on the Service Definition page to add a new Service Operation, the system
automatically appends the service operation name with the name of the selected REST method and
opens the Service Operation General page.

To access an existing Service Operation select PeopleTools > Integration Broker > Integration
Setup > Service Definitions

Select the service that contains the service operation with which you want to work. The Services page
appears. In the Existing Service Operations section, select the service operation.

2. In the Operation Description field, enter a description for the operation.

3. (Optional) Select the User ID/ Password Required check box to require a user ID and password for
inbound service operations.

See “Managing User Authentication” (Integration Broker Administration).

4. The Security Verification drop-down list appears when you are configuring a provider service
operation. You may select the level of security with which inbound integrations must be sent. The
valid options for REST based provider/inbound service operations are:

e Basic Authentication.
e Basic Authentication and SSL.
*  None. (Default.)

e QAuth2 Authentication
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*  OAuth?2 Authentication and SSL

*  PeopleSoft Token.

*  PeopleSoft Token and SSL.

+ SSL.

See “Validating Security on Inbound Integrations” (Integration Broker Administration).
5. (Optional) In the Operation Comments field, enter comments about the service operation.
6. (Optional) From the Object Owner ID field, select the owner of the definition.

The owner ID helps to determine the application team that last made a change to a service
definition. The values in the drop-down list box are translate table values that you can define in the
OBJECTOWNERID field record.

7. (Optional) In the Operation Alias field, enter an alias name for the service operation.

When working with REST service operations the service operation alias is automatically populated
with the service operation name as you entered it when you created the service operation.

Related Links
“Understanding OAuth 2.0” (Security Administration)

Managing REST Resource Definitions

This section discusses how to:

* Configure a REST resource definition.
* Define a REST base URL.

* Define a document template.

* Define a URI template.

* Use the URI Template Builder.

* Validate a URI template.

* Use the URI Template Builder to build a URI template.

Understanding Managing REST Resource Definitions

When you configure a REST resource definition the end result is the URL that the service consumer uses
to invoke the service.

The information defined in the REST resource definition is included in the WADL document that the
service provider furnishes to the service consumer. The service consumer then extracts the information
from the WADL document and defines it in the consumer service operation it creates for the service.
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REST service operation definitions contain a REST Resource Definition section where you configure and
manage the resource definition.

The REST resource definition is where you define the REST base URL, one or more URI templates, and
a document template. The section also contains a feature that enables you to validate the defined URI
templates.

To build URI templates you can manually enter template strings or use the URI Template Builder.

Understanding REST Resource Definition Concepts

306

This section describes REST resource definition concepts.

REST Base URL
The REST base URL is the common part of the URL to invoke the provider or consumer web service.

For a REST service provider this value is always the REST target location entry defined on the Service
Configuration page for provider service operations. When the Provide Web Service wizard is used to
create the WADL document, the option to select a secure REST target location can be selected. For
provider service operations this URL is simply informational to show what would be used when creating
the complete URLC(s).

The REST base URL is constructed as part of the initialization/retrieval of the service operation and uses
the following format:

<Provider REST target location>/< External alias from any-to-local routing>/

For a REST consumer the common part of the URL defined is the provider's WADL document.

Document Template

A document template is a Document type message that define in the REST resource definition. The
document message has primitive elements and collection elements defined with names used for value
replacement within the URI template. This document can only contain primitive elements and collection
elements. The document cannot contain any imports (compounds) or compound elements. The advantage
of using documents is that they cannot be inadvertently changed, as is not the case with defined records
and/or fields.

Note: In the Document definition, the variables defined with the braces ( {} ) in the URI template must
be the exact name of the element name defined on the Document page, not the Tag Name defined on the
XML page.

A document template is a URI on the wire with values in it.

URI Template

Resources are constructed using URI templates. URI templates use a simple syntax where braces denote
variables to be replaced when the templates are converted to actual URLs. You define the values for the
URI template variables in the REST document template.

You can define one or more URI template strings to define one or more resources for the definition

Note: PeopleSoft supports direct variable substitution.
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The following example shows a sample URI template syntax:
weather/{state}/{city}?forecast={day}

The denoted variables identified with the braces ( {} ) are replaced with the actual values as defined in the
document template. In the example shown the variables are state, city and day.

The system validates the string entered for the template to ensure that there is no equivalent or ambiguous
defined templates currently entered on the grid. Moreover the values used within the braces ( {} ) must be
defined on the document template to pass validation.

You can build URI templates by manually entering variable strings in the template fields in the REST
Resource Definition or you can use the URI Builder. Each of these methods for building URI templates is
discussed later in this topic.

URI Index

The system assigns an integer index value to each URI template you create for a REST service operation
upon save.

You will later use these index numbers in PeopleCode to call and manipulate the associate URI template.

URI Template Validation

When you construct a URI template, you can verify the URL produced.

The REST Resource Definition URI grid features a Validate link that provides access to the Validate URI
page where you can populate the URI with values from the document template and then test the link.

Understanding URI Template Expressions and Expansions

When building URI templates it is necessary to know these terms:

Field or Control Description

Expression The text between “{‘and ‘}’, including the enclosing braces.

Expansion The string result obtained from a template expression after
processing it according to its expression type, list of variables
names, and value modifiers.

PeopleSoft supports the URI template expressions shown in the table. The table summarizes each type
of template expression by its associated operator. The example expansions are based on the following
variables and values:

var = “walue”

tools = “tools rules!”

empty = W

list = [ “wall”, “wval2”, “wval3” ]
path = “/foo/bar”

X = 1024

y = 768
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In each code example, the values in the first column are the expressions and the values in the second
column are the expansions.

Expression Type | Operator Description
Form-Style & Form-style query continuation
(Continuation.)
{&x, v} &x=10246y=768
{&x,y,empty} &x=1024&y=768&empty=
{&list} &list=vall,val2,val3
{&list*} &list=vall&list=val2&list=val3
Form-Style ? Form-style query expansion.
(Expansion.)
(?x,v} 2x=10248y=768
{?x,y,empty} ?x=1024&y=768&empty=
{?1list} ?list=vall,val2,val3
{?list*} ?list=vall&list=val2&list=val3
Note that the expansion process omits the equal sign ( =) when the variable value is
empty.
Fragment. # Fragment expansion with comma-separated values.
{#var} #value
{#tools} #tools%20rules!
{#path}/here #/foo/bar/here
{#path,x}/here #/foo/bar,1024/here
{#path{x}/here #/foo/barl024/here
{#empty}/here #/here
{#1list} #vall,val2,val3
{#list*} #vall,val2,val3
Label. Label expansion, dot-prefixed
X{.var} X.value
X (.empty} X.
X{.list} X.vall,val2,val3
X{.list*} X.vall,val2,val3
Path-Segment. / Path-segments, slash-separated

{/var} /value
(/var,empty} /value/

{/1list} /vall,val2,val3
{/1list*} /vall,val2,val3

Path-Style.

308

Path-style parameters, semicolon-prefixed.

{;x,v} ;x=1024;y=768
{;x,y,empty} ;x=1024;y=768;empty
{;1list} ;list=vall,val2,val3

{;1list*}

;list=vall;list=val2;list=val3
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Expression Type | Operator Description

Note that the expansion process omits the equal sign ( =) when the variable value is

empty.

Reserved. + Reserved expansion with comma-separated values.
{+var} value
{+tools} tools%20rules!
{+path}/here /foo/bar/here

{+path,x}/here /foo/bar,1024/here
{+path{x}/here /foo/barl024/here
{+empty}/here /here

{+1list} vall,val2,val3

{+1list*} vall,val2,val3
Simple String. NA Simple expansion with comma-separated values.

{var} value

{tools} tools%20rules$21

{path}/here $2Ffoo%2Fbar/here

{(x,y} 1024, 768

{var=default} value

{list} vall,val2,val3

{list*} vall,val2,val3

Note the following about the operators, expressions, and expansions shown in the table:

€.

The operator’s associated delimiter (<}, “?7,”/”,”.”,”#”) is omitted when none of the listed variables
are defined.

cC 9

Multiple variables and list values have their values joined with a comma (“,”) if there is no predefined
joining mechanism for the operator.

The operators plus ( + ) and fragment ( # ) substitute non-encoded reserved characters found inside the
variables value; the other operators pct-encode reserved characters found in the variable values prior
to expansion.

(32 33}

The explode modifier (“*”) indicates that the variable represents a composite value that may be
substituted in full or partial forms, depending on the variables type or schema. The asterisk (“*”)
indicates that just the component names and values are included in the expansion.

Prerequisites for Managing REST Resource Definitions

The REST target URL must be specified on the Service Configuration — Target Locations page. The steps
for defining the REST target location are described elsewhere in the product documentation.

See “Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration
Broker Administration).

You must have created a Document type message that contains the values for any variable data you plan
to use in the URI templates. For this reason you must have an understanding of PeopleSoft Documents
Technology to create and manipulate Document type messages.

For information on PeopleSoft Documents Technology see the product documentation for Documents
Technology.
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Configuring REST Resource Definitions

This section lists the steps to configure a REST resource definition. Other section within this topic
provide in-depth information and procedures to complete each step.

To configure a REST resource definition:

1. Access the Service Operations — General page (select PeopleTools > Integration
Broker > Integration Setup > Service Operation Definitions).

2. Locate the REST Resource Definition section of the page.
3. Inthe REST Base URL field, enter the base URL.

4. In the Document Template field, enter the name of the document message to associate to the resource
definition or click the Lookup button to search the database.

5. In the Template field, enter the syntax for the URI template.
There are two options to create and enter the URI template syntax:
* Manually create and enter the syntax.

* Use the URI Template Builder page to create and enter the syntax.

6. Click the Save button.

7. (Optional.) Click the Validate link to validate a URI template.

Defining REST Base URLs

310

This section describes defining REST base URLSs for provider and consumer service operations.

Understanding Defining REST Base URLs

For provider service operations the system auto-populates the REST base URL. As mentioned elsewhere
in the product documentation, the base URL is composed of the REST target namespace defined on the
Service Configuration page and the routing alias defined on the Routings — Parameters page on the any-
to-local routing for the service operation. The REST base URL takes the following format:

http://<ProviderRESTTargetNamespace>/<RoutingAlias>
For example:

http://providerserver.example.com:8010/PSIGW/RESTListeningConnector/weatherstation.=

vl

For consumer service operations you obtain the REST base URL from the WADL document furnished to
you by the service provider. You specify the URL in the REST Base URL field in the REST Resource
Definition section of the Service Operations — General page.
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Specifying REST Base URLs (Provider Services)

As described previously, the REST base URL for a provider service operation is auto-populated by the
system. The value populated comes from the REST target location defined on the system and the routing
alias defined on the any-to-local routing definition for the service operation.

The REST base URL for a provider service operation appears in a read-only field in the REST Resource
Definition section of the Service Operations — General page.

To access the Service Operations — General page select PeopleTools > Integration
Broker > Integration Setup > Service Operation Definitions.

This example illustrates the REST Resource Definition section on the Service Operations — General page
for a provider service operation.

REST Resource Definition

REST Base URL hitp://providerserver example. com:8010/PSIGW/RESTLIistening Connectorfweatherstation. w1/

URI Template Format Example: weatherd{statel{city}?forecast={day}

Personalize | Find | ) | £l First <] 1af 1 n Last

Validate |Build
) | validate Build [+ [=]

Document Template | Q. Wiew Message

The example shows that the system has populated the REST base URL as described earlier in this topic.

To modify the REST base URL for a provider service operation you must change the REST target
namespace defined on the Service Configuration — Target Namespace page and/or the routing alias for the
any-to-local routing as defined on the Routings — Parameters page.

See “Setting Target Locations for REST Services” (Integration Broker Administration)Configuring
Routing Definitions

Specifying REST Base URLs (Consumer Services)

The service provider furnishes service consumers the value of the base URL to define, usually in a WADL
document. As the service consumer you then define this value in the REST Resource Definition section of
the Service Operations — General page in the consumer service operation definition.

To access the Service Operations — General page select PeopleTools > Integration
Broker > Integration Setup > Service Operation Definitions.
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This example illustrates the REST Resource Definition section on the Service Operations — General page

for a consumer service operation.

REST Resource Definition

REST Base URL |
URI Template Format Example: weatherd{state}{city}?forecast={day}

URI
Index (Template

alize | Find | 1 | 88

First n 1of 1 n Last
Validate (Build
Walidate Build

=

Q

Document Template | Wiew Message

To specify the REST base URL for a consumer service, in the REST Base URL field enter the URL

provided by the provider. The format is:

http://providerserver.example.com:8010/PSIGW/RESTListeningConnector/weatherstation.=

vl

Defining Document Templates

To define a document template:

1. Access the REST Resource Definitions section of the Service Operations — General page

(PeopleTools > Integration Broker > Integration Setup > Service

Operation Definitions).

2. In the Document Template field enter a document name or use the Lookup button to search for one.
After you select a message, you can click the View Message link to view it.
3. Click the Save button.

Building URI Templates

Use the REST Resource Definition section on the Service Operations — General page to build one or more

URI template strings to define one or more resources for the definition.

To access the Service Operations — General page select PeopleTools > Integration

Broker > Integration Setup > Service Operation Definitions.

312
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This example illustrates the REST Resource Definition section in the Service Operations — General page
for a provider REST service operation.

REST Resource Definition

REST Base URL  http://providerserver example. com:8010/PSIGW/RESTLIsteningConnector®VeatherStation w1/

URI Template Format Example: weatherf{state}{city}Mforecast={day}

URI ersanalize | Fing | B | 2 First B 1.q 0t s B L ast
Index |Template Validate |Build
1 |weather{state W{city JPforecast={day} | walidate  Build [=]
2 [weather{state){city} | walidate Build =
3 |weathen’{state} | Walidate Build E
4 |weatherf{cuumry}f{state}f{city}?fﬂrecast:{day} | “alidate Build [=]
Document Template |GE_WEATHERTEMPLATE. v1 A wiew Message

Use this section to add one or more template URI strings to define one or more resources for the service
operation definition.

A URI template format example appears just about the URI grid for you to use as a guide for building
URI templates.

In the example the URI grid shows that there are four URI templates defined for the service operation.
The QF WEATHERTEMPLATE.vI value defined in the Document Template field is a Document type
message. The message contains the primitive elements to supply values for country, state, city and day
indicated by the variables {country}, {state}, {city}, and {day} defined in the URI templates.
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This example illustrates the primitive elements defined in a sample document called
QFE WEATHERTEMPLATE.

Document HKML Relational

Package: QE_Weather
Document Name: QE_WeatherTemplate
Version Hame: v

F Metadata References

b Document Details

Left | Right

[= QE WeatherTemplate

You cannot save a URI template until you define a document template. The processes for defining
document templates is described earlier in this topic. Note, too, that when you save the resource
definition, the system assigns a sequential URI index to each URI template.

Building URI Templates Manually

To manually build a URI template enter the URI string in the Template field in the REST Resource
Definition section of the Service Operations — General page. The URI template expressions supported are
described earlier in this topic.

To access the page select PeopleTools > Integration Broker > Integration Setup > Service
Operation Definitions.
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This example illustrates two URI templates added to a REST resource definition for a provider service.

REST Resource Definition

REST Base URL http:providerserver. example. com:8010/PSIGWRESTListeningConnectorfweatherstation.vl/
URI Template Format Example: weather{statecity}?forecast={day}

Personalize | Find | B | i First 4] 13 of 3 n Last

Validate |Build
1 |weather{statel{city)Pforecast={day} | validate Buid —[+] [=]
|weather{statel{city} | validate Buid —[+] [=]
|weather{state} | validate Build  [+] [=]
Document Template |@E_WEATHERTEMPLATE-V1 Q. wiew Message

This example shows two URI template strings added to template, weather/{state}/{city} and
weather/{state}. Note that neither of the added URI strings has an index value. When the page is
saved, the system assigns a sequential index values to each URI string added.

To manually build a URI template:
1. Access the REST Resource Definition section on the Service Operations — General page.

To access the page select PeopleTools > Integration Broker > Integration Setup > Service
Operation Definitions.

2. Inthe URI grid, click the Add a Row button (+) to add a row for the template.
3. Manually enter the URI string.

4. Click the Save button.

Building URI Templates Using the URI Template Builder

Using the URI Template Builder page (IB_ URIBUILDER SEC) to build URI templates can simplify
building complex or lengthy URIs.

This section describes how to access the URI Template Builder page and describes the fields and controls
you use to build a URI template.

The steps to build a URI template using the URI Template Builder page vary, depending on the document
template defined and the business requirements and goals of each URI template. An example that
illustrates using the URI Template builder to build a URI template appears at the end of this topic.

Prerequisites for Using the URI Template Builder

To build a URI template using the URI Template Builder you must first define a document template in the
resource definition. The document template must contain the values for the variables you plan to build out
in the URI template.

Using the URI Template Builder

To access the URI Template Builder select PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions. The Service Operations — General page appears. In the REST
Resource Definition section of the page, click the Build link.
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This example illustrates the URI Template Builder page. You can find definitions for the fields and

controls later on this page.

URI Template Builder
Help
Expression Workspace Constant
Expression Type | Simple String v| |
© Primitive | country v _Add | Append Ta URI |
Type String
O Collection forecast |
Explode Modifier z Separator
| | Append To URI |
Append To URI
URI Template | | “alidate I

The URI Template Builder features three sections for building a URI template:

Field or Control

Description

Expression Workspace

Use this section to build the expression. The system reads the
document template defined for the resource definition and
makes the primitive and collection variable elements defined
in the document available to build the URI. After you build
an expression click the Append to URIbutton to add it to the
URI Template field at the bottom of the page.

Constant Use this section to define constants and then append them to
the URI Template field at the bottom of the page.
Separator Use this button to append the value in the URI Template field

with a forward slash (“/”).

The following fields and controls appear on this page:
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Field or Control

Description

Expression Type

Select an expression type from the drop-down list. The values
are:

*  Form-Style (Continuation).
*  Form-Style (Expansion).

»  Fragment.

*  Label

*  Path-Segment.

*  Path-Style.

*  Reserved.

*  Simple String. (Default.)

The expression types are discussed in detail earlier in this
topic.

Primitive

Select the control to build an expression based on a primitive
element contained in the document template.

After you select the control select a primitive element from the
drop-down list.

By default this control is enabled.

Type

This read only field displays the data type of the primitive
element selected.

Add

Click the button to add the selected primitive or collection
element to the expression field at the bottom of the Expression
Workspace.

Collection

Select the control to build an expression based on a collection
element contained in the document template.

After you select the control select a collection element from
the drop-down list.

Click the Add button to add the element to the expression
field.
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Field or Control

Description

Explode Modifier

This control becomes enabled after you add a collection
element to the expression field.

Select an explode modifier from the drop-down list and click
the Explode Modifier box to add it to the collection element
in the expression field.

ok cc

Currently, the asterisk explode modifier ( ) is the only

explode modifier supported.

Append To URI

Click the button to append the URI Template field with the

expression, constant, or separator.

Constant

Enter a constant value to append to the URI.

URI Template

Displays the URI template string.

Validate

Click the button to access the Validate URI page to validate the
URI template string.

OK

Click the button to populate the Template field in the resource
definition with the value in the URI Template field and to
return to the Service Operations — General page.

Cancel

Click the button to exit the URI Template Builder page

without saving any information.

This section discusses how to:
* Use the Validate URI page.
* Use the Set Value page.

* Validate a URI template.

Using the Validate URI Page

After you construct a URI template you can verify the URL produced by using the Validate URI page
(IB_SVCVERIFY_SEC). Use the Set Value page (IB_LSTESTER SEC) to set test values for the URL.

To access the Validate URI page select PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions and click the Validate link next to the URI template for the

URL to validate.
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This example illustrates the fields and controls on the Validate URI page. You can find definitions for the

fields and controls later on this page.

Validate URI

Package (QE ‘“Weather
Document QE \WeatherTemplate

Version v

Left | Right

=l QE WeatherTemplate
country

[ix}
—
i}
—
Lan}

# % 8% 8 8 8

=
(o)
[yn)
o

forecast
period

|
[y
-ﬁ LY

URI Template weather{statelcity}?forecast={day}
Generate URL |

URL

The Validate URI page displays the document information and the elements defined in the document

template specified for the REST resource definition.

The name of the URI template that is selected for validation appears in the URI Template field. In the
previous example, the following URI template appears in the URI Template field and is selected for

validation:

weather/{state}/{city}?forecast={day}

To validate the URI template, you click each element in the document tree that corresponds to each
variable in the URI template, and enter a test value for use in validation using the Set Value page.

Note: Using the Set Value page is described in the next section.

After you assign a test value for a template, the test value appears next to the element in the document

tree.
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This example illustrates the Validate URI page. Test values defined for each variable in the URI template

appear next to the variable element name.

Validate URI

Package GQFE ‘\Weather
Document QE_\WeatherTemplate
Version 1

Left | Right

= QE WeatherTemplate

countey

state - Wisconsin
city - Washburn
year

day - Friday
week

# O & R R 8

URI Template weathern!statecitylvforecast={day}
Generate URL |

upe  [Mttpcfprovidersener example.corm801 0P SIGWIRESTLIstening Canne

After you enter test values click the Generate URL button to generate a URL to test.

The following fields and controls appear on the page:

Field or Control Description

Package Package name in which the document is defined.
Document Document name.

Version Document version.

Document Tree

values for the element.

Displays the element defined in the document template. Click
an element name to access the Set Value page and to set test

URI Template Builder page.

URI Template This field displays the URI template string created using the
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Field or Control Description

Generate URL Click the button to generate a URL based on the test values
entered.

URL After you click the Generate URL button, this field displays
the generated URL.

Return Click the button to return to the URI Template Builder page.

Using the Set Value Page
Use the Set Value page to enter test values for URI template validation.

When you click an element in the document tree on the Validate URI page, the Set Value page
(IB_LSTESTER SEC) appears.

This example illustrates the fields and controls on the Set Value page. You can find definitions for the
fields and controls later on this page.

Set Value

Element Name: country
Primitive Type: String
Field Length: 30

Long:

The Set Value page provides information about the primitive element selected to assist you in providing
a useful value to test. The information that appears varies, depending on the primitive type for which you
are providing a value. After you set a test value for an element, the test value appears next to the element
name on the document tree.

The Element Name field displays the element name with which you're working.

In the example, the Primitive Type ficld and Field Length field display the data type and length as
defined for the element in the document.

The name of the field where you enter a test value depends on the data type. In the previous example, the
data type is a string, and therefore the system prompts you to enter a Long value.

The following table lists the possible labels for the field where you enter a test value:
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Data Type Primitive Type Field Label Test Value Field Label
Binary Bin Long

Boolean Bool Page displays a check box.
Character Character Char

Date Date Date

DateTime DT Datetime

Decimal Dec Numeric

Integer Int Numeric

String String Long

Text Text Long

Time Time Time

When you have defined test values for all variables in the URI template, click the Generate URL button
to generate a URL based on the test values you entered.

Validate URI Templates

To validate a URI template:

1. Access the Validate URI page (PeopleTools > Integration Broker > Integration Setup > Service
Operation Definitions and click the Validate link next to the URI template for the URL to validate.

2. In the document tree click an element to define a test value.
The Set Value page appears.
3. Enter a test value for the element and click the OK button.

The Validate URI page appears.

4. Repeat step 2 and step 3 for each variable element in the URI template.

5. On the Validate URI page, click the Generate URL button.

The URL generated based on the test values entered appears in the URL field.

6. Cut and paste the URL into a browser to test.
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7. Click the Return button to return to the Service Operations — General page.

Example: Using the URI Template Builder to Build URI Templates

This section provides an example of using the URI Template Builder to build a URI template. This
section discusses how to:

* Access the URI Template Builder.

* Build the expression string for the example URI template.
* Append the expression string to the example URI template.
* Add a separator to the example URI template.

e Add a constant to the example URI template.

* Validate the example URI template.

* Add the example URI template to the REST resource definition.

Understanding the URI Template Builder Example

The documentation in this section describes how to use the URI Template Builder page to create a
URI template for the provider service QF WEATHERSTATION using the OF WEATHERSTATION.V1
document template illustrated throughout this topic.

This example illustrates building the following URI template:

{state,country}/WhiteSalmon

In this example:

» There is one simple string expression, { state, country}.
This expression consists of two primitive elements.

¢ There is one constant, WhiteSalmon.

* The expression and constant are separated by a separator (“/ ).

Note: In this example, the prerequisites for building a URI template have already been met: the REST
base URL is defined and the document template is defined.

Accessing the URI Template Builder

To start, access the REST resource definition for the service operation (PeopleTools > Integration
Broker > Integration Setup > Service Operation Definitions. The Service Operations — General page

appears).
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This example illustrates the configuration of the REST resource definition before building the fourth URI

template.

URI
Index |Template

URI Template Format Example: weather/{state}f{city}?forecast={day}

REST Resource Definition

REST Base URL |http:fproviderserer example. com:B010/PSIGW/RESTListeningConnectarfweatherstation. w1/

First mn 1-4 of 4 D Last

1 |Weathen’{state}f{city}?forecasF{day}

2 |weatherf{state}f{city}

3 |Weatherf{state}

Validate |Build
| walidate Build =
| walidate Build =
| walidate Build =
| walidate Build =

Document Template |QE_WEATHERTEMF'LATE.V1

A wiew hlessage

The service operation is currently defined with three URI templates. In this example a fourth URI
template will be defined using the URI Template Builder page.

In the last row in the URI grid, click the Build link. The URI Template page appears.

This example illustrates the URI Template Builder page.

URI Template Builder

7 Help

Expression Workspace

Expression Type | Simple String

Explode Modifier

© Primitive | courtry v|  add |
Type String
O Collection forecast |

Constant

Append To URI |

Separator

| Append To URI |

Append To URI

URI Template |

| walidate |

Building the Expression String for the Example URI Template

This section describes how to build the expression string { state, country}.

To build an expression string, use the Expression Workspace section of the URI Template Builder page.
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This example illustrates the Expression Workspace of URI Template Builder after the expression string is
built. The string appears in the expression field at the bottom of the workspace.

Expression Workspace

<

Expression Type |=imple String

Primitive country hd Add
Type String
Collection forecast |

Explode Modifier
[state country]

Append To URI

To build the expression string:

1. Inthe Expression Workspace, from the Expression Type drop-down list, select Simple String.

2. Click Primitive. and from the Primitive drop-down list, select state and click the Add button
The {state} expression appears in the expression field.

3. From the Primitive drop-down list, select country. and click the Add button.

The country element is added to the { state} expression. And the value in the expression field is
{state, country} as shown in the previous example.

4. Click the Append to URI button.
5. In the Separator section, click the Append to URI button.
A forward slash is added to the URI in the which now appears as {state, country}/
6. In the Constant section, enter White Salmon and click the Append to URI button.
The constant is added to the URI and now appears as { state, country}/WhiteSalmon.
7. Under the URI string, click the Append to URI button.

The string is added to the URI Template field and the template is complete.

Appending the Expression String to the Example URI Template

After you have created an expression you add it to the URL template.
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This example illustrates an expression string appended to the URL template. The URL Template field
contains the string created in the previous section.

URI Template |{state country}

To append an expression from the Expression Workspace to the URL Template field, click the Append
to URI button at the bottom of the Expression Workspace.

Adding a Separator to the Example URI Template

To add a separator to a URI template, click the Append to URI button in the Separator section of the URI
Template Builder page.

This example illustrates the Separator section of the URI Template Builder page.

Separator

Append To URI

When you click the Append to URI button in this section, the system appends the value in the URI
Template ficld with a forward slash (/).

This example illustrates a separator appended to the expression string created in the previous section.

URI Template |{state country}

Adding a Constant to the Example URI Template
The constant to add to the URI template for this example is WhiteSalmon.
To add a constant to a URI template use the Constant section of the URI Template Builder page.

This example illustrates the Constant section of the URI Template page with a constant value entered.

Constant
WhiteSalmon

Append To LRI

When you click the Append to URI button in the Constant section, the value entered is appended to the
URI template in the URI Template field.
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This example illustrates a constant appended to the URI template.

URI Template |{state countryiWhiteSalmon

To add a constant to a URI template:
1. Enter the constant value in the Constant field.

2. Click the Append to URI button.

Validating the Example URI Template

Managing REST Service Operations

Click the Validate button on the URI Template Builder page to access the Validate URI page to validate
and test the URI template. Use the page to define test values for the variable elements in the URI

template.

This example illustrates the Validate URI page.

Validate URI

Package GQF ‘Weather
Documemt  QE \WeatherTemplate

Version w1

Left | Right

= QE WeatherTemplate

country
ate

i
3

@ 8 8 ¥ @
5 B

e ek

[T
=| @& forecast
= period

URI Template  {state countryihiteSalmon

Generate LUIRL |

URL

The top of the page shows the document template metadata information. The tree structure shows the
elements used in the document template. And the URI Template field shows the URI template to test.

In this example the URI template to testis { state, country}/WhiteSalmon. The variables in the
template are those in the expression { state, country} and WhiteSalmon is a constant. Since only
test values for variables are defined for testing, test values will be set for the state and country elements.

In this example the following test values are set to test the URI template:
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Document Template Element Test Value
state Washington
country United States

To define test values, click an element in the document tree structure to access the Set Value page.

This example illustrates setting

the test value for the state element. The example shows that Washington

has been defined for the element.

Set Value

Lang

Element Name:

Primitive Type:

Field Length:

state
=tring
a0

HWashington

After you set a value for an element, the value appears in the document tree view on the Set Value page.
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This example illustrates that the test value Washington has been set for the state element in the document

template.

Validate URI

Package 0QE_‘Weather
Document  QE_WeatherTemplata

Version w1

Left | Right

= OE WeatherTemplate

= country
= state - Washindton

il

£ 8 B B B

=
i
fis
=

forecast
petiod

]
T
® oe

URI Template  {state countryihhiteSalmon

Generate LIRL |

URL

After you defined test values for all variable elements in the URI template, click the Generate URL

button to generate a URL to test.
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This example illustrates the Validate URI page when all test values have been defined and the URL had

been generated based on the test values.

Validate URI

Package ©QFE_‘“Weather
Document  QE_‘WeatherTemplate
Version
Left | Right

[= QE WeatherTemplate
country - United States

state - Washinifton
City

M & & & & & &
E

URI Template {state countrydhiteSalmon
Generate URL |

upL (htpiprovidersererexarple.com:801WPSIGWIRESTLIsteningConne

The URL field in the previous example shows the URL generated. The complete URL is:

http://providerserver.example.com:8010/PSIGW/RESTListeningConnector/WeatherStation.=

v1/Washington, United$20States/WhiteSalmon
Cut and paste the URL into a browser for testing.
To validate the example URI template:
1. From the URI Template Builder page, click the Validate button.
The Validate URI page appears.
2. Define a test value for the state element.
a. Click the state element in the document tree.
The Set Value page appears.
b. In the Long field enter Washington.

c. Click the OK button.
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The Validate URI page appears and the test value Washington appears after the state element in
the document tree structure.
3. Define a test value for the country element.
a. Click the country element in the document tree.
The Set Value page appears.
b. In the Long field enter United States
c. Click the OK button.
The Validate URI page appears and the test value United States appears after the country element
in the document tree structure.
4. Click the Generate URL button
The generated URL appears in the URL field.
5. Copy the URL to test in a browser.

6. Click the Return button to return to the URL Template Builder page.

Adding the Example URI Template to the REST Resource Definition.

After you have created the URI template and performed any necessary validation, add it to the REST
resource definition.

The URI template appears in the REST Resource Definition section of the Service Operations — General
page.

This example illustrates the REST Resource Definition section with the example URI template added to
the last row in the URI grid.

BEST Resource Definition

REST Base URL |hitp:fiprovidersemer example corm 801 IPSIGWIRESTListeningConnectoreatherStation w1/

URI Template Format Example: weatheri state ¥ ity *forecast={day}

URI Personalize | Find | E | g First K 1-4 of 4 n Last
index [Temptste " yaidate [puid_ |
1 [weathen(statey(city) ?forecast={day) Validate Build [=]
2 [weathert statel{city} Yalidate Build [=]
3 |Weatherr{state} Walidate Build [=]
4 |{state,counw}w\rhiteSalmnn Walidate Build =1
Document Template |QE_WEATHERTEMPLATE »1 QL View Message

The URI template created in this example appears in the last row of the URI grid. Note that you must save
the service operation definition to save the URI template. When you save the service operation definition
the system assigns an index to the URI template.
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In the example shown, the service operation has been saved as indicated by an index number appearing
next to the example URI template.

To add a URI template to the REST resource definition:

1. After you complete the URI template and perform any validation, on the URI Template Builder page
click the OK button.

The Service Operations — General page appears. The URI template appears in REST Resource
Definition section of the page in the URI grid.

2. Click the Save button.

The URI template is saved and the system assigns an index to the URI template.

Defining REST Service Operation Version Information

This section discusses how to:
* Define default REST service operation versions.
* Define message instances for REST service operations.

* Define fault messages for REST service operations.

Understanding Default REST Service Operations

When you first create a service operation definition, the definition that you initially define is the default
version.

When the newly created service operation definition opens, the Default check box is enabled and is read-
only.

You can subsequently define additional service operation versions and assign them as the default.

See Managing Service Operation Versions.

Defining Default REST Service Operation Versions
To define the REST service operation default version:

1. Access the Service Operations - General page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions).

2. In the Version field, enter a version identifier.
The default is vi.
3. (Optional) In the Version Description field, enter a description for the operation version.

If you enter no information, the description by default is the name of the service operation when you
save the definition.
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4. (Optional) In the Version Comments check box, enter comments about the version.

5. (Optional) Select the Runtime Schema Validation check box to enable service schema validation at
runtime.

6. (Optional). In the Routing Actions Upon Save box, check the Generate Local-to-Local routing box
to generate the routing when you save the service operation definition.

Note that the Any-to-Local box is read-only and selected by default and an any-to-local routing is
created upon save.

This box only appears when working with provider service operations.

More information about routing definitions for provider REST services is available in the product
documentation.

See Managing Provider REST Service Operations

Continue to the next section to specify messages for service operations. You cannot save the service
operation definition until you define messages for it.

Defining Message Instances for REST Service Operations

You specify messages for service operations in the Message Information section of the Service Operations
— General page.

The messages that you specify define the structure of the data that is contained in the service operation.

The REST method type determines the number of messages and message types (request or response)
that you specify. The possible request and response message combinations by REST method type are
described elsewhere in this topic.

To specify messages for a REST service operation:
1. Locate the Message Information section on the Service Operations — General page.
2. Locate the Type field, and take note of the message type to define.

3. In the Message.Version field, enter the message name followed by a dot and version, or click the
Lookup button to search for a message.

After you select the message, you can click the View Message link to view the message.

4. From the Content-Type drop-down list, select the MIME content type for the message. The valid
values are:

» application/json
* application/xml
o text/xml

o text/plain

e text/html
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(Optional) Define optional content-types.

To define optional content-types:

a.

Click the Optional Content-Types link.

The Set Content Type page appears.

Type in any content type or select a content type from the Content-Type drop-down list.

The valid values from the Content-Type drop-down list are the same as those listed in Step 4.

To add additional content-types, click the Add Row button (+) and type in a content type or select
a content-type from the list.

Click the OK button.

The Service Operations — General page appears.

From the Status Code drop-down list, select the HTTP response code to return to the integration
partner.

Note that the content-type defines the acceptable HTTP media type.

The valid HTTP status code values are:

L]

200 - Default.

201 - This value is valid only when the REST method is Post.
202

203 - This value is valid only when the REST method is Get.
204

205

206

207

(Optional) Define optional status codes.

You can defined optional status codes on response messages only.

To define optional status codes:

a.

b.

Click the Optional Status Codes link.
The Set Status Codes page appears.
From the Status Code drop-down list, select a status code.

The valid values are the same as those listed in Step 6.
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¢. To add additional status codes, click the Add Row button (+) and select a status code from the list.
d. Click the OK button.

The Service Operations — General page appears.

8. Repeat steps 1 through 7 for each message type that appears in the Message Information section.

9. Click the Save button.

Defining Fault Messages for REST Service Operations

This section describes how to specify fault messages for REST service operations.

Understanding Fault Messages for REST Service Operations
You can specify fault messages for service operations for error handling.

Note the following about fault messages:

*  You cannot add fault messages to asynchronous service operations.

* Fault messages must be nonrowset-based messages, container messages, or document messages. Fault
messages cannot be rowset-based messages.

Understanding Fault Message HTTP Return Status Codes for REST Service
Operations and the OnError Method

The system recognizes and uses fault message HTTP status codes only if the fault Message is used in the
OnError method. Simply using the fault message within the OnRequest method will be treated like any
other message.

Understanding Fault Message HTTP Return Status Codes and Service System
Status for Provider REST Service Operations

If you specify fault messages for provider REST service operations, the service system status impacts the
HTTP return status codes as follows:

Field or Control Description

Production If the service system status is set to Production, any errors by
the framework or that are not part of a fault message defined
in the OnError method will result in an HTTP status code

returned of 500 with the errors not included in the payload.

If a fault message is defined on the service operation and
invoked within the OnError method, then the status code of
400 (or any other status code set for the fault) will be returned
as the HT TP status code along with the error message.
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Field or Control

Description

Development

If the service system status is set to Development, any errors
by the framework or that are not part of a fault message

defined in the OnError method will result in an HTTP status
code returned of 500 with the error message included in the

payload.

If the fault message is defined on the service operation and
invoked within the OnError method, the status code of 400 (or
any other status code set for the fault) will be returned as the
HTTP status code along with the error message.

Defining Fault Messages for REST Service Operations

To define a fault message for a REST service operation:

1. Locate the Default Service Operation Version section on the Service Operations — General tab.

2. Click the Add Fault Type button.

A new row appears in which to specify a message. Note that the Type field in the new row displays

Fault.

3. In the Message.Version field, enter the message name, or click the Lookup button to search for one.

After you select the message, you can click the View Message link to view the message.

4. From the Content-Type drop-down list, select the MIME content type of the message.

The valid values are:
* application/json
* application/xml
*  text/xml

o text/plain

e text/html

5. (Optional) Define optional content-types.
To define optional content-types:
a. Click the Optional Content-Types link.

The Set Content Type page appears.

b. Type in any content type or select a content type from the Content-Type drop-down list.

The valid values from the Content-Type drop-down list are the same as those listed in Step 4.
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c. To add additional content-types, click the Add Row button (+) and type in a content type or select
a content-type from the list.

d. Click the OK button.

The Service Operations — General page appears.

6. From the Status drop-down list, select a status code. The default and only value is 400.

7. Click the Save button.

To delete a fault message, in the Default Service Operation Version section, click the Delete Fault Type
button. Then click the Save button.

Managing REST Service Operation Versions

You can create and use different versions of service operations. The process for managing REST service
operation versions is identical to the process for managing non-REST service operation versions.

See Managing Service Operation Versions.

Note: REST resource definition are defined at the service operation level and not the service operation
version level. As a result, REST resource definitions cannot be versioned.

Managing Provider REST Service Operations

This section describes configuration tasks and considerations specific to managing provider REST service
operations. This section discusses how to:

Manage target connectors for provider REST service operations.
Manage messages for provider REST service operations.

Secure provider REST service operations.

Add handlers to provider REST service operations.

Manage routings definitions for provider REST service operations.

Define routing header properties for provider REST service operations.

Managing Target Connectors for Provider REST Service Operations

Only the HTTP target connector is supported for providing REST service operations.
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Managing Messages for Provider REST Service Operations

For a provider REST service operations defined with a nonrowset-based message, the Root Element
field on the message definition must be populated. The root element value you specify is used for proper
WADL generation.

Related Links
Adding Message Definitions

Securing Provider REST Service Operations

338

This section discusses securing provider REST service operations.

Requiring Secured Inbound Consumer Requests

When you create provider REST services you can set the level of security with which inbound service
operations must be sent using options in the Req Verification drop-down list on the Service Operations
page. If you set a required inbound security level and inbound messages do not meet the requirement, the
messages are rejected.

The following security levels are supported for provider REST service operations:
*  Basic Authentication.

*  Basic Authentication and SSL.

*  None. (Default).

*  OAuth?2 Authentication

e QAuth2 Authentication and SSL

*  PeopleSoft Token

*  PeopleSoft Token and SSL

 SSL.

See “Understanding OAuth 2.0” (Security Administration).

Setting Permissions for Provider REST Service Operations

Provider REST service operations are secured using permission lists. The process for setting permissions
for provider REST service operations is identical to the process for setting permissions for non-REST
service operations.

See Setting Permissions to Service Operations.

See “Validating Security on Inbound Integrations” (Integration Broker Administration).
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Adding Handlers to Provider REST Services Operations

The only Handler Type available for provider REST services is the OnRequest handler and the handler
is implemented as an application class. The application class is implemented as any other OnRequest
integration broker event.

Implementing handlers is discussed in greater detail elsewhere in the product documentation

See Understanding Service Operation Handlers.

See Using PeopleCode to Manage REST Service Operations.

Managing Routing Definitions for Provider REST Service Operations

This section discusses how to manage routing definitions for Provider REST service operations.

Working with System-Generating Routing Definitions for REST Service
Operations

An any-to-local routing is always created for a provider REST service operation when you initially
save the service operation definition. The routing name is a system-generated name with the format
~GENERATED~<unique number>. You cannot delete this system-generated routing, but you can
inactivate it. You can also regenerate the any-to-local routing in the Routing Actions Upon Save section
on the Service Operations-General tab. Note that if you regenerated the routing any request or response
headers previously defined will be deleted.

You can also generate a local-to-local routing for any REST-based service operation in the Routing
Actions Upon Save section on the Service Operations-General tab. You may also inactivate local-to-local
routings you create for a REST service.

Any-to-local and local-to-local routing types are discussed elsewhere in the product documentation.
See Routing Types.
You cannot create point-to-point routings for REST-based service operations.

Additional information about configuring and working with routing definitions is described elsewhere in
the product documentation.

Related Links

Managing System-Generated Routing Definitions
Configuring Routing Definitions

Activating and Inactivating Routing Definitions

Defining Properties for Provider REST Service Operation Application Class

For Integration Broker, there are two properties that can be defined for a REST provider Service
Operation Application Class. These two properties, when implemented, can override the Content Type
and Response Code for the OnError event.

The application package: PS PT application package,
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method IRequestHandler defined in its comments refers to these properties and how to use them.

If an error occurs the OnError method, if implemented, will be automatically invoked. The
type of exception can be viewed by using the Message object to retrieve the Exception object
(&Message.IBException).

Please see the PeopleCode Language Reference guide for more information about the Exception class.

OnError

The return string of this method is used for a custom error message back to the sender (if it’s not
PeopleSoft). If the request was via SOAP then the string will be wrapped in a SOAP FAULT and
returned. If the string itself is SOAP then it will not be wrapped but sent back as is.

Note that the return string is optional, in that if the string is null then the Integration Broker runtime will
handle the error.

OnError Functionality (REST Based Service Only)

The Response Code and Content Type will be automatically set based on the value defined for the
Fault Message on the Service Operation Definition. These can be overridden by setting the property
OnErrorHttpResponseCode and/or the property OnErrorContentType.

*/

interface IRequestHandler
method OnRequest (&message As Message) Returns Message;
method OnError (&request As Message) Returns string;
property integer OnErrorHttpResponseCode;
property string OnErrorContentType;

end-interface;

The following example illustrates how to invoke these properties using the OnError method:
import PS PT:Integration:IRequestHandler;

class WeatherData implements PS PT:Integration:IRequestHandler
method WeatherDatal() ;
method OnRequest (&MSG As Message) Returns Message;
method OnError (&request As Message) Returns string;
property integer OnErrorHttpResponseCode;
property string OnErrorContentType;

/* constructor */
method WeatherData
end-method;

method OnRequest
/+ &MSG as Message +/
/+ Returns Message +/
/+ Extends/implements PS PT:Integration:IRequestHandler.OnRequest +/
/* Variable Declaration */

Return &response;
end-method;
method OnError
/+ &request as Message +/
/+ Returns String +/

/+ Extends/implements PS PT:Integration:IRequestHandler.OnError +/
Local Message &Fault Msg;
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/* Create the fault string exception based on the proper format to be sent ba=

ck */

/* Override the content type and Response Code in this case

%This.OnErrorHttpResponseCode = 405;
%$This.OnErrorContentType = "application/json";

Return <The fault string>;
End-If;

end-method;

Defining Routing Header Properties for Provider REST Service Operations

On provider REST-based service operations the any-to-local routing definition features a Header

Properties page (IB_ ROUTINGRESTPROP) where you add request message and response headers to the

service operation. The headers are shown in the generated WADL document for the service operation.

To access the Header Routings page Routings-Header Properties page select PeopleTools > Integration
Broker > Integration Setup > Routings and click the Header Properties tab.

This example illustrates the Routings — Header Properties page. The example shows the header properties
for a system-generated any-to-local routing for a REST-based provider service operation.

Routing Definitions Parameters Header Properties

Routing Name: ~GEMERATED~48593706

Request Headers Personaiize | Find | View A B0 | 8 First B 45 0ra I ast
Pro Hame Comment

|ﬁ.ccept—0harset &) |Character sets that are acceptable: utf-8 %| E|
|ﬁccept—Language Q |ﬁ.cceptab|e languages for response en-LUS %| E|
I-Modified-Since € |Allows a 304 Not Modified to be returned if contentis = | [=]
Response Headers Personalize | Find | View A1 | B | 8 First B 45 or6 B Last
Proj Name Value Comment I_l_
Allow C, |GET, HEAD,DELETE, P |valid actions for a = [=]
|Cnntent—Language ') |Eng |The language the content | (=]
Date Q| The date and time thatthe = | =
|Expires Q | |Gi'u'es the datetime after ?| =
Host CL |ikcollins-t61 Transaction Server = [=]
|Warning Q | |,a., general warning about %| [=]

The request and response headers that you can add are standard HTTP request and response header fields.

There are several sources for addition information and descriptions of HTTP header fields. One such

source is the World Wide Web Consortium (W3C).

See World Wide Web Consortium.
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Note: If you regenerate a routing any header fields defined for the routing are deleted and you must
recreate them.

You also use this page to define compression on provider service operations requests and responses.

See Setting Compression for REST Service Operations.

Use the LoadRESTHeaders method of the IBInfo class to load the response and request headers at
runtime.

See Using PeopleCode to Manage Provider REST Service Operations.

Adding Request Header Properties
To add a request header property:

1. Access the Routings-Header Properties page (PeopleTools > Integration Broker > Integration
Setup > Routing Definitions and click theHeader Properties tab).

2. In the Request Headers section of the page, click the Add Row button (+) to add a row.
3. In the Property Name field, click the Lookup button and select a property to add.
The system adds the property to the grid.
4. Inthe Comments field, enter a comment about the property.
5. Repeat steps 2—4 to add additional request header properties.

6. Click the Save button.

Adding Response Header Properties
To add a response header property:

1. Access the Routings-Header Properties page (PeopleTools > Integration Broker > Integration
Setup > Routing Definitions and click the Header Properties tab).

2. In the Response Headers section of the page, click the Add Row button (+) to add a row.
3. In the Property Name field click the Lookup button and select a property to add.
The system adds the property to the grid.
4. In the Value field enter a value for the property.
5. In the Comment column enter a comment for the property.
6. Repeat Steps 2—5 to add additional response header properties.

7. Click the Save button.
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Managing Consumer REST Service Operations

This section describes configuration tasks and considerations specific to managing consumer REST
service operations. This section discusses how to:

* Add handlers to consumer REST service operations.
* Manage routing definitions for consumer REST service operations.

e Secure consumer REST service operations.

Adding Handlers to Consumer REST Service Operations

There are no handlers for consumer REST service operations. You may add connector properties to
consumer service operations on the routing definition using the Routings-Connector Properties page or
add them dynamically by using PeopleCode.

See Defining and Overriding Gateway and Connector PropertiesUsing PeopleCode to Manage REST
Service Operations.

Manage Routing Definitions for Consumer REST Service Operations

The system creates a single outbound local-to-WADL node routing when you initially save a
consumer REST service operation. The routing name is a system-generated name with the format
~GENERATED~<unique number>. You cannot delete this system-generated routing but you can
inactivate it.

Related Links

Managing System-Generated Routing Definitions
Configuring Routing Definitions

Activating and Inactivating Routing Definitions

Securing Consumer REST Service Operations

A PeopleSoft REST service operation provider may require that consumer services be sent secured.
PeopleSoft REST providers may communicate to you that they require consumer REST service operation
be secured using SSL, basic authentication, or basic authentication and SSL.

Securing Consumer REST Requests Using SSL/TLS

You can determine any SSL requirement based on the REST base URL the provider supplies and as
defined on the Service Operations — General page. If the URL is a Hypertext Transfer Protocol Secure
URL (HTTPS), then the provider has implemented SSL and your consumer request must also be sent
using the SSL protocol. Information for setting up SSL/TLS is provided elsewhere in the product
documentation.

See “Implementing Web Server SSL/TLS Encryption” (Security Administration).
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Securing Consumer REST Requests Using Basic Authentication

If a PeopleSoft REST provider system is defined in your integration network, you can use basic HTTP
authentication or PeopleSoft tokens to secure consumer requests and the PeopleSoft providing system
accepts the requests as meeting the basic authentication requirement. When using PeopleSoft tokens,

the system sends the token as an HTTP header property as part of the request. This behavior allows you
to securely pass user credentials for proper authentication instead of using basic authentication which
requires that you set an external user name and external password on the routing. If the provider has basic
authentication selected for inbound security verification and no PeopleSoft token or basic authentication
credentials are passed, a basic authentication pop-up window appears and the user must enter his or her
credentials at that time. The PeopleSoft token option is a way to not have to prompt for user credentials
for PeopleSoft-to-PeopleSoft integrations.

If a PeopleSoft REST provider is not in your integration network and the provider requires inbound basic
authentication, you cannot secure the request with a PeopleSoft token. The providing system will reject
such a request. You must secure the request using basic HTTP authentication.

If the consumer system is a third-party system and the provider requires inbound basic authentication, the
third-party system must secure the request using basic HTTP authentication.

You specify basic HTTP authentication for a consumer outbound request on the routing definition on
the Routings — Parameters page (IB. ROUTINGDEFNDOC). The Parameters section for the outbound
request features a WS Security link that enables you to set the security level for the outbound consumer
request.

To access the Routings — Parameters page select PeopleTools > Integration Broker > Integration
Setup > Routing Definitions and click the Parameters tab.
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This example illustrates the Routings — Parameters page. Click the WS Security link to set the security
level for outbound requests.

Routing Definitions Parameters Caonnectar Properi

Routing Hame ~GEMERATED~939157 496
Service Operation QE_WEATHERSTATIOM_CONSUME_GET
Sendce Operation Version vl
Sender Node QE_LOCAL
Fecener Mode WADL_MNODE

Type Inbound Respaonse
External Alias |QE_WEATHERSTATION_CONSUME v1
Alias Referances
Message.\er into Transform 1 | Q
Transform Program 1 | Q
Transform Program 2 | Q
Messageer out of Transforms | Q
Type Cuthound Request
External Alias |QE_WEATHERSTATION_CONSUME v1
WS Security Alias Referances
Messageer into Transform 1 | Q
Transform Program 1 | Q
Transform Program 2 | &)
MessageMer out of Transforms | Q

When you click the WS Security link the Routing Security page (IB. ROUTINGDEFN_SEC) appears.

This example illustrates the Routing Security page.

Routing Security

*Authentication Option: | None v |

Use Authentication Option drop-down list to select the authentication option for the request. If you
select basic authentication as the authentication option, External User ID and External Password ficlds
appear and you must enter the external user ID and password values as furnished by the provider.
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This example illustrates the Routing Security page. The example shows the page when Basic
Authentication is selected as the authentication option

Routing Security

*Authentication Option: Basic Authentication w

*External User ID:

*External Password:

Keep in mind that in addition to basic authentication, the provider may require that you send the request
secured by SSL.

To secure a REST consumer request using basic authentication:

1. Access the Routings-Parameters page (PeopleTools > Integration Broker > Integration
Setup > Routing Definitions and click the Parameters tab).

2. In the parameters section for the outbound request, click the WS Security link.
The Routing Security drop-down list appears:
3. From the Authentication Option drop-down list, select an authentication method. The options are:
*  Basic Authentication.
If you select this option, go to step 4.
*  None. (Default)
If you select this option, go to step 6.
*  PeopleSoft Token.

If you select this option, go to step 6.

4. In the External User ID field, enter the ID furnished to you by the REST provider.
5. In the External Password field, enter the password furnished to you by the REST provider.

6. Click the OK button.

Securing Consumer REST Requests Using OAuth2 Authentication

If a REST Provider uses IDCS or AZURE for their authentication server, then you can create a Service
Application under OAuth2 Administration. See Security link for configuration of OAuth2 “Understanding
OAuth 2.0” (Security Administration). Once configured, the http header can be added to the Message
prior to performing the SyncRequest.

The following code example shows how to add the OAuth2 token to the http header.

import PT SECURITY:OQAuth2:*;
Local PT_SECURITY:0Auth2:SEC AUTHTOKEN &auth;
&auth = create PT SECURITY:0Auth2:SEC AUTHTOKEN () ;
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&ret = &MSG.IBInfo.IBConnectorInfo.AddConnectorProperties ("Authorization", "Bearer =

" | &auth.GetAccessToken (<service application name>), $HttpHeader);

Related Links

“Validating Security on Inbound Integrations” (Integration Broker Administration)
“Understanding OAuth 2.0” (Security Administration)

Sending and Receiving Binary Data for Consumer REST Service Operations

When sending encoded binary data for REST consumer-based service operations, you must use the
HTTP target connector. The HTTP listening and target connectors provide a web-standard method for an
integration gateway to exchange messages with both PeopleSoft and third-party applications. See “Using
the HTTP Target Connector” (Integration Broker Administration).

Http Properties to send and receive binary data:
* Base64toBinary

* Response-Binary

Sending Binary Data for Consumer REST Service Operations

To send binary data the developer must base64 encode the binary data add it to the message via
&MSG.SetContentString(). The Developer must also set the http property as follows:

&bRet = &MSG.IBInfo.IBConnectorInfo.AddConnectorProperties ("Base64toBinary", "Y", %=

HttpProperty) ;

Receiving Binary Data for Consumer REST Service Operations
To receive binary data the developer must set this http property as follows:

&bRet = &MSG.IBInfo.IBConnectorInfo.AddConnectorProperties ("Response-Binary", "Y", =
$HttpProperty) ;

The data returned in the message will be base64 encoded.

&MSG.GetContentString () ;

The developer will first need to decode the data to get the actual binary data.

To allow HTTP target Connector to accept binary response data, check for the following response content
types:

* application/octet-stream
* application/x-binary

However, for the following response content types, there is no need to set the Response-Binary http
property as Integration Broker will treat the data as binary and base64 it:

» application/octet-stream
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» application/x-binary

* image

Related Links
Sending and Receiving Binary Data

Setting Compression for REST Service Operations

This section discusses how to:
* Set compression for provider REST service operations.

e Set compression for consumer REST service operations.

Understanding Setting Compression for REST Service Operations

PeopleSoft supports gzip and base64 (deflate) compression.

A REST service operation provider may request that inbound consumer requests be compressed using
gzip or base64 (deflate) compression. The consumer is not required to send the data compressed.

The provider specifies the compression preference and the type of compression that the provider system
can process on the routing definition using the Routings — Header Properties page. The compression
preferences are then included in the WADL document that the provider furnishes to the consumer. The
REST consumer can then view the compression preferences of the provider.

A REST service operation consumer may specify that a response from the provider be compressed using
gzip or base64 (deflate) compression. The consumer specifies this request on the outbound request routing
definition using the Routings — Connector Properties page. The compression requirement for the provider
response is then included in the HTTP target connector headers. The REST provider can then ensure that
its response meets the compression requirement of the consumer.

Setting Compression for Provider REST Service Operations

348

This section discusses how to set compression for Provider REST service operations.

Understanding Setting Compression for Provider REST Service Operations

You use the Routings — Header Properties page (IB_ROUTINGRESTPROP) to specify the compression
method that the providing system will accept on inbound requests from a consumer, as well as the
compression method the provider is using on the response to the consumer.

The two properties to use to specify message compression on the provider system are Accept-Encoding
and Content-Encoding.

For provider request and response headers set compression as follows:
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Field or Control

Description

Provider Request Header

Use the Accept-Encoding property for the Request Header
to indicate the compression method the providing system
will accept on inbound requests from the consumer. The
information you specify here is included in generated WADL
documents that you provide consumers.

There are no values to select, rather you specify the
compression method in the Comments field. The valid

compression methods are:

base64 (deflate).

gzip.

Provider Response Header

Use the Content-Encoding property for the Response Header
to indicate the compression method used on the outbound
response to the consumer. The information you specify here
is included in generated WADL documents that you provide
consumers. The compression method used should match

the compression method that the consumer specifies in the
connector properties in the inbound request. The valid values
are:

base64 (deflate).

gzip.

Setting Compression for Provider REST Service Operations

Use the Routings — Header Properties page (IB_ ROUTINGRESTPROP) to set compression for provider

REST service operations. To access the page, select P

eopleTools > Integration Broker > Integration

Setup > Routing Definitions and click the Header Properties tab.

This example illustrates the Routings — Header Properties page.

Routing Definitions Parameters

Routing Name ~GEMERATED~17660145

Request Headers

Pro Name Comment

Header Properties

Personalize | Find | View

El , =
ol | )

First BB 1 of 1 I Last

|Acce pt-Encoding

Q |gzip or baseG4(deflate)

Response Headers

Pro Name

Personalize | Find | View

Value

2 I
w | |

First Kl 1 o 1 B Last

Comment

|Cnntent—Encnding

€y |baseB4(defiate)

Q |Respnnse Compression
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The previous example shows that the Request Header is set to Accept-Encoding and that the provider
will accept requests that are gzip or base64 (deflate) compressed. The example shows that the Response
Header is set to Content-Encoding and that the provider will send its response to the consumer base64
(deflate) compressed.

To set compression for provider REST service operations:
1. Access the Routings—Header Properties page:

a. Select PeopleTools > Integration Broker > Integration Setup > Service Definitions and in
the Existing Operations section click the name of the service operation. The Service Operations —
General page appears.

b. Click the Routings tab and in the Routing Definitions grid click the name of the routing
definition. The Routing-Definitions page appears.

c. Click the Header Properties tab.

2. Set the request header.
In the Request Headers section:
a. In the Property Name field click the Lookup button and choose Accept-Encoding from the list.
b. Inthe Comment field enter a comment regarding the compression method the provider system
will accept for the inbound request from the consumer.
3. Set the response header.
In the Response Headers section:
a. Inthe Property Name field click the Lookup button and choose Confent-Encoding from the list.
b. In the Value field click the Lookup button and choose the compression used for the response
message to the consumer. The valid values are base64 (deflate) or gzip.
4. Click the Save button.

The other options featured on the Routings — Header Properties page are discussed elsewhere in the
product documentation.

See Defining Routing Header Properties for Provider REST Service Operations.

Defining Compression for Consumer REST Service Operations

350

This section discusses how to define compression for consumer REST service operations.

Understanding Setting Compression for Consumer REST Service Operations

A WADL document furnished to a REST consumer by a REST provider indicates if requests must be
compressed and if so the compression method the provider system accepts. In addition, as a REST
consumer you may require that responses from the provider be compressed and that the system can handle
a specific compression method.
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The two properties to use to specify message compression on consumer systems are Accept-Encoding and
Content-Encoding.

For consumer request and response headers set compression as follows:

Field or Control Description

Consumer Response Headers Use the Accept-Encoding property to indicate to the provider
the compression method to use in its response to your
consumer system. The valid options are:

e base64 (deflate).

e gzip.

Consumer Request Headers Use the Content-Encoding property to indicate to the provider
the compression method used on the outgoing request. The
valid options are:

e base64 (deflate).

e gzip.

Setting Compression for REST Consumer Service Operations

You use the Routings — Connector Properties page (IB_ ROUTINGRESTCPRP) to specify the
compression method used for the outbound request and the compression method(s) the system can accept
for the provider's response.

To access the Routings — Connector Properties page, select PeopleTools > Integration
Broker > Integration Setup > Routing Definitions.

This example illustrates the Routings — Connector Properties page.

Routing Definitions Parameters Connector Properties Routing Properties

Routing Name ~GEMERATED~GG6965849
Service Operation QE_WEATHERSTATION_COMSUME_POST

Service Operation Version vl
Gateway ID |LOCAL ')

Connector ID

*Delivery Mode

Connector Properties Personaiize | Find | B | #  First Bl 12052 B 155t
Pro 1D Pro Name Value

HEADER \Content-Encoding C, |base64(deflate) Q [+ []
HEADER \Accept-Encoding C, |baseb4(defate) Q [#] [=]
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The previous example shows that on the REST consumer has set Content-Encoding and Accept-Encoding
to base64 (deflate). By setting the Content-Encoding property to base64(deflate), the consumer is
indicating that it is sending the consumer request to the provider base64 (deflate) compressed. By setting
the Accept-Encoding property to base64(deflate), the REST consumer is indicating to the REST provider
that it will accept a response that is base64 (deflate) compressed.

To set compression for consumer REST service operations:
1. Access the Routings — Connector Properties page:

a. Select PeopleTools > Integration Broker > Integration Setup > Service Definitions and in
the Existing Operations section click the name of the service operation. The Service Operations —
General page appears.

b. Click the Routings tab and in the Routing Definitions grid click the name of the routing
definition. The Routing-Definitions page appears.

c. Click the Connector Properties tab.

2. Set the request header.
a. In the Property Name field click the Lookup button and choose Content-Encoding from the list.
b. In the Value field click the Lookup button and choose the compression method used for the
outbound request. The valid values are base64 (deflate) or gzip.
3. Set the response header.
a. In the Property Name ficld click the Lookup button and choose Accept-Encoding from the list.
b. In the Value field click the Lookup button and choose the compression method that the provider
should use for the response back to the consumer. The valid values are base64 (deflate) or gzip.
4. Click the Save button.

The other options featured on the Routings-Connector Properties page are discussed elsewhere in the
product documentation.

See Defining and Overriding Gateway and Connector Properties.

Renaming and Deleting REST Service Operations
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You can rename and delete service operations using the Services Operations page in the Service
Administration component. The process for renaming and deleting REST service operations is identical to
the process for renaming and deleting non-REST service operations.

See Renaming and Deleting Service Operations.
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Understanding Service Operation Queues

Service operations queues are used to queue service operations for processing.

Adding Queue Definitions

Use the Queue Definitions page (IB. QUEUEDEFN) to add queue definitions to the system. To access the
Queue Definitions page, select PeopleTools > Integration Broker > Integration Setup > Queue
Definitions.

This example illustrates the Queue Definitions page.

Queue Definitions

Queue Name: QE_PO_QUELE
Description: |QE_F‘ 0_QUEUE Archive Unordered
Comments: Queue Status: Run =
Object Owner ID: PeopleTool v
Operations Assigned to Queue Define Partitioning Fields

Common Fields View A First B 1.10 of 10 B Last

view Al | First B 190 ot

Include Field

12 [} Last

Version O QE_BUSINESS_UNIT |
QE PO ARR XFORMW Vi 0 O VENDOR 1D |
QE PO ASYNC V1 - -
QE PO ASYNCHUB v O QE_BUYER_ID |
QE PO ASYNCNEG V1 0O QE_PO_REF |
QE PO ASYNCRR V4 0 = - |
QE PO ASYNCTOSYNC V1
QF PO _ASYNCTOSYNCALIAS VA [l QE_PO_sTATUS |
QE PO ASYNC XFORM V4 Fl QE PO DT |
QE PO ATS XFORM V1 e i |
QE PO SRCRECFALSE V4
PUBLISHER |
PUBPROC |

Save Add Field

The Operations Assigned to Queue check box displays the names of the service operations assigned to a
queue. Click a service operation name to open the service operation definition.

You work with the following page elements when you add a queue.
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Field or Control

Description

Queue Name

Enter the name of the queue.

Archive

Select to archive service operation instances that are assigned
to the queue. By default, archiving is not enabled.

When you enable archiving, you can archive or delete
transactions in the Asynchronous Details component of the
Service Operations Monitor. This check box also controls
whether the Archive or Delete action is available in the
Asynchronous Details component of the Services Operations
Monitor.

If archiving is not enabled, the system purges the queue entries
that have been processed.

Note: This setting controls whether archiving is available for
asynchronous transactions only and pertains to transactions in
a specific queue.

Unordered

Select to enable field partitioning and to process service
operations unordered.

By default, the check box is deselected and inbound service
operations that are assigned to a queue are processed one at a
time sequentially in the order that they are sent.

Select to force the channel to handle all of its service
operations in parallel (unordered), which does not guarantee
a particular processing sequence. This disables the channel’s
partitioning fields.

Deselect this check box if you want all of the queues’s service
operations processed sequentially or if you want to use the
partitioning fields.

Description

Enter a description for the queue.

Queue Status

Values are:

Run: (default) Service operations that are assigned to this
queue are received and processed normally.

Pause: Service operations are received but not processed until
the status is reset to Run.

Note: You can also pause and restart queues in the Service
Operations Monitor.

354
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Field or Control Description

Object Owner ID From the drop-down list box, select the object owner.

The owner ID helps to determine the application team that last
made a change to the definition. The values in the drop-down
list box are translate table values that you can define in the
OBJECTOWNERID field record.

Comments Use this area to enter comments about the definition.

Operations Assigned to Queue This read-only section lists all service operations that are
assigned to the queue.

Include Select the Include check box next to a field name to include
the field in queue partitioning.

Add Field Click to view and select partitioning fields.

Related Links
Applying Queue Partitioning

“Understanding Pausing Nodes” (Integration Broker Service Operations Monitor)

Applying Queue Partitioning
This section provides an overview of queue partitioning and discusses how to select partitioning fields.

Understanding Queue Partitioning

This section discusses queue partitioning

Queue Partitioning

By default, all inbound service operations that are assigned to a given service operation queue are
processed one at a time, in the order they are sent. Consequently, the sending node can engage in a
series of transactions that modify a specific record, and the changes are applied by the receiving node
in the correct order. This can be inefficient if the sequence does not matter or if the sequence is relevant
only within groups of service operations with the same key values. One solution to this inefficiency is
partitioning.

Note: Partitioning applies only to asynchronous messaging.

To maximize messaging efficiency and throughput, you want the system to simultaneously process as
many service operations as possible. Because queues enforce service operation sequence, ideally you have
a separate service operation queue for each group of service operations that must be processed in order.
You can achieve this goal by designating specific fields that are common to the service operations that are
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assigned to a queue. These fields partition, or divide, the queues into subqueues. PeopleSoft Integration
Broker creates these subqueues at runtime.

Each subqueue processes only the service operations for which the designated common fields have an
identical combination of values. The service operations within each subqueue are processed in the order
that they are sent, so they remain in sequence. Each subqueue works in parallel with the other subqueues
—all subqueues simultaneously process their own associated service operations.

You implement partitioning by designating the partitioning fields in the queue definition; no other steps
are required.

Note: The more partitioning fields that you designate, the more subqueues are generated. If you designate
a combination of fields that are unique for each service operation, all service operations are processed
simultaneously, in their own subqueues, without regard to sending order. This is the equivalent of
selecting the Unordered check box in the queues definition.

Note: For inbound transactions, re-partitioning (re-running of the queue partition logic) could take place
as a result of a successful inbound transform if no partition key was passed as part of the request.

Queue Partitioning Fields
When working with queue partitioning fields, note the following points:

* The maximum length of a queue partitioning value should not exceed 60 characters. The system
truncates any value longer than 60 characters when you use the PeopleCode SubQueueName property.

* Fields of types image and long character aren’t available for partitioning.

*  When you are partitioning nonrowset-based or inbound messages, tags cannot be mixed case.

Selecting Partitioning Fields

356

You can partition queues using any combination of:
* Database record fields.
*  Message header fields.

*  Message XML fields.

Database Record Fields

Database record fields are the data fields in a PeopleSoft rowset-compatible message. Typically, the more
service operations that you assign to the queue, the fewer fields they have in common.

The database record fields that are common to all service operations in the queues appear in the queues’s
Common Field list. If only one service operation is assigned to the queues, all of its fields appear on the
partitioning list.

To designate a field as a partitioning key, select the check box next to its name.
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Message Header Fields

The message header fields are system-maintained fields that are common to all service operations,
regardless of format. If a queue includes any nonrowset-compatible service operations, the message
header fields are the only ones that PeopleSoft Integration Broker recognizes as common to every service
operation. You can view them as part of the message XML in Integration Broker Monitor. You can also
access some of them using equivalent PeopleCode Message class properties, as indicated later in this
topic. The message header fields are:

*  OPERATIONNAME: This field contains the name of the operation in the PeopleSoft Pure Internet
Architecture.

* PUBLISHER: This field contains the user ID that is in effect when the service operation is published,
that is, the ID of the user who is signed in to the publishing database.

*  PUBPROC: This field refers to the PeopleSoft process that publishes the service operation.

It is generated when the service operation is published, and it can be the name of a component, an
Application Engine program, or an iScript program.

These header fields are always available in the queue’s partitioning field list. To designate a field as a
partitioning key, select the Include check box next to its name.

Message XML Fields

The message XML fields comprise all the fields that exist anywhere in a message, including PeopleSoft
common application message attributes (PSCAMA) record fields. Such fields may not be visible in the
queues’s partitioning field list, but they are valid for partitioning. Message XML fields can have aliases,
allowing for support of mixed-case names.

To designate a message XML field as a partitioning key:

1. Access the Queue Definitions page (PeopleTools > Integration Broker > Integration
Setup > Queue Definitions).

2. Click the Add Field button.
3. Enter the tag name of the XML field, or click the Lookup button to search for one.
The value does not have to be in the database.

All names are uppercase by default. You can then add an alias, which can be mixed-case for
partitioning.

At runtime, the integration engine searches each message for the first instance of that field tag and uses
the value that is associated with it for partitioning. Therefore, if you have common fields in the PSCAMA
record that are specific to a batch publish set, you can use those fields.

Renaming and Deleting Queues

You can rename and delete queue definitions using the Queue page (IB. HOME PAGE3) in the Service
Administration component (IB_ HOME PAGE).
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The Queues page contains two sections: a Delete section that enables you to delete a queue definition and
a Rename section that enables you to rename a queue definition.

To access the page, select PeopleTools > Integration Broker > Service Utilities > Integration
Broker Admin and select the Queues tab.

When you first access the page, both sections are collapsed. Click the section-header arrow buttons to
expand and collapse each section.

This example illustrates the Service Administration — Queues page.

W3DL Senvices Senvice Operations Messages Message Schemas Queues Routings El

Service System Status: Development
Queue Name: |

Search
]
Queues Customize | Find | Wiew All| IEll Bl First 4 1 of1 n Last

Select Queue Hame Results

Delete

Queue Name: | Q

Hew Name: |

Rename

Results:

The top of the page displays a Service System Status ficld with the current setting, as defined on the
Service Configuration page. This setting affects the ability to rename and delete queues.

See “Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration
Broker Administration).

Renaming Queue Definitions
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To rename a queue definition:

1. Access the Services Administration - Queues page (PeopleTools > Integration
Broker > Integration Broker Admin and click the Queues tab).

2. Click the arrow next to the Rename section header to expand the section.

3. In the Queue Name field, enter the queue definition to rename, or click the Lookup button to search
for and select the queue to rename.

4. In the New Name field, enter the new name for the queue definition.
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5. Click the Rename button.

Deleting Queue Definitions
To delete a message definition:

1. Access the Services Administration - Queues page (PeopleTools > Integration
Broker > Integration Broker Admin and click the Queues tab).

2. Click the arrow next to the Delete section header to expand the section.

3. In the Queue Name field, enter the name of the queue definition to delete, and click the Search
button.

Search results appear in the results grid.
4. In the results grid, select the check box next to the queue or queues to delete.

5. Click the Delete button.

Deleting Queues During Upgrade

To delete a queue definition in an application upgrade project, first ensure that no live instances of
messages are assigned to that queue. Archive or delete any such messages in both the source and the
target database. Otherwise, an error message appears during the copy process indicating that the message
is in use.
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Understanding Message Schema Validation

PeopleSoft Integration Broker enables you to validate, at runtime, the messages defined in service
operations against message schemas.

Message Schema Validation

Validating messages against message schemas can ensure that during integration development no changes
or deletions were inadvertently made to a message. You can use schema validation on outbound and
inbound messages.

During runtime schema validation, PeopleSoft Integration Broker checks messages to ensure that the
XML structure is valid according to the specified message schema. If Integration Broker encounters a
service operation with a message structure that does not adhere to the specified message schema, message
delivery fails and Integration Broker generates an error message.

Schema validation is based on the message schema for the message.version defined on the default service
operation.

You can view any schema validation error details on the source application server, using the
Asynchronous Details page or Synchronous Details page in the Service Operations Monitor.

When schema validation is enabled the structure of a message cannot be changed.

Message Schema Validation and Transformations

In instances where an inbound transaction has a transformation applied, the input message.version is used
for schema validation. If an input message.version is not defined, then validation takes place using the
request message.version of the default service operation.

For the case where a point-to-point routing and an any-to-local routing are both defined, the system uses
the point-to-point routing to check for a transform.

Message Schema Validation and Part Messages

PeopleSoft Integration Broker does not perform parser validation on part messages in container messages.

URLSs defined in container messages do not contain absolute paths. As a result, the parser cannot import
these schemas to perform validation.
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PeopleSoft internal validation is performed on the data and structure of part messages within contain
messages. However, these validation results may be different than results achieved using parser
validation.

Prerequisites for Validating Message Schemas

Before you can enable schema validation, you must build or import a message schema for the message
and message version.

If no message schema is present for service operations that contain regular nonrowset-based messages or
container messages, it is not possible to enable validation.

For service operations that contain rowset-based messages, the system will attempt to generate a schema
if one is missing. If the system is able to successfully generate a message schema for a rowset-based
message, validation is enabled.

See Understanding the Message Schema Builder.

Selecting Service Operations

This section discusses how to select service operations that contain messages to validate against message
schemas at runtime.

Selecting a Service Operation

362

The first step to enabling runtime message schema validation is to select the service operations that
contain the messages to validate.

When you access the Service Schema Builder component (IB_ SERVICEVAL), the Service Schema
Validation page (IB_SERVICEVAL) appears and displays a search engine that you use to search for
service operations.

To access the Service Schema Validation page select PeopleTools > Integration Broker > Service
Utilities > Validate Service Schemas.

This example illustrates the Service Schema Validation page.

Service Schema Validation

Service: | Q

Service Operation: | Q

Search |

Copyright © 1988, 2023, Oracle and/or its affiliates.



Chapter 14

Enabling Runtime Message Schema Validation

To search for a service operation, enter the service or service operation with which to work and click the
Search button. A list of results displays in the Service Operations grid. If you do not enter any search
criteria and click the Search button, the system returns all services and service operations in the database.

When you search for service schema validation data, the system returns the results in the Service
Operations grid shown on the Service Schema Validation.

This example illustrates the fields and controls on the Service Schema Validation page. You can find
definitions for the fields and controls later on this page.

Service:

Service Operation:

Service Operations

Service Schema Validation

| Q
| Q

Customize | Find | v

First B 110 or 250 I Last

[sevice  [Service Operation Version [Validation  |Results e
ASYNC_MDMN_RESPONSE ASYNC_MDMN_RESPONSE VERSION_1 F Schema
PT_WORKLIST CREATE_WORKLIST_ITEM W1 F Schema
DELETE_ROLE DELETE_ROLE al F Schema
DELETE_USER_PROFILE DELETE_USER_PROFILE VERSION_1 F Schema
EMAIL_MSG EMAIL_MSG VERSION_1 F Schema
GENCOMPONENTURL ~ GENCOMPONENTURL_SO vl O Schema
SAWSESSIONSERVICE GETHTMLFORPAGEWITHONEREFPORT V1 F Schema
IB_UTILITY GETROUTINGS W1 F Schema
IB_UTILITY GETSCHEMA W1 F Schema
SAWSESSIONSERVICE GETSUBITEMS W1 F Schema
Field or Control Description

Service

Indicates the name of the service.

Service Operation

Indicates the name of the service operation.

Version

Indicates the version of the service operation.

Validation

Indicates if runtime schema validation is enabled.

When the check box is selected, schema validation is enabled.
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Field or Control Description

Results Displays validation results.

The valid values are:

e Error generating schema. Unable to turn on validation.
This message appears if one or more of the messages in
the service operation is nonrowset-based and schemas do
not exist for the nonrowset-based messages.

*  Service operation saved.

This message appears when you have successfully
enabled runtime schema validation and saved the changes.

e Error saving service operation.

Schema Click the link to access message schemas for all messages
defined on the service operation.

See Viewing Defined Message Schemas.

Viewing Defined Message Schemas

This section discusses how to view defined XML schemas for messages.

Viewing XML Schemas Defined for Messages

To view defined message schemas for all messages contained in a service operation, in the Service
Operations grid, locate a service operation with which to work and click the Schema link. The systems
displays the service operation in the Schema Builder page (IB_ SCHEMABUILD).

This example illustrates the Message Schema Builder page. The example shows the page displaying two
messages for the MCFEM REQ MKFOLDER service operation.

Message Schema Builder

Message Criteria

Service Operation: MCFEM_REQ_MKFOLDER
Service: MCFEM_REC_MKFOLDER  Service Operation Version: VERSION_1

Message Schemas Customize | Find | View A1 B0 3 First B 40 02 B Lot
Message Message Version Exists |Updated on Build Results
07/06/2009
[] MCFEM REQ MKFOLDER VERSION_1 Yes Yes e ian
07/06/2009
[] MCFEM RES MKFOLDER VERSION_1 Yes Yes e ian
SelectAll [ ClearAll Build Selected Schemas Delete Selected Schemas
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The Exists field displays a value of Yes for both messages and indicates schemas have been built for both
messages.

If schemas are not built for a message or messages, you can build them directly from this page by
selecting the check boxes next to each message name and clicking the Build Selected Schemas button.

To view the XML schema for a message, click the message name link.

This example illustrates the message schema for the MCFEM REQ MKFOLDER message.

Message: MCFEM_REQ_MKFOLDER . VERSION_1

Schema:

=%ml version="1.0"?= -
=x¥sd:schema xminsxsd="httpfwww w3 .org/2001MLSchema”™
=x¥sd:element name="MCFEM_REQ_MKFOLDER"
type="MCFEM_REQ_MKFOLDER_TypeShape™/=
=¥sd.complexType name="MCFEM_REQ_MKFOLDER_TypeShape™=
=xsd.sequence=
=¥sd:element name="FieldTypes" type="FieldTypes_TypeShape"/=
=¥sd.element name="MsgData" type="MsaData_TypeShape=
=hsd:sequence=
=fsd.complexType=
=¥sd.complexType name="FieldTypes_TypeShape™=
=xsd:all=
=¥sd:element name="MCFEM_REQ" type="FieldTypesMCFEM_REQ_TypeShape™=
< >

To return to the Schema Builder page, click the Return button.

Using the Schema Builder page is documented in detail elsewhere in the product documentation.

Related Links
Understanding the Message Schema Builder

Enabling Runtime Message Schema Validation

This section discusses how to enable runtime schema validation for all messages defined in a service
operation:

You can enable runtime message schema validation from the Service Schema Validation page or from the
Service Operations page.

Using the Service Schema Validation Page to Enable Runtime Message
Schema Validation

To enable runtime schema validation using the Service Schema Validation page:

1. Access the Service Schema Validation page (PeopleTools > Integration Broker > Service
Utilities > Validate Service Schemas).
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Select a service operation that contains messages against which you want to validate message
schemas.

See Selecting Service Operations.

Select the Validation check box.

Click the Save button.

Using the Service Operations page to Enable Runtime Message Schema
Validation

366

To enable runtime schema validation using the Service Operations page:

1.

Access the Service Operations page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions).

In the Default Service Operation Version section of the page, select the Runtime Schema Validation
check box.

Click the Save button.
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Understanding Creating Component Interface-Based Services

PeopleSoft Integration Broker enables you to take an existing component interface and create a service
that can be used to invoke the component interface. Further, it creates service operations, including
request messages and response messages (if appropriate). The system creates an inbound any-to-local
routing for the service operation version, as well as handlers for each method you choose to include in the
service.

All service operations you generate from component interfaces are synchronous service operations.

Naming Conventions Integration Metadata Created

This section highlight the naming conventions that the PeopleSoft system uses when it creates services
and services-related data based on component interfaces.

When it creates a web service from a component interface, the PeopleSoft system adds a C/ _prefix to
the component interface name. So if the component interface name is MYCI, the service name the system
creates is CI MYCI

The following table highlights naming conventions the PeopleSoft systems applies to other services data
based on the method with which you are working:

Component Service Operation Message Component Request Response

Interface Name Name Interface Message Message

Method Handler Shape Shape

Create <service name> C MXXXXXX ONREQUESTHDLKI Buffer Key

Find <service name> F MXXXXXX ONREQUESTHDLKet Keys CI Buffer

Get <service_name> G MXXXXXX ONREQUESTHDILKind Keys Key Collection

Update <service_name> UP MXXXXXX ONREQUESTHDLKI Buffer Notification

Updatedata <service_name> UD MxXXXXX ONREQUESTHDLKI Buffer Notification

User-defined <service name> <method | MXxxxxx ONREQUESTHDLKI Buffer Method Return
name> Type
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The naming convention used for message names, Mxxxxxx, is the letter M followed by a random six-digit
number, as denoted by the x's. An example of a message name is M548902.

Note: The maximum number of characters for a service operation name is 30. If using a user-defined
method name yields a greater result, the name is used is <service_name> Mxxx, where xxX is a three-
digit random number. An example of such a name is CI USERCI M101023.

User-Defined Method Restrictions

368

This section discusses restrictions related to using user-defined methods when exposing component
interfaces as services.

User-Defined Method Actions

User-defined methods which are executed with the Create action should not be exposed as web services.

Specifying Method Parameters and Parameter Names

All user defined methods that will be accessed via the service interface must have a doc string.
The doc string contains:

1. The keyword GET. .

2. An ordered list of parameter names corresponding to the method's parameters.

The following example shows the format of the doc string:

Function simpleFunction (&sParm As string, &dParm As date,
&nParm As number, &bParm As boolean)
Returns string
Doc "GET, StringParm, DateParm, NumParm , BoolParm"

Local string &aString = &sParm;

&aString = &aString | " -- " | &dParm;
&aString = &aString | " -- " | &nParm;
&aString = &aString | " -- " | &bParm;

Return &aString;

End-Function;

The contents of the doc string are used when the function is invoked. For example, if GET is specified,
then the GET keys are set, and GET is called on the component interface before the used-defined method
is invoked.

The list of parameters are used at runtime to match the data in the input message with the method's
parameters. This is an ordered list; if the parameter list in the doc string and the method parameters don't
match, then the method may not work correctly. The names in the doc parameter list will be the names
visible in any WSDL created for the service.

Method parameters and return values must be of a primitive type, such as a string, date or number. Object
parameters or return values are not supported.
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Impact of Changing Component Interfaces

If a user modifies or deletes a component interface in PeopleSoft Application Designer, when the user
saves the changes, PeopleSoft Integration Broker checks if a service exists for the component interface.
If a service exists, and the component structure/properties have changed in the component interface, a
warning message appears stating that a service exists for the component interface.

If the component interface structure changes, a status of Does not match appears in the CI-Based Services
Review Status grid, and the operation appears as active in the Service Operations component.

Prerequisites for Creating Component Interface-Based Services

Prior to creating any component interface-based web services and service operations, you must define the
schema namespace, service namespace, and target location in the Service Configuration page

See “Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration
Broker Administration).

Selecting Component Interfaces to Expose as Services

This section discusses how to select component interfaces to expose as web services.

The first step to creating component interface-based services is to choose the component interface on
which to base a service. To do so, use the CI-Based Services component (IB_CISERVICES) and the
Select Component Interface page (IB_ CISERVICES).

This example illustrates the Select Component Interfaces page.

Cl-Based Services
Select Component Interfaces

Component Interface Name: CURRENCY_CD_Cl Q
Component Name: Q
Owner ID: | i |

Search

oS5
customize | Find | View A1 | 20| B First Bl 4 o1 B Last

Component Name: Object Owner ID
| CURRENCY_CD_CI CURRENCY_CD_COMP

Review Cl Status

When you search for component interfaces to select, the system returns results only for those component
interfaces to which you have permissions.

To select a component interface:

1. Access the Select Component Interfaces page (PeopleTools > Integration Broker > Web
Services > Provide CI-Based Services).
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2. Search for a component interface:

Note: You can search only for those component interfaces to which you have permissions.

*  Click the Search button to search from all component interfaces in the database, or

* Select one or more of the following criteria to narrow your search and then click the Search

button.

Field or Control Description

Component Interface Name Enter part or all of the name of the component interface to
use, or click the Lookup button to search for one.

Component Name Enter part or all of the component name to which a
component interface belongs.

Owner ID Owner ID drop-down list box, select the person or group
that owns the component interface.

The Select Cls grid displays are component interfaces that match your search.
3. Select the Select check box next to one or more component interfaces.
4. Click the Review CI Status button.

The Review CI Status page appears where you can review details about the select component interface
and select the methods to include as operations in the service.

Selecting Component Interface Methods to Include as Service
Operations

This section discusses using the Review Status page (IB_ CISERVICES?2) to select methods to include
web services as service operations.
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This example illustrates the fields and controls on the Review Status page. You can find definitions for the
fields and controls later on this page.

Cl-Based Services
Review Status

Status Find  First B 4 or 1 I Last
CIName:  CURRENCY_CD_CI Description:
Service: CI_CURRENCY_CD_CI Status: Service does not exist and will be created.
Choose Method
[select  [Acion =~ |Method =~ |Service Operation [status
A Create Operation. Get Does not exist
"] Create Operation. Create Does not exist
"1 Create Operation. Find Does not exist
[F] Create Operation. Update Does not exist.
A Create Operation. Updatedata Does not exist.

SelectAll [ Deselectal

Display Selected Actions | Return to Select Cls

The Review Status page shows the following information about the component interface you select to
expose as a service:

Field or Control Description

CI Name Name of the component interface.

Service Name of the service created based on the component interface.
Note that the service name is the component interface name
with CI _added as a prefix.

Description A description of the component interface. This information is

taken from the component interface record and displays if it
exists.

Status (Service) Displays the status of the service. The valid values are:

e Service does not exist and will be created. Indicates that a
services does not exist for the service and the system will
create one.

*  Service Exists. Indicates that a service has already been
created for the component interface.
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Field or Control Description
Select Select the check box to include a method as an operation for
the service.

If the check box is disabled, the method has already been
included in the operation and the Service Operation field
displays the name of the operation created.

You can select one or more methods at a time.

Action Displays the action available to perform on the method. The
valid values are:

*  Create Operation. This action displays if no service
operation exists for the method.

*  Create New Version. This action displays if the current
request or response shape do not match the shapes
previously generated. A new service operation version is
generated.

*  None. If an operation exists, it compares the component
interface and the service operation. If they are in sync, no
action is required.

Method Name of the component interface method.

The system displays user-defined and standard methods. All
user-defined methods appear in lowercase.

You can create service operations based on the following
standard component interface methods:

*  Create.
*  Get

e Find

*  Update.

*  Updatedata.
»  User-defined methods.

Update and Updatedata appear if both Get and Save have been
enabled in the component interface.

Note: All user-defined methods are lowercase. If you have
a user-defined method called update, it is a different method
than the Update method used here.

Service Operation Name of the service operation, if one exists for a method.

The name the system give the service operation depends on the
service name as well as the component interface method.
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Field or Control Description

Status (Service Operation) The status corresponds to the value in the Action field. The
valid values are:

*  Does not exist. No service operation exists for the
method.

e Does not match. The service operation does not match the
existing component interface.

*  OK. The service operation matches the existing
component interface.

*  Operation created. The system created the operation.

Display Selected Actions Click the button to display a summary of the actions requested
and then generate services and service operations.

Generating Component Interface-Based Services

This section discusses how to:
* Generate services and service operations from component interface methods.
* Inherit component interface security permission lists.

* Add message names and descriptions to generated service operations.

Generating Services and Service Operations from Component Interface
Methods

Use the Confirm Actions page (IB_CISERVICES SEC) to confirm the component interface and select
actions to use for generating service operations.

This example illustrates the fields and controls on the Confirm Actions page. You can find definitions for
the fields and controls later on this page.

[confirm Actions |

Actions Find F\rs(n 10f1 o La|

CiName:  CURRENCY_CD_CI Description:

Seniice:  CI_CURRENCY_CD_CI Service Alias: |
Service Status: Service does not exist and will be created. Inherit All Cl Permissions
Choose Operation

Action Service Operation Aliag Inherit Cl Permissions Version Message Names and
Descriptions

Create Operation.  Get CI_CURREMCY_CD_CI_G.WV1 li [ Names and Descriptions
Create Operation.  Create CI_CURREMCY_CD_CI_CWV1 li [¥] li Mames and Descriptions

Perform Selected Actions Retum to Select Cls

You can work with the following page elements:
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Field or Control

Description

Service Alias

(Optional.) Enter an alias name for the service. The name
you enter can be lower or mixed-case. If specified, this is
the service name that appears in any WSDL documents you
generate.

Inherit All CI Permissions

Select the check box so that all service operations you create
inherit the security permissions as defined for the component
interface after which they are based. By default the check box
is selected.

To inherit security permissions for specific service operations
only, use the Inherit CI Permission check box in the Choose

Operation grid.

See Inheriting Component Interface Security Permission Lists.

Select

(Optional.) Deselect the check box to omit creating a service
operation for a method.

Alias (Service Operation)

(Optional.) Enter an alias name for the service operation.

The name you enter can be lower or mixed-case. If specified,
this is the service operation name that appears in any WSDL
documents you generate.

Inherit CI Permissions

Select the check box for a service operation to inherit the
security permissions as defined for the component interface
after which it is based. By default the check box is selected for
all service operations based off of a component interface.

Deselect the check box for each service operation you do not
want to inherit the permissions defined for the component

interface after which it is based.

See Inheriting Component Interface Security Permission Lists.

Version

(Optional.) Service operations created default version V1.

You may enter a different value to use as the version when the
service operation is created.

This field is a text field, so you may enter numeric or text
values.

Message Names and Descriptions

(Optional.) Click the link to specify names and descriptions
for messages in the service operation. The message names
and descriptions will appear in the generated XML message
schema.

If you do not enter message names or descriptions, PeopleSoft
Integration Broker assigns system-generated names to the
messages. The following example shows a sample system-
generated message name: M702221.V1
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Field or Control

Description

Perform Selected Action

Click the button to generate services and service operations for
the component interface and selected methods.

After the service and service operations are created, the
Review Status page displays and you can review the actions
performed as well as access the service definition created.

Return to Select Cls

Click the link to return to the previous page, the Review Status
page.

Inheriting Component Interface Security Permission Lists

You can specify that all or select component interface-based service operations inherit the security
permission list(s) of the component interface from which they are derived. This feature allows you to
bypass the process of manually assigning permission lists to the service operations after you generate

them.

The Confirm Actions page (IB_ CISERVICES SEC) shown in the previous section contains an Inherit
All CI Permissions check box located on the upper half of the page. The Choose Operation grid of the
page features an Inherit CI Permissions check box for each service operation to be generated.

Important! Permission lists granted to a component interface after the service operation is created are not
propagated to the service operations and you must manually add them.

Field or Control

Description

Inherit All CI Permissions

Select the check box for all service operations to inherit the
permission lists of the component interface from which they
are based. By default the check box is selected.

Deselect the check box to choose select service operations

to inherit the permission list(s) of the base component
interface or to manually define permission lists for the service
operations in the PeopleTools Security component.

Inherit CI Permissions

Select the check box for each service operation that is to
inherit the permission list(s) of the base component interface.

Deselect the check box for each service operation this is not to
inherit the permission list(s) of the base component.

The system generates service operations for the Update and UpdateData methods based the existence
of the Get method. Therefore, the same permissions granted to a component interface's Get method are
inherited by service operations based on the Update and UpdateData methods

Related Links

Generating Services and Service Operations from Component Interface Methods

Setting Permissions to Service Operations
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Adding Message Names and Descriptions to Generated Service Operations

The Confirm Actions page features a Message Names and Descriptions link for each service operation.
Click the link to open the Message Names and Descriptions page (IBCISERVICES2 SEC). On the page
you can enter names for each message in the service operations. You can also enter a description for each

message name. The message names and description will appear in the generated XML message schema
for the service operation.

This example illustrates the Message Names and Descriptions page.

Message Names and Descriptions
Request Message Name:

Request Description:

Response Message Name:

Response Description:

Fault Message Hame:

Fault Description:

In the message name fields, enter a message name. You do not need to append the message name with a

version number. The system automatically creates a version of the message as version one, and appends
the message name with . V1.

When you have completed entering message names and descriptions, click the OK button to return to the
Confirm Actions page.

Viewing Component Interface-Based Service Definitions

376

After you generate services and service operations, the Review Status page (IB_SERVICES?2) appears.

Use the page to review the actions performed.
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This example illustrates the Review Status page.

Cl-Based Services
Review Status

Status First (] 10f1 n Last
ClName:  CURRENCY_CD_CI Description:
Service: CI_CURRENCY_CD_CI Status: Senice saved.

View Service Definition

Choose Method
[setect  [Acion =~ [Method Service Operation [Staws
Create Operation. Get CI_CURRENCY_CD_CI_GW1 Operation created.
Create Operation. Create CI_CURRENCY_CD_CI_CN1 Operation created.
] Create Operation. Find Does not exist.
] Create Operation. Update Does not exist.
O Create Operation. Updatedata Does not exist.

Selectall 0 Deselect Al

Display Selected Actions | Return to Select Cls

For example, the previous graphic shows the names of the two service operations created as well as the
service operation status of Operation created

From this page you can continue to create additional service operations using the remaining available
methods for the component interface.

Or, you can click the Return to Select CI link to return to the Select Component Interface page to select
new component interfaces for which to generate services and service operations.

You can also click the View Service Definition link to view the service definition for the service created.

When you click the View Service Definition link the service you created, CI CURRENCY CD _CI
appears in the Services page.
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This example illustrates the Services page.

Services

Service:  CI_CURRENCY_CD_Cl
*Description:  |CI_CURRENCY_CD_CI

Comments:

Service Alias: |

Object Owner ID: | b
*Namespace: |http:ﬂxm|ns.nracle.cn m/Enterprise/Tools/sernvices
Link Existing Operations View WSDL Provide Web Senice

Service Operations

Service Operation: |

Operation Type: | W | Add |

Existing Operations Customize | Find | View Al | ] 88 First K 12 or 2 B Last

Operation Meszage Links

Operation.Default Version Description
Cl CURRENCY CD Cl €31 Cl_CURRENCY_CD_CI_C Synch

[0 [

£l CURREMCY CD Cl GVl CI_CURREMCY_CD_CI_G Synch

From this page you can perform actions as you would on any other service, including:
*  Click the Provide Web Service link to generate WSDL for the service.
» Use the Service Operations check box to add additional service operations to the service.

*  Click either of the operations that display in the Existing Operations check box to generate routing
definitions, view the response, request or fault messages, view handler details, and more.

¢ Andsoon.

Related Links

Understanding Managing Services
Understanding Managing REST Services

Understanding Managing Service Operations
Understanding REST Service Operations
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Understanding Creating Component Interface-Based REST
Services

PeopleSoft Integration Broker enables you to take an existing component interface and create a REST-
based service that can be used to invoke the component interface. Further, it creates service operations,
including request messages and response messages (if appropriate). The system creates an inbound any-
to-local routing for the service operation version, as well as handlers for each method you choose to
include in the service.

All service operations you generate from component interfaces are synchronous service operations.
This feature allows you to:
* Create services for selected component interfaces.
* Add selected methods to existing REST services previously created using this component.
*  Compare selected component interfaces with the REST services previously created using this
component.
Naming Conventions Created by Integration Metadata

This section highlights the naming conventions that the PeopleSoft system uses when it creates REST
services and services-related data based on component interfaces.

When it creates a web service from a component interface, the PeopleSoft system adds a CIRT _ prefix to
the component interface name. So if the component interface name is MY CI, the service name the system
creates is CIRT _MYCI.

The following table highlights naming conventions the PeopleSoft systems applies to other service data
based on the method with which you are working:

Component Service Message Component Request Response
Interface Method | Operation Name | Name Interface Handler | Message Shape | Message Shape
Create CIRT <CIName>_ | MXXXXXX ONREQUESTHDLR| CI Buffer structure | Object Key
C_POST
Get CIRT <CIName> | MxXXxxx ONREQUESTHDLR| Get Keys CI Buffer
G _GET
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Component Service Message Component Request Response

Interface Method | Operation Name | Name Interface Handler | Message Shape | Message Shape

Find CIRT <CIName> | MxXXXxXXX ONREQUESTHDLR| Find Keys Find Key Collection
F_GET

Update CIRT <CI Name>_ | Mxxxxxx ONREQUESTHDLR| CI Buffer structure | Notification, error
U _PUT details

Update Data CIRT <CI Name> | MXXXXXX ONREQUESTHDLR| CI Buffer structure | Notification, error
UD PUT details

Note: The maximum number of characters for a service operation name is 30.

Impact of Changing Component Interfaces

If a user modifies or deletes a component interface in PeopleSoft Application Designer, when the user
saves the changes, PeopleSoft Integration Broker checks if a service exists for the component interface.
If a service exists, and the component structure or properties have changed in the component interface, a
warning message appears stating that a service exists for the component interface.

If the component interface structure changes, a status of Does not match appears in the CI-Based REST
Services Review Status grid, and the operation appears as active in the Service Operations component.

Prerequisites for Creating Component Interface-Based REST
Services

Prior to creating component interface-based REST services and service operations, you must define the
schema namespace, service namespace, and target location in the Service Configuration page.

See “Understanding Configuring PeopleSoft Integration Broker for Handling Services” (Integration
Broker Administration).

Selecting Component Interfaces to Expose as REST Services

This section discusses how to select component interfaces to expose as REST services.

The first step to creating component interface-based REST services is to choose the component
interface on which to base a service. To do so, use the CI-Based REST Services component
(IB_CISERVICES REST) and the Select Component Interface page (IB_ CISERVICES).
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This example illustrates the Select Component Interfaces page.

Cl-Based REST Services

Select Component Interfaces

component Interface Name |QE_B

Component Hame

Review Cl Status

(=] Matify

Personalize | Find | View Al | &Y | EH First ‘&' 1-20f2 '} Last

Owner ID
Search
Select Cls
Select Cl Hame Description Component Name Owner ID
| QE_BD_CALENDAR DETAIL_CALENDAR PeopleTools Demo
[l QE_BUS_EXP QE_BUSINESS_EXP PeopleTools Demo

When you search for component interfaces to select, the system returns results only for those component

interfaces to which you have permissions.

To select a component interface:

1. Access the Select Component Interfaces page (PeopleTools > Integration Broker > Web

Services > Provide CI-Based REST Services).

2. Search for a component interface:

Note: You can search only for those component interfaces to which you have permissions.

*  Click the Search button to search from all component interfaces in the database, or

» Select one or more of the following criteria to narrow your search and then click the Search

button.

Field or Control

Description

Component Interface Name

Enter part or all of the name of the component interface to
use, or click the Lookup button to search for one.

Component Name Enter part or all of the component name to which a
component interface belongs.
Owner ID Owner ID drop-down list box, select the person or group

that owns the component interface.

The Select Cls grid displays are component interfaces that match your search.

3. Select the check box next to one or more component interfaces.
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4. Click the Review CI Status button.

Chapter 16

The Review Status page appears where you can review details about the selected component interface and
then select the methods to include as operations in the REST service.

Related Links

Selecting Component Interface Methods to Include as REST Service Operations

Selecting Component Interface Methods to Include as REST

Service Operations

This section discusses using the Review Status page (IB_ CISERVICES?2) to select methods to include

REST services as service operations.

This example illustrates the fields and controls on the Review Status page. You can find definitions for the

fields and controls later on this page.

Cl-Based REST Services

Review Status

Status

CIName QE_BUS_EXP
Service CIRT_QE_BUS_EXP
Wiew Senice Definition
Choose Method

Select Action Method

] Create Operation. Get

(= Create Operation. Find

=] Create Operation. Update

] Create Operation. Updatedata
¥ Select Al Deselact All

Display Selected Actions Return to Selact Cls

=] Motify

Description

Service Operation Status

Find First ‘4 10f1 '»/ Last

Status  Service exists.

Does not exist.
Does not exist.
Does not exist.

Does not exist.

The Review Status page shows the following information about the component interface you select to

€Xpose as a service:

Field or Control

Description

CI Name

Name of the component interface.

Service

Name of the REST service created based on the component
interface.

Note that the REST service name is the component interface
name with CIRT added as a prefix.
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Field or Control

Description

Description

A description of the component interface. This information is
taken from the component interface record and displays if it
exists.

Status (Service)

Displays the status of the service. The valid values are:

*  Service does not exist and will be created. Indicates that a
services does not exist for the service and the system will
create one.

»  Service Exists. Indicates that a service has already been
created for the component interface.

Select

Select the check box to include a method as an operation for
the service.

If the check box is disabled, the method has already been
included in the operation and the Service Operation field
displays the name of the operation created.

You can select one or more methods at a time.

Action

Displays the action available to perform on the method. The
valid values are:

*  Create Operation. Indicates that no service operation
exists for the method and a new service operation can be
created.

*  Create New Version. Indicates that the current request
or response shape do not match the shapes previously
generated and a new service operation version can be
generated.

*  None. If an operation exists, it compares the component
interface and the service operation. The availability of
this action indicates that the component interface and the
service operation are in sync, no action is required.
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Field or Control Description

Method Name of the component interface method.

You can create service operations based on the following
standard component interface methods:

*  Create.
*  Get.

*  Find

*  Update.

*  Updatedata.

Update and Updatedata appear if both Get and Save have been
enabled in the component interface.

Service Operation Name of the service operation, if one exists for a method.

The name the system gives the service operation depends on
the service name as well as the component interface method.

Status (Service Operation) The status corresponds to the value in the Action field. The
valid values are:

*  Does not exist. No service operation exists for the
method.

*  Does not match. The service operation does not match the
existing component interface.

*  OK. The service operation matches the existing
component interface.

*  Operation created. The system created the operation.

Display Selected Actions Click the button to display a summary of the actions requested
and then generate REST services and service operations.

Related Links

Selecting Component Interfaces to Expose as REST Services

Generating Component Interface-Based REST Services

This section discusses how to:
* Generate REST services and service operations from component interface methods.

* Inherit component interface security permission lists.
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* Add message names and descriptions to generated REST service operations.

Generating REST Services and Service Operations from Component

Interface Methods

Use the Confirm Actions page (IB_CISERVICES SEC) to confirm the component interface and select
actions to use for generating REST service operations.

This example illustrates the fields and controls on the Confirm Actions page. You can find definitions for

the fields and controls later on this page.

Cl-Based Services

Confirm Actions

Actions

Service Status: Senvice does not exist and will be created.

Choose Operation

Cl Name: QE_BUS_EXP Description:
Service: CIRT_CE_BUS_EXP Service Alias:
Inherit All Cl Permissions

Select Action Method Service Operation Inherit Cl Permissions Version

Help

Find First 4/ 10f1 '*/ Last

Message Names and
Descriptions

Create Operation. Update CIRT_QE_BUS_EXP_U_PUTV1 Names and Descriptions
Return to Select Cls
You can work with the following page elements:
Field or Control Description

Service Alias

(Optional.) Enter an alias name for the service. The name
you enter can be lower or mixed-case. If specified, this is
the service name that appears in all WSDL documents you
generate.

Inherit All CI Permissions

Select the check box so that all service operations you create
inherit the security permissions as defined for the component
interface after which they are based. By default the check box
is selected.

To inherit security permissions for specific service operations
only, use the Inherit CI Permission check box in the Choose

Operation grid.

See Inheriting Component Interface Security Permission Lists.

Select

(Optional.) Deselect the check box to omit creating a service
operation for a method.

Alias (Service Operation)

(Optional.) Enter an alias name for the service operation.

The name you enter can be lower or mixed-case. If specified,
this is the service operation name that appears in any WSDL
documents you generate.
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Field or Control

Description

Inherit CI Permissions

Select the check box for a service operation to inherit the
security permissions as defined for the component interface
after which it is based. By default the check box is selected for
all service operations based off of a component interface.

Deselect the check box for each service operation you do not
want to inherit the permissions defined for the component

interface after which it is based.

See Inheriting Component Interface Security Permission Lists.

Version

(Optional.) Service operations created default version V1.

You may enter a different value to use as the version when the
service operation is created.

This field is a text field, so you may enter numeric or text
values.

Message Names and Descriptions

(Optional.) Click the link to specify names and descriptions
for messages in the service operation. The message names
and descriptions will appear in the generated XML message
schema.

If you do not enter message names or descriptions, PeopleSoft
Integration Broker assigns system-generated names to the
messages. The following example shows a sample system-
generated message name: M702221.V1

Perform Selected Action

Click the button to generate REST services and service
operations for the component interface and selected methods.

After the REST service and service operations are created, the
Review Status page displays and you can review the actions
performed as well as access the REST service definition
created.

Return to Select Cls

Click the link to return to the previous page, the Review Status
page.

Inheriting Component Interface Security Permission Lists

386

You can specify that all or select component interface-based service operations inherit the security
permission list(s) of the component interface from which they are derived. This feature allows you to
bypass the process of manually assigning permission lists to the service operations after you generate

them.

The Confirm Actions page (IB_CISERVICES SEC) shown in the previous section contains an Inherit
All CI Permissions check box located on the upper half of the page. The Choose Operation grid of the
page features an Inherit CI Permissions check box for each service operation to be generated.
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Important! Permission lists granted to a component interface after the service operation is created are not
propagated to the service operations and you must manually add them.

Field or Control Description

Inherit All CI Permissions Select the check box for all service operations to inherit the
permission lists of the component interface from which they
are based. By default the check box is selected.

Deselect the check box to choose select service operations

to inherit the permission list(s) of the base component
interface or to manually define permission lists for the service
operations in the PeopleTools Security component.

Inherit CI Permissions Select the check box for each service operation that is to
inherit the permission list(s) of the base component interface.

Deselect the check box for each service operation this is not to
inherit the permission list(s) of the base component.

The system generates service operations for the Update and UpdateData methods based the existence
of the Get method. Therefore, the same permissions granted to a component interface's Get method are
inherited by service operations based on the Update and UpdateData methods

Related Links

Generating REST Services and Service Operations from Component Interface Methods

Setting Permissions to Service Operations

Adding Message Names and Descriptions to Generated Service Operations

The Confirm Actions page features a Message Names and Descriptions link for each service operation.
Click the link to open the Message Names and Descriptions page (IBCISERVICES2 SEC). On the page
you can enter names for each message in the service operations. You can also enter a description for each
message name. The message names and description will appear in the generated XML message schema
for the service operation.
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This example illustrates the Message Names and Descriptions page.

Message Names and Descriptions
Help
Request Message Name:

Request Description:

Response Message Name:

Response Description:

Fault Message Name:

Fault Description;

OK Cancel

In the message name fields, enter a message name. You do not need to append the message name with a

version number. The system automatically creates a version for the message as version one, and appends
the message name with . V1.

When you have completed entering message names and descriptions, click the OK button to return to the
Confirm Actions page.

Viewing Component Interface-Based REST Service Definitions

After you generate REST services and service operations, the Review Status page (IB_SERVICES?2)
appears.

Use the page to review the actions performed.
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This example illustrates the Review Status page.

Cl-Based REST Services

Review Status

Status Find First ‘4" 10of1 '»/ Last

ClName QE_BUS_EXP Description

Service CIRT_QE_BUS_EXP Status Service saved.
View Service Definition
Choose Method

Select Action Method Service Operation Status

Create Operation. Update CIRT_QE_BUS_EXP_U_PUTV1 Operation created.
] Create Operation. Get Does not exist.
0 Create Operation. Find Does not exist.
0 Create Operation. Updatedata Does not exist.
¥ Select All Deselect All

Display Selected Actions Retum to Select Cls

=] Notify

For example, the previous graphic shows the name of one service operation created as well as the service
operation status of Operation created.

From this page you can continue to create additional service operations using the remaining available
methods for the component interface.

Or, you can click the Return to Select ClIs link to return to the Select Component Interfaces page to
select new component interfaces to generate services and service operations.

You can also click the View Service Definition link to view the service definition for the service created.

When you click the View Service Definition link the service you created,
CIRT QF BUS EXP U PUTVI appears in the Services page.
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Services
Service CIRT_QE_BUS_EXP REST Service Type
*Description |(CIRT_QOE_BUS_EXP Is Provider
Comments
Service Alias |CIRT_QE_BUS_EXP
Owner ID -

*Namespace hitp/fxmins.oracle.com/EnterpriseToolsisenices

Link Existing Operations Wiew WADL Provide Web Service

Service Operations
Service Operation |CIRT_QE_BUS_EXP -

REST Method: - Add

Existing Operations Personalize | Find | View All | Ii-?—'l E First ‘4’ 10of1 '*' Last

Operation Message Links | [F=¥

Operation.Default Version Alias Active L IEETT
Type
CIRT_QE_BUS_EXP_U_PUTWV1 CIRT_QE_BUS_EXP_U_PUT Synch ﬂ
Save Return to Search Add

From this page you can perform actions as you would on any other service, including:

*  Click the Provide Web Service link to generate WSDL for the service.

e Use the fields in theService Operations grid to add additional service operations to the service.

»  Click the operation displayed in the Existing Operations grid to generate routing definitions, view

the response, request or fault messages, view handler details, and more.

¢ And soon.

Defining Routing Header Properties for Cl-Based REST Services

For Cl-based REST services, in addition to sending and receiving services in XML format, you can send

and receive the services in JSON format as well.

To define routing header properties for Cl-based REST services, click the operation displayed in the
Existing Operations grid on the Services page, and then access the Header Properties tab from the 1B

Routing Definitions page.
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This example illustrates the Header Properties section on the IB Routing Definitions page.

IB Routing Definitions

Routing Definitions Parameters

Request Headers

Header Properties

Routing Name ~GENERATED~17367744
Personalize | Find | View All | (2] | @ First 4/ 1-20f2 [} Last

Help,

Routing Definitions | Parameters | Header Properties

Property Name Comment
Accept Q |textf:<ml, application/json PRIEIHE
Content-Type Q |textf:<ml, application/json PRIEIHE
Response Headers Personalize | Find | View All | | @ First (4 10of1 (» Last
Property Name Value Comment
Q Q | / &=
Save Return

Related Links

Defining Routing Header Properties for Provider REST Service Operations
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Understanding Service Operation Handlers

Messaging handlers, or handlers are associated with a service operation on the Handlers tab of the Service
Operations page.

Handlers define additional programming to be used with processing the message associated with the
service operation.
Service Operation Handler Types
The following are the different types of handlers:
*  On Notify
*  On Pre-notify
*  OnPost-notify
*  On Receive
* On Request
* On Response
* OnRoute

¢  On Send

Handler Types and Messaging Types

The availability of each handler type depends on the type of service operation you are using. The
following tables list the message types used for each service operation type and the handler types
available for use.

Table 1: Handler Types and Messaging Types

Service Operation
Type

On Notify Handler
Type

On Pre-Notify
Handler Type

On Post-Notify
Handler Type

On Receive Handler
Type

Asynchronous one-way

Request message

Request message

Request message

Request message

Asynchronous request /
response

Request message

NA

NA

Request message
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response

Service Operation On Notify Handler On Pre-Notify On Post-Notify On Receive Handler
Type Type Handler Type Handler Type Type
Asynchronous to Request message NA NA NA
synchronous
Synchronous NA NA NA NA
Table 2: Handler Types and Messaging Types (cont.)
Service Operation On Request Handler | On Response On Route Handler On Send Handler
Type Type Handler Type Type Type
Asynchronous one-way | NA NA Request message Request message
Asynchronous request / | NA Response message *Request message Request message

*Response message

Asynchronous to
synchronous

Request message

Response message

*Request message

*Response message

Request message

Synchronous

Request message

NA

Request message

Request message

Note: For On Route with On Send, the message structure is a request message. For On Route with On
Receive, the message structure is a response message.

The On Response handler type is used to identify the type of On Notify event to be fired. For example,
assume there are four On Notify handlers that are to be fired—three are general On Notify events, that is,
the message is processed as part of the request, and the fourth is a response to the original asynchronous
request. The fourth one is specified with a handler type of On Response, and the application class selected
is the base class OnNotify.

Table 3: Handler Types and Messaging Types (REST service operations).

REST Provider On Request Handler | On Response On Route Handler On Send Handler
HTTP Method Type Handler Type Type Type

Delete NA NA NA NA

Get NA NA NA NA

Head NA NA NA NA

Patch Request message NA NA NA
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REST Provider On Request Handler | On Response On Route Handler On Send Handler
HTTP Method Type Handler Type Type Type

Post Request message NA NA NA

Put Request message NA NA NA

There are no handlers for REST consumer service operations. You may add connector properties to
consumer service operations on the routing definition using the Routings-Connector Properties page or
add them dynamically by using PeopleCode.

See Defining and Overriding Gateway and Connector PropertiesUsing PeopleCode to Manage REST

Service Operations.

Related Links

Adding Handlers to Service Operations

Understanding Implementing Handlers

You can implement handlers using application classes, application engine programs, component
interfaces, data mover scripts or pre-PeopleTools 8.48 integration PeopleCode constructs.

The following tables list the handlers you can implement using application classes, application engine
programs, component interfaces and bulk-load processing.

Note: For REST provider services you may only implement the OnRequest handler using an application

class.
Table 1:
Implementation On Notify Handler | On Pre-notify On Post-notify On Receive Handler
Application class Y Y Y Y
Application Engine Y N N N
Component interface Y N N N
Bulk load Y N N N
Table 2:
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Implementation On Route Handler On Send Handler On Request Handler | On Response
Handler

Application class Y Y Y Y

Application Engine N N N N

Component interface N N Y Y

Bulk load N N N N

In addition to the implementation methods listed in the table, there is also a deprecated PeopleCode
handler (DPC handler) that the system automatically creates for any integration PeopleCode that cannot
be migrated to the PeopleTools 8.48 or higher systems.

The handler implementation methods listed in the tables are discussed in greater detail in subsequent
sections of this topic.

Related Links

Implementing Handlers Using Application Classes

Implementing Handlers Using Application Engine Programs
Implementing Handlers Using Component Interfaces

Implementing Handlers Using Bulk Load Processing
Implementing Handlers Using Deprecated PeopleCode Handlers

Adding Handlers to Service Operations

This section describes how to:
* Add a handler to a service operation.

*  Set handler processing sequence.

Understanding Adding Handler Definitions to Service Operations

396

When you create a handler definition you supply basic information about the handler, then define
information specific to the implementation method for the handler.

You can create and use multiple handlers for a service operation. In addition you can set the sequence in
which the system performs handler processing.

Handler Processing Sequence

The Sequence field enables you to select the order in which PeopleSoft Integration Broker performs
handler processing. A handler with a sequence value of / is processed first, followed by that with a value
of 2, and so on.
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If multiple notification handlers exist and are active, but no sequence is set, the system processes handlers

alphabetically.

If an error occurs in a notification, all subsequent handler processing stops until the error is corrected, the

service operation is resubmitted, and the handler runs successfully.

In an error situation, the Service Operation Monitor shows a status of Error for the handler with the error,

and all remaining handlers to be processed are in a status of New.

Adding a Handler to a Service Operation

To add a handler to a service operation use the Service Operations — Handlers page
(IB_SERVICEHDLR).

This example illustrates the Service Operations — Handlers page.

General Handlers Routings

Service Operation: TEST_SVC_OPERATION
Default Version: Il
Operation Type: Asynchronous - One Way

Customize | Find | View Al| 2] B8 First BN 1.2 o 3 B Last

Sequence | *Implementation *Status

TEST HNDLR_01 On Notify 3 Application Class Details =
TEST_HNDLR_02 On Notify 1 Application Class Details =]
TEST HNDLR_03 On Notify 2 Application Class Details =

To create a handler definition:

1. Access the Service Operations—Handlers page (PeopleTools > Integration Broker > Integration

Setup > Service Operation Definitions and click the Handlers tab).

2. In the Handlers section, enter a handler name in theName field.

Note that for OnRequest, and OnRoute handlers, you need not enter a name. The system adds a

handler name after you provide the handler details.
3. From the Type drop-down list box, select the handler type.
The service operation type determines the handler types that are available to choose.
See Handler Types and Messaging Types.
The valid values are:

4. In the Sequence field, enter a number to specify the order of processing for the handler.

The Sequence field appears only when there are multiple notification handlers defined and active for

the service operation.

5. From the Implementation drop-down list box, select the method to use to implement the handler.
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The handler type determines the available implementation methods.
See Understanding Implementing Handlers.

From the Status drop-down list box, select a status for the handler.
Values are:

*  Active. (Default.) Select to make the handler active.

e [Inactive. Select to make the handler inactive.

7. Click the Save button.

Repeat these steps to add additional handlers to the service operation.

Specifying General Handler Details

398

The details you enter for a handler depend on the implementation method of the handler.

This section describes general handler detail information you must specify for implementing handlers
using application classes and component interfaces.

There are additional details you must define for these implementation methods, as well as for application
engine and data mover script implementation methods. See the sections for each implementation method
for additional information you must specify.

Note: You do not enter handler details for handler implementations using a deprecated PeopleCode
handler.

To add general handler details:

L.

On the Handlers tab of the Service Operations — Handlers tab, in the Handlers section, click the
Details link.

The Action Details page appears.

In the Description field, enter a description for the handler. By default, the system populates this field
with the name of the service operation associated with the handler.

(Optional.) In the Comments field, enter comments about the handler.

(Optional.) In the Handler Owner field, enter the name of the person or group that owns or maintains
the handler.

Related Links

Implementing Handlers Using Application Classes

Implementing Handlers Using Application Engine Programs

Implementing Handlers Using Component Interfaces

Implementing Handlers Using Bulk Load Processing

Implementing Handlers Using Deprecated PeopleCode Handlers
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Implementing Handlers Using Application Classes

This section provides an overview of implementing handlers using application classes and discusses how
to:

» Develop an application class for implementing a handler.

*  Specify application class implementation details.

Understanding Implementing Handlers Using Application Classes

You can specify an application class as a handler for a service operation. This is the most typical
implementation of a handler.

The process for implementing a handler using an application class is:
1. Develop an application class for implementing the handler.
This process is discussed in this section.

See Developing Application Classes for Implementing Handlers.

2. Add a handler to the service operation.
This process is discussed elsewhere in this topic.

See Adding a Handler to a Service Operation.

3. Specify general handler details.
This process is discussed elsewhere in this topic.

See Specifying General Handler Details.

4. Specify application class details for the handler.
This process is discussed in this section.

See Specifying Application Class Implementation Details.

Developing Application Classes for Implementing Handlers

This section discusses how to develop application classes for implementing service operation handlers.

After you create the application package, you must specify the application package, class and method in
the service operation definition as part of the handler details.

Understanding Interfaces and Deriving Application Classes

For each handler type, the following table lists the interface from which to derive the application class.
The interfaces are located in the PS_PT application package:
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Handler Type Application Class Interface
On Notify INotificationHandler

On Post Notify IPrePostNotification

On Pre Notify IPrePostNotification

On Response INotificationHandler

On Receive IReceiver

On Request IRequestHandler

On Send ISend

On Route IRouter

Understanding Input and Output Parameters

For application class handlers, the names that populate the drop-down used for selecting the appropriate
method must have the exact signature required for the method.

Handler Type Input Parameter to Method Method Output Parameter
On Notify Message Void (none)

On Response Message Void (none)

On Receive Message Int

On Request Message Message

On Send Message Message

On Route* Message Integer or Boolean

For the On Route handler type, if you select a method that returns as integer, the handler type is On Route
Send. If you select a method that returns as Boolean, the handler type is On Route Receive.

400
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Developing an Application Class for Implementing a Handler

To develop an application class for implementing a handler:

1.

Select the Integration Broker method that you want to implement based on the type of service
operation you are creating.

Create a new application class, and import the appropriate Integration Broker application class. For
example:

import PS PT:Integration:INotificationHandler;
Define a class that implements the Integration Broker application class.

Define the method that implements the Integration Broker method, with the appropriate signature. In
the following example, the OnNotify method would be available as a handler method.

class RESPONSE NOTIFICATION implements PS PT:Integration:INotificationHandler =

method RESPONSE NOTIFICATION() ;
method OnNotify (&MSG As Message) ;

end-class;

In the definition of the class, create the program-specific code to be used for this handler.

Specifying Application Class Implementation Details

Before specifying application class implementation details for a handler, you must first create the
application class to implement the handler, add a handler to the service operation definition, and specify
general handler details.

To specify application class implementation details:

1.

On the Service Operations — Handlers tab, in the Handlers section, click the Details link.

The Handler Details page appears.

2. Complete the following fields:

Field or Control Description

Package Name Enter the package name that contains the class that you want
to specify, or use the Lookup button to search for and select
one.

Path Enter the name or names of any subpackages that contain
the application class that you want to specity, or use the
Lookup button to search for and select one.
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Field or Control Description

Class ID Enter the name of the application class that contains the
method that you want to specify, or use the Lookup button
to search for and select one.

Only application classes that implement an appropriate base
class are shown. The base class is dependent on the handler

type.

Method From the Method drop-down list box, select the method
from the selected application class that you want to specify.

Only methods with the correct signature for the current
handler type are shown.

3. Click the OK button.

4. Click the Save button.

Implementing Handlers Using Application Engine Programs

This section provides and overview of implementing handlers using application engine programs and
discusses how to:

* Specify application engine implementation details.
* Retrieve service operation content from application engine programs.

*  View subscription contract status.

Understanding Implementing Handlers Using Application Engine Programs

402

Application engine handlers are available for notification events (OnNotify) and schedule an application
engine program to run within PeopleSoft Process Scheduler to process service operation content. This
handler is a good alternative for long-running programs or service operations that have large amounts of
data to process, since processing is performed by PeopleSoft Process Scheduler and not in the PeopleSoft
Integration Broker runtime environment.

After the service operation is invoked, you can track the process by viewing the subscription contract in
the Service Operations Monitor.

When you implement a handler using an application engine program, you must retrieve the transaction
ID that you use to get message data from within the application engine program. The run control record
PSIBRUNCNTL is populated with the transaction ID prior to scheduling the actual application engine
program. Note that it is not required to retrieve the transaction ID, therefore any application engine
program can be scheduled that does not require initialization parameters via a run control table.

The process for implementing a handler using and application engine program is:

1. Develop the application engine program.
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Developing application engine programs is discussed elsewhere in the PeopleTools product
documentation.

See “Application Engine Overview” (Application Engine)
2. Add a handler to the service operation.
This process is discussed elsewhere in this topic.

See Adding a Handler to a Service Operation.

3. Specify general handler details.
This process is discussed elsewhere in this topic.

See Specifying General Handler Details.

4. Specify application engine handler implementation details.

This process is discussed in this section.

See Specifying Application Engine Handler Implementation Details.
5. Retrieve service operation content from the application engine program.

This process is discussed in this section.

See Retrieving Service Operation Content from Application Engine Programs.
6. View subscription contract status.

This process is discussed in this section.

See Viewing Subscription Contract Status.

Specifying Application Engine Handler Implementation Details

Before specifying application engine handler implementation details, you must first create the application
engine program to process the service operation, add a handler to the service operation definition, and
specify general handler details.

To specify application class implementation details:
1. On the Service Operations — Handlers tab, in the Handlers section, click the Details link.
The Action Details page appears.

2. Inthe Program Name field, click the Lookup button to locate the name of the application engine
program to use.

3. Click the OK button.

4. Click the Save button.
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Retrieving Service Operation Content from Application Engine Programs
This section discusses how to:
* Retrieve a transaction ID from an application engine program.

» Instantiate a Message object using a transaction ID.

Understanding Retrieving Service Operation Content from Application Engine
Programs

Within the application engine program, you can retrieve the transaction ID and thereby get an instantiated
Message object to retrieve the content data respectively.

Retrieving Transaction IDs from Application Engine Programs

Use the GetlBTransactionIDforAE method on the %IntBroker object to get the transaction ID or simply
write the SQL to retrieve the ID.

The following examples show how to get the transaction ID from an application engine program and
instantiate a Message object.

Method from %IntBroker Object:

StrTransaction = $IntBroker.GetIBTransactionIDforAE
(string OperID, string Run Control ID);

&MSG = $IntBroker.GetMessage (StrTransaction, %IntBroker SUB);
Or, you can write code within a SQL step similar to the following:

$SelectInit (IBTRANSACTIONID)
SELECT IBTRANSACTIONID
FROM PSIBRUNCNTL
WHERE OPRID = $Bind (OPRID)
AND RUN CNTL ID = $Bind(RUN _CNTL_ ID)

Or, you can perform a simple SQLExec as follows:

SQLExec ("select ibtransactionid from psibruncntl where oprid = :1 and
run_cntl id = :2",

j book aet.oprid, j book aet.run cntl id, &ibtransid);

Instantiating Message Objects Using Transaction IDs

The following code example shows how to instantiate a Message object using the transaction ID from an
application engine program:

&MSG = $IntBroker.GetMessage (J BOOK AET.IBTRANSACTIONID, %IntBroker SUB);

Viewing Subscription Contract Status

The following table lists the possible contract statuses that may display in the Service Operations Monitor
when implementing a handler using an application engine program:
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Service Operations Monitor Status Description

Working At runtime, the Service Operations Monitor shows a status of
Working for the subscription contract when it is picked up by
the subscription contract handler.

Submit After the application engine program is scheduled
successfully, the state of contracts changes to Submit in the
Service Operations Monitor. This status indicates that the
application engine program has been successfully submitted
and a process instance has been returned.

Error »  Ifthe program does not get scheduled successfully, the
status is set to Error

* A Process Monitor status of Error will change the
subscription contract status in the Service Operations
Monitor to Error. You must read the error details from
the Process Monitor Details page, since the Service
Operations Monitor does not have access to the Process
Monitor error tables.

Done When the application engine program has been processed
successfully, the status of the contract in the Service
Operations Monitor is Done.

Cancel *  For application engine programs that have Process
Monitor status of Cancel or Delete, the status of the
subscription contract in the Service Operations Monitor is
changed to Cancel.

+ If'the instance is deleted from the process scheduler table
then the status of the subscription contract is Cancel. This
will clear out the contract in the partitioned queue so that
the next contract in sequence can be processed.

Note: In the Service Operations Monitor the Submit status has the same behavior as the Working status,
thus proper queue partitioning behavior is maintained. Therefore, intelligent queue partitioning should be
taken into account for service operations using the application engine handler.

A Subscription Contract processing an application engine handler cannot be cancelled or resubmitted
from the Service Operations Monitor, but rather must be done in the Process Monitor. Once you resubmit
or cancel the program in the Process Monitor, the status is updated for the subscription contract. Refresh
the Service Operations Monitor page to view the updated status. Note that there could be a delay from
when the time you cancel or resubmit the application engine program in the Process Monitor and when
the update is seen in the Service Operations Monitor. In addition, at least one Pub/Sub domain must be
active for this status update to happen.
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Implementing Handlers Using Component Interfaces

You can implement a component interface as a handler to access extant business rules and processes to be
used with the service operation data.

Understanding Implementing Handlers Using Component Interfaces

This section provides an overview of implementing handlers using component interfaces.
You can only use a component interface for On Notify, On Request and On Response handler types.

Component interfaces can be used as handlers for asynchronous and synchronous service operations.
Asynchronous service operations should only be used with component interface methods that do not
require a response, such as Update or Insert.

You must expose a component interface as a service before you can implement any of the component
interface methods as handler actions.

The standard methods for a component interface (such as Find, Get, Save, Update, and so on) are
automatically available for a handler. However, if you want to use a user-defined method, you must
include the keyword Doc as part of the signature.

The process for implementing a handler using a component interface is:
1. Expose the component interface as a service.

See Selecting Component Interfaces to Expose as Services.

2. Add a handler to the service operation.

See Adding a Handler to a Service Operation.

3. Specify general handler details.

See Specifying General Handler Details.

4. Specify component interface handler implementation details.

See Specifying Component Interface Handler Implementation Details.

Specifying Component Interface Handler Implementation Details

406

Before specifying component interface handler implementation details, you must first create a service
from the component interface, add a handler to the service operation definition, and specify general
handler details.

To specify component interface implementation details:
1. On the Service Operations — Handlers tab, in the Handlers section, click the Details link.

The Action Details page appears.
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2. In the Name field enter the component interface name, or use the Lookup button to search for and
select one.

3. From the Action drop-down list box, select an action.
4. Click the OK button.

5. Click the Save button.

Implementing Handlers Using Bulk Load Processing

This section provides and overview of implementing handlers using the bulk load processing and
discusses how to:

¢ Enable transactional rollback.
* Enable table truncation.
*  Specify XML attributes for nonrowset-based messages.

* Add data structures to nonrowset-based messages.

Understanding Implementing Handlers Using the Bulk Load Handler

You can bulk load large amounts of data (large messages) into a local table using the bulk load handler.

Note: Bulk load handlers are allowed only on asynchronous service operations and only one bulk load
handler is allowed per service operation.

When you implement a handler using a data mover script use the OnNotify event. When the OnNotify
event is fired, the message data is inserted into the tables. Bulk load handlers do not perform any data
validation.

Bulk Load Handler Message Types

You can use bulk load handlers for service operations that contain the following types of asynchronous
messages:

* Rowset-based messages.

For service operations that contain rowset-based messages, the message structure determines
processing.

* Nonrowset-based messages.

For service operations that contain nonrowset-based messages, you define the structure for processing
by mapping data to PeopleSoft records and providing attribute names and values.

* Container messages that contain rowset-based messages parts.

For service operations with container messages that contain rowset-based message parts, the bulk load
handler uses the message structure of the message parts to determine processing.
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Transactional Rollback

Bulk load handler processing is destructive load processing, meaning that the handler deletes existing
data from the table and then bulk inserts the new data.

PeopleSoft Integration Broker provides an optional transaction rollback feature that enables you to
rollback the database to the pre-bulk insert state if needed.

Transactional rollback is dependent on the bulk size of the data to be updated. Therefore, when you select
the rollback option, a Rollback Size field appears where you specify a rollback value. The default value is
32 kilobytes.

Table Truncation
By default, the bulk load handler truncates table data before performing any processing.

PeopleSoft Integration Broker enables you to disable table truncation.

Nonrowset-Based Messages and the Bulk Load Handler

If a service operation contains a nonrowset-based message, you must add a data structure to define the
message content, thereby allowing non-PeopleSoft data to map to the records and fields in the database.

In addition, you can provide an XML attribute name/value pair to distinguish record and field nodes on
incoming XML content.

Process Overview for Implementing Handlers Using Bulk Load Handlers
The process for implementing a bulk load handler is:
1. Add a bulk load handler to the service operation on the target system.

This procedure is discussed elsewhere in this topic.

See Adding a Handler to a Service Operation.

2. Specify general handler details.
This procedure is discussed elsewhere in this topic.

See Specifying General Handler Details.

3. (Optional.) Enable transactional rollback and the rollback size.
This procedure is discussed in this section.
4. (Optional.) Specify XML record attributes.
This procedure is discussed in this section.
5. Add the data structure for the message contained in the service operation.
The step is required only when a nonrowset-based message is contained in the service operation.

This procedure is discussed in this section.
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Enabling Transactional Rollback

The Bulk Load Handler page (IB_SERVICEHDLS5_ SEC) features a Rollback Non-Destructive Load
option that you can set to enable transaction rollback.

This example illustrates the Bulk Load Handler page. The example shows the page when the service
operation contains a nonrowset-based message.

Bulk Load Handler

[l Rollback Hon-Destructive Load
Truncate Table(s)

XML Record Indicator Attribute

Attribute Name:

Attribute Value:

Add Record to Root
Left | Right

[= Data Structure

The previous example shows the Bulk Load Handler page that displays when the service operation
contains a nonrowset-based message.

If the service operation contains a rowset-based message, the page does not display the XML attribute
fields or the data tree structure controls.

This example illustrates the Bulk Load Handler page. The example shows the page when the service
operation contains a rowset-based message.

Bulk Load Handler

] Roliback Non-Destructive Load
Truncate Table(s)

Note: Transactional rollback is not supported if message segments are used. Transactional rollback will
automatically be disabled if the message being processed contains more then one message segment.

To enable rollback processing:

1. On the Service Operations — Handlers tab, in the Handlers section, click the Details link.
The Bulk Load Handler page appears.

2. Select the Rollback Non-Destructive Load check box.

The Rollback Size field appears.
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3. Inthe Rollback Size field, enter a rollback size value, in kilobytes.
The amount of data that you can rollback is depends on your database.

The default is 32.

Warning! Before you specify a rollback size value, verify the rollback size configured for your
database. If the rollback size value specified in the PeopleSoft Pure Internet Architecture is greater
then the transactional rollback size configured on the database, then transactional rollback will be
disabled for that particular transaction, thereby causing destructive load processing to take place. To
avoid destructive load processing, modify the rollback size configured for your database so that it is
greater than the value you specify on the Bulk Load Handler page.

4. Click the Save button.

Enabling Table Truncation

The Bulk Load Handler page features a Truncate Table(s) option that you can set so that the system
truncates the database table(s) prior to handler processing. The option is located under the Non-
Destructive Load option on the Bulk Load Handler page.

By default, the Truncate Table(s) option is enabled and the PeopleSoft system performs table truncation.
However, if you do not wish to perform table truncation you can deselect the option to disable table
truncation.

To enable/disable table truncation:

1. Access the Bulk Load Handler page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions and click the Handlers tab. Click the Details link for the
bulk load handler).

2. On the Truncate Table(s) check box perform one of the following options:
e To enable table truncation, select the check box.

e To disable table truncation, deselect the check box.
3. Click the OK button.

Specifying XML Record Attribute Values

Use the XML Record Indicator Attribute check box on the Bulk Load Handler page to distinguish and
specify records and fields on incoming XML content of nonrowset-based messages.
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This example illustrates a partial view of the Bulk Load Handler page. The example shows the XML
Record Indicator Attribute section of the page that you use to specify an attribute name and value for
nonrowset-based messages.

XML Record Indicator Attribute

Attribute Name:

Attribute Value:

When you specify an attribute name and value, the system recognizes content with that name and value as
a record. Content placed in the message after that attribute name/value pair is considered child data.

When the service operation contains a nonrowset-based message, you must specify an attribute name and
attribute value. If you do not supply values for these fields, an error message appears. These fields are
optional when the service operation contains a rowset-based message.

To specify XML record attribute values:

1. Access the Bulk Load Handler page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions and click the Handlers tab. Click the Details link for the
bulk load handler).

2. In the Attribute Name ficld, enter the attribute name that the system should recognize as the record.
For example, Class.

3. In the Attribute Value ficld, enter the value for the attribute name.
For example, R.

4. Click the Save button.

Adding Data Structures for Nonrowset-Based Messages
This section discusses how to:
¢ Build data structures for nonrowset-based data structures.

» Insert nonrowset-based messages in project definitions.

Building Nonrowset-Based Data Structures

The Bulk Load Handler details page provides a data tree, similar to that found in the Messages
component, that you use to build the structure of the nonrowset-based message.

You must define a minimum of one record to save the handler definition.

For building the data structure you use the same graphical user interface and procedures that you would
for managing rowset-based messages in the Messages component.

By clicking the Add Record to Root link you can begin to create the data structure by adding a root
record. As with the Messages component, you can select to include or exclude fields and specify field
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aliases. One unique difference here, however, is that you can build structures with multiple level 0
records. At save time, the system builds a message for each level 0 record found in the structure.

Note that message references are not allowed.

Message structures you create on the Bulk Load Handler details page are not accessible in the Messages
component and appear only as part of the bulk load handler.

The message names start with ~/[B M DMS~.

See the documentation elsewhere in the product documentation for managing rowset-based messages for
creating the data structure. Again, even though here you are building the structure of a nonrowset-based
message, you will use the same graphical user interface and procedures as those for working with rowset-
based messages.

See Managing Rowset-Based Messages.

Inserting Nonrowset—Based Messages in Project Definitions

You must assign nonrowset-based messages you create using the Bulk Load Handler page to a bulk load
handler. To accomplish this task, in PeopleSoft Application Designer when you insert a service operation
handler definition into a project, you must include the message(s) as a related definition.

This example illustrates the Insert into Project page.

Insert into Project _ |

X

Drefinition Type: |Service Operation Handlers j [nzert
Selection Criteria Related Definitions Close

Marne: |

Mew Search

Select Al

Definitionz matching zelection critena:

) R

Service Operation Mames | Semvice Dperation Handler Mames
[E_FLIGHTPLAM GEM_UPG_HAMDLER_21703
[E_FLIGHTPLAM_ASYMNCCOMEBO GEM_UPG_HaMDLER_11824
LE_FLIGHTPLAM_&ASYWNCCOMEBO GEM_UPG_HaMDLER_13763
QE_FLIGHTPLAM_ASYMCCOMED GEM_UPG_HaMDLER_15912
[E_FLIGHTPLAM_SYMC REQUESTHDLR
[E_FLIGHTPLAM_SYMWCCOMEBO REQUESTHDLR
LE_FLIGHTPLAM_TRAMSFORM GEM_UPG_HaMDLER_1E373
[E_FLIGHTPLAM_TRAMSFORM GEM_UPG_HAMDLER_22671
LE_FLIGHTPLAM_INSTRUCT BULK_LOAD_TEST
LE_FLIGHTPLAM_UNSTRUCT GEM_UPG_HaMDLER_13639
QOE FLIGHTPL&M UMNSTRUCT GEM UPG HaMDLER 24068 b

236 definitionz] found

To insert a service operation handler definition and related message definitions into a project:

1. In PeopleSoft Application Designer, from the Insert menu, select Definitions info Project.
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The Insert into Project page appears.
2. From the Definition Type drop-down list box, select Service Operation Handlers.
3. Click Insert to view all service operation definitions and handlers in the system.
4. Click the name of the service operation and handler to insert into the project.
5. In the Related Definition section, click Messages.

6. Click the Insert button to insert the service operation, handler, and related messages into the project.

Implementing Handlers Using Deprecated PeopleCode Handlers

This section discusses the deprecated PeopleCode handler and using the Service Administration —
Deprecated PeopleCode page to delete deprecated PeopleCode handlers.

Understanding the Deprecated PeopleCode Handler

During the upgrade process, the PeopleSoft system creates a deprecated PeopleCode handler (DPC
handler) for any integration PeopleCode that cannot be migrated from a PeopleTools 8.47 or earlier
system to a PeopleTools 8.55 system. Deprecated handlers enable you to run PeopleTools 8.47 and
earlier PeopleCode (subscription or OnRequest). However, PeopleSoft recommends that you correct the
PeopleCode and migrate the code into an Application Class type handler for use in PeopleTools 8.55
systems.

Deleting Deprecated PeopleCode Handlers

Use the Service Administration — Deprecated PeopleCode page (IB_ HOME PAGES) to delete deprecated
PeopleCode and its associated handler(s).

To access the page select PeopleTools > Integration Broker > Service Utilities > Integration
Broker Admin and click the Deprecated PeopleCode tab.

This example illustrates the Service Administration — Deprecated PeopleCode page.

R ous | I 1

Service System Status:  Development

Note: Deleted Deprecated PeopleCode can not be recreated. Deletion occurs at the Service Operation level. If a Service Operation contains multiple deprecated PeopleCode
items, deleting one of the items causes the deletion of all of them.
~ Delete

Service Operation: Q

Search

Deprecated PeopleCode Handlers personalize | Find | View AL B | 88 Firet B 4 op B Lot

Select Service Operation Handler Hame Handler Alias Resulis

Delete

The page enables you to delete the PeopleCode that was assigned to the Pre-PeopleTools 8.48
subscription, along with the (deprecated) handler that was created to invoke the PeopleCode.
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Warning! Deleted deprecated PeopleCode cannot be recreated.

To delete a deprecated PeopleCode handler:

1. Access the Service Administration — Deprecated PeopleCode page (PeopleTools > Integration
Broker > Service Utilities > Integration Broker Admin and click the Deprecated PeopleCode
tab).

2. Inthe Service Operation ficld, enter the name of the service operation that contains the deprecated
PeopleCode handler, or click the Lookup button to search for one.

3. Click the Search button.
The search results appear in the Deprecated PeopleCode Handler grid.
4. Select the Select check box next to the handler to delete.

5. Click the Delete button.
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Managing Service Operation Routing
Definitions

Understanding Routing Definitions

This section provides overview information about routing definitions.

Routing Definitions

A routing definition defines the sending and receiving nodes for a transaction, specifies any inbound
and outbound transformations to invoke and defines external aliases. It also defines overrides that the
default integration gateway and the default target connector that the local node use to communicate with
an integration endpoint.

Routing Types

There are four routing types:

Term Definition

Any-to-local An any-to-local routing enables the local node to receive
transactions from any node.

This routing type is for inbound transactions only and the
“any” node is always the sending node.

You can use this routing type for all service operation types,
except for asynchronous-to-synchronous service operations.

Local-to-local A local-to-local routing is a routing in which transactions are
sent and received within the local database.

When working with synchronous service operations, you
have the option to generate transactional routings, whereby
the OnRequest event will run under the existing transaction
boundary of the component.

Local-to-Atom A local-to-Atom routing is used exclusively with feeds
functionality.

See Feed Publishing Framework.

Point-to-point A point-to-point routing requires that specific nodes that you
define send and receive a transaction.
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Defining Routing Definitions

A routing definition must exist on each system that is participating in a particular transaction.

For example, let's say that System A is going to send a service operation to System B and a point-to-point
routing needs to be created between the two systems. Further, the local node on System A is called Node
A, and the local node on System B is called Node B.

System A and System B need to have the identical service operation defined on each of their systems.

In addition, System A needs to have an outbound routing definition defined on its system that specifies its
local node, Node A, as the sending node. The routing definition must specify System B's local node, Node
B, as the receiving node.

System B needs to have an inbound routing definition defined on its system that specifies its local node,
Node B, as the receiving node. The routing definition on System B also needs to specify System A's local
node, Node A, as the sending node.

The exception to this is when a receiving system generates an any-to-local routing for a service operation.
If the receiving system has an any-to-local routing definition defined for a particular service operation, it
will accept requests from any node without the need of a specific point-to-point routing definition.

So using the examples of System A being the sending system and System B being the receiving system,
this is what happens when an any-to-local routing is defined. System A still needs to have a routing
definition defined on its system where its local node, Node 4, is defined as the sending node, and
System's B local node, Node B, is defined as the receiving node. On System B, when the any-to-local
routing was generated, the PeopleSoft system automatically populated System B's local node, Node B,
as the receiving node and listed the value of ~4ny~ as the sending node to designate that the system will
accept the service operation specified on the routing from any node.

Methods for Generating and Defining Routing Definitions
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This section discusses methods of generating and defining routing definitions.

System-Generated Routing Definitions During Upgrade

If upgrading from a PeopleTools 8.47 or earlier release, during the upgrade process the PeopleSoft system
creates routing definitions from node transaction and relationship data defined in your earlier PeopleTools
8.4x release.

System-Generated Routing Definitions During Consuming Services

When you consume a service using the Consume Web Service wizard, the system creates PeopleSoft
integration metadata for the imported service, including routing definitions.

System-Generated Routing Definitions at Runtime

The PeopleSoft system can generate any-to-local and local-to-local routing definition for you. The system
takes integration metadata from the service operation, including service operation name, service operation
version, service operation type, local node information, and other data, and generates a routing definition.

If you make any subsequent modifications to the service operation, you can regenerate the routing
definition to reflect the changes. In addition, at any point you can open the definition and manually
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modify it to include transformations, as well as override default integration gateway and target connector
settings.

You use the Service Operations-General page to generate any-to-local and local-to-local routing
definitions.

You may also manually create local-to-local routing definitions. However, you must always system-
generate any-to-local routing definition.

See Managing System-Generated Routing Definitions.

User-Defined Routing Definitions

When you require a point-to-point routing, you must manually create it. You can also manually create
local-to-local routing definitions.

However, you must always system generate any-to-local routing definitions.

To create user-defined routing definitions, use the Routings component or the Service Operations-
Routings page.

See Adding Routing Definitions.

Summary of Methods for Creating and Generating Routing Definitions

The following table summarizes the method for generating and defining routing definitions:

Routing Type System-Generated User-Defined
Any-to-local Yes No
Local-to-local Yes Yes
Point-to-point No Yes

Routing Definition Naming Conventions

The following table lists the naming conventions for routing definitions:

Method for Generating and Convention Description
Creating Routing Definitions

System-generated during upgrade. ~GEN_UPG~<unique number> Routing definitions generated during the
upgrade process. These may be any-to-
For example: ~GEN_UPG~10062 local, local-to-local, or point-to-point

routing definitions.
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Method for Generating and Convention Description
Creating Routing Definitions

System-generated at runtime. ~GENERATED~<unique number> Routing definitions generated by the
PeopleSoft system from the Service
For example: ~GENERATED~15312 Operations-General tab. These routing
definitions are any-to-local or local-to-

local.
System generated by the Consume Web | ~IMPORTED~<unique number> Routing definitions generated using the
Service wizard. Consume Web Service wizard.
For example:~/MPORTED~14857
User-defined. Up to 30 characters, no spaces. Manually created point-to-point routing
definitions and local-to-local routings.
For example: OE ROUTING. You can also rename system-generated

routing definitions using the Service
No special characters, such as dots (“.”) | Administration component.

and slashes (“/” or “\”), are permitted.

Routing Definition External Aliases

When working with routing definitions you have the option of creating a routing alias. This alias is used
as a SOAPAction attribute in the WSDL binding to identify the service operation in the Integration Broker
metadata.

The routing external alias defaults to <ServiceOperationAlias>.<Version>, if present. Otherwise it
defaults to <ServiceOperation>.<Version>.

In an asynchronous request/response any-to-local routing, the outbound routing alias format is <Alias
Name> CALLBACK.<Version>.

For inbound transactions you can fire multiple service operations for one invocation when external aliases
on the routing definition are the same for each service operation. This is called service operation mapping.

Related Links

Searching for Duplicate External Routing Aliases

Service Operation Mapping

Service Operation Mapping

418

You can map inbound asynchronous transactions to one or more service operations by specifying the
name of the inbound transaction as the external alias on the routing for each service operation that you
want to invoke.

Note: Service operation mapping is supported for inbound asynchronous transactions only.

For example, there is an inbound asynchronous transaction from SAP called Customer SAP. However,
the service operation contained in that transaction maps to two service operations on the PeopleSoft
system, Customer_Get and Customer Update. To invoke both service operations, change the external
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alias name on the inbound routing definition for the Customer Get and Customer Update service
operations to Customer_SAP. When the routings are determined at runtime for this external service
operation name, PeopleSoft Integration Broker will find both service operations (Customer Get and
Customer_Update) and process them accordingly.

Graphical Routings View

The Routing Definitions page provides a Graphical View link that enables you to view routing
definitions in graphical format. The graphical routings view is intended to provide you with a view of the
flow of data between integration partners.

Related Links

Viewing Routing Definitions in Graphical Format

Integration Status

When you use the Graphical View link to view a routing definition in graphical format, an Integration
Not Active link displays if any metadata associated with the integration is inactive. Inactive metadata
might include the routing definition, the service operation, a service operation handler, and so on.

If you click the Integration Not Active link an Integration Status page appears and you can view activate
the metadata.

Managing System-Generated Routing Definitions

This section discusses how to:
* View system-generated routing definition status.
» Initiate system-generated routing definitions.

* Regenerate system-generated routing definitions.

Understanding Managing System-Generated Routing Definitions

The PeopleSoft system can automatically generate any-to-local and local-to-local routing definitions
when you save a service operation definition.

After the system generates the routing definition, you can view and fine-tune the definition as needed
using the pages in the Routings component.

In addition, if you make any changes to a service operation after the system has generated a routing
definition for it, you can have the system regenerate a routing definition. However, any modifications
made to the routing definition are lost when you regenerate it.
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Viewing System-Generated Routing Definition Status

The Service Operations — General page (IB_SERVICE) features a Routing Status check box that you can
use to verify if any system-generated routing definitions exist for a service operation. To access the page
select PeopleTools > Integration Broker > Integration Setup > Service Operation Definitions.

This example illustrates the Routing Status group box on the Service Operations — General page.

Routing Status

Any-to-Local: Coes not exist
Local-to-Local: Coes not exist
Local-to-Atom: Does not exist.

When an any-to-local, local-to-local, or local-to Atom routing definition exists for the service operation,
the corresponding field displays a status of Exists. When no routing definition exists, the corresponding
field displays Does not exist.

Note: The system generates a Local-to-Atom routing definition when you publish a service operation as a
feed. Using and managing feeds is described elsewhere in the product documentation.

See the product documentation for Feed Publishing Framework.

Initiating System-Generated Routing Definitions

420

The Default Service Operation Version section of the Service Operations-General page features a Routing
Actions Upon Save group box where you can choose the type of routing to generate, any-to-local or local-
to-local.

To access the Service Operations-General page select PeopleTools > Integration Broker >
Integration Setup > Service Operation Definitions.

This example illustrates the Routings Actions Upon Save group box that appears on the Service
Operations — General page when you are working with an asynchronous service operation definition.

Routing Actions Upon Save

[ Generate Any-to-Local
[ ] Generate Local-to-Local

The previous example shows the Routing Actions Upon Save group box that appears when you are
working with an asynchronous service operation definition. When you are working with a synchronous
service operation definition, the group box features an additional control.
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This example illustrates the Routings Actions Upon Save group box that appears on the Service
Operations — General page when you are working with a synchronous service operation definition.

Routing Actions Upon Save

[ | Generate Any-to-Local
[ Generate Local-to-Local

Transactional

When you select Generate Local-to-Local, the Transactional check box becomes available for
selection. By choosing the Transactional check box, the system routes the service operations using the
OnRequest event on a single transaction.

When you initiate system-generated any-to-local or local-to-local routings, PeopleSoft Integration Broker
checks to see if the routing you are initiating is already in the system. This situation can arise when any-
to-local and local-to-local routings are created in another database and are imported into the current
database. If the routing already exists in the current database, a message appears indicating so and no new
routing is generated. You must remove the routing before generating a new one.

See Deleting Duplicate Routing Definitions.

Note: Any-to-Local routing definitions are read-only, with the exception of the external alias name and
transform information. You may need to change the external alias name for WSDL generation.

To initiate a system-generated routing definition:
1. From the Service Operations-General page, locate the Default Service Operation Version section.
2. In the Routing Actions Upon Save group box select one of the following options:

*  Generate Any-to-Local. Generates an any-to-local routing definition when you save the service
operation record.

*  Generate Local-to-Local. Generates a local-to-local routing definition when you save the service
operation.

If working with a synchronous service operation, click the Transactional check box if you want
to generate a transactional local-to-local routing.

3. Click the Save button.

When you save the service operation the system generates the routing definition that you selected.

After you save the service operation definition the Routing Status group box displays a status of Exists for
the routing definition generated.

To view the routing definition , click the Service Operations — Routings tab and click the name of the
routing. The Routing Definitions page appears and you can view and modify routing definition details.

Related Links
Routing Definition Naming Conventions
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Defining General Routing Information
Defining Routing Parameters
Defining and Overriding Gateway and Connector Properties

Regenerating System-Generated Routing Definitions

If a system-generated routing exists for a service operation and you change some aspect of the service
operation, you can have the system regenerate the routing definition. However, any modifications made to
the routing definition are lost when you regenerate it.

To initiate the regeneration of a routing definition, use the Routing Actions Upon Save box on the
Service Operations-General page to regenerate the routing. To access this page select PeopleTools >
Integration Broker > Integration Setup > Service Operation Definitions.

To regenerate a system-generated routing definition:

1. Access the Service Operations-General page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions).

2. On the page, locate the Default Service Operation Version section.
3. In the Routing Actions Upon Save group box select one of the following options:

*  Regenerate Any-to-Local. Regenerates an any-to-local routing definition when you save the
service operation definition.

*  Regenerate Local-to-Local. Regenerates a local-to-local routing definition when you save the
service operation.
4. Click the Save button.
When you save the service operation the system regenerates the routing definition that you selected.

After you save the service operation record the Routing Status group box displays a status of Exists for
the routing definition generated.

Adding Routing Definitions

422

This section discusses how to:

* Add a routing definition.

* Define general routing definition information.

* Define routing parameters for requests and responses.
* Define routing properties.

* Define and override gateway and connector properties.
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Understanding Adding Routing Definitions

Managing Service Operation Routing Definitions

The following table describes the locations within the PeopleSoft system where you can add routing

definitions:
Page Page Object ID Component Component Object | Navigation
ID
Routings Definition IB_ROUTINGDEFN | Routings IB_ROUTINGDEFN PeopleTools

> Integration
Broker > Integration
Setup > Routing
Definitions.

Service Operations -
Routings

IB_SERVICERTNGS

Service Operations

IB_SERVICE

PeopleTools

> Integration
Broker > Integration
Setup > Service
Operation Definitions
and click the Routings
tab.

Node - Routings

IB_NODEROUTINGS

Nodes

IB_NODE

PeopleTools

> Integration
Broker > Integration
Setup > Node
Definitions and click
the Routings tab.

Note: When using the RSS feeds functionality you may need to create a routing definition for a non-
default service operation version. The only location that you can add a routing definition for a non-default
service operation version is in the Routings component.

Note: You cannot add routings to the system for REST-based services. You can only use system
generated routings (any-to-local or local-to-local) for REST-based services.

Adding Routing Definitions Using the Routings Component

This section describes adding routing definitions using the Routings component (IB_ ROUTINGDEFN).

To add a routing definition using the Routings component you first add the definition to the system and
then configure the routing.

Use the Routing Definitions — Add a New Value page to add the definition to the system. To access the
page select PeopleTools > Integration Broker > Integration Setup > Routing Definitions and click
the Add a New Value tab.
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This example illustrates the Routing Definitions — Add a New Value page.

Routing Definitions

Eind an Existing Value Add a New Value

Routing Hame:|

Add

To add a routing record using the Routings component:

1. Select PeopleTools > Integration Broker > Integration Setup > Routing Definitions.
2. Click the Add a Value tab.

3. In the Routing Name field, enter a name for the routing definition.

4. Click the Add button.

The routing definition is added to the system and the Routing Definitions page appears where you can
define the routing details.

See Defining General Routing Information.

Adding Routing Definitions From Service Operation Definitions

424

When working in a service operation definition, you can use the Service Operations — Routings page
(IB_SERVICERTNGS) to add a routing definition to the service operation. To access the Service
Operations — Routing page select PeopleTools > Integration Broker > Integration Setup > Routing
Definitions and click the Routings tab.

This example illustrates the Service Operations — Routings page.

General Handlers Routings

Service Operation: QE_FLIGHTPLAN_SYNC
Default Version: VERSION_1
[Juser Exception

Hote: This user exception status is applicable only if an outbound routing cannot be determined. If a valid outbound routing can be determined then the user exception
status on the actual routing will be used.

Routing Name: | Add

Routing Definitions Customize | Find | View Al

Selected Hame Version Operation Type |Sender Node Receiver Node |Direction

] ~GEN~UPG~20198 VERSION_1 Synch QE_LOCAL QE_IBTGT Outbound Active [=]
Inactivate Selected Routings | Activate Selected Routings |

When you are adding a routing definition for a synchronous service operation, the system displays a User
Exception check box at the top of the page. Select the check box to capture any exceptions that occur
before the system validates an outbound routing for the service operation. This option enables you to
capture errors such as inactive routing definitions, multiple routing definitions, any errors that result from
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running the OnRouteSend PeopleCode event, and other initialization errors. When the User Exception
option is enabled and if an exception does occur before a routing can be validated, the system returns a
response message to the integration partner that contains the exception.

To add a routing definition from a service operation definition:

1. Access the Service Operations - Routings page (PeopleTools > Integration Broker > Integration
Setup > Service Operation Definitions and click the Routings tab).

2. (Optional.) Select the User Exception check box to capture exceptions before routing validation.
3. In the Routing Name field, enter a name for the routing definition.
4. Click the Add button.

The routing definition is added to the system and the Routing Definitions page appears where you can
define the routing details.

See Defining General Routing Information.

Adding Routing Definitions Using the Nodes Component
This section describes adding routing definitions using the Nodes component (IB_ NODEROUTINGS).

To add a routing definition using the Nodes component you first add the definition to the system and then
configure the routing.

Use the Nodes — Routings page to add the definition to the system. To access the page select
PeopleTools > Integration Broker > Integration Setup > Node Definitions and click the Routings
tab.

This example illustrates the Nodes — Routings page.

Mode Definitions Connectors Portal WS Security Routings

Node Name: TEST_NODE

Routing Name: [ Add

Routing Definitions Customize | Find | View Al | E\ # First n 10f1 n Last

Selected Hame |Service Operation :: '::ci:‘ fation Operation Type |Sender Node Receiver Hode  |Direction Status Resulis r

To add a routing definition from the Nodes-Routings page:

1. Access the Nodes-Routings page (PeopleTools > Integration Broker > Integration
Setup > Node Definitions and click the Routings tab).

2. In the Routing Name field, enter a name for the routing definition.
3. Click the Add button.

The routing definition is added to the system and the Routing Definitions page appears where you can
define the routing details.

See Defining General Routing Information.
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Configuring Routing Definitions

Defining General Routing Information

426

This section discusses how to:

* Define general routing information.

*  Define routing parameters.

* Define and override gateway and connector properties.

*  Define routing properties.

After you add a routing definition to the system use the pages of the Routing component to define the
routing details. Use the Routings — Routing Definitions page to define general routing information.

This example illustrates the fields and controls on the Routings — Routing Definitions page when you are
working with a synchronous service operation. You can find definitions for the fields and controls later on

this page.

Routing Definitions ||

Routing Name:

*Service Operation:
Version:
*Description:

Comments:;

*Sender Node:
*Receiver Node:
Operation Type:

Object Owner ID:
*Log Detail:
OnSend Handler:

QE_PO_SYMC

QE_PO_SYNC

Synchranous

Header and Detail

Active
System Generated

Graphical View

User Exception

Q

The fields that appear on the Routing—Routing Definitions page vary based on if you are defining a
routing for a synchronous service operation or an asynchronous service operations.

The various ways to access this page are discussed in the previous section.

See Understanding Adding Routing Definitions.
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When you add a routing definition from a service operation record, the PeopleSoft system automatically
populates some of the data on this page based on the data in the service operations record from which
you created the routing. Automatically populated data includes the service operation name, version, and

routing type.

Field or Control

Description

Routing Name

Indicates the name of the routing definition. This name is
specified when you add a routing definition to the system.

Service Operation

Enter the name of the service operation that will use the
routing.

If you access the Routings component from the Service
Operations — Routings tab, PeopleSoft Integration Broker
automatically populates this information.

Active

(Optional.) Select the check box to activate the routing.
By default, new routing definition are active.

If any of the referenced nodes are inactive, you cannot activate
the routing.

System Generated

When selected, indicates that the PeopleSoft system generated
the routing definition.

Version Indicates the version of the service operation selected.
Description Description of the routing definition. If you do not enter a
description, this value defaults to the name of the service
operation associated with the routing definition upon save.
Graphical View Click this link to view saved routing definitions in graphical
format.
See Viewing Routing Definitions in Graphical Format.
Comments (Optional.) Enter comments about the routing definition.
Sender Node Enter the name of the sending node.

Receiving Node

Enter the name of the receiving node.
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Field or Control

Description

Unordered Segments

(Optional.) Select the check box to indicate that system should
process the service operation messages in parallel.

The Unordered Segments check box appears only under the
following conditions:

*  The local node is the receiving node.
*  After you save the initial routing definition
This feature is frequently used in conjunction with the

OnPreNotify Handler and OnPostNotify Handler fields to
perform pre- or post-processing on segmented messages.

Operation Type

Indicates the service operation type. PeopleSoft Integration
Broker automatically populates this information when you
select the service operation.

User Exception

The User Exception check box displays only for synchronous
service operations.

(Optional.) Select the check box to enable exception handling
using PeopleCode.

When enabled and an error occurs you can handle any errors
in the calling PeopleCode.

If not enabled any errors that occur cause the program to stop.

Object Owner ID

(Optional.) From the drop-down list box, select the owner of
the definition.

The owner ID helps to determine the application team that last
made a change to the definition. The values in the drop-down
list box are translate table values that you can define in the
OBJECTOWNERID field record.

OnPreNotify Handler

(Optional.) From the drop-down list box, select an
OnPreNotify handler to perform pre-processing on segmented
messages being processed in parallel by the system.

This page control appears only when the Unordered
Segments check box is selected.

OnPostNotify Handler

(Optional.) From the drop-down list box, select an
OnPostNotify handler to perform post-processing on
segmented messages being processed in parallel by the system.

This page control appears only when the Unordered
Segments check box is selected.
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Field or Control

Description

Accept Compression

(Optional.) The Accept Compression check box displays only
for inbound synchronous non-REST service operations.

Setting compression for REST service operations is discussed
elsewhere in the product documentation.

See Setting Compression for REST Service Operations.

Select the check box for the system to send the response to the
consumer compressed.

You must compress the response before sending, using
PeopleCode or by setting the Min Message Size Compression
parameter in PSAdmin.

You can override the compression of the response using
PeopleCode by setting the CompressionOverride property on
IBInfo. The following example shows sample PeopleCode to
override compression of the response message:

&MSG.IBInfo.CompressionOverride = $IntBr=

oker Compress;
Set/Get property for Compression overrid=

e. Valid parms : %IntBroker Compress, %>
IntBroker UnCompress, %IntBroker Compres=

s_Reset
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Field or Control

Description

Log Detail

The Log Detail drop-down list box displays only for
synchronous service operations.

This option enables you to set the level of information logging
for synchronous messages that is viewable in the Service
Operations Monitor.

The valid values are:
*  Header.

Log header information only. With this option, you can
view synchronous message header information in the
Service Operations Monitor.

*  Header and Detail. Log header and message detail
information. With this option, you can view synchronous
message header information and XML message content
on in the Service Operations Monitor.

When you select this option for a consumer REST service
operation routing, a Service Operation Security link
appears and you can add permissions to the service
operation. Doing so enables access to service operation
details in the Service Operations Monitor.

*  No Logging. (Default.) Turn off all logging. No
information is available to view in the Service Operations
Monitor.

Service Operation Security

A Service Operation Security link appears when the selected
routing definition is for an outbound REST-based service
operation

Click the link to access the Web Service Access page and to
add permissions to the view details for the service operation in
the Service Operations Monitor.

OnSend Handler

This field displays when an OnSend handler is defined for the
service operation and the sending node is the local node. It
also displays when the system is serving as a hub, and neither
the sender nor receiver are local.

Select a handler from the list. This handler runs when a
message is sent or received to perform processing logic.

Schema Validation Details

This field displays only when working with any-to-local
routing definitions.

(Optional.) When this check box is selected and a schema
validation error occurs the raw schema parser errors are
returned to the consumer within the default message CDATA
tag. If the check box is not selected (Default) then if a schema
validation error occurs the systems uses the standard message
set/ ID framework to generate the error.
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Field or Control Description

OnReceive Handler This field displays when an OnReceive handler is defined
for the service operation and one of the following conditions
exists:

*  The sending node is the local node, or

»  The service operation type is asynchronous request/
response where the sender is not local and the receiver is
local, or.

*  The system is serving as a hub, and neither the sender
(initiator) nor final receiver are local.

Select a handler from the list. This handler runs when a
message is sent or received to perform processing logic.

Use Secure Target Location This check box appears only when you are working with an
outbound asynchronous request/response service operation.

Select the check box to use the secure target location as the
endpoint for the response. If the check box is not selected, the
(unsecured) target location is used.

Defining Routing Parameters

This section provides an overview of defining transformations for any-to-local routing definitions and
discusses how to define general routing parameters.

Understanding Routing Parameters for Requests and Responses

A routing definition contains routing parameters for each inbound request, inbound response, outbound
request and outbound response associated with a service operation. The routing parameters that you
can define include for each request or response include, routing alias, message names before and after
transformation, and transformation program names.

You define routing parameters using the Routings — Parameters page in the Routings component.

The following tables list the number of routing parameters a routing definition contains based on the
service operation type and whether the sending and receiving nodes are local.

Note: Parameters for routing definitions for REST service operations are not included in the following
tables, since they are system generated.

Asynchronous service operations have the following routing parameters:

Copyright © 1988, 2023, Oracle and/or its affiliates. 431



Managing Service Operation Routing Definitions

Chapter 18

Service Sender is Receiver is Inbound Outbound Inbound Outbound
Operation Local Local Request Request Response Response
Type Routing Routing Routing Routing
Asynchronous | Y Y N Y N N

One- Way

Asynchronous |Y N N Y N N

One- Way

Asynchronous | N Y Y N N N

One- Way

Asynchronous | N N Y Y N N

One- Way
Synchronous service operations have the following routing parameters:

Service Sender is Receiver is Inbound Outbound Inbound Outbound
Operation Local Local Request Request Response Response
Type Routing Routing Routing Routing
Synchronous Y Y Y Y Y Y
Synchronous Y N N Y Y N
Synchronous N Y Y N N Y
Synchronous N N Y Y Y Y

Asynchronous-to-synchronous service operations may have the following routing parameters:

to-synchronous

Service Sender is Receiver is Inbound Outbound Inbound Outbound
Operation Local Local Request Request Response Response
Type Routing Routing Routing Routing
Asynchronous- | Y Y Y N N Y
to-synchronous

Asynchronous- | Y N N Y Y N
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Service Sender is Receiver is Inbound Outbound Inbound Outbound
Operation Local Local Request Request Response Response
Type Routing Routing Routing Routing
Asynchronous- | N Y Y N N Y

to-synchronous

Asynchronous- | N N Y Y Y Y
to-synchronous

Asynchronous request/response service operations may have the following routing parameters:

Service Sender is Receiver is Inbound Outbound Inbound Outbound
Operation Local Local Request Request Response Response
Type Routing Routing Routing Routing
Asynchronous | Y Y N Y Y N

Request /

Response

Asynchronous |Y N N Y Y N

Request /

Response

Asynchronous | N Y Y N N Y

Request /

Response

Asynchronous | N N Y Y Y Y

Request /

Response

Understanding Transformations on Any-to-Local Routing Definitions

If you define a transformation on an any-to-local routing definition, the system uses the input
message.version on the transform for the inbound request for WSDL. If a transform is defined on the
outbound response, then the system uses the message.version on the output of the transformation for

WSDL.

In cases where the input message.version or output message.version are not defined on the transform, the
system uses the request or response message.version defined on the service operation for WSDL.

Note that any-to-local routing definitions are read-only when WSDL has been exported. As a result, you
cannot change the in/out message transformation, aliases, and so on.
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Defining Routing Parameters for Requests and Responses

Use the Routings-Parameters page (IB_ ROUTINGDEFNDOC) to view and define parameters for
requests and responses associated with a service operation. Information you define includes, routing
external aliases for inbound and outbound requests and responses, as well as any inbound or outbound
transformations to invoke.

To access the Routings - Parameters page, select PeopleTools > Integration Broker > Integration
Setup > Routing Definitions and click the Parameters tab.

This example illustrates the fields and controls on the Routings — Parameters page. You can find
definitions for the fields and controls later on this page.

Routing Definitions Parameters Connector Properies Routing Properties

Routing Name: QE_PO_SYNC

Service Operation: QE_PO_SYNC
Service Operation Version: W1
Sender Node: QE_LOCAL

Receiver Hode: QE_IBTGT

Type: Inbound Response
External Alias:  |Q@E_PO_SYNC.V1
Alias References
Message. Ver into Transform 1: | Q
Transform Program 1: | Q
Transform Program 2: | Q
Message Ver out of Transforms: | Q
Type: Outbound Request
External Alias:  |QE_PO_SYNC.V1
Alias References
Message. Ver into Transform 1: | Q
Transform Program 1: | Q
Transform Program 2: | Q
Message.Ver out of Transforms: | Q

The following page elements display on the Routings-Parameters page:
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Field or Control

Description

Type

Specifies the routing direction and the type of message
(request or response) associated with the service operation.
This information is automatically populated from the service

operation definition.

External Alias

This alias is used as a SOAPAction attribute in the WSDL
binding to identify the service operation in the Integration
Broker metadata.

The routing external alias defaults to
<ServiceOperationAlias>.<Version>, if present. Otherwise it

defaults to <ServiceOperation>.<Version>.

In an asynchronous request/response any-to-local routing, the
outbound routing alias format is <Alias Name> CALLBACK.

<Version>.

For inbound transactions you can fire multiple service
operations for one invocation when external aliases on the
routing definition are the same for each service operation. This
is called service operation mapping.

See Service Operation Mapping.

Duplicate external aliases are not allowed for synchronous
operations.

See Searching for Duplicate External Routing Aliases.

Alias References

Click the link to view other routing definitions with the same

external alias.

See Searching for Duplicate External Routing Aliases.
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Field or Control

Description

WS Security

This link appears on the Parameters page when you are
working with:

*  Non-REST service operations and are integrating with
external nodes.

Click the link to override WS Security settings configured
at the node level for the outbound request or response.

See “Overriding Node-Level WS-Security Settings on
Routing Definitions” (Integration Broker Administration).

*  Outbound consumer REST service operations.

Click the link to set the security level of the outbound
request as required by the REST provider.

See Securing Consumer REST Service Operations.

Message.Ver into Transform 1

Displays the name of the request or response message
associated with the service operation before any

transformations are applied.

For inbound transactions, this is the message name and version
as it arrives from the integration partner system, before any

transformations are applied.

For outbound transactions, this is the message name and
version directly from the PeopleSoft system, before any
transformations are applied.

Transform Program 1

(Optional.) Enter the name of the transform program to invoke
on the message listed in the Message.Ver into Transform 1
field.

Transform Program 2

(Optional.) Enter the name of the transform program to invoke
after the transform program in the Transform Program 1
field has completed processing.

When you invoke two transform programs, the output from the
first transform program (Transform Program 1) is used as the
input into the second transform program (Transform Program
2).
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Field or Control Description

Message. Ver out of Transforms (Optional.) Enter the name of the message after all transform
program have completed processing.

For inbound messages, this is the message name and version
that the PeopleSoft system is expecting.

For outbound messages, this is the message name and version

that the integration partner system is expecting.

When the Routings-Parameters page first displays values for the Message.Ver into Transform 1 and
Message.Ver out of Transforms fields display values to assist you in choosing transform programs.
After you save the page, values do not appear in these fields unless the transform programs have an input/
output messages associated with them.

Note: Based on the transform selected, the message.version of the inbound request or response and

the message.version of the outbound request or response that the system populated on the page can be
different then those specified on the component. Should this occur a warning message displays and you
can accept or reject the message.version information populated on the Routings - Parameters page. If
you reject the message.version information populated on the page, you can modify the fields with the
appropriate message.version information, or change the information that is specified on the component.

Defining and Overriding Gateway and Connector Properties

The Routings-Connector Properties page (IB_ROUTINGDEFCON) enables you to define and override
the default integration gateway and target connector that the local node uses to communicate with an
endpoint for a specific routing definition.

To access the Routings — Connector Properties page select PeopleTools > Integration
Broker > Integration Setup > Routing Definitions and click the Connector Properties tab.

Note: The Routings — Connector Properties page displays in the Routings component only if the receiving
node is not the local node.

This example illustrates the fields and controls on the Routings — Connector Properties page. You can find
definitions for the fields and controls later on this page.

| T [ comecto